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About This Guide

This Novell GroupWise 2012 Installation Guide helps you install a new GroupWise system or update an
existing GroupWise 6.x/7/8 system to GroupWise 2012. The guide is divided into the following

sections:

¢ Part I, “GroupWise Product Overview,” on page 13

*

*

Chapter 1, “What Is GroupWise?,” on page 15
Chapter 2, “GroupWise System Requirements,” on page 19

¢ Part II, “Installation,” on page 27

*

*

*

*

Chapter 3, “Installing a Basic GroupWise System,” on page 29

Chapter 4, “Installing the GroupWise Internet Agent,” on page 77

Chapter 5, “Installing GroupWise WebAccess,” on page 103

Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 123
Chapter 7, “Installing GroupWise Monitor,” on page 151

Chapter 8, “Installing GroupWise Agents,” on page 175

Chapter 9, “Installing the GroupWise Client,” on page 211

Chapter 10, “Using Novell Messenger with GroupWise,” on page 225

Chapter 11, “Using the Novell Data Synchronizer Mobility Pack with GroupWise,” on
page 227

Chapter 12, “Using Novell Vibe with GroupWise,” on page 229

¢ Part III, “Update,” on page 231

*

*

*

*

*

Chapter 13, “What’s New in GroupWise 2012,” on page 233

Chapter 14, “Understanding the Update Process,” on page 239

Chapter 15, “Migrating Away from NetWare,” on page 245

Chapter 16, “Preparing Your GroupWise 8 System for the Update,” on page 249
Chapter 17, “Installing the GroupWise 2012 Software,” on page 251

Chapter 18, “Updating the Primary Domain,” on page 257

Chapter 19, “Updating Secondary Domains,” on page 259

Chapter 20, “Updating Post Offices,” on page 261

Chapter 21, “Updating the GroupWise Internet Agent,” on page 265

Chapter 22, “Updating GroupWise WebAccess,” on page 267

Chapter 23, “Updating the Calendar Publishing Host,” on page 273

Chapter 24, “Updating GroupWise Monitor,” on page 277

Chapter 25, “Updating Users’ GroupWise Windows Clients,” on page 281
Chapter 26, “Updating Earlier GroupWise Systems to Version 2012,” on page 283

¢ Part IV, “Appendixes,” on page 287

*

Appendix A, “GroupWise Version Compatibility,” on page 289

About This Guide
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¢ Appendix B, “GroupWise Linux Executables,” on page 297
¢ Appendix C, “Third-Party Materials,” on page 329

For troubleshooting assistance, see:

¢ GroupWise 2012 Troubleshooting 1: Error Messages

¢ GroupWise 2012 Troubleshooting 2: Solutions to Common Problems

¢ GroupWise 2012 Troubleshooting 3: Message Flow and Directory Structure
¢ Novell Support and Knowledgebase (http://www.novell.com/support)

To search the GroupWise documentation from the Novell Support Web site, click Advanced
Search, select Documentation in the Search In drop-down list, select GroupWise in the Products
drop-down list, type the search string, then click Search.

¢ GroupWise Support Forums (http://forums.novell.com/forumdisplay.php?&f=356)
¢ GroupWise Support Community (http://www.novell.com/support/products/groupwise)

¢ GroupWise Cool Solutions (http://www.novell.com/coolsolutions/gwmag/index.html)

Audience

This guide is intended for network administrators who install and administer GroupWise.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation.

Additional Documentation

For additional GroupWise documentation, see the following guides at the Novell GroupWise 2012
Documentation Web site (http://www.novell.com/documentation/groupwise2012):

¢ Installation Guide

* Server Migration Guide

¢ Administration Guide

¢ Multi-System Administration Guide

¢ Interoperability Guide

¢ Troubleshooting Guides

¢ GroupWise User Frequently Asked Questions (FAQ)

¢ GroupWise User Guides

¢ GroupWise User Quick Starts
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1.1

111

What Is GroupWise?

Novell GroupWise is an enterprise collaboration system that provides secure email, calendaring,
scheduling, and secure instant messaging. GroupWise also includes task management, contact
management, document management, and other productivity tools. Companion products provide
secure instant messaging (Novell Messenger), synchronization with mobile devices (Novell Data
Synchronizer) and teaming workspaces (Novell Vibe) for complete enterprise connectivity and
collaboration.

GroupWise can be used on your desktop on Windows, Macintosh, or Linux, in a Web browser
anywhere you have an Internet connection, on an Apple iPad, and on mobile devices. Your
GroupWise system can be set up on Linux, Windows, or a combination of these operating systems.

The following sections include more details about what GroupWise provides and what you need to
do to set up your GroupWise system to best meet your users’ needs.

¢ Section 1.1, “What GroupWise Provides,” on page 15

¢ Section 1.2, “What You Need to Install,” on page 18

What GroupWise Provides

GroupWise provides communication and collaboration services that are secure, highly available, and
easily accessible:

¢ Section 1.1.1, “Essential Communication and Collaboration Services,” on page 15

¢ Section 1.1.2, “Available Anytime,” on page 16

¢ Section 1.1.3, “Accessible Anywhere,” on page 16

¢ Section 1.1.4, “Always Secure,” on page 17

¢ Section 1.1.5, “Competitive Performance,” on page 17

¢ Section 1.1.6, “Evaluation Version Available,” on page 17

Essential Communication and Collaboration Services

GroupWise provides a variety of tools to enable users to work together and work smarter.

¢ Messaging: Send and receive mail messages, phone messages, and reminder notes. A mail
message is for general correspondence. A phone message is for those who take phone messages
for others. A reminder note includes a start date and, when accepted by the recipient, is posted
to the recipient’s Calendar.

¢ Scheduling: Schedule both appointments and tasks. When you schedule an appointment, you
can search other users’ Calendars to find free times for the appointment. When you schedule a
task, you can assign a priority and due date to the task. If the recipient accepts an appointment
or task, it is automatically added to his or her Calendar.
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Calendaring: View and manage your appointments, tasks, and reminder notes in a Calendar
view. You can create multiple calendars. You can also publish personal calendars and free/busy
status so that non-GroupWise users can conveniently schedule meetings with you.

Task Management: Accept or decline the tasks you are sent, and track accepted tasks through to
completion. You can turn any message into a task. You can also organize, schedule, and monitor
tasks in your Tasklist folder.

Contact Management: Manage information for your contacts, groups, resources, and
organizations, including being able to view, update, delete, and add information to the contacts
in your address books and Contacts folders. In addition, you can view a history of messages sent
to and received from individual contacts and compile notes on interactions with contacts.

Document Management: Store documents in GroupWise libraries. In a library, documents are
compressed to save disk space and encrypted to maintain security. With document
management, you can check in, check out, share, and create multiple versions of documents.

Instant Messaging: Communicate in real time with other GroupWise users through Novell
Messenger. Novell Messenger lets you know when other users are online, busy, or away from
their desks. It also allows you to save conversations.

Teaming: Collaborate on a Novell Vibe Web site where personal, team, and global workspaces
can include discussion folders, shared calendars, shared documents, blogs, wikis, surveys, and
more. Powerful search capabilities make finding information quick and easy. GroupWise
includes integration with Vibe, so that you can access a Vibe site from the GroupWise Windows
client.

1.1.2 Available Anytime

GroupWise ensures that your essential communication tools are always available.

¢ Caching: The GroupWise Windows client includes a Caching mode that allows you to cache

GroupWise information to your local drive and continue to work even when you aren’t logged
into your network mailbox.

LDAP Pooling: If you are using LDAP authentication for GroupWise mailbox authentication,
LDAP pooling ensures that there is always an LDAP server through which authentication can be
performed.

Clustering: To ensure that GroupWise data is always available and GroupWise components are
always running, you can install GroupWise in a cluster on Linux or Windows.

1.1.3  Accessible Anywhere

16

GroupWise lets you communicate and collaborate with other people by using the device that is most
convenient:

¢ Personal Computers: To access your GroupWise mailbox with the most robust functionality,

you can run the GroupWise Windows client on any workstation that uses Windows XP or later.

¢+ Web Browsers: When you are away from your office, or when you prefer a platform other than

Windows, you can access your GroupWise mailbox from a variety of desktop Web browsers by
using GroupWise WebAccess.

¢ Tablet Computers: For those who prefer a more mobile computer, you can access your

GroupWise mailbox from a tablet device such as the Apple iPad.
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1.1.6

¢ Mobile Devices: If you want to access email messages, calendar items, tasks, and so on from a
handheld mobile device such as your cell phone, you have several options:

¢ GroupWise WebAccess: GroupWise WebAccess includes a basic template customized for
use on the small display available on a typical mobile device.

¢ Data Synchronizer Mobility Pack: The Mobility Pack, available free of charge to
GroupWise customers with maintenance contracts, synchronizes GroupWise data to most
popular mobile devices.

¢ BlackBerry Enterprise Server for GroupWise: This solution from Research in Motion
provides synchronization of GroupWise data for BlackBerry users.

¢ Other Email Clients: GroupWise enables you to access your mailbox with any POP3, IMAP4, or
SOAP email client.

Always Secure

GroupWise provides extensive security measures to protect your information.

¢ Encryption: To protect your information as it is stored in the various GroupWise databases and
moved across the network, GroupWise encrypts the information. Each piece of information is
encrypted differently through the use of randomly generated encryption keys.

¢ Open Security Standards: To further ensure that your information is secure while moving
across your internal network or across the Internet, GroupWise supports open security
standards such as Secure Sockets Layer (SSL), Secure Multipurpose Internet Mail Extension (S/
MIME), Public Key Infrastructure (PKI), and Transport Layer Security (TLS).

¢ Spam Protection: To protect you from seeing unwanted messages, the GroupWise Windows
client includes a Junk Mail Handling feature that lets you control unwanted Internet email
messages. In addition, you can configure the GroupWise Internet Agent to reject messages from
known open relay hosts and spam hosts. GroupWise also works with partner products that
provide additional anti-spam solutions.

¢ Virus Protection: GroupWise works with partner products to provide solutions that detect and

eliminate viruses.

For information about additional security solutions available for GroupWise through GroupWise
partners, see the Novell Partner Product Guide (http://www.novell.com/partnerguide).

Competitive Performance

GroupWise functionality compares very favorably with competitive email solutions:
+ Novell GroupWise 2012 and Microsoft Exchange/Outlook 2012 (http://www.novell.com/
products/groupwise/features/groupwise-vs-outlook.html)
¢ Novell GroupWise 2012 and Google Gmail (http://www.novell.com/products/groupwise/

features/groupwise-vs-gmail.html)

Evaluation Version Available

An evaluation version of GroupWise is available on the Novell Downloads Web site (http://
download.novell.com). With the evaluation version of GroupWise, you can create a test GroupWise
system that includes any number of domains, post offices, and users. The evaluation version does not
expire. However, the evaluation software cannot legally be installed and run in a production
environment
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1.2

What You Need to Install

GroupWise includes multiple components that you need to install to realize the full benefits of
GroupWise. However, some components might not be necessary, depending on your needs. The
following table outlines the components, what they provide, and where to find instructions for

installing them.

Component

What it does

Go to

Administration, Agents,
and Windows Client

Internet Agent

WebAccess

Calendar Publishing Host

Monitor

Agents (Message
Transfer Agent, Post
Office Agent, and
Document Viewer Agent)

GroupWise Windows
Client

Necessary for a basic GroupWise
system. These components are
required and must be installed before
any other components.

Provides Internet email
communication, POP3/IMAP4/SOAP
client access, and paging services.

Provides access to mailboxes through
a desktop Web browser, tablet
computer, or mobile device.

Provides public access to personal
GroupWise calendars and free/busy
availability to Internet users.

Provides administrative monitoring of
the GroupWise agents.

Necessary for each new domain and
post office that you create.

Can be rolled out to all GroupWise
Windows users on a convenient
schedule.

Chapter 3, “Installing a Basic GroupWise
System,” on page 29

Chapter 4, “Installing the GroupWise
Internet Agent,” on page 77

Chapter 5, “Installing GroupWise
WebAccess,” on page 103

Chapter 6, “Installing the GroupWise
Calendar Publishing Host,” on page 123

Chapter 7, “Installing GroupWise Monitor,
on page 151

Chapter 8, “Installing GroupWise Agents,”
on page 175

Chapter 9, “Installing the GroupWise
Client,” on page 211

In addition to the sections referenced in the above table, this Installation Guide includes the following

supplemental sections:

¢ Chapter 10, “Using Novell Messenger with GroupWise,” on page 225

¢ Chapter 11, “Using the Novell Data Synchronizer Mobility Pack with GroupWise,” on page 227

¢ Chapter 12, “Using Novell Vibe with GroupWise,” on page 229

The information in these sections is provided as a reference for installing additional components after
you have created your basic GroupWise system.
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GroupWise System Requirements

You, as a GroupWise administrator, must ensure that your system meets GroupWise system
requirements, so that your GroupWise system can be set up successfully. After your GroupWise
system is set up, you must ensure that users’ workstations meet GroupWise client requirements, so
that users can run the GroupWise clients successfully.

¢ Section 2.1, “GroupWise Administration Requirements,” on page 19

¢ Section 2.2, “GroupWise User Requirements,” on page 22

¢ Section 2.3, “Supported Environments,” on page 23

2.1 GroupWise Administration Requirements

¢ Section 2.1.1, “Hardware and Operating System Requirements,” on page 19
¢ Section 2.1.2, “Software Requirements,” on page 20

¢ Section 2.1.3, “Internet Connectivity Requirements,” on page 21

¢ Section 2.1.4, “Web Server Requirements,” on page 21

¢ Section 2.1.5, “Web Browser Requirements,” on page 22

2.1.1 Hardware and Operating System Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

(3 Any of the following server operating systems for the GroupWise agents (Post Office Agent,
Message Transfer Agent, Document Viewer Agent, Internet Agent, Monitor Agent):

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles for the Post Office Agent, the Message Transfer Agent, and the Internet Agent. By
default, the GroupWise agents run as daemons without user interfaces.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack

(3 Adequate server memory as required by the operating system

Depending on the anticipated load on the GroupWise agents, additional memory might be
required, as detailed in Section 8.2.3, “Agent Memory Requirements,” on page 177.

(3 Adequate server disk space as required by each GroupWise component:

¢ Software distribution directory: Approximately 800 MB for all GroupWise components in
one language

GroupWise System Requirements 19



2.1.2

20

¢ Domain directory: 100-200 MB for the domain database, plus 1 GB or more for message
queues when links are down

¢ Post office directory: 5 MB per user (minimum); 100 MB or more per user (recommended);
plus 100-300 MB for the post office database; plus 500 MB or more for message queues
when links are down

¢ Message Transfer Agent/Post Office Agent/Document Viewer Agent installation:
approximately 117 MB (varies by platform)

¢ Internet Agent installation: approximately 91 MB (varies by platform)

¢ WebAccess installation: approximately 127 MB (shared with the Calendar Publishing Host
Application and the Monitor Application when they are installed on the same Web server;
varies by platform)

¢ Calendar Publishing Host installation: approximately 127 MB (shared with the WebAccess
Application and the Monitor Application when they are installed on the same Web server;
varies by platform), plus 50 KB per published calendar and 50 KB per user for free/busy
searching

¢ Monitor installation: approximately 38 MB for the Monitor Agent (varies by platform);
approximately 127 MB for the Monitor Application (shared with the WebAccess
Application and the Calendar Publishing Host Application when they are installed on the
same Web server; varies by platform)

Software Requirements

0

0

eDirectory 8.7 or later, plus the latest Support Pack, with LDAP enabled

You can download Directory from the Novell Downloads site (http://download.novell.com).
ConsoleOne 1.3.6h or later, with the LDAP snap-in installed

GroupWise 2012 includes ConsoleOne 1.3.6h for Linux and for Windows in the downloaded
GroupWise 2012 software image.

You can install the LDAP snap-in for Linux ConsoleOne along with ConsoleOne. You can
download the LDAP snap-in for Windows ConsoleOne from the Novell Downloads site (http://
download.novell.com/Download?buildid=FCT5LqrhcGI~).

ConsoleOne requires IBM JRE 5 Update 11 or later.

On Windows, ConsoleOne also requires the latest version of Novell Client 2 SP1 for Windows.
You can download the latest Novell Client from the Novell Downloads site (http://
download.novell.com).

On Linux, ConsoleOne also requires the X Window System, version X11R6 or later.

Any of the following environments for running ConsoleOne and the GroupWise Installation
program:
¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack
¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers
where the X Windows System is not available.
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* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack, plus the latest Novell Client

* Windows XP Professional, Windows Vista Professional or Business, Windows 7
Professional, or Windows 8 Professional plus the latest Service Pack, plus the latest Novell
Client (ConsoleOne only)

2.1.3 Internet Connectivity Requirements

(3 Internet domain name for your company

(O Internet Service Provider (ISP) or in-house DNS address resolution

2.1.4  Web Server Requirements

The Web server that is supported for your operating system, for use with WebAccess, Monitor, and
the Calendar Publishing Host:

O OES 2 Linux /SLES 10

Apache 2.2 plus:
¢ Tomcat 5 or later

Tomcat 5 is included with the Linux operating system. If it is not already installed, use YaST
to install it before you install the GroupWise software.

¢ IBM JRE 5 or later
¢ ModProxy Module
0 OES11/SLES 11
Apache 2.2 plus:
¢ Tomcat 6 or later

For OES 11, Tomcat 6 is included with the Linux operating system. If it is not already
installed, use YaST to install it before you install the GroupWise software.

For SLES 11, Tomcat 6 is added to the Linux server with the GroupWise software.
¢ IBM JRE 5 or later
¢ ModProxy Module
(0 Windows Server 2003/2003 R2
Microsoft Internet Information Server (IIS) 6 or later plus:
+ Tomcat 6
¢ IBM JRE 5 or later
¢ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

(0 Windows Server 2008/2008 R2
Microsoft Internet Information Server (IIS) 7 or later plus:
¢ Tomcat 6

¢ IBM JRE 5 or later
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+ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

O Windows Server 2012/2012 R2
Microsoft Internet Information Server (IIS) 7 or later plus:
+ Tomcat 6
¢ IBM JRE 5 or later
¢ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

2.1.5 Web Browser Requirements

Any of the following Web browsers for the agent Web consoles:

O Linux: Mozilla Firefox

O Windows: Microsoft Internet Explorer 8.0 or later; Mozilla Firefox; Google Chrome

2.2 GroupWise User Requirements

¢ Section 2.2.1, “GroupWise Client Requirements,” on page 22
¢ Section 2.2.2, “GroupWise WebAccess Requirements,” on page 23
¢ Section 2.2.3, “GroupWise WebAccess Mobile Requirements,” on page 23

2.2.1  GroupWise Client Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.

[ Any of the following desktop operating systems for the GroupWise Windows client:
¢ Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
¢ Windows Vista on a 1 GHz or higher workstation with at least 1 GB of RAM
¢ Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Windows 8 or 8.1 on a 1 GHz or higher workstation with at least 1 GB of RAM

NOTE: Microsoft Surface tablets are not supported. You can synchronize GroupWise data
to the device with the GroupWise Mobility Service.

(3 Approximately 200 MB of free disk space on each user’s workstation to install the Windows
client
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GroupWise WebAccess Requirements

Any of the following user environments:

(3 Any of the following Web browsers:
* Linux: Mozilla Firefox
¢+ Windows: Microsoft Internet Explorer 8.0 or later; Mozilla Firefox; Google Chrome

¢ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

(3 Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that
supports Hypertext Markup Language (HTML) 4.0 or later

NOTE: Microsoft Surface tablets are not supported. You can synchronize GroupWise data to the
device with the GroupWise Mobility Service.

GroupWise WebAccess Mobile Requirements
Any of the following tablet operating systems and devices:

a Apple iOS 4 or later, with the Safari Web browser, on the Apple iPad 1 or 2

O Android 3.2 or 4.0, with the Android web browser, or Android 4.1, with the Chrome browser, on
any Android device

O RIM Tablet OS 1.0.0 or later, with the BlackBerry Playbook Web browser, on the BlackBerry
Playbook 2

NOTE: Microsoft Surface tablets are not supported. You can synchronize GroupWise data to the
device with the GroupWise Mobility Service.

Supported Environments

¢ Section 2.3.1, “IPv6 Support,” on page 23

¢ Section 2.3.2, “Clustering Support,” on page 24

¢ Section 2.3.3, “Xen Virtualization Support,” on page 24

¢ Section 2.3.4, “VMware Support,” on page 24

¢ Section 2.3.5, “Citrix Support,” on page 24

¢ Section 2.3.6, “Domain Services for Windows Support,” on page 25

¢ Section 2.3.7, “Linux File System Support,” on page 25

IPv6 Support

The Post Office Agent, the Message Transfer Agent, the Internet Agent, and the Monitor Agent
support the IPv6 protocol when it is available on the server. If IPv6 is available, the agent detects it
and supports it by default, along with IPv4. The Document Viewer Agent does not support IPv6.

As you configure your GroupWise system and specify the network address of an IPv6 server in
ConsoleOne, you must specify its DNS hostname. IP Address fields in ConsoleOne do not
accommodate IPv6 address format.
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2.3.2

2.3.3

2.3.4

2.3.5

Clustering Support

You can set up your GroupWise system in any of the following clustering environments, as described
in the GroupWise 2012 Interoperability Guide:
¢ “Novell Cluster Services on Linux”

¢ “Microsoft Clustering on Windows”

If you are using one of these clustering environments, follow the installation instructions in the
GroupWise 2012 Interoperability Guide, rather than the installation instructions in this guide.

Xen Virtualization Support

You can install components of your GroupWise system in virtual environments where a software
program enables one physical server to function as if it were two or more physical servers. Xen
virtualization technology in OES 2 (Linux version), OES 11, and SUSE Linux Enterprise Server (SLES)
10 and 11 is supported. For more information, see:

¢ Open Enterprise Server 2 Virtualization Documentation Web site (http://www.novell.com/
documentation/oes2/virtualization.html#virtualization)

¢ SLES Virtualization Technology Documentation Web site (http://www.novell.com/
documentation/vmserver).

Large post offices with busy Post Office Agents are not good candidates for Xen virtualization.
Specialized Post Office Agents, such as an indexing Post Office Agent with no mailboxes and users,
could be virtualized using Xen. Other GroupWise components such as the Message Transfer Agent
and the Internet Agent do well when virtualized using Xen.

VMware Support

GroupWise is supported on the following versions of VMware:

¢ VMware Server (formally GSX Server), an enterprise-class virtual infrastructure for x86-based
servers

+ VMware ESX Server, a data center-class virtual infrastructure for mission-critical environments

For more information, see the VMware Web site (http://www.vmware.com).

All GroupWise components are good candidates for VMware virtualization.

Citrix Support

Any version of the GroupWise client runs successfully on any 32-bit version of Citrix terminal
services.

The GroupWise agents run successfully on Citrix XenServer.

For more information, see the Citrix Web site (http://www.citrix.com).
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2.3.6  Domain Services for Windows Support

GroupWise can be used with Domain Services for Windows (DSfW) in your eDirectory tree.
GroupWise accounts can be added to User objects in the DSfW partition, but all other GroupWise
objects (Domain, Post Office, Agent, and so on) must be created in the eDirectory partition. Do not
install GroupWise on the same server with DSfW.

2.3.7 Linux File System Support

For best GroupWise performance on Linux, the ext3 file system is recommended. If you are running
OES Linux and need the feature-rich environment of the NSS file system, GroupWise is also
supported there. The reiser3 and Btrfs file systems are also supported.

NOTE: If you choose to use the NSS file system, turn off Salvage for best performance. For more
information, see the Novell Open Enterprise Server Documentation (http://www.novell.com/
documentation) .
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Installation

¢ Chapter 3, “Installing a Basic GroupWise System,” on page 29

¢ Chapter 4, “Installing the GroupWise Internet Agent,” on page 77

¢ Chapter 5, “Installing GroupWise WebAccess,” on page 103

¢ Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 123

¢ Chapter 7, “Installing GroupWise Monitor,” on page 151

¢ Chapter 8, “Installing GroupWise Agents,” on page 175

¢ Chapter 9, “Installing the GroupWise Client,” on page 211

¢ Chapter 10, “Using Novell Messenger with GroupWise,” on page 225

¢ Chapter 11, “Using the Novell Data Synchronizer Mobility Pack with GroupWise,” on page 227
¢ Chapter 12, “Using Novell Vibe with GroupWise,” on page 229

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
Wiki (http://wiki.novell.com/index.php/GroupWise).
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3.1

Installing a Basic GroupWise System

Every Novell GroupWise system, whether it services five users or 50,000 users, starts as a basic
GroupWise system. The following sections present the background information and installation
instructions you need to successfully implement your basic GroupWise system.

¢ Section 3.1, “Basic System Overview,” on page 29

¢ Section 3.2, “Planning a Basic GroupWise System,” on page 30

¢ Section 3.3, “Setting Up a Basic GroupWise System,” on page 49

*

Section 3.4, “Testing Your Basic GroupWise System,” on page 70
¢ Section 3.5, “What’s Next,” on page 71
¢ Section 3.6, “Basic GroupWise System Worksheet,” on page 72

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise

2012 Interoperability Guide before starting to set up your GroupWise system.

Basic System Overview

A basic GroupWise system consists of a single domain (the primary domain) with one post office, a
document library, and one or more users, as shown below.

in (& = M Transfer
Domain -\._* -— essage Transfe

L)) Agent
\=b
F 3
Document Viewer
Agent
A 4
Post Office | — Post Office
with Library Qﬁ Agent
F 3
GroupWise

‘ ‘ m Users

Each GroupWise user has a mailbox in the post office. Users run the GroupWise client on a personal

workstation or use GroupWise WebAccess in a Web browser (wherever an Internet connection is
available) in order to access their mailboxes and to send and receive mail.
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3.2

3.2.1

Three agents are installed in a basic GroupWise system:

¢ Post Office Agent (POA): Responds to the GroupWise clients’ requests for mailbox data and
delivers messages between users’ mailboxes in a post office.

¢+ Message Transfer Agent (MTA): Routes messages between post offices (if there is more than
one post office in the domain) and between domains (if there is more than one domain in the
system).

¢ Document Viewer Agent (DVA): Converts attached document files into HTML format for
display in GroupWise WebAccess and for indexing by the POA, if the POA has been configured
to use it.

After you finish setting up your basic GroupWise system, you can review Section 3.5, “What’s Next,”
on page 71 to learn how you can expand your GroupWise system.

Planning a Basic GroupWise System

The GroupWise Installation program helps you install the GroupWise software to the appropriate
locations and helps you create and configure your basic GroupWise system (primary domain, post
office, and agents).

If you are comfortable with your knowledge of GroupWise, you can skip this planning section and
continue with Section 3.3, “Setting Up a Basic GroupWise System,” on page 49. Otherwise, you
should use the “Basic GroupWise System Worksheet” on page 72 to record your decisions about how
to set up your basic GroupWise system. The topics in this section present the required information in
a convenient planning sequence. The Installation Worksheet organizes the information in the order in
which you need it during installation and setup.

¢ Section 3.2.1, “Determining Installation Locations,” on page 30

¢ Section 3.2.2, “Planning Your Primary Domain,” on page 34

¢ Section 3.2.3, “Planning Your Post Office,” on page 40

¢ Section 3.2.4, “Planning Your GroupWise Agents,” on page 43

¢ Section 3.2.5, “Sample GroupWise Configurations,” on page 48

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practice
Wiki (http://wiki.novell.com/index.php/GroupWise).

IMPORTANT: If you plan to install GroupWise in a clustered server environment, refer to the
GroupWise 2012 Interoperability Guide as you plan your GroupWise system.

Determining Installation Locations

The GroupWise Installation program prompts you for information about the Novell eDirectory tree
where you plan to create GroupWise objects and the network server locations where you plan to
create GroupWise directories and install software.

¢ “Novell eDirectory” on page 31

¢ “ConsoleOne” on page 32

+ “GroupWise Software Distribution Directory” on page 32

¢ “Agent Platform” on page 33
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Novell eDirectory

GroupWise is administered through eDirectory, the directory service provided by Novell. All
components, such as domains, post offices, libraries, and agents, as well as all users” GroupWise
accounts, are configured through objects in eDirectory. You need to make sure that you have
eDirectory installed in your environment. eDirectory can be installed on Linux or Windows.

GroupWise 2012 includes the Novell eDirectory downloadable ISO image to assist those who do not
already have eDirectory installed and want to install it on Linux or Windows. Follow the instructions
in the Novell eDirectory Installation Guide (http://www.novell.com/documentation/edir88) to install
eDirectory, along with its latest Support Pack, before proceeding to install your basic GroupWise
system.

¢ “eDirectory Tree Access” on page 31

¢ “User Objects in eDirectory” on page 31

eDirectory Tree Access

In order to access the eDirectory tree, the GroupWise Installation program needs the IP address or
DNS hostname of a server where a replica of the tree can be found. It also needs an eDirectory user
name with Admin-equivalent rights, the password for the user name, and the eDirectory context
where the User object can be found. Some parts of the installation process require LDAP
authentication to eDirectory, so LDAP must be enabled on your eDirectory server.

The GroupWise Installation program must extend the schema of the eDirectory tree where you plan
to create your GroupWise system. Because all objects for a single GroupWise domain must reside in
the same eDirectory tree, installing a basic system (one domain) requires you to extend one tree only.
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Under System Settings, specify the IP address or DNS hostname of a server where a replica of the eDirectory
tree resides. Also provide the authentication information so that the GroupWise Installation program can access
the eDirectory tree and extend the schema.

User Objects in eDirectory

You must make sure all users who will use GroupWise exist in eDirectory. GroupWise accounts can
only be assigned to eDirectory User objects and GroupWise External Entity objects.

NOTE: GroupWise external entities represent non-eDirectory users and are added to eDirectory for
the sole purpose of assigning GroupWise accounts to these users. GroupWise external entities require
GroupWise licenses but not eDirectory licenses. You can add GroupWise external entities only after
you have installed GroupWise.
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ConsoleOne

GroupWise administration is performed through ConsoleOne, using the version listed in Section 2.1,
“GroupWise Administration Requirements,” on page 19. When you install GroupWise, the
GroupWise Administrator snap-ins are copied into an existing ConsoleOne installation. The
GroupWise Administrator snap-ins extend the functionality of ConsoleOne to let you administer
GroupWise. ConsoleOne considerations differ by platform:

Linux: For a GroupWise system on Linux, ConsoleOne must already be installed before you set up your
GroupWise system.

For your convenience, ConsoleOne is included in the downloaded GroupWise 2012 software
image in the consoleone/Linux subdirectory. To install ConsoleOne, run c1-install. Ata
later time, you can install ConsoleOne to additional Linux locations.

The required ConsoleOne installation directory is:
/usr/ConsoleOne

Windows: For a GroupWise system on Windows, you need to decide which ConsoleOne location you want to
use to administer GroupWise. This can be a ConsoleOne location on a network server, such as
where domains and post offices are located, or it can be on a local workstation. If you plan to use
ConsoleOne on a local workstation, you need to perform the ConsoleOne installation from that
workstation.

For your convenience, ConsoleOne is included in the downloaded GroupWise 2012 software
image. The GroupWise Installation program lets you install ConsoleOne if necessary. You can also
use the GroupWise Installation program at a later time to install ConsoleOne and the GroupWise
Administrator snap-ins to additional locations.

The default ConsoleOne installation directory is:

drive:\Novell\ConsoleOne
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Under ConsoleOne Directory, specify the path for the ConsoleOne location you want to use to administer
GroupWise.

For more information about ConsoleOne, see “ConsoleOne Administration Tool” in “System” in the
GroupWise 2012 Administration Guide.

GroupWise Software Distribution Directory

During installation, you are prompted to create a GroupWise software distribution directory on a
network server and then copy selected GroupWise software components to the directory.

You should consider the following when deciding where to create the software distribution directory:

¢ “Disk Space Required for the Software” on page 33

¢ “Default Software Distribution Directory Location” on page 33

GroupWise 2012 Installation Guide



Disk Space Required for the Software

The disk space required for the directory depends on which software components you copy to the
directory. The maximum disk space required to store all the GroupWise software components for one
language is approximately 800 MB. For a breakdown by component, see Section 2.1, “GroupWise
Administration Requirements,” on page 19.

We recommend that you copy at least the GroupWise client files to the directory. This enables users to
install the GroupWise client from the distribution directory. Otherwise, you need to mount the
downloaded GroupWise 2012 software image as a network volume or file system, unless you use one
of the software distribution methods described in “Distributing the GroupWise Windows Client” in
“Client” in the GroupWise 2012 Administration Guide.

NOTE: On Linux, you should install the GroupWise Administration component to your software
distribution directory. It includes the RPMs for GroupWise Check (GWCheck) and the GroupWise
Database Copy utility (DBCopy). These RPMs are not installed by the GroupWise Installation
program. For more information about these utilities, see “Stand-Alone Database Maintenance
Programs” in “Databases” in the GroupWise 2012 Administration Guide.

Default Software Distribution Directory Location

The default location for the software distribution directory varies by platform:

Linux: /opt/novell /groupwise/software

Windows: drive:\grpwise\software
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Under Software Distribution Directory, specify the path for the software distribution directory.

Under Software Selection, mark the software components that you want to copy there.

The GroupWise Installation program lets you create one software distribution directory. After you set
up your basic GroupWise system, you can create additional software distribution directories if
needed. For more information, see “Software Directory Management” in “System” in the GroupWise
2012 Administration Guide.

Agent Platform

The Message Transfer Agent (MTA), the Post Office Agent (POA), and the Document Viewer Agent
(DVA) are available as Linux executables and Windows executables. Plan to create domains and post
offices on the same platform and server where you plan to install the agents.
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Under Agent Software Platform, specify the type of agents (Linux or Windows) you want to use.

Installing a Basic GroupWise System 33



34

3.2.2

Planning Your Primary Domain

The primary domain functions as the main administration unit for the GroupWise system. Domains
that you create after the first domain are secondary domains.

When you configure GroupWise information in eDirectory, it is also stored in the GroupWise domain
database. From the domain database, the GroupWise agents distribute the information to each post
office database. Users then get the information, such as user addresses, from the post office database.
Domains can be located on Linux and Windows servers.

In a multiple-post-office system, the domain also organizes post offices into a logical grouping for
addressing and routing purposes, and enables you to scale your GroupWise system to meet your
current and future needs.

As you create your basic GroupWise system, the Installation program prompts you for information
about the primary domain.

¢ “System and Domain Names” on page 34

¢ “Domain Directory” on page 35

¢ “Domain Context” on page 36

¢ “Domain Language” on page 39

¢ “Domain Time Zone” on page 40

System and Domain Names

Each domain requires a unique name. The name is used as the Domain object’s name in eDirectory. It
is also used for addressing and routing purposes within GroupWise, and can appear in the
GroupWise Address Book. The domain name can reflect a location, company name or branch name,
or some other element that makes sense for your organization. For example, you might want the
domain name to be the location (such as Provo) while the post office name is one of the company’s
departments (such as Research).

A domain name should consist of a single string. Use underscores (_) rather than spaces as separators
between words to facilitate addressing across the Internet.

Do not use any of the characters listed below in system and domain names:

ASCII characters 0-31 Comma ,

Asterisk * Double quote "

At sigh @ Extended ASCII characters that are graphical or typographical symbols; accented
characters in the extended range can be used

Braces { } Parentheses ()

Colon : Period .

IMPORTANT: Name your domain carefully. After it is created, the name cannot be changed.

You must also provide a name for your GroupWise system. The system name is used when
connecting to other GroupWise systems; for this reason, it must be different than any other
GroupWise system with which you might want to connect. The system name can be your company
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name (for example, Novell), GroupWise, or anything else that fits the naming scheme you want to
use. The system name is displayed only in ConsoleOne so any characters can be used. You cannot
change the name after your system is created.
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Under System Settings, specify the name of the GroupWise system that you want to create in eDirectory.

Under Primary Domain Settings, specify the domain name.

Domain Directory

The domain requires a directory structure in which to store database files and temporary files that are
created during message routing. As you choose a location for the domain directory, consider the
following:

¢ “Domain Security” on page 35

¢ “Server Platform and Version” on page 35

¢ “MTA Access” on page 35

¢ “Domain Disk Space Requirements” on page 36

¢ “Domain Directory Name” on page 36

Domain Security

GroupWise users never need access to the domain directory, so you should create it in a location that
you can easily secure.

Server Platform and Version

The domain directory can be located on any of the supported platforms listed in Section 2.1,
“GroupWise Administration Requirements,” on page 19.

MTA Access

The MTA requires direct access to the domain directory so that it can write to the domain database
(wpdomain.db). Therefore, you might want to consider the server type (Linux or Windows) and
location (local or remote) of the MTA before deciding on a domain directory. For information about
the MTA, see Section 3.2.4, “Planning Your GroupWise Agents,” on page 43. For examples of possible
domain directory locations and MTA configurations, see “Sample GroupWise Configurations” on
page 48.

IMPORTANT: On Linux, the MTA must be installed on the same server where its directory structure
is located. A file system mount between Linux servers does not provide the necessary file locking
mechanisms for the GroupWise Linux MTA to write to the domain database on a remote Linux
server.
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Domain Disk Space Requirements

The domain directory requires a minimum of 100-200 MB of disk space for the domain database. In
addition, you should plan for an additional 1 GB or more of free disk space for the temporary storage
of messages when links are down.

For additional guidance, visit the GroupWise Best Practices Wiki (http://wiki.novell.com/index.php/
GroupWise).

Domain Directory Name

You should specify an empty directory for the domain. If you want, the directory can reflect the
domain name you chose. Use the following platform-specific conventions:

Linux: Use only lowercase characters.

Windows: No limitations.

Choose the name and path carefully. After the directory is created, it is difficult to rename.
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Under Primary Domain Settings, specify the full path for the domain directory.

IMPORTANT: The installation process proceeds more smoothly if you create the domain directory
in advance.

Domain Context

You can create the Domain object in any Organization or Organizational Unit container in any
context in your eDirectory tree. The only requirement is that it be in the same tree as the other objects
associated with the domain (Post Office object, User objects, and so on).

The following sections provide examples of where you might place your Domain object. Because it is
helpful to discuss the Domain object’s context in relationship to the Post Office object’s context, the
examples also include context information for the Post Office object.

¢ “Objects in the Same Container as Users’ Organizational Units” on page 37

¢ “Objects Mirror eDirectory Organization” on page 37

¢ “Objects Mirror Network Server Organization” on page 38

¢ “Objects in a Dedicated Container” on page 38

¢ “The GroupWise View in ConsoleOne” on page 39
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Objects in the Same Container as Users’ Organizational Units

In the following example, the Domain object (Provo) and Post Office object (Research) reside in the
same container (Provo) as the organizational units (Accounting, Manufacturing, R&D, and Sales) that
contain the users. This allows you to associate the domain with a single organization and associate
one post office with all users within the organization.

- &2y Prove
Dﬁ Accounting
D@ Manufacturing
-1 Prova
D@ R&D
EEJ Regearch
-8 Sales

Objects Mirror eDirectory Organization

The following example is similar to the previous example, except that a separate post office is created
for each organizational unit that contains users. The Domain object (Provo) resides in the
organization (Provo) and the Post Office objects reside in the same organizational units (Accounting,
Manufacturing, R&D, and Sales) as the users.

=55 Provo

-7 Accounting
- Pavrall
=718 Manufacturing
- Shipping
-8 Provo
=-%8 R&D
w-Ja Research
=78 Sales

- Marketing

As in the previous example, this organizational structure allows you to quickly associate users with
their post offices. In addition, if you have thousands of users split between the different
organizational units, this method allows you to create multiple post offices with a smaller number of
users on each post office.
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Objects Mirror Network Server Organization

Because the domain and post office have directory structures on network servers, you could also
choose to place the Domain and Post Office objects in the same context as the servers where the
directories will reside, as shown in the following example.

-2 Provi

P8 Accounting
8 Manufacturing
%3 RED
-7 Bales
El':'l§ Servers

PRY-RE&D_WOLI
- Research

Objects in a Dedicated Container

If, rather than mirroring your eDirectory or server organization, you prefer to keep all your
GroupWise objects together, you could create a container, such as GroupWise, and place all
GroupWise objects in that container, as shown below.

-2 Provo

----- 53 Accounting
E|‘:'I§ Groupyise
- =-@& Provo
EEJ Research
8 Manufacturing
%3 RED
[ D@ Sales

Administratively, this type of organizational structure makes it easier to restrict a GroupWise
administrator’s object and property rights to GroupWise objects only.

For information about GroupWise administrator rights, see “GroupWise Administrator Rights” in
“Security Administration” in the GroupWise 2012 Administration Guide.
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Under Primary Domain Settings, specify the context where you want to create the Domain object.

IMPORTANT: If the context does not already exist in your eDirectory tree, create the context now.
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The GroupWise View in ConsoleOne

ConsoleOne includes a GroupWise View, displayed under the GroupWise System container.

The GroupWise View filters out all non-GroupWise objects and shows how GroupWise objects relate
to each other. For example, in the left pane, notice the Post Office object (Development) is subordinate
to the Domain object (Provol). You can select an object in the left pane and display its associated
objects (User, Resource, and so on) in the right pane.

Novell ConsoleOne

File Edt Wiew Tools Help
| QF %] Q|3 A& e lfosen ]
Object D | Domsin Mame | Past Office N...| Last Name | Given Name |
T A B adharmapalan Provo3 harketing Dharmapalan  Ahtnah -
i ?" CORP_TREE & aramirez Provao2 Sales Ramirez Art
% Groupitfise & askoczylas  Provol Development Skoczylas Alfons

'5 bgelzoming  Provo3 Marketing Gensaming BEenjii
G cholton Provo3 Marketing Bolton Charles
a thaughey Provo3 Marketing Haughey Flavian —

& Pravol )

% Development {3 ﬂhornpson Provo3 Marketing Tho.mpson Fred
15 gstith Provol Development Smith Grace
'5 hzarmiento  Prowvo2 Sales Sarmiento Hesther
& jdesoto Provo3 Marketing DeSato Janet

% Marketing & jpangilinan Provol Development Pangilinan Joe
'5 Jjstevens Prowvo2 Sales Stevens Jazon
'5 Tracouk Provod Marketing Yacouk Ishmael
a khuang Provol Development Huang Kuo-Chahg
{3 mbarnard Prowvol Development  Barnard Mt
15 mdelstorre Provo2 Sales de la Tarre Martha
n; Frlarmaroux Provo3 Marketing Larmaraux Marie ﬂ

|Corporate Wil |Prnv01 |\\JBD-NW\SYS\gwsystem\pr0v01

The GroupWise View is particularly useful if your GroupWise objects are placed in different contexts
in the eDirectory tree. Rather than searching for GroupWise objects throughout the tree, you can
administer the objects from the GroupWise View.

Some GroupWise administrative functions can only be done in the GroupWise View. This includes
such tasks as defining users from other GroupWise systems so that they appear in your system’s
GroupWise Address Book.

For more information about the GroupWise View, see “GroupWise View” in “System” in the
GroupWise 2012 Administration Guide.

Domain Language

The domain language determines the sort order for items in the GroupWise Address Book.

NOTE: The list of languages displayed in ConsoleOne includes more languages than GroupWise
supports. See “Multilingual GroupWise Systems” in “System” in the GroupWise 2012 Administration
Guide for a list of valid domain languages.
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Under Primary Domain Settings, specify the language for the domain. The domain language becomes the
default language for the domain’s post offices.
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3.2.3

Domain Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time) for
a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles user’s
calendar at 1:00 p.m. Pacific Time.
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Under Primary Domain Settings, specify the time zone for the domain. The domain time zone becomes the
default time zone for the domain’s post offices.

Planning Your Post Office

The post office contains users’ mailboxes. Like a domain, a post office requires a name, has a
directory structure and an eDirectory object, and can be configured to support different languages
and time zones. Post offices can be located on Linux and Windows servers.

The following sections prepare you to supply the GroupWise Installation program with the required
information.

¢ “Post Office Name” on page 40

¢ “Post Office Directory” on page 41

+ “Post Office Context” on page 42

¢ “Post Office Language” on page 42

¢ “Post Office Time Zone” on page 43

Post Office Name

The post office, like the domain, requires a unique name. The name is used as the Post Office object’s
name in eDirectory. It is also used for addressing and routing purposes within GroupWise, and can
appear in the GroupWise Address Book. The post office name can reflect any element that makes
sense for your organization. For example, you might want the domain name to be the location (such
as Provo) while the post office name is one of the company’s departments (such as Research).

Post office names must be a single string. Use underscores (_) rather than spaces as separators
between words to facilitate addressing across the Internet. The same characters that are invalid in
domain names are also invalid in post office names (see “System and Domain Names” on page 34).

IMPORTANT: Name your post office carefully. After it is created, the name cannot be changed.
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Under Post Office Settings, specify the name you have selected.
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Post Office Directory

The post office requires a directory structure in which to store database files and temporary files that
are created during message routing and delivery. As you choose a location for the post office
directory, consider the following:

¢ “Post Office Security” on page 41

¢ “Server Platform and Version” on page 41

¢ “POA Access” on page 41

¢ “Post Office Disk Space Requirements” on page 41
¢ “Post Office Directory Name” on page 42

Post Office Security

The GroupWise Windows client accesses the post office through a client/server (TCP/IP) connection
to the Post Office Agent (POA). GroupWise WebAccess uses an HTTP connection through a Web
server. Therefore, GroupWise users never need access to the post office directory, so you should
create the directory in a location that you can easily secure.

Server Platform and Version

The post office directory can be located on any of the supported platforms listed in Section 2.1,
“GroupWise Administration Requirements,” on page 19.

POA Access

The POA requires direct access to the post office directory so that it can write to the post office
database (wphost . db). Therefore, the POA must be installed on the same server where its directory
structure is located.

Post Office Disk Space Requirements

The post office directory holds users” messages and attachments, so you should plan a minimum of 5
MB per user. 100 MB or more per user is recommended. Although actual messages are relatively
small, message attachments (documents, spreadsheets, images, and so on) can greatly increase the
amount of disk space used.

Using ConsoleOne, you can restrict the amount of disk space users are allowed for their mailboxes.
When you know the number of users and the amount of disk space allocated to each user, you can
more accurately determine the amount of disk space required for the post office.

You can reduce the amount of disk space required for the post office by forcing users to run the
GroupWise Windows clients in Caching mode rather than Online mode. In Online mode, messages
are stored only in the post office. In Caching mode, messages are also stored on users’ local drives, so
you can reduce the size of users’ Online mailboxes independent of what users want to store in
personal locations.

In addition to user messages and attachments, the post office directory also contains a document
library. If you want to use GroupWise document management, you should take into account the disk
space you want to provide for storing documents.

Plan for 100-300 MB for the post office database, which holds the GroupWise Address Book and
updates to it for download by Remote client users. Also plan 500 MB or more for the temporary
storage of messages when links are down.
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Post Office Directory Name

You should specify an empty directory for the post office. If you want, the directory can reflect the
post office name you chose. Use the following platform-specific conventions:

Linux: Use only lowercase characters.

Windows: No limitations.

Choose the name and path carefully. After the directory is created, it is difficult to rename. If the
directory you specify does not exist, it is created during installation.
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Under Post Office Settings, specify the full path for the post office directory.

IMPORTANT: The installation process proceeds more smoothly if you create the post office
directory in advance.

Post Office Context

Like the Domain object, you can create the Post Office object in any Organization or Organizational

Unit container in any context in your eDirectory tree. The only requirement is that it be in the same

tree as the Domain object and other objects associated with the domain (User objects and so on). For
configuration examples, see “Domain Context” on page 36.
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Under Post Office Settings, specify the context where you want to create the Post Office object.

IMPORTANT: If the context does not already exist in your eDirectory tree, create the context now.

Post Office Language

The post office language determines the sort order for items in the GroupWise Address Book.

NOTE: The list of languages displayed in ConsoleOne includes more languages than GroupWise
supports. See “Multilingual GroupWise Systems” in “System” in the GroupWise 2012 Administration
Guide for a list of valid post office languages.

The post office assumes the same language as its domain unless you specify otherwise. For example,
if you set the domain and post office language to English, the GroupWise Address Book items are
sorted according to English sort order rules. This is true even if some users in the post office are
running non-English GroupWise clients such as German or Japanese. Their client interface and Help
files are in German or Japanese, but the sort order in the GroupWise Address Book is according to
English standards. Time, date, and number formats for the non-English clients default to the
workstation language.
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Under Post Office Settings, specify the language for the post office.
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Post Office Time Zone

When a message is sent from a user in one time zone to a user in another time zone, GroupWise
adjusts the message’s time so that it is correct for the recipient’s time zone. For example, if a user in
New York (GMT -05:00, Eastern Time) schedules a user in Los Angeles (GMT -08:00, Pacific Time) for
a conference call at 4:00 p.m. Eastern Time, the appointment is scheduled in the Los Angeles user’s
calendar at 1:00 p.m. Pacific Time.

The post office assumes the same time zone as its domain unless you specify otherwise.
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Under Post Office Settings, specify the time zone where the post office is located.

3.2.4  Planning Your GroupWise Agents

The Message Transfer Agent (MTA) and Post Office Agent (POA) route messages through the
GroupWise system. The MTA handles all message traffic between the domain and post office, while
the POA handles all message traffic within the post office. The Document Viewer Agent (DVA)
converts attached document files into HTML for viewing in GroupWise WebAccess and for indexing
by the POA, if it has been configured to use it. The GroupWise agents can run on Linux and
Windows servers.

¢ Message Transfer Agent: GroupWise requires one MTA per domain, which means that you
need to install and run one MTA for your basic GroupWise system.

In addition to routing user messages between post offices and between domains, the MTA
routes administration messages from the domain to the post office. For example, when a user is
given a GroupWise account in eDirectory, the user is added to the GroupWise domain database.
At the same time, the MTA routes an administration message from the domain to the post office
so that the POA can add the user to the post office database. After the user is added to the post
office database, the post office’s users can see the newly added user’s information in the
GroupWise Address Book

¢ Post Office Agent: GroupWise requires one POA per post office, which means that you need to
install and run one POA for your basic GroupWise system.

The POA routes messages within the post office, updates the post office database when it
receives administration messages from the MTA, and performs other maintenance tasks in the
post office.

¢ Document Viewer Agent: GroupWise requires at least one DVA. It is automatically installed
along with the MTA and the POA.

The DVA can simultaneously convert multiple document files into HTML format. If it
encounters a problem converting a particular document file, the problem does not affect
conversion of other document files, nor does the problem document file affect the functioning of
WebAccess or of the POA.

The following sections prepare you to supply the information required when installing the MTA and
POA:

¢ “Agent Location” on page 44
+ “POA Configuration” on page 44
¢ “MTA Link to the Post Office” on page 45

¢ “Agent Server Consoles and Web Consoles” on page 45
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¢ “Linux Installation Options: Automatic Startup, Document View Agent Configuration, and
Linux Mount Directory” on page 46

+ “Windows Installation Options: SNMP Traps and Service versus Application” on page 47

Agent Location

The MTA requires direct access to the domain directory so that it can write to the domain database.
The POA requires direct access to the post office directory so that it can write to the post office
database. The DVA does not require direct access to any directory, because it communicates with the
POA through TCP/IP.

Install the MTA and the POA on the same server as its directory. For example, you would install the
MTA on the same server as the domain directory and the POA on the same server as the post office
directory. This ensures that the agent always has access to its directory.

IMPORTANT: For Linux, this is required, because file system mounts between Linux servers do not
provide the necessary file locking mechanisms for the GroupWise Linux agents to access their
databases on remote Linux servers. For Windows, other configurations are possible after installation
of your basic GroupWise system, but are not recommended.

Consider these platform-specific guidelines:
Linux: The Linux agents are automatically installed to /opt/novell/groupwise/agents. On Linux,
do not move the agent software to a different location.

Windows: The default installation directory is ¢: \Program Files\Novell\GroupWise
Server\Agents. However, you can install the agents to any directory you want.
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Under Installation Path for your software platform, specify the installation path for the agents.

POA Configuration

In order to configure the POA, you need to know the IP address or DNS hostname of the server
where you plan to install the POA. The POA uses its client/server port to communicate with
GroupWise clients; the default client/server port is 1677. The POA uses its message transfer port to
communicate with the MTA; the default message transfer port is 7101. Use these default port
numbers unless they are already in use by another program on the server where you plan to install
the POA.
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Under POA Network Address, specify the IP address or DNS hostname of the POA’s server, along with the
required port numbers.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the Appendixes.
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MTA Link to the Post Office

To route user and administration messages to the post office, the MTA requires a TCP/IP connection
with the post office’s POA. The MTA uses its message transfer port to communicate with the POA;
the default message transfer port is 7100. Use this default port number unless it is already in use by
another program on the server where you plan to install the MTA.
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Under MTA Network Address, specify the IP address or DNS hostname of the MTA's server, along with the
required port number.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Agent Server Consoles and Web Consoles

The MTA, the POA, and the DVA provide agent server consoles to let you monitor and, for the MTA
and the POA, reconfigure the agents while at the agent servers for the current agent session. The
availability of agent server consoles varies by platform.

Linux: The MTA and POA server consoles are displayed only if you start the agents with the --show
startup switch on the command line or if you use the show = yes option in the GroupWise High
Availability service configuration file (gwha . conf) to cause the grpwise script to start the agents
with server consoles.For more information, see “Configuring the GroupWise High Availability
Service in the gwha.conf File” on page 196.

The DVA does not have a server console on Linux.

Windows: The MTA and POA server consoles are displayed if you run the agents as applications but are not
displayed if you run the agents as services. The DVA displays a console message window, but not
a full server console.

When the agent server consoles are not available, you can monitor and configure the agents through
a Web browser. This feature, referred to as the agent Web console, lets you access the agents’ statistics
and diagnostic information from any location where you are connected to the Internet and have
access to a Web browser.

By default, the MTA Web console is enabled on port 7180, the POA Web console is enabled on port
7181, and the DVA Web console is enabled on port 8301. Use these default port numbers unless they
are already in use by another program on the server where you plan to install the agents.

In your browser, you access the agent Web consoles using the following URLs:
http://agent network address:port

where agent_network_address is the agent’s IP addresses or DNS hostnames and port is the agent’s Web
console HTTP port number.

BASIC GROUPWISE SYSTEM WORKSHEET

Under POA Network Address, specify the POA's HTTP port number.
Under MTA Network Address, specify the MTA's HTTP port number.

Under DVA Network Address, specify the DVA's HTTP port number.
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For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Linux Installation Options: Automatic Startup, Document View Agent
Configuration, and Linux Mount Directory

If you are installing the GroupWise agents on Linux, you have the following additional installation
options:

¢ “Automatic Startup” on page 46

¢ “Enable Document Viewer Agent” on page 46

¢ “Linux Mount Directory” on page 46

Automatic Startup

The Linux GroupWise agents are Run Control compliant. The Installation program creates symbolic
links to the /etc/init.d/grpwise script in the rc3.d and rc5. d directories so that the agents can
load on restart into run level 3 or 5, depending on the configuration of your Linux server.

If you want to configure the agents for high availability, as described in “Enabling the GroupWise
High Availability Service for the Linux GroupWise Agents” on page 195, they must be configured to
start automatically on system startup.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Linux Installation Options, mark whether or not you want to configure the GroupWise Linux agents to
start automatically.

Enable Document Viewer Agent

The Document Viewer Agent is configured for high availability independently from the POA and the
MTA.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Linux Installation Options, mark whether or not you want to configure the Linux Document Viewer gent to
start automatically.

Linux Mount Directory

Typically, Linux servers and workstations use /mnt for the mount directory. In the future as your
GroupWise system grows, the Linux mount directory helps ConsoleOne resolve the UNC paths of
GroupWise domain database locations into Linux paths. Although the mount directory information
is not used when you are creating your basic GroupWise system, it is gathered at this time for later
reference.

GroupWise domains and their associated databases can be located on Linux servers or Windows
servers. In the Linux mount directory, you will eventually create mount points that have the same
names as the servers that are mounted to those mount points. You will need to do this for each server
where a domain is located that you want to access from ConsoleOne on Linux. When you are ready
to expand your basic GroupWise system to additional servers, see “ConsoleOne on Linux” and
“ConsoleOne in a Multiple-Platform Environment” in “System” in the GroupWise 2012 Administration
Guide.
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The following table illustrates the correspondence between UNC paths and Linux mount points for
GroupWise database locations on Linux servers and on Windows servers, assuming the typical Linux
mount directory of /mnt:

Platform GroupWise Domain UNC Path Corresponding Linux Mount Point
Linux: \\1lnx server\gw partition or directory\ /mnt/Inx server/

domain directory gw partition or directory
Windows: \\windows server\gw share\ /mnt/windows server/

domain directory gw_share

IMPORTANT: Although Windows is not a case-sensitive operating system, the case of characters in
path names becomes significant when the directory structure is mounted to a Linux machine.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Linux Installation Options, specify a different directory if you do not want to use the default /mnt
directory.

Windows Installation Options: SNMP Traps and Service versus Application

If you are installing the GroupWise agents on Windows, you have the following additional
installation options:
¢ “SNMP Services” on page 47

¢ “Service versus Application” on page 48

SNMP Services

If you want the GroupWise agents to be able to communicate with SNMP management and
monitoring programs, you must configure them for this functionality during installation. The
Windows SNMP service must already be enabled on the Windows server in order to configure this
functionality for the GroupWise agents.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Windows Installation Options, mark whether you want to configure the GroupWise agents to
communicate with SNMP management and monitoring programs. If you do, ensure that the Windows SNMP
service is enabled on the GroupWise agent server.

For more information about SNMP, see the following sections in the GroupWise 2012 Administration
Guide:

+ “Setting Up SNMP Services for the POA” in “Post Office Agent”
+ “Setting Up SNMP Services for the MTA” in “Message Transfer Agent”
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3.2.5

Service versus Application

You can run the Windows MTA, POA, and DVA as Windows services or applications.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Windows: Installation Options, mark whether you want to run the GroupWise agents as Windows
services.

When you run the agents as Windows services, they must run under a specific user account. The
user account you use depends on where the domain and post office directories are located:

¢ When the domain and post office directories are located on the same server where you are
installing the agents, the agents can run under the local system account and no password is
required.

When the agents run under the local system account, you can enable them to display the agent
server consoles on the server desktop on Windows Server 2003. This interaction with the
desktop is not available on Windows Server 2008 and later Windows versions.

¢ When the domain and post office directories are located on a remote Windows server, you must
specify a user with rights to access the domain and post office directories, along with the user’s
associated password.

¢ For the DVA, the user account depends on the location of the DVA home directory, as described
in “Setting the DVA Home Directory” in “Document Viewer Agent” in the GroupWise 2012
Administration Guide.

IMPORTANT: For simplicity of agent administration, running the GroupWise agents as the
Windows Administrator user is highly recommended.

As with all Windows services, you can start the agents manually or have them start automatically
each time the Windows server restarts.

BASIC GROUPWISE SYSTEM WORKSHEET

Under Windows Service Information, record the Windows user account that the agent services will run under,
and if necessary, the password for the account. If you are using the local system account, indicate whether you
want to allow the agent services to interact with the desktop to display the agent server consoles. Select
whether you want the agent services to start automatically or manually.

Sample GroupWise Configurations

Many different configurations are possible for your GroupWise system after you create your basic
GroupWise system. The following diagrams illustrate a basic GroupWise system (primary domain
and one post office) on Linux and Windows.

¢ “Linux Server” on page 49

¢+ “Windows Server” on page 49
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Linux Server

The following diagram shows all GroupWise components on a Linux server.

Linux
g
/usr/ConsoleOne/bin » — ConsoleOne
Administrator /gwsystem/provo » |— Domain (Provo)
EJ’: /gwsystem/research » [— Post Office (Research)
& loptnovelligroupwise/software » — Software Distribution Directory
Jopt/novell/groupwise/agents/bin (— [ Linux MTA
— Linux POA
— Linux DVA

Windows Server

The following diagram shows all GroupWise components on a Windows server.
Windows

c:\novell\consoleone
— ConsoleOne

\4

c:\gwsystem\provo

— Domain (Provo)

v

Administrator
c:\gwsystem\research

Em — Post Office (Research)
: i ft
~ clgrpwiselsoftware — Software Distribution Directory

v

v

c:\Program Files\Novell\ i
GroupWise Server\Agents (—> [ Windows MTA

t: L Windows POA
— Windows DVA

3.3 Setting Up a Basic GroupWise System

Follow the setup instructions for the platform where you are creating your basic GroupWise system:

¢ Section 3.3.1, “Linux: Setting Up a Basic GroupWise System,” on page 49
¢ Section 3.3.2, “Windows: Setting Up a Basic GroupWise System,” on page 61

3.3.1 Linux: Setting Up a Basic GroupWise System

You should have already reviewed Section 3.2, “Planning a Basic GroupWise System,” on page 30
and filled out the worksheet. The following sections step you through the GroupWise Installation
program.

¢ “Preparing the Linux Server for Your Basic GroupWise System” on page 50

¢ “Starting the Linux GroupWise Installation Program” on page 50

¢ “Installing the GroupWise Software” on page 51
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“Selecting a Linux Mount Directory” on page 53

“Using ConsoleOne to Create Your Basic GroupWise System” on page 53

“Installing and Starting the Linux GroupWise Agents” on page 57

“Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines” on page 61

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise
2012 Interoperability Guide before starting to set up your GroupWise system.

If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for
GroupWise Administration” in the GroupWise 2012 Administration Guide before beginning to set up
your GroupWise system on Linux.

Preparing the Linux Server for Your Basic GroupWise System

1

Ensure that the Linux server for your basic GroupWise system meets the system requirements
listed in Section 2.1, “GroupWise Administration Requirements,” on page 19.

Ensure that the Linux operating system media is available, in case the GroupWise Installation
program needs to install supporting packages on the Linux server.

3 Ensure that the Linux server has a static IP address.

Ensure that the firewall on the Linux server has the ports open that are used by the GroupWise
Post Office Agent (POA) and Message Transfer Agent (MTA).

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

Ensure that the directories exist where you want to create your domain and post office directory
structures, as described in “Domain Directory Name” on page 36 and “Post Office Directory
Name” on page 42.

Ensure that ConsoleOne is installed on the Linux server, as described in “ConsoleOne” on

page 32.

Ensure that eDirectory User objects exist for the GroupWise accounts that you want to create, as
described in “User Objects in eDirectory” on page 31.

Ensure that the eDirectory container objects exist where you want to create the Domain object
and Post Office objects for your Basic GroupWise system, as described in “Domain Context” on
page 36.

Continue with Starting the Linux GroupWise Installation Program.

Starting the Linux GroupWise Installation Program

1
2

In a terminal window, become root by entering su - and the root password.

Run the GroupWise Installation program at the root of the downloaded GroupWise 2012 software
image

./install
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3 Select the language in which you want to run the GroupWise Installation program, then click

OK.

il GroupWise i

Novell. GroupWise

View the Readme

View the Quick Start

View the Installation Guide

Create or update a GroupWise system

Install Products

Displays a web page with important information you should read
before installing.

Displays a high-level checklist of system requirements and installation
steps to guide vou through setting up your Group\ise system.

Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupWise WebAccess and GroupWise Intemet

Agent.

Launches the GroupWise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or
the updating of an existing GroupWise system.

Displays the GroupWise components you can individually install once
you've created a GroupWise system.

4 (Optional) Review the Readme, Quick Start, and Installation Guide to better prepare yourself for
setting up your basic GroupWise system.

5 Continue with Installing the GroupWise Software.

Installing the GroupWise Software

1 Click Create or update a GroupWise system.

N GroupWise Atmin st ationCenfigaraton X |

Introduction

Oo0OoOo0Oood

Cancel

[ introduction Welcome to the GroupWwise &dministration Configuration
Program. This program will do the following:

& Install Administration and Agent soffware
& Set up the software distribution directory

» Update an existing Groupiise system or launch
CaonsaleCne to allow creation of & new GroupWise system

Next |

The list on the left details the steps the Installation program performs for you.

2 Click Next, accept the License Agreement, then click Next.
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3 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.

Software Distribution Directory
Software Selection

The Installation program automatically installs the GroupWise Administrator snap-ins to
ConsoleOne under /usr/ConsoleOne. Then, the Installation program copies the selected
software components into your software distribution directory.

4 When the copying is complete, click Next.

GroupWise Admin St ation|Configuration. i

Create or Update a GroupWise System

[F] Introduction Are you

[F] License Agreement « Creating a new GroupWise system?

[] Software Distribution % Updating an existing GroupWise system?
Directory

[¥] Select Software
[¥] Install & Copy Files

[ create or Update a
GroupWise System

a

Cancel | | Hext

5 Select Creating a new GroupWise system, then click Next.

GroupWise Admin St ation|Configuration. i

Create a Hew GroupWise System

[¥] introduction You can now configure and administer GraupWise from
ConsoleOne.
[¥] License agreement

» Click Run to stant ConsoleOne with the GroupWise Setup

[¥] Software Distribution Advisor to help you configure your system.
Directory
[] select Software & Click Cancel and ConsoleOne will not run at this time.
Hawever, the next time you run ConsoleCne, you will have
[¥] nstall & Copy Files the option to use the Group'Wise Setup Advisor

[] create or Update a
GroupWise System

[¥] Finish

Cancel | Previous | Run

You use the New System utility in ConsoleOne to create your basic GroupWise system.
6 Click Run to start ConsoleOne.

7 Continue with Selecting a Linux Mount Directory.
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Selecting a Linux Mount Directory

The first time you start ConsoleOne with the GroupWise Administrator snap-ins installed, you are
prompted to specify a Linux mount directory under which you create mount points for future
domains in your GroupWise system.

1 In the Linux Mount Directory dialog box, browse to and select the Linux mount directory from
your Basic GroupWise System Worksheet, then click OK.

™ GroupWise Administrater x

Linux Mount Directory:
[ rmnt =

Erter a walid path 1o the roum directory and click OF, or
click Cancel to continue.

The mount directory information is stored in a user-specific preferences file (. consoleone/
SnapinPrefs.ser) in each GroupWise administrator’s home directory. If necessary, you can
later select a different mount directory in ConsoleOne, as described in “Changing the Linux
Mount Directory” in “System” in the GroupWise 2012 Administration Guide

For instructions on using the Linux mount directory after creating your basic GroupWise
system, see “Mounting a Linux File System for a Domain or a Post Office” in “System” in the
GroupWise 2012 Administration Guide.

After you select the Linux mount directory, the New System Utility provides some instructions
for creating your basic GroupWise system.

B GroupWise System Setup x

After authenticating to the eDirectory tree where you want to create the new
Groupiiise system, select the GroupWise System object, then click Toaols > Crouphifise
Utilities > Mew System to create and configure the new system

2 Click OK to proceed into ConsoleOne.

3 Continue with Using ConsoleOne to Create Your Basic GroupWise System.

Using ConsoleOne to Create Your Basic GroupWise System

ConsoleOne automatically attempts to authenticate to an eDirectory tree when it starts.

1 Fill in the fields in the Login window from your Basic GroupWise System Worksheet, then click
Login to start ConsoleOne:

- Login x
Novelil
Login name: | |
Password: | |
Tree: | [~
Context | ‘V|
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If the Login dialog box does not appear automatically, select the NDS object, then click File >

Authenticate. Under some circumstances, you might need to specify the IP address of the server
instead of the tree name.

File Edit Yiew Tools Help

1D Wy wiarld ‘| DS
[ -2 DS ‘| T8 GroupWise Systerm
o @ .CORP_TREE. :

o= [ Groupiise System

2 items 3

Because the GroupWise Administrator snap-ins have been installed to ConsoleOne, a

GroupWise System object is displayed. As you add domains and post offices to your GroupWise
system, they are listed under the GroupWise System object.

2 Under the NDS object, select the tree where you want to create the GroupWise system, then click
Tools > GroupWise Utilities > New System.

= Grouplise System Setup

GroupWise Setup Progress

The first step in creating a Croupiise system is 1o collect
information about the system wou want 1o create

Novell

@Collect systerm information
o Create system

« Install agent software

| < Back “ Next = “ Cancel || Finish " Help |

3 Follow the prompts to provide the GroupWise system and domain information from your Basic
GroupWise System Worksheet.
Software Distribution Directory
eDirectory Tree
eDirectory Schema Extension
System Name
Primary Domain
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Domain Directory
Domain Context
Domain Language
Domain Time Zone

4 Follow the prompts to provide the GroupWise post office information from your Basic
GroupWise System Worksheet.

Post Office Name
Post Office Directory
Post Office Context
Post Office Language
Post Office Time Zone

5 Follow the prompts to provide information about how to link the domain and the post office
from your Basic GroupWise System Worksheet.

Post Office Link
POA Network Address
MTA Network Address

When you have provided the system, domain, post office, and agent information for your
GroupWise system, you are ready to create users. However, adding users at this point is
optional. After the Installation program has finished, you can add users to the post office at any
time by using ConsoleOne. We recommend that you just add yourself and a test user at this
time.

- GroupWise System Setup x

Post Office Users

You can ghve existing eDirectory users Groupiise accounts
on thiz post office now, or you can create Groupiise
accounts later.

Novell.

Select users for the post office

e
| < Back " Mext = ” Cancel ” Finish ” Help |

6 Add users as needed, then click Next.
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The Installation program summarizes your overall progress.
F ] GroupWise System Setup x

GroupWise Setup Progress

You are now ready to create your Croupiifise system. You
will e given a chance to review the inforrmation before your
System is created

Novell.

== ¢’ Collect systemn information
== 55 Create system
« [Install agent software

| < Back " Mext = ” Cancel ” Finish ” Help |

7 Click Next to display a summary of the system, domain, post office, and agent information you

entered.
o GroupWise System Setup x
Summary
Novell.
Swstem narme: Corp Mail
Tree: CORP_TREE
Domain name: waltham1
—— Comain context Croupiifise
2 Comain directory: fawsystern fwaltham 1
== == s Comain time zone: (CGMT-05:00) Eastern Time (US & C
Domain language: English - U
Post office name M anagement
Post office context: Croupiifise
Post office directory.  fgwsysternfmanagerment
- Post office time zone: (GMT-05:00) Eastern Time (US & C
S Post office language:  English - US
4 i I IC

If the abowe information is correct, click Mext 1o create your
Croupiifise sy=tem. To correct amy infarmation, click Back
until wou reach the appropriate page.

| < Back " Mext = ” Cancel ” Finish ” Help |

After you have verified that the information you entered is correct, you are ready to create your
GroupWise system.

8 Click Next to create your GroupWise system.
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The Installation program summarizes your overall progress.
m GroupWise Systam Setup b3

GroupWise Setup Progress

You have successfully created your GroupWise system. You
rmust now install and run the GroupWise agent software.

o ||;IE y’ Collect system information
o = ¢ Create system
= .ﬁl pesl [ [_Evlnstall agent software

Novell.

| < Back " Next “ Cancel ” Finish ” Help |

9 Click Next to install the MTA and POA software.
10 Continue with Installing and Starting the Linux GroupWise Agents.

Installing and Starting the Linux GroupWise Agents

At this point, the Installation program has created eDirectory objects and network server directories
associated with your GroupWise system. You now need to install and start the MTA and POA on

your Linux server.

¢ “Installing the Linux Agents” on page 57

¢ “Starting the Linux Agents with a User Interface” on page 58

Installing the Linux Agents

The GroupWise Installation program starts the Agent Configuration program for you.

GroupWise Agents Configuration

Introduction
[ introduction Welcome to the GroupWise Agent Configuration Program. The
following agent software will be configured
O
hessage Transfer Routes messages hetween domains,
Agent (MTA) post offices, and gateways
Post Office Agent Delivers messages to users'
(PO&): mailhoxes.

Document Yiewer Processes attachments far use with
Agent (DVA): Weh Access.

Cancel | | Hext

1 Review the Introduction, then click Next.
The DVA is configured for high availability separately from the MTA and the POA.
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Document Viewer Agent

2 (Conditional) If you want to configure the DVA for high availability, click Yes.

or
Click No.
N GroupWiza Agents| Configuration S

Configuration Complete

[¥] Introduction Group'ise dgent Configuration is complete.

] configuration Complete W Launch GroupiWise Agents on system startup

| | Exit |

3 On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected by
default.

IMPORTANT: If you want to configure the agents for high availability, as described in
“Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195, they must be configured to start automatically on system startup.

4 (Conditional) If you do not want the agents to start automatically when the server restarts,
deselect Launch GroupWise Agents on System Startup.

5 Click Exit to complete the agent configuration.

6 For convenience, leave ConsoleOne running while you start the agents in a terminal window.
7 Continue with Starting the Linux Agents with a User Interface.

Starting the Linux Agents with a User Interface

1 In a terminal window, become root by entering su - and the root password.

2 Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin

3 Use one of the following commands to start the MTA:
Syntax:

./gwmta --show --home domain directory &
./gwmta --show @domain name.mta &
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Example:

./gwmta --show --home /gwsystem/domlnx &
./gwmta --show @provo.mta &

The --show startup switch starts the MTA with a server console interface similar to that provided
for the Windows MTAs when they run as Windows applications. This user interface requires

that the X Window System and Open Motif be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.

The @domain.mta startup switch specifies the MTA startup files, which contains the --home
startup switch.

To remind yourself of these commands when you are at your Linux server, view the gwmta man

page.

The ampersand (&) causes the MTA to run in the background, so that the terminal window you
started it in is again available for use.

File Configuration Log

Dublin1 - GroupWise MTA

=0OX

Help

Tublinl

Groupllize Message Transfer Fgent

Up Time: 0 Days O Hrs 1 Mins

—Status

Tomaires
Post OFf

Cateways

Processing

*

Total

ices

1
1
2

Statistics
Total

Closed | Routed ]
0| Undeliverable ]

0| Errors ]

0

10 Hirutes
o
o
0

<10412/07 06113145 T15: MTA configuration loaded

[

|E]

The status messages displayed on the MTA server console are also written to the MTA log file
(mmddmta . nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name
includes the month and day when it was created, along with an incrementing extension to

accommodate multiple log files on the same day.

4 In ConsoleOne, check to see that the domain as been updated:

4a Browse to and right-click the Domain object, then click Properties.
4b Verify that the Database Version field displays 12 (short for 2012), then click Cancel.

5 In the terminal window, use one of the following commands to start the POA:

Syntax:

Example:

. /gwpoa
. /gwpoa

. /gwpoa
. /gwpoa

--show
--show

--show
--show

--home post office direc
@post_office name.poa &

--home /gwsystem/polnx &
@polnx.poa &

tory &
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To remind yourself of these commands when you are at your Linux server, view the gwpoa man

page.
Localization Dublin1 - GroupWise POA
File Configuration Log GStatistics Actions Help
Localization, Jublinl Up Time: O Days O Hres 1 Mins
Groupllize Post Office Agent
Status Statistics
Processing * Busyy 0 ¢ 0 C#S Requests: 0 Total Messages: Q
lUser Connectionss @ | Requests Pending: 0 Undeliverable: ]
File Queues: @ | User Timed Outy 0 Problem Messages: ]

02321358 936 Action Set #1 3 Default Mailbox/Library Structure Check
03:21:58 936 Type of Database Files to Check: User Msg Doc

03321358 936 Database Check Actioni Analyze Fizup

03:21:58 936 Level of Database Analysis and Verification: Structural
02321358 926 Delete Temporary/Backup Files Older than (days): 7
03:21:58 936 Event #2 : Default leekly Maintenance Event

02321358 926 Days to Perform Action(s): Sa

03:21:58 936 Time to Perform Action(s): 3:00am

02321358 936 Action Set #1 3 Default Mailbox/Library Structure and Content Check
03:21:58 936 Type of Databasze Files to Check: User Hsg Doc

03121358 936 Database Check Actioni Analyze Fizup

03:21:58 936 Level of Database Fnalysis and YWerification: Structural/Contents
03321358 936 Generate Database Check Statistics

03:21:58 936 Delete Temporary/Backup Files Older than {days): 7
03:21:58 936 PAction Set #2 ¢ Default Audit Report

03321358 936 Database Check Action:Unknoun

03:21:58 938 Distribute Database Check Log to Administrator

0332158 936

03121358 472 Initializing dispatcher

03321358 088 Initializing dispatcher

f3:21:58 E24 MTP: Listening for inbound connections

The status messages displayed on the POA server console are also written to the POA log file
(mmddpoa . nnn) in the /var/log/novell/groupwise/post_office.poa directory. The log file
name includes the month and day when it was created, along with an incrementing extension to
accommodate multiple log files on the same day.

6 In ConsoleOne, check to see that the post office database as been updated:
6a Browse to and right-click the Post Office object, then click Properties.
6b Verify that the Database Version field displays 12 (short for 2012), then click Cancel.

After the post office database has been updated, users can connect to the post office using
the GroupWise Windows client or GroupWise WebAccess.

7 If you want to finish setting up your basic GroupWise system so that users can access it, continue
with Section 3.4, “Testing Your Basic GroupWise System,” on page 70.

or

If you want to learn more about managing the GroupWise agents on Linux, skip to the following
sections in Chapter 8, “Installing GroupWise Agents,” on page 175:

¢ “Starting the Linux Agents as Daemons” on page 188

¢ “Starting the Linux Agents on System Startup” on page 189

¢ “Monitoring the Linux GroupWise Agents from Your Web Browser” on page 200
¢ “Running the Linux GroupWise Agents as a Non-root User” on page 192

¢ “Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195

¢ “Stopping the Linux GroupWise Agents” on page 190
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3.3.2

Installing the GroupWise Administrator Snap-Ins to Additional Linux Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to
ConsoleOne were installed under /usr/ConsoleOne of the server where you ran the GroupWise
Installation program. If ConsoleOne is installed in multiple locations and if you want to be able to
administer GroupWise from those locations, you need to install the GroupWise snap-ins to each
ConsoleOne installation.

1 Go to the Linux machine where you want to install the GroupWise snap-ins to ConsoleOne.

2 Make sure you are logged in as root and have network access to the software distribution
directory or downloaded GroupWise 2012 software image and the domain directory.

3 Start the GroupWise Installation program (install), then click Install Products > GroupWise
Administration > Install Administration.

4 When the installation is complete, click OK, then click Configure GroupWise Administration.

5 Accept the License Agreement, then follow the prompts to provide the necessary information.

6 Repeat Step 1 through Step 5 for each location where you want to install the GroupWise snap-

ms.

7 Skip to What’s Next.

Windows: Setting Up a Basic GroupWise System

You should have already reviewed Section 3.2, “Planning a Basic GroupWise System,” on page 30
and filled out the worksheet. The following sections step you through the GroupWise Installation
program for creating a new GroupWise system.

¢ “Preparing the Windows Server for Your Basic GroupWise System” on page 61

¢ “Starting the Windows GroupWise Installation Program” on page 62

¢ “Installing Your Basic GroupWise System” on page 64

¢ “Starting the GroupWise Agents” on page 66

¢ “Setting Up and Testing the GroupWise Windows Client on the GroupWise Server” on page 66

¢ “Installing the GroupWise Administrator Snap-Ins to Additional Windows Machines” on
page 67

¢ “Setting Up Predefined Installations” on page 68

IMPORTANT: If you plan to install GroupWise in a clustered server environment, see the GroupWise

2012 Interoperability Guide before starting to set up your GroupWise system.

Preparing the Windows Server for Your Basic GroupWise System

1 Make sure that the Windows server for your basic GroupWise system meets the system
requirements listed in Section 2.1, “GroupWise Administration Requirements,” on page 19.

2 Make sure that the Windows server has a static IP address.

3 Make sure that the firewall on the Windows server has the ports open that are used by the
GroupWise Post Office Agent (POA) and Message Transfer Agent (MTA).

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

4 Make sure that the directories exist where you want to create your domain and post office
directory structures, as described in “Domain Directory Name” on page 36 and “Post Office
Directory Name” on page 42.
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5 Make sure that eDirectory User objects exist for the GroupWise accounts that you want to create,

as described in “User Objects in eDirectory” on page 31.

Make sure that the eDirectory container objects exist where you want to create the Domain
object and Post Office objects for your Basic GroupWise system, as described in “Domain
Context” on page 36.

Configure the Windows server to ensure GroupWise database integrity across the network:

7a At the selected Windows machine, right-click the Novell Client icon (the Red N) on the
toolbar at the bottom of your screen, then click Novell Client Properties.

7b Click Advanced Settings.

7c Set File Caching to Off.

7d Set File Commit to On.

7e Click OK to save the new Novell Client settings.

7f Reboot the Windows machine to put the new settings into effect.
(Optional) Enable SNMP.

If you want to monitor the GroupWise Windows agents from an SNMP manager program,
SNMP must be enabled on the Windows server where the agents are installed. If it is not already
enabled, you must enable it before you run the Installation program.

For example, in Windows Server 2008:
8a In the Server Manager, right-click Features, then click Add Features.
8b Select SNMP Services., then click Next.
8c Click Install.

9 Continue with Starting the Windows GroupWise Installation Program.

Starting the Windows GroupWise Installation Program

1 Log in as an Admin equivalent to the eDirectory tree in which you are creating your GroupWise

system.

2 Run setup.exe at the root of the downloaded GroupWise 2012 software image.

3 (Conditional) If prompted, select the language in which you want to run the GroupWise

Installation program, then click OK.

On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.
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The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard

GroupWise

Grouptfize System Installation

iew the Quick Start

iews the Installation Guide

Inztall Groupiwise System

Irztall More Components

Instalshield

Ok

Displays impartant infarmation you should read before instaling Grouplafise.

Displays a high-level checklist of system requirsments and installation steps ta guide
wou through setting up your Grouptise spstem.

Dizplaps overview and task information to help pou plan, instal, and maintain a basic
Grouplwfize gpstem and all additional components.

Creates or updates a basic Groupt/ise system, including Group\wise adrinistration,
the Post Office Agent, the Message Transfer Agent, and the Intemet Agent.

Installs or updates Groupiwise web Access, Groupwise Monitor, the Calendar
Publishing Host, and the Groupwise Windows client.

< Back | Mext » | Cancel |

4 Click Install GroupWise System, then click Yes to accept the License Agreement and display the

Installation Type page.

GroupWise - Installshield Wizard

GroupWise
Inztall Type

[¥] Licerse Agreement
[ Install Type

Installation Guide |

x|
Select a zetup tppe.

& Standard

@ Install GroupWize components and select settings.
" Fredefined
@ Install Groupwise components with settings from a previous installation,

Path ta configuration file from a previous installation:

| =

| Wse predefined settings in an edpress instal

" Uninstall

@ Femove Grouplwize components

< Back | | Cancel |

When you create a new GroupWise system, you are performing a Standard installation. Other
installation options on this page are described in “Setting Up Predefined Installations” on

page 68.
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5 Click Next to accept the default of Standard.

GroupWise - InstallShield Wizard
GroupWise

Ok

Group'wise Compaonents

[¥] License Agreement
[ Install Type Grouplafize system oplions:

[ Group\wise Components ¥ Create a new system
[ Software Platiom ™ Update an existing system

" Install individual components

Select the Groupiwise components you want to install.
¥ | Grouphifise &dministratior

¥ | Grouphifise &gents

I~ Groupiwise Intemnst Agent

Installation Guide |

J | Cancel |

6 Make sure that Create a new system is selected, then click Next.

7 Continue with Installing Your Basic GroupWise System.

Installing Your Basic GroupWise System

1 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.
Software Platform
Administration Options
ConsoleOne Path
Software Distribution Directory
Software Selection

After the GroupWise Installation program has gathered this administrative information, it is
ready to gather information about the eDirectory tree and the GroupWise objects to create.
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2 Follow the prompts to provide the following information from your Basic GroupWise System

Worksheet.

GroupWise - InstallShield Wizard

GroupWise System Creation

Groupwise System Name

E License Agreement

V] Irstall Type

[¥] Groupiwise Components
[¥] Software Platform

V] Admiristration Installation
[¥] Groupiwise Systern Creation

GroupWise system name:

é.

DMS hostname or IP address of the eDirectory server:

GroupWize Syatem Mame
Usemanne:
Frimary Domain Settings

Post Dffice Settings I il
P04 MNetwork Address .

Contest:
MTA Network Address I
[ Agent Installation

D Summary and M odification Pazaward:

[ Firish I jl

ooood

Installation Guide | < Back Mext » Cancel

GroupWise System Name and System Settings
Primary Domain Settings
Post Office Settings

After the GroupWise Installation program has gathered eDirectory information, it is ready to
gather GroupWise agent information.

3 Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.

GroupWise - InstallShield Wizard E|
GroupWise System Creation P~
POA Metwork Address c

[¥] License Agreement

[¥] Install Type

E Groupiw/ise Components
[¥] Software Platfom

[¥] Administration Installation
[¥] Groupiwiss Spstem Creation

Specify the TCP/IP infarmation for the machine that will run the Post Office Agent
[FOA] This information is needed for Groupwise users or the MTA to establish a
TCP/IP connection to the post office.

TCP/P Address

1+ |P address: ‘ |

Groupize Spstem Mame " DNS hostname ‘ |

Primary Domain 5 ettings
Post Office Settings
FO& Network Address
MTA Network Address
D Agent Installation

[ Summan and Modification

[] Finish

Clignt/server part:

O0EEE

Message transfer port:

HTTF part:

Installation Guide < Back Mext » Cancel

POA Network Address
MTA Network Address

Installing a Basic GroupWise System 65



66

Agent Installation Path
Windows Service Information

4 On the Summary and Modification page:
4a Review the installation information you have provided.

4b (Conditional) If you need to change information, select the information to change, then click
Edit setting.

4c Specify the desired information, then click OK.
5 Click Install to start the installation.
Status messages keep you informed about the installation and system creation progress.

6 Click Finish when the installation and system creation is completed.

Starting the GroupWise Agents

The GroupWise Installation program does not start the agent for you. For instructions, see “Starting
the Windows GroupWise Agents” on page 205.

IMPORTANT: The GroupWise agents must be running in order to access your GroupWise mailbox
to send and receive messages.

Setting Up and Testing the GroupWise Windows Client on the GroupWise Server

To test your new GroupWise system, you can install and run the GroupWise Windows client on your
local machine. To accomplish this test quickly, follow the instructions in the specific sections of
Chapter 9, “Installing the GroupWise Client,” on page 211 that are listed below, in order to create test
GroupWise user accounts and mailboxes.

¢ “Assigning GroupWise Accounts to eDirectory Users” on page 211

¢ “Installing and Starting the GroupWise Windows Client” on page 214
As an easy test:

1 Create a test GroupWise account for your own eDirectory user.

You can delete it after the test if you want your permanent mailbox elsewhere in the GroupWise
system.

2 Make sure that you can log in to the test GroupWise account.

3 As a further test, create a second test account, install the client on a second machine, and
exchange messages between the two users.

4 Skip to Section 4.5, “What’s Next,” on page 99.
or

Install the GroupWise Administrator snap-ins to additional locations, as described in Installing
the GroupWise Administrator Snap-Ins to Additional Windows Machines.
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Installing the GroupWise Administrator Snap-Ins to Additional Windows

Machines

As part of creating your basic GroupWise system, the GroupWise Administrator snap-ins to
ConsoleOne were installed in one location. If ConsoleOne is installed in multiple locations and if you

want to be able to administer GroupWise from those locations, you need to install the GroupWise

snap-ins to each ConsoleOne installation.

1 Go to the Windows machine where you want to install the GroupWise snap-ins to ConsoleOne.

2 Configure the Windows machine, as described in Step 7 in “Starting the Windows GroupWise
Installation Program” on page 62.

3 Make sure you are logged in as an Admin equivalent and have network access to a software
distribution directory or the downloaded GroupWise 2012 software image and the domain

directory.

4 Start the GroupWise Installation program (setup.exe).

5 Click Install GroupWise System, click Yes to accept the License Agreement, then click Next to

display the GroupWise Components page.

GroupWise - InstallsShield Wizard

GroupWise
GroupWwise Components

[¥] License Agreement

[#] Install Type

|:| Grouptize Components:
[ Software Platfom

Installation Guide |

X
=)
GroupWWize system oplions:

% Create a new system

" Update an existing system

" Install individual components

Select the Group'wise components pou want to install.
¥ Groughwise Admiistration

¥ Groupiwise sgents

I Groupiwise Internet Agent

<Back | (Hews Cancel

6 Select Install Individual Components.

Installing a Basic GroupWise System

67



68

7 Deselect GroupWise Agents, then click Next.

GroupWise - InstallShield Wizard

Administration Installation

oL

Administration O ptions

[¥] Licerse Agreement
] Instal Type Select the options pou want to install.

E Groupiise Components ¥ Install administration files
[¥] Software Platform

V] Admiristration Installation
[0 Admiristration Options
1 Summary and Modification

] Finish

v Copy files to 2 software distribution directory

Installation Guide | < Back | —

| Cancel |

8 Deselect Copy Files to a Software Distribution Directory, then click Next.

9 Follow the prompts to install the GroupWise Administrator snap-ins to ConsoleOne on your
current Windows machine.

10 Repeat Step 1 through Step 9 for each location where you want to install the GroupWise snap-
ins.

11 Skip to Section 3.5, “What’s Next,” on page 71.

Setting Up Predefined Installations

Whenever you run any installation using the Windows GroupWise Installation program, from a full
system creation to installation of a single GroupWise component, you can save all the information
you provide during the installation into a configuration file. You then have the option of performing
that installation again and again using the previous installation information as defaults for the next
installation, or performing an express installation with no intervention on your part.

You can create installation configuration files to create a new GroupWise system, update an existing
GroupWise system, and install GroupWise administration, agents (the MTA, POA, and DVA as a
group), and the GWIA.

NOTE: You cannot currently create installation configuration files to install GroupWise WebAccess,
GroupWise Monitor, the GroupWise Calendar Publishing Host, or the GroupWise Windows client.
Predefined installations are not available when you run the Linux Installation program.

¢ “Deciding Where to Store Installation Configuration Files” on page 69
¢ “Creating an Installation Configuration File” on page 69

¢ “Running a Predefined Installation” on page 70
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Deciding Where to Store Installation Configuration Files

You can store installation configuration files in any convenient location, taking into account the
following:

¢ If you run the GroupWise Installation program only from your own workstation, you can store
the configuration files locally. However, if you want them to be available from multiple locations
or to multiple users, you should store them on the network.

¢ For the least amount of interaction during predefined installations, you can create the
configuration files with passwords stored in them. Passwords are stored in clear text. Therefore,
if you store the configuration files with passwords, you should store them in a secure location.

Creating an Installation Configuration File

1 Create a directory where you want to store installation configuration files.

2 Run an installation that you want to repeat.

The final Installation program page allows you to create the configuration file.

GroupWise - InstallShield Wizard x|
GroupWise
Installation Complate
IE License Agreement

Groupiwize has installed the selected components successfully.
[¥] Install Type

[¥] Groupiwise Componets
[¥#] Software Platform

. [~ Save settings for a future installation
[¥] Agent Installation

IE‘ Summary and Modification Path ta configuration file for the future installation:
] Finish IC:\grpwise\Agants cfg @

I | Save passwords in e configuration file.

[ Launch GroupWwise agents now

Inztallation Guide | Install Mare Components | < Back Flmsh Cancel

3 Select Save Settings for a Future Installation.
4 Specity the full path and file name for the installation configuration file.
The configuration file name automatically receives a . cfg extension

5 Select Save Passwords in the Configuration File if you store your configuration files in a secure
location and you do not want to be prompted for passwords during an express installation.

6 Click Finish to complete the current installation.
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Running a Predefined Installation

1 Start the GroupWise Installation program, click Install GroupWise System, then click Yes to accept
the License Agreement.

GroupWise - InstallShield Wizard x|
GroupWise
Inztall Type
[¥] License dgreement
Select tup |
|:| Install Type: SIS A SElp e
1 Standard
@ Install Grouptwise components and select settings.
© Predefined
@ Install Groupwise components with gettings fram a previous installation,
Path to configuration file fram a previous installation:
™| sz predefined seffings in an exmress install
© Uninstal
@ Remove GrouptWise components
Installation Guide | < Back Hext> Cancel

2 Select Predefined.

3 Browse to and select the installation configuration file from a previous installation that you want
to repeat.

4 If you want to run the predefined installation without intervention or if you want to stop only
for providing passwords, select Use Predefined Settings in an Express Install.

or

If you want to use the settings in the installation configuration file as the default as you run the
Installation program yourself, do not select Use Predefined Settings in an Express Install.

This option allows you to quickly click through the Installation program pages, while adjusting
only a few settings for the current installation.

5 Click Next to start the predefined installation.

3.4 Testing Your Basic GroupWise System

To ensure that your basic GroupWise system is functioning, you should create two test users and
have them exchange messages.

1 Create test users, as described in Section 9.2.1, “Assigning GroupWise Accounts to Users,” on
page 211

2 Install the GroupWise Windows client to provide mailbox access on a Windows workstation, as
described in Chapter 9, “Installing the GroupWise Client,” on page 211.

or

Install GroupWise WebAccess to provide mailbox access from a Web browser, as described in
Chapter 5, “Installing GroupWise WebAccess,” on page 103

GroupWise 2012 Installation Guide



3 After installing the software necessary to provide mailbox access, log in as each test user and
exchange email messages.

4 (Conditional) If you encounter problems, see “Strategies for Message Delivery Problems” in
GroupWise 2012 Troubleshooting 2: Solutions to Common Problems.

3.5 What's Next

After you have set up your basic GroupWise system, you can expand the system by:
¢ Setting up access to the Internet through the GroupWise Internet Agent (GWIA).

See Chapter 4, “Installing the GroupWise Internet Agent,” on page 77.

¢ Setting up GroupWise WebAccess so that users can access their mailboxes through a Web
browser on a computer or mobile device.

See Chapter 5, “Installing GroupWise WebAccess,” on page 103.

¢ Setting up a GroupWise Calendar Publishing Host so that GroupWise users can share their
personal calendars and free/busy information with Internet users.

See Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 123.
¢ Setting up GroupWise Monitor to monitor your GroupWise agents.
See Chapter 7, “Installing GroupWise Monitor,” on page 151.

¢ Installing the agents on additional servers as you add domains and post offices to your
GroupWise system.

See Chapter 8, “Installing GroupWise Agents,” on page 175.
¢ Setting up users to run the GroupWise client on their workstations.
See Chapter 9, “Installing the GroupWise Client,” on page 211.
¢ Setting up instant messaging capabilities for users.
See Chapter 10, “Using Novell Messenger with GroupWise,” on page 225.
¢ Setting up synchronization between users” GroupWise mailboxes and their mobile devices.

See Chapter 11, “Using the Novell Data Synchronizer Mobility Pack with GroupWise,” on
page 227.

¢ Setting up team collaboration capabilities.
See Chapter 12, “Using Novell Vibe with GroupWise,” on page 229.

After your GroupWise system is fully installed, you can refer to sections of the GroupWise 2012
Administration Guide as you maintain your GroupWise system by:

¢ Adding multiple domains to your GroupWise system.

See “Domains”.
¢ Adding post offices to new domains.
See “Post Offices”.
¢ Adding more users to post offices.
See “Users”.
¢ Defining resources that users can schedule.
See “Resources”.

¢ Defining groups of users that GroupWise users can select when addressing messages.
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See “Distribution Lists, Groups, and Organizational Roles”.

¢ Changing the GroupWise client from Online mode to Caching mode so that users’ messages are
stored on a local drive as well as in the post office.

See “Client”.

¢ Setting up GroupWise Remote so that Windows client users can access their mailboxes from a
computer that is not directly connected to your network.

See “Client”.
¢ Controlling the functionality of users’” GroupWise client software.
See “Client”.
¢ Configuring your current post office’s library or setting up additional libraries.
See “Libraries and Documents”.
¢ Adding additional post offices to the domain.
See “Post Offices”.
¢ Adding additional domains to the system. See “Domains”.

¢ Configuring the Post Office Agent (POA) and Message Transfer Agent (MTA) to support secure
connections (SSL).

See “Post Office Agent” and “Message Transfer Agent”.
¢ Connecting to other GroupWise 6.x, 7, 8, or 2012 systemes.
See the GroupWise 2012 Multi-System Administration Guide.

3.6 Basic GroupWise System Worksheet

Installation Program Field Value for Your GroupWise Explanation

System
Agent Software Platform: Section 3.2.1, “Determining
Installation Locations,” on
¢ Linux page 30
* Windows
GroupWise Basic System “Domain Directory Name”
Directories: on page 36 and “Post Office

Directory Name” on page 42
¢ Domain directory

+ Post office directory
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Installation Program Field

Value for Your GroupWise Explanation

System

Administration Options:

* |Install administration
files

* Yes
+ No

+ Copy files to a
software distribution
directory

* Yes

+ No

Section 3.2.1, “Determining
Installation Locations,” on
page 30.

ConsoleOne Directory:

“ConsoleOne” on page 32

Software Distribution
Directory:

“GroupWise Software
Distribution Directory” on
page 32

Software Selection:

¢ ConsoleOne Snap-ins
+ GroupWise Monitor
+ Windows Agents

+ GroupWise
WebAccess

+ GroupWise Calendar
Publishing Host

* GroupWise Internet
Agent

+ GroupWise Client for
Windows

Section 3.2.1, “Determining
Installation Locations,” on
page 30.

Linux Mount Directory:
¢ /mnt

(default)

“Linux Mount Directory” on
page 46

eDirectory Login
Information:
+ Login name
¢ Password

+ eDirectory tree or DNS
hostname or IP
address of tree

¢ Context

Section 3.2.1, “Determining
Installation Locations,” on
page 30

GroupWise System
Name:

“System and Domain
Names” on page 34
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Installation Program Field Value for Your GroupWise
System

Explanation

Primary Domain Settings:

¢ Domain name

+ Path to domain
database

+ Domain object context
+ Domain language

+ Domain time zone:

Section 3.2.2, “Planning
Your Primary Domain,” on
page 34

Post Office Settings:

+ Post office name

+ Path to post office
database

+ Post office object
context

+ Post office language

* Post office time zone:

Section 3.2.3, “Planning
Your Post Office,” on
page 40

POA Network Address:

¢ |P address

¢ DNS hostname

+ Client/server port
(default 1677)

¢ Message transfer port
(default 7101)

¢ HTTP port
(default 7181)

Section 3.2.4, “Planning
Your GroupWise Agents,”
on page 43

MTA Network Address:

+ |P address

¢ DNS hostname

* Message transfer port
(default 7100)

¢ HTTP port
(default 7180)

Section 3.2.4, “Planning
Your GroupWise Agents,”
on page 43

Installation Path:

“Agent Location” on
page 44
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Installation Program Field

Value for Your GroupWise Explanation

System

Linux Installation
Options:

+ Enable Document
Viewer Agent
* Yes
+ No

¢ Launch the
GroupWise agents on
system startup

* Yes

+ No

“Linux Installation Options:
Automatic Startup,
Document View Agent
Configuration, and Linux
Mount Directory” on

page 46

Windows Installation
Options:

+ Install and configure
SNMP for GroupWise
agents

* Yes
* No

+ |Install as Windows
services

* Yes

* No

“Windows Installation
Options: SNMP Traps and
Service versus Application”
on page 47

Windows Service
Information:

+ Use local system
account

+ Allow service to
interact with
desktop

* Use this Windows user

account

+ Name of
Windows user
account

+ Password
* Startup type

+ Automatic

+ Manual

+ Disabled

”

“Service versus Application
on page 48
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4.1

Installing the GroupWise Internet Agent

The GroupWise Internet Agent (GWIA) enables you to send and receive messages over the Internet.

The following sections provide information to help you successfully install the GWIA in your
existing GroupWise system.

¢ Section 4.1, “GroupWise Internet Agent Overview,” on page 77

¢ Section 4.2, “Internet Agent System Requirements,” on page 80

¢ Section 4.3, “Planning the GroupWise Internet Agent,” on page 81

*

Section 4.4, “Setting Up the Internet Agent,” on page 87

*

Section 4.5, “What's Next,” on page 99

*

Section 4.6, “GroupWise Internet Agent Installation Worksheet,” on page 99

IMPORTANT: If you plan to install the GWIA in a clustered server environment, see the GroupWise
2012 Interoperability Guide before you install the GWIA.

GroupWise Internet Agent Overview

The Internet Agent (GWIA) allows communication between GroupWise users and users of other

messaging systems who send email across the Internet. The GWIA picks up inbound email messages

from the Internet, converts them from RFC-822 or MIME format to the GroupWise message format,
and then passes the converted messages to the GroupWise Message Transfer Agent (MTA).

For outgoing messages to the Internet, the GroupWise MTA passes the messages to the GWIA, which

then converts the messages to Internet messaging format, and then sends them to the designated
Internet addresses.

..—‘
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Choose from the following list of topics to learn more about the capabilities of the GWIA.

¢ “SMTP/MIME Service” on page 78
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¢ “POP3 Service” on page 79

¢ “IMAP4 Service” on page 79

¢ “LDAP Services” on page 79

+ “iCal and iMip Services” on page 79

¢ “Secure Connections via SSL” on page 79
¢ “Access Control” on page 79

¢ “Multiple Threading” on page 79

¢ “SNMP-Compliant” on page 80

SMTP/MIME Service

The SMTP/MIME service in the GWIA allows you to send and receive email with standard encoding
on attachments, international character sets, and multipart messages. Multimedia email with images,
sound, and video can also be exchanged. The service also includes these additional features:

¢ SMTP Dial-Up Service: The GWIA includes SMTP dial-up functionality. This can be useful
when your system does not meet the requirements of a dedicated Internet connection, or when
you prefer not to have a permanent Internet connection. With the SMTP dial-up feature, you can

establish a schedule to periodically check the message store without maintaining a permanent
link.

¢ Flexible Addressing: The GWIA offers full GroupWise addressing support, including system
groups, nicknames, and individual users.

The GWIA also takes advantage of GroupWise Internet addressing, which allows inbound
messages addressed in a variety of formats to be delivered to GW users. These formats include:

UserID@Internet domain name
UserID.PostOffice@Internet domain name
Last_Name.First Name@Internet domain name
First Name.Last Name@Internet domain name
First Initial Last Name@Internet domain name

¢ Internet Users in the Address Book: Internet users can be added to the GroupWise Address
Book so users won't have to remember long Internet addresses.

¢ Real-Time Blacklists: Organizations such as SpamCop provide lists of IP addresses that are
known to be open relay hosts or spam hosts. You can use the real-time blacklists provided by
such sites to protect your users from offensive spam.

¢ Spam Protection: Anti-spam services use different indicators to mark potential spam. One
might use a string of asterisks; the more asterisks, the greater the likelihood that the message is
spam. Another might use a numerical value; the higher the number, the greater the likelihood
that the message is spam. You can configure the GWIA to recognize as spam whatever indicators
your anti-spam service uses and flag such messages for processing by the client Junk Mail
Handling feature.

¢ Accounting: The accounting feature provides inbound and outbound tracking of messages
passing through the GWIA. This lets administrators track how the GWIA is being used.
GroupWise Monitor includes a Gateway Accounting report that organizes information gathered
in GWIA accounting files into a format that is visually easy to read.

¢ DNS Name Resolution: The GWIA can access a DNS server directly to resolve host names to IP
addresses, or it can rely on a relay host to perform the name resolution.

¢ Connect to Other GroupWise Systems Through the Internet: With passthrough addressing,
you can connect to other GroupWise systems anywhere on the Internet and have access to all of
the GroupWise features. The Internet simply becomes a mail transport medium for GroupWise.
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POP3 Service

The Post Office Protocol 3 (POP3) service in the GWIA allows you to download messages from your
GroupWise post office to a POP3 client application such as a Web browser’s email program or a
Telnet application. The GWIA acts as the POP3 server, providing a TCP connection between the
user’s GroupWise post office and a POP3 client. Accessing the GroupWise post office via the GWIA's
POP3 server capability, users can retrieve their email messages and manage them through user ID
login options.

IMAP4 Service

The GWIA supports the Internet Messaging Access Protocol 4 (IMAP4). As an IMAP4 server, the
GWIA allows IMAP4-compliant email clients to read and manipulate GroupWise messages.

LDAP Services

The GWIA supports the Lightweight Directory Access Protocol (LDAP) directory standard with
LDAP server capability that allows access for directory searches of GroupWise post offices. Using
LDAP Public Access, Internet mail clients can do lookups on GroupWise users and address
information.

ICal and iMip Services

The GWIA supports iCalendar (iCal), the Internet Calendaring and Scheduling core object
specification (RFC 2445), and iMIP, the iCalendar Message-based Interoperability Protocol (REC
2447). When a GroupWise user sends an appointment to an external Internet user, the GWIA
converts the appointment into an iMIP message that can be read and accepted, declined, or canceled
in compatible email systems such as Microsoft Exchange and Lotus Notes. GroupWise users can also
receive and accept, decline, or cancel appointments from users of these email systems. Accept/decline
notifications are also exchanged between systems. In addition, tasks to an from users in other email
systems can be marked Completed.

Secure Connections via SSL
The GWIA supports the use of SSL for its connections to SMTP hosts, POP3 clients, IMAP4 clients,

and GWIA Web console.

Access Control

The GWIA includes security capabilities called Access Control that allow administrators to control
user access to all services (SMTP/MIME, LDAP, POP3, and IMAP4). Access Control can help you
reduce costs and provide added security.

With the SMTP/MIME service, Access Control can be used to block messages being sent to or
received from specific host or IP addresses.

Multiple Threading

Multiple threading allows more than one send or receive process to be running concurrently. You can
configure the number of threads to enhance the speed and performance of the GWIA. The number of
threads are set separately for the SMTP/MIME service, POP3 service, IMAP4 service, and LDAP
service.
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The GWIA can be managed by any SNMP-compliant network manager, such as the alarm
management features of Novell ZENworks Server Management.

4.2 Internet Agent System Requirements

The following sections define the system requirements for the Internet Agent (GWIA):

¢ Section 4.2.1, “Hardware and Operating System Requirements,” on page 80
¢ Section 4.2.2, “Software Requirements,” on page 80
¢ Section 4.2.3, “GroupWise System Requirements,” on page 81

¢ Section 4.2.4, “Internet Connectivity Requirements,” on page 81

42.1 Hardware and Operating System Requirements

The network server where you install the Internet Agent (GWIA) must meet the following
requirements:

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
(3 Any of the following server operating systems for the GWIA:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI GWIA server console. By
default, the GWIA runs as a daemon without a user interface.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack

(O Adequate server memory as required by the operating system
[ Adequate server disk space:
¢ Approximately 91 MB for the GWIA program files (varies by platform)

¢ 200 MB minimum for message file processing. The actual amount is determined by the
number and size of message files being processed at one time by the GWIA.

4.2.2 Software Requirements

[ Any of the following environments for running the GroupWise Installation program:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack
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¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers
where the X Windows System is not available.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack, plus
the latest Novell Client

GroupWise System Requirements

The GroupWise system in which you install the Internet Agent (GWIA) must meet the following
requirements:

(3 The domain’s version must be equal to or later than the GWIA'’s version. The domain’s version is
determined by the Message Transfer Agent (MTA) version running for it.

(3 The versions of any post offices that the GWIA accesses on behalf of POP3 or IMAP4 clients
must be equal to or later than the GWIA’s version. A post office’s version is determined by the
Post Office Agent (POA) version running for it.

Internet Connectivity Requirements

Before you install the Internet Agent (GWIA), you need to ensure that your network is configured for
Internet connectivity.

(3 Internet Connection: You can connect to the Internet by using a direct connection over a leased
line or a standard switched telephone line.

O Internet Domain Name: You must have an Internet domain name. The domain name must be
defined by an MX RR (mail exchanger resource record) in DNS.

(3 DNS Server Access or Relay Host Access: If you want the GWIA to send messages directly to
other SMTP hosts, it requires access to a DNS server for address resolution. Otherwise, it
requires access to a relay host that can perform the address resolution and message routing.
Make sure the server where you plan to install the GWIA is configured to access a DNS server or
can access your relay host. For specific details, refer to your server documentation.

(J IP Address: The GWIA’s server requires a static IP address and a fully qualified DNS hostname.

Planning the GroupWise Internet Agent

Use the “GroupWise Internet Agent Installation Worksheet” on page 99 to record your decisions
about how to install the Internet Agent (GWIA). The topics in this section present the required
information in a convenient planning sequence. The Installation Worksheet organizes the
information in the order in which you need it during installation.

¢ Section 4.3.1, “Selecting the GWIA Platform,” on page 82

¢ Section 4.3.2, “Gathering Server Information,” on page 82

¢ Section 4.3.3, “Selecting the GWIA Installation Directory,” on page 83

¢ Section 4.3.4, “Gathering Domain and Gateway Information,” on page 83

*

Section 4.3.5, “Selecting the Gateway Object Name,” on page 84
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¢ Section 4.3.6, “Specifying the Internet Mail Domain Name for Your GroupWise System,” on
page 84

¢ Section 4.3.7, “Handling Outbound Mail,” on page 84

¢ Section 4.3.8, “Enabling the GWIA Web Console,” on page 84

¢ Section 4.3.9, “Linux Installation Options: LDAP Information, Automatic Startup, and
Clustering,” on page 85

¢ Section 4.3.10, “Windows Installation Options: SNMP Traps and Service versus Application,” on
page 86

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
Wiki (http://wiki.novell.com/index.php/GroupWise).

IMPORTANT: If you plan to install the GWIA in a clustered server environment, refer to the
GroupWise 2012 Interoperability Guide as you plan your GWIA installation.

Selecting the GWIA Platform

The GWIA is available as a Linux executable and a Windows executable.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Software Platform, mark whether you plan to install the GWIA on Linux or Windows. Review Section 4.2,
“Internet Agent System Requirements,” on page 80 to ensure that the specific server you have selected meets
the listed requirements.

Gathering Server Information

The GWIA and the MTA can communicate by transferring message files through message queue
directories, as shown in diagrams in GroupWise 2012 Troubleshooting 3: Message Flow and Directory
Structure:

¢ “Mapped/UNC Link Open: Outbound Transfer to the Internet Successful”
¢ “Mapped/UNC Link Open: Inbound Transfer from the Internet Successful”

As an alternative, you can configure the GWIA so that it uses TCP/IP to communicate with the MTA,
instead of message files, as shown in these additional diagrams:

¢ “TCP/IP Link Open: Outbound Transfer to the Internet Successful”
¢ “TCP/IP Link Open: Inbound Transfer from the Internet Successful”

The GroupWise Installation program needs to know the network address of the server where the
GWIA will run. For best performance, install the GWIA on the same server with the domain it
belongs to. In this configuration, in a GroupWise system with a single GWIA, UNC links between the
GWIA and the MTA are most effective. Therefore, the GWIA Installation program displays a default
port number of 0 (zero), indicating that TCP/IP will not be used.

In a larger GroupWise system with multiple GWIAs, you can configure the GWIA to communicate
with the MTA by way of TCP/IP. This configuration enables you to designate an alternate GWIA for
the domain. With this configuration, if the domain’s primary GWIA goes down, the MTA can fail
over to another GWIA in your GroupWise system until the primary GWIA is up and running again.
This feature is especially useful in larger GroupWise systems where multiple GWIAs handle a large
number of Internet messages.
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4.3.4

If you want to enable TCP/IP communication between the GWIA and the MTA, use a port number of
7102 or any other available port number. If you do not want to enable TCP/IP communication, use 0
(zero) as the port number.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Server Information, list the IP address and DNS hostname of the server where you plan to install the
GWIA. Also, specify the port number for TCP/IP communication if you want to enable it.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Selecting the GWIA Installation Directory
The GWIA installation directory depends on the platform where you are installing it.

Linux: The Linux GWIA is automatically installed to /opt /novell/groupwise/agents.

Windows: The default installation directory is c: \Program Files\Novell\GroupWise Server\GWIA.
However, you can install the GWIA to any directory you want.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Installation Path, record the directory where you want to install the GWIA software.

Gathering Domain and Gateway Information

The GWIA requires a GroupWise gateway directory in which to store configuration information and
work files. The gateway directory must be located under a GroupWise domain directory. The default
directory name is gwia. If you change the name, use the following platform-specific conventions:

Linux: Use only lowercase characters

Windows: No limitations.

After you specify the domain directory location and a gateway directory name, the GroupWise
Installation program creates the gateway directory under the domain\wpgate directory (for example,
provo\wpgate\gwia).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under GroupWise Domain, specify the domain name and the full path to the domain directory where you want
to create the gateway directory, then give the gateway directory a name.

If you are installing the Linux GWIA, record the eDirectory context of the Domain object in LDAP format (for
example, cn=provo, ou=groupwise, o=corporate).
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4.3.5 Selecting the Gateway Object Name

The GWIA also requires a GroupWise Gateway object in Novell eDirectory. By default, it is named
the same as the gateway directory and is referred to as the GWIA object. This object stores the
GWIA's information and enables configuration of the agent through ConsoleOne.

The GWIA object is created below the Domain object. If you have multiple domains, the GroupWise
Installation program uses the Domain object associated with the domain directory where you are
creating the GWIA gateway directory.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Internet Agent Object Name, specify the name you want to give the GWIA's eDirectory object. The
default name is the same as the gateway directory name you chose under GroupWise Domain.

4.3.6  Specifying the Internet Mail Domain Name for Your GroupWise System

When email users across the Internet address messages to GroupWise users, the address includes the
Internet mail domain for your GroupWise system (for example, novell.com). Typically, the Internet
mail domain name for your GroupWise system is the name of your company, with its accompanying
domain type (.com, .edy, and so on).

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Internet Mail Domain Name, specify the name you want your GroupWise system to be known by across
the Internet.

4.3.7 Handling Outbound Mail

If the GWIA is connected to the Internet and is able to perform DNS name resolution, it can send
messages from GroupWise users directly across the Internet to Internet users. However, you might
prefer to keep the GWIA behind your firewall. To accomplish this, you can configure the GWIA to
route all outbound messages to a relay host.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEETT

Under Relay Host, mark how you want to handle outbound mail. If you plan to use a relay host, specify the IP
address of the relay host.

4.3.8 Enabling the GWIA Web Console

84

The GWIA server console enables you to monitor the GWIA from the server where it is running. If
you want, you can enable the GWIA Web console. The Web console lets you view the GWIA’s
statistical and diagnostic information through a Web browser, which is useful if want to see the
GWIA's activity without physically visiting the agent’s server.

You access the Web console by entering the GWIA's network address and HTTP port number in a
Web browser (for example, http://172.16.5.18:9850). If necessary, you can change the GWIA's
default HTTP port number (9850).
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If you want to restrict access to the Web console, you can assign a user name and password. This can
be any user name and password you want. By default, the user name and password are passed
through a non-secure connection between the Web browser and the GWIA. Therefore, we
recommend that you do not use an existing eDirectory user name and password unless you secure
this connection by using SSL. For information about securing the GWIA’s connections, see “Internet
Agent” in the GroupWise 2012 Administration Guide.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Enable Web Console, select Yes if you want to enable the GWIA Web console. If you want to restrict
access to the Web console, enter a user name and password.

Linux Installation Options: LDAP Information, Automatic Startup, and
Clustering

When you install the Linux GWIA, the following Linux-specific options are available in the
Installation program:

¢ “LDAP Information” on page 85
¢ “Automatic Startup” on page 86

¢ “Clustering on Linux” on page 86

LDAP Information

The Installation program needs to access eDirectory through LDAP. eDirectory access is required in
order to create the GWIA object. To obtain access, the Installation program needs the IP address and
port number of an LDAP server, along with an eDirectory user name and password to log in with.
The user must have sufficient rights to create GroupWise objects in eDirectory. Because the
Installation program uses LDAP to access eDirectory, you must provide the user name in LDAP
format. For example:

cn=admin, ou=users, o=corporate

If you want to secure the connection to eDirectory with SSL, you can specify a certificate file. For
background information about SSL, see “Trusted Root Certificates and LDAP Authentication” in
“Security Administration” in the GroupWise 2012 Administration Guide.

IMPORTANT: If you do not want to use SSL, the LDAP server must be configured to accept clear
text passwords. This is configured on the server’s LDAP Group object in ConsoleOne by deselecting
Require TLS for Simple Binds with Password. The LDAP snap-in to ConsoleOne is required in order to
change the setting.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Linux LDAP Authentication, specify the IP address and port number of an LDAP server, a user name in
LDAP format, the password for the user name, and if necessary, the full path to your SSL root certificate file.
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Automatic Startup

The Linux GWIA is Run Control compliant. You can have the Installation program create symbolic
links to the /etc/init.d/grpwise script in the re3.d and rc5. d directories so that the GWIA starts
on server restart into run level 3 or 5, depending on the configuration of your Linux system.

If you want to configure the GWIA for high availability, as described in “Enabling the GroupWise
High Availability Service for the Linux GroupWise Agents” on page 195, it must be configured to
start automatically on system startup.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Linux Installation Options, mark whether or not you want to configure the Linux server to start the GWIA
automatically.

Clustering on Linux

On Linux, you can install the GWIA on Novell Cluster Services. The Linux GroupWise Installation
program provides a Configure GroupWise for Clustering option that simplifies the process of installing
the Linux GWIA on multiple nodes in the cluster.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Linux Installation Options, mark whether or not you want to configure the Linux GWIA for clustering
using Novell Cluster Services. If you do, follow the installation instructions provided in “Implementing the
Internet Agent in a Linux Cluster” in “Novell Cluster Services on Linux” in the GroupWise 2012 Interoperability
Guide, rather than the installation instructions provided in this guide.

Windows Installation Options: SNMP Traps and Service versus
Application

When you install the Windows GWIA, you have choices about how the GWIA interacts with the
Windows operating system.

¢ “SNMP Traps” on page 86

+ “Service versus Application” on page 87

SNMP Traps

If you want to use an SNMP manager program to monitor the Windows GWIA, you must install
some SNMP components along with the GWIA software.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Windows Installation Path, mark Install and Configure SNMP for GroupWise Agents if you want to use
an SNMP manager program.

If this option is dimmed during installation, the SNMP service has not been enabled on the Windows server
where you are installing the GWIA. If you want to monitor the GWIA from an SNMP management program, the
SNMP service must be enabled so you can select this option.
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NOTE: The Linux GWIA relies on operating system components for SNMP functionality and does
not require this installation option.

Service versus Application

You can run the Windows GWIA as a Windows service or application.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Windows Installation Options, mark whether you want to run the GWIA as a Windows service.

When you run the GWIA as a Windows service, it must run under a specific user account. The user
account you use depends on where the domain directory is located:

¢ When the domain directory is located on the same server where you are installing the GWIA, the
GWIA can run under the local system account and no password is required.

When the GWIA runs under the local system account, you can enable it to display the GWIA
server consoles on the server desktop on Windows Server 2003. This interaction with the
desktop is not available on Windows Server 2008 or later Windows versions.

¢ When the domain directory is located on a remote Windows server, you must specify a user with
rights to access the domain directory, along with the user’s associated password.

IMPORTANT: For simplicity of GWIA administration, running the GWIA as the Windows
Administrator user is highly recommended.

As with all Windows services, you can start the GWIA manually or have it start automatically each
time the Windows server restarts.

GROUPWISE INTERNET AGENT INSTALLATION WORKSHEET

Under Windows Service Information, record the Windows user account that the GWIA service will run under,
and if necessary, the password for the account. If you are using the local system account, indicate whether you
want to allow the GWIA service to interact with the desktop to display the GWIA server console. Select whether
you want the GWIA service to start automatically or manually.

Setting Up the Internet Agent

Complete the following tasks to set up the Internet Agent (GWIA):

¢ Section 4.4.1, “Installing the GWIA,” on page 88

¢ Section 4.4.2, “Setting Up Internet Addressing,” on page 94
¢ Section 4.4.3, “Assigning a Postmaster,” on page 96

¢ Section 4.4.4, “Starting the GWIA,” on page 96

¢ Section 4.4.5, “Testing the GWIA,” on page 98
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Installing the GWIA

As you install the GWIA, you are prompted to supply configuration information. You should have
already reviewed Section 4.3, “Planning the GroupWise Internet Agent,” on page 81 and filled out
the worksheet. The following sections step you through the GroupWise Installation program for
installing the GWIA.

¢ “Linux: Installing the GWIA” on page 88
+ “Windows: Installing the GWIA Software” on page 91

IMPORTANT: If you plan install the GWIA in a clustered server environment, see the GroupWise
2012 Interoperability Guide before you install the GWIA.

Linux: Installing the GWIA

¢ “Preparing the Linux Server for the GWIA” on page 88
¢ “Installing the Linux GWIA Software” on page 89
If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for

GroupWise Administration” in the GroupWise 2012 Administration Guide before you install the GWIA
on Linux.

Preparing the Linux Server for the GWIA
1 Make sure that the Linux server where you are installing the GWIA meets the system
requirements listed in Section 4.2, “Internet Agent System Requirements,” on page 80.
2 Make sure that the Linux server has a static IP address.
3 (Conditional) If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server:

Disable it. For example, use the following commands to stop and disable Postfix:

/etc/init.d/postfix stop
chkconfig postfix off

or

Configure the GWIA to bind exclusively to the server IP address, as described in “Binding the
GWIA to a Specific IP Address” in “Internet Agent” in the GroupWise 2012 Administration Guide,
so that the GWIA does not conflict with the default Postfix IP address of 127.0.0.1 (the loopback
address).

4 (Conditional) If you want to use the GWIA for POP3 and IMAP4 mail, make sure no POP3 or
IMAP4 daemons are running on your Linux server.

5 Make sure that the firewall on the Linux server has the ports open that are used by the GWIA.
For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

6 Make sure that LDAP is running on your eDirectory server and that it is configured to accept
login from the GroupWise Installation program.

The GroupWise Installation program requires eDirectory access in order to create the GWIA
object in eDirectory. The Installation program uses LDAP to gain the required access.

7 Continue with Installing the Linux GWIA Software.
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Installing the Linux GWIA Software
1 In a terminal window on the server where you want to install the GWIA, log in as root, then
provide the root password.
2 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the GWIA software to a software distribution directory, change to /
opt/novell/groupwise/software.

3 Run ./install.

The X Window System is required for running the GUI GroupWise Installation program. If you
are not using the X Window System, you can install GroupWise components individually, as
described in “Installing GroupWise Components Using the Text-Based Installation Program” on
page 185.

4 Select the language in which you want to run the GroupWise Installation program, then click
OK.

The main GroupWise System Installation page appears.

Novell. GroupWise

View the Readme Displays a web page with important information you should read
before installing.

View the Quick Start Displays a high-level checklist of system requirements and installation
steps to guide vou through setting up your Group\ise system.

View the Installation Guide Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupWise WebAccess and GroupWise Intemet
Agent.

Create or update a GroupWise system Launches the GroupWise Installation and Setup Advisors. These

advisors step you through the creation of a new GroupWise system or
the updating of an existing GroupWise system.

Install Products Displays the GroupWise components you can individually install once
you've created a GroupWise system.

5 Click Install Products > GroupWise Internet Agent > Install Internet Agent to install the GWIA
software.

6 When the installation is complete, click OK.
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7 Click Configure Internet Agent.

N GroupWise Internet Agent Configuration x|

Introduction

[ introduction Welcome to the Group'ise Internet dgent Configuration

Fragram. This program will do the following

+ Create the GroupWise Internet Agent abject in eDirectary

= Configure startup files for GroupWise Internet Agent

OooooOoooOooao

Cancel Mext |

8 Follow the prompts to configure the GWIA using the following information from the

GroupWise Internet Agent Installation Worksheet:

Server Information

Relay Host

Internet Mail Domain Name
Domain Directory

LDAP Authentication
Gateway Object
N GroupWise Internet Agent Configuration x

Configuration Complete

[¥] introduction Group'ise Internet Agent Configuration is completa.

| Fezia Sy el W Launch Intarnet Agant on system startup
[] server Information

[¥] Relay Host

[¥] Intemet Mail Domain Hame
[¥] Domain Directory

[F] LDAP Authentication

[¥] Gateway Object

[¥] Configuration Complete

| | Exit |

On the Configuration Complete page, Launch Internet Agent on System Startup is selected by
default.

IMPORTANT: If you want to configure the GWIA for high availability, as described in
“Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195, it must be configured to start automatically on system startup.

(Conditional) If you do not want the GWIA to start automatically when the server restarts,
deselect Launch Internet Agent on System Startup.

10 Click Exit to exit the GWIA Installation program.
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The GWIA software is installed to /opt /novell/groupwise/agents.
11 Skip to “Setting Up Internet Addressing” on page 94.

Windows: Installing the GWIA Software

¢ “Preparing the Windows Server for the GWIA” on page 91
¢ “Installing the Windows GWIA Software” on page 91

Preparing the Windows Server for the GWIA
1 Make sure that the Windows server where you are installing the GWIA meets the system
requirements listed in Section 4.2, “Internet Agent System Requirements,” on page 80.
2 Make sure that the Windows server has a static IP address.

3 Make sure that the firewall on the Windows server has the ports open that are used by the
GWIA.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

4 Make sure that no other GroupWise agents are currently running on the server where you want
to install the GWIA.

5 Make sure that you have access to the directory where you want to install the GWIA and to the
domain directory.

6 Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the
Installation program to create the GWIA object.

7 Continue with Installing the Windows GWIA Software

Installing the Windows GWIA Software

1 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the GWIA software to a software distribution directory, change to
that location

2 Run setup.exe.

3 (Conditional) If prompted, select the interface language for the Installation program, then click
OK.

On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.
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The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard
GroupWise

Grouptfize System Installation

Ok

{View e Bedne |

| Displays impartant infarmation you should read before instaling Grouplafise.

iew the Quick Start

Displays a high-level checklist of system requirsments and installation steps ta guide
wou through setting up your Grouptise spstem.

| Dizplaps overview and task information to help pou plan, instal, and maintain a basic

“iews the Installation Guide Grouplwise system and all additional componerits.

Creates or updates a basic Groupt/ise system, including Group\wise adrinistration,
Install Groupwise Systemn the Post Office Agent, the Message Transfer Agent, and the Intemet Agent.

Irztall More Components

Installs or updates Groupiwise web Access, Groupwise Monitor, the Calendar
Publishing Host, and the Groupwise Windows client.

Instaltield <Back | Hews | cancel |

4 Click Install GroupWise System, then click Yes to accept the License Agreement and display the
Installation Type page.

GroupWise - Installshield Wizard x|
GroupWise
Inztall Type

[¥] Licerse Agreement

|:| Install Type Select a zetup tppe.

& Standard

@ Install GroupWize components and select settings.
" Fredefined
@ Install Groupwise components with settings from a previous installation,

Path ta configuration file from a previous installation:

| =

| Wse predefined settings in an edpress instal

" Uninstall

@ Femove Grouplwize components

Installation Guide | < Back |

| Cancel |

When you install the GWIA, you are performing a Standard installation. Other installation
options on this page are described in “Setting Up Predefined Installations” on page 68.
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5 Click Next to accept the default of Standard.

GroupWise - InstallShield Wizard él
GroupWise
Group'wise Compaonents

[¥] License Agreement
[ Install Type Grouplafize system oplions:

[ Group\wise Components ¥ Create a new system
[ Software Platiom ™ Update an existing system

" Install individual components

Select the Groupiwise components you want to install.
¥ | Grouphifise &dministratior

¥ | Grouphifise &gents

I~ Groupiwise Intemnst Agent

Installation Guids | < Back |

Cancel |

6 Select Install Individual Components, deselect GroupWise Administration and GroupWise Agents,
then select GroupWise Internet Agent.

7 Follow the prompts to configure the GWIA using the following information from the
GroupWise Internet Agent Installation Worksheet:

Software Platform

Installation Path

Windows Installation Options
Server Information

Web Console Information

Relay Host

GroupWise Domain

GroupWise Internet Agent Name
Internet Mail Domain Name
Windows Service Information
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GroupWise - InstallShield Wizard

GroupWise Settings
Summary and Modification

[] License Agreement

[¥] Install Type

[¥] Groupwise Components
[¥] Software Platform

E Internet Agent Installation
[ Summary and Modification

[ Finish

Installation Guide

Modify the settings pou wish to change.
Setting

é

| Valug |

GroupiWise [ntermet Agent
Installation path
windows service
Inztall only
IP addiess
Pait
Enable web console
Usemarne
Password
HTTF part
Send outbound mail through a relay host
Domain path
GroupiWise Internet Agent subdirectory
Object name
Host portion af the Internet mai domain name

Edit setting

C:\Program Files [=86MNovell ..
Mo

Mo

172165618

702

Yes

admin

9860

No
C:hgwaystembprovo?
Giwila

Giwila

ConzoleOne

< Back Inslall Cancel

8 On the Summary and Modification page:

8a Review the installation information you have provided.

8b (Conditional) If you need to change information, select the information to change, then click
Edit Setting, specify the desired information, then click OK.

9 Click Install to start the GWIA installation.

Status messages keep you informed about the installation progress.

The GWIA software is installed into the following directory:

c¢:\Program Files\Novell\GroupWise\GWIA

10 When the installation is complete, click Finish, then continue with Setting Up Internet

Addressing.

Setting Up Internet Addressing

When you install the GWIA, it by default supports native Internet-style addressing consisting of a
user name and Internet domain name (for example, userID@Internet_domain_name). The GroupWise
Installation program provided the opportunity for you to specify your Internet domain name on the
Mail Domain Name page. It also offered you the alternative of entering the information from
ConsoleOne. This can be convenient if you want to install the GWIA before you have received your
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Internet domain name from your Internet Service Provider (ISP). If you selected Enter from
ConsoleOne on the Mail Domain Name page during installation, follow the instructions below to
provide the Internet domain name in ConsoleOne.

1 In ConsoleOne, select the GroupWise System object, then click Tools > GroupWise System
Operations > Internet Addressing.

Internet Addressing

Internet Domains | Addressing Formats || Publish to eDirectory

OK

X

——

Inkernet Domain kames
Create

Internet Agent fior outbound SMTR{MIME messages:
Provol.@WIA R

Mote: You must choose a default Internet Agent before you can define
Internet Domain names.

2 Click Create.

Internet domain name §|
Internet Domain Mame:
\ J
Description:

[[] Used for external Groupiise systems only

3 Specify the Internet domain name that you have received from your ISP (for example,
yourcompanyname . com).

4 Add a description if needed, then click OK to add the Internet domain name to the list.
5 Click OK again to save the Internet domain name as part of your GroupWise system.

For more information about Internet addressing, see “Configuring Internet Addressing” in
“Internet Agent” in the GroupWise 2012 Administration Guide.

Your GroupWise system is now configured to receive email addressed to that Internet domain
name.

6 Continue with Assigning a Postmaster.
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4.4.3 Assigning a Postmaster

The Internet requires each site to assign at least one user to be a Postmaster. The Postmaster is
assigned to be the recipient of messages addressed to postmaster@host.

1 In ConsoleOne, right-click the GWIA object, then click Properties.
2 Click GroupWise > Gateway Administrators.

Properties of GWIA E|
LDAP I POP3AMAPE I Server Directories I Access Cortrol vl Reattach | Post Office Links | GroupWise - »
Gatewway Administratars
Add
Administrator Rale
r
r
r
I
Page Options.. | Cancel | | Help |

3 On the Gateway Administrators page, click Add, select a GroupWise user to be the Postmaster,
then click OK.

4 Select the user from the list, then click Postmaster.
5 Click OK to save the information.

6 Continue with Starting the GWIA.

The GWIA can also be configured to send problem messages to the Postmaster. For instructions, see
“Determining What to Do with Undeliverable Messages” in “Internet Agent” in the GroupWise 2012
Administration Guide.

444  Starting the GWIA

After you install the GWIA, set up Internet addressing, and configured a Postmaster, you can start
the GWIA.

¢ “Linux: Starting the GWIA” on page 96
+ “Windows: Starting the GWIA” on page 98

Linux: Starting the GWIA

To start the Linux GWIA with a user interface:

1 Make sure that the MTA for the domain is running.

2 In a terminal window, become root by entering su - and the root password.
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3 Change to the /opt/novell/groupwise/agents/bin directory.
4 Enter the following command to start the GWIA:

./gwia --show egwia.cfg &

The --show switch starts the GWIA with a server console interface similar to that provided for

the Window GWIA. This user interface requires that the X Window System and Open Motif be
running on the Linux server.

The

@ startup switch points to the GWIA startup file (gwia.cfg) and is required to start the

GWIA.

The ampersand (&) causes the GWIA to run in the background, so that the terminal window you
started it in is again available for use.

To remind yourself of this command when you are at your Linux server, view the gwia man

page.

Jf ‘GroupWise Intermet Agent —Ox
File Configuration Log Statistics Help
Tublinl, CWIA Up Time: O Days O Hrs 1 Mins

—Status —Message Statistics
Processing * Out. 10 Hirutes In 10 Hirutes
! 1 ] ] ] ]
Grouphlise Open orne
Status 0 0 0 0
Other Link Open Pazsthrough o o o i)
Program Idle 24 | Convert Errors 1] 0 0 0
L [ewel Normal Communication Erraors 1] 1] 1] ]
Total Bytes 0,0 0,0
06:09:08 816 GHT OFfset= O hours, O minutes o
06:09:08 816 Hemisphere= NORTH

109108 816
108 816
103108 816
108 816
109:08 816
108 816

06309308 816 -pop3 ——imapd --ldap ——mime —-mudas 2 --=d 8 -—+d 16
06:09:08 816 ——p 10 —-te 2 ——tg 5 —tc 5 —tr 5 ——td 3 —-tt 10 -—p
0B:09:08 516 t 10 --it 10 —-ldapthrd 10 --st 4 —-rt 4 --dsn --dsha

108 816
109308 816 End Configuration Information
108 BE4 Starting GUHTTP-Listener
Y
I

Daylight Sawving Change= 1 hours, 0 minutes

Taylight Saving Begin= 3725 {month/day)

Daylight Sawing End= 10428 (montheday)

SHHP On

Startup Suitches= --show -—home /gusystemsdublinl/upgat
efguia ——dhome Aguaystem/dublinl/wpgatesguwia ——amtp -

ge 4 -—hn pru-gudoc

09 048 LOAP zerver running

=

|E]

The status messages displayed on the GWIA server console are also written to the GWIA log file
(mmddlog . nnn) in the /var/log/novell/groupwise/domain.gwia directory. The log file name
includes the month and day when it was created, along with an incrementing extension to
accommodate multiple log files on the same day.

After the GWIA starts successfully, refer to the following sections in Chapter 8, “Installing
GroupWise Agents,” on page 175 for additional information about managing the GWIA on
Linux:

*

*

*

5 Skip

“Starting the Linux Agents as Daemons” on page 188

“Monitoring the Linux GroupWise Agents from Your Web Browser” on page 200
“Starting the Linux Agents on System Startup” on page 189

“Running the Linux GroupWise Agents as a Non-root User” on page 192

“Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195

“Stopping the Linux GroupWise Agents” on page 190
“Uninstalling the Linux GroupWise Agents” on page 201
to Section 4.4.5, “Testing the GWIA,” on page 98
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Windows: Starting the GWIA
1 (Conditional) If the domain directory is not on the GWIA server, map a drive to the domain
directory as a user that has rights to access the domain directory.

2 If the GWIA is installed as a Windows application, click Start > All Programs > GroupWise Internet
Agent > GroupWise Internet Agent.

&8 GroupWise Internet Agent g@gl

File Configuration Log Skatistics Help

Provo2 Glala2 Up Time: 0 Days OHre 1 Mine

Status Message Statistics

Processing Out 10 Minutes In 10 Minutes
Momal 1} 0 1} 1}

GroupWize Open Status 0 0

Other Link.  Open Passthrough 0 0 0 0

Progiam  Ide 25 Convert Erors 1] 1] 1] 1]
Comrauricatiar 0 0 0 0

LogLevel Nomal Tatal Butes 00 00

145062 908 Startup Switches= /Home-\\bd-winhe$hgwsystemhpra -

145052908 vo2'wpgatehGZWIAZ /DHome-c:\gipwisehgwia /SMTP /POP3 /)

145052908  IMAP4 /LDAP /MIME /MUDAS-2 /5D-8 /RD-16 /P10 /TE-2 /

145052908 TG6/TCH/TRA/TD-3/TT-10/PT-10 AT-10 ALdapThid

1460525908 10 /5T-4 /AT-4 /DSN /Dsnbdge-4 AHN-UBD_XP.dnsd

148052908  hep.provo.novell.com” AW ORE-c:\arpwisebgwiak000.PRCAG

145052908  WwWORK /LOG-c \grpwisehguwia

14:50:52 908 E nd Configuration Infarmation

14:50:53 134 LDAP server running b’

or

If the GWIA is installed as a Windows service, click the Start menu > Control Panel >
Administrative Tools > Services. Right-click the GWIA service, then click Start.

If the GWIA does not start successfully, see “Starting the Windows GroupWise Agents” on
page 205.

3 (Conditional) If you enabled the GWIA Web console, use the following URL to log into the Web
console:
http://internet agent network address:http port

For example:

http://172.16.5.18:9850

For more information, see “Using the GWIA Web Console” in “Internet Agent” in the GroupWise
2012 Administration Guide.

4 Continue with Testing the GWIA.

445 Testing the GWIA

After you start the GWIA, you should send a message to ensure that the system is working properly.

1 Open a new mail message in your GroupWise client.

2 In the To field, enter the Internet address of a colleague or friend that is not in your GroupWise
system.

3 Send the message, then contact the recipient to verify that he or she received it.

4 Have the recipient reply to your message to verify that you receive the reply in your GroupWise
mailbox.

5 Continue with What'’s Next.
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45 What's Next

The “Internet Agent” section of the GroupWise 2012 Administration Guide provides information to help
you further configure and maintain the GWIA, including how to:

*

Configure addressing options.

See “Configuring Internet Addressing” and “Configuring How the GWIA Handles Email
Addresses”.

Optimize configuration settings for the SMTP/MIME, IMAP, POP, and LDAP services.
See “Configuring Internet Services”.

Use SSL to secure connections between the GWIA and other SMTP hosts, POP/IMAP clients,
and the GWIA Web console.

See “Securing GWIA Connections with SSL”.

Control users” access to SMTP/MIME (inbound and outbound), IMAP, and POP services.
See “Controlling User Access to the Internet”.

Protect users from spam. See “Blocking Unwanted Email from the Internet”

Control logging for the GWIA.

See “Using GWIA Log Files”.

4.6 GroupWise Internet Agent Installation Worksheet

Installation Program Field Value for Your GroupWise Explanation

System
Agent Software Platform: Section 4.3.1, “Selecting the
GWIA Platform,” on page 82
¢ Linux
+ Windows
Installation Path: Section 4.3.3, “Selecting the
GWIA Installation Directory,”
on page 83
Linux Installation Section 4.3.9, “Linux
Options: Installation Options: LDAP
Information, Automatic
¢ Launch the Internet Startup, and Clustering,” on
Agent on system page 85
Startup
* Yes
+ No

+ Configure the Internet
Agent for clustering

* Yes

+ No

Installing the GroupWise Internet Agent

99



100

Installation Program Field Value for Your GroupWise
System

Explanation

Windows Installation
Options:

+ Install and configure
SNMP for the Internet
Agent

* Yes
+ No

+ Install the Internet
Agent as a Windows
service

* Yes

* No

Section 4.3.10, “Windows
Installation Options: SNMP
Traps and Service versus
Application,” on page 86

Server Information:
¢ TCP/IP address
IP address

DNS hostname
+ Message transfer port
(default 0)

Section 4.3.2, “Gathering
Server Information,” on
page 82

Enable Web Console:
* Yes
User name
Password
HTTP port

(default 9850)

* No

Section 4.3.8, “Enabling the
GWIA Web Console,” on
page 84

Relay Host:

+ Send outbound mail
directly to Internet
hosts

+ Send outbound mail
through a relay host

IP address of the relay
host machine

Section 4.3.7, “Handling
Outbound Mail,” on page 84

GroupWise Domain:

¢ Domain directory

* Internet Agent
subdirectory

+ Domain context in
LDAP format

Section 4.3.4, “Gathering
Domain and Gateway
Information,” on page 83
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Installation Program Field Value for Your GroupWise Explanation

System
LDAP Authentication Section 4.3.9, “Linux
(Linux only): Installation Options: LDAP
Information, Automatic
¢ LDAP server IP Startup, and Clustering,” on
address page 85
¢ Port
¢ User name
+ Password
¢ Use SSL connection
* Yes
Path to SSL
certificate file
+ No
Internet Agent Object “eDirectory Tree Access” on
Name: page 31
¢ DNS hostname or IP Section 4.3.5, “Selecting the
address of tree Gateway Object Name,” on
page 84
* User name
¢ Context
+ Password
* Internet Agent object
name
Domain name and
context
Internet Mail Domain Section 4.3.6, “Specifying
Name: the Internet Mail Domain
Name for Your GroupWise
¢ Enter from System,” on page 84
ConsoleOne
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Installation Program Field Value for Your GroupWise
System

Explanation

Windows Service
Information:

* User local system
account

+ Allow service to
interact with
desktop

+ Use this Windows user
account

¢ Name of
Windows user
account

+ Password
+ Startup type

+ Automatic

+ Manual

+ Disabled

Section 4.3.10, “Windows
Installation Options: SNMP
Traps and Service versus
Application,” on page 86
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5.1

5.1.1

Installing GroupWise WebAccess

Novell GroupWise WebAccess enables user access to GroupWise mailboxes through desktop Web
browsers, through tablet computers such as Apple iPads, and through mobile devices (http://
www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_qs_webaccbasic/
gw2012_qgs_webaccbasic.pdf). The following sections provide information to help you successfully
install the GroupWise WebAccess Application in your existing GroupWise system.

¢ Section 5.1, “GroupWise WebAccess Application Overview,” on page 103

¢ Section 5.2, “WebAccess System Requirements,” on page 105

¢ Section 5.3, “Planning GroupWise WebAccess,” on page 108

¢ Section 5.4, “Setting Up GroupWise WebAccess,” on page 110

¢ Section 5.5, “Testing GroupWise WebAccess,” on page 116

¢ Section 5.6, “What's Next,” on page 119

¢ Section 5.7, “GroupWise WebAccess Installation Worksheet,” on page 120

GroupWise WebAccess Application Overview

¢ Section 5.1.1, “GroupWise WebAccess Functionality,” on page 103
¢ Section 5.1.2, “GroupWise WebAccess Components,” on page 104
¢ Section 5.1.3, “WebAccess Security Requirements,” on page 104

GroupWise WebAccess Functionality

GroupWise WebAccess, when used in a desktop Web browser, provides most of the functionality
available in the GroupWise Windows client. On an Apple iPad, most commonly used functionality is
available. WebAccess functionality on mobile devices is limited compared to WebAccess in a desktop
browser or an iPad. For WebAccess user functionality details, see

¢ GroupWise 2012 WebAccess User Guide
¢ GroupWise 2012 WebAccess Mobile User Guide
¢ WebAccess Basic Interface Quick Start (http://www.novell.com/documentation/groupwise2012/

pdfdoc/gw2012_qgs_webaccbasic/gw2012_qs_webaccbasic.pdf)

After you set up GroupWise WebAccess, you should look at Section 5.6, “What’s Next,” on page 119
for additional information you might want to be aware of as you configure, maintain, and expand
GroupWise WebAccess.
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5.1.2

5.1.3

GroupWise WebAccess Components

GroupWise WebAccess consists of four components: the browser-based WebAccess user interface
(desktop computer, tablet computer, or mobile device), the WebAccess Application, the Post Office
Agent, and the Document Viewer Agent.

Post Document
WebAccess Office Viewer
=, Application Agent Agent
|:I VA Y =
R B .' ‘ -
-_—y 4 /
Web Browser Web Server t 1

Internet

WebAccess Application: The WebAccess Application, which resides on the Web server, provides the
GroupWise WebAccess user interface. As users perform actions in the WebAccess, the WebAccess
Application passes information between the Web browser and the Post Office Agent.

Post Office Agent: The Post Office Agent (POA) receives user requests from the WebAccess
Application, accesses post offices and libraries to process the requests, and then passes information
back to the WebAccess Application.

Document Viewer Agent: The Document Viewer Agent (DVA) isolates the conversion process for
attached document files. The DVA can simultaneously convert multiple document files into HTML
format. If it encounters a problem converting a document file, the problem does not affect conversion
of other document files, nor does it affect the functioning of the WebAccess Application. Therefore,
GroupWise WebAccess users do not experience interruptions because of document files that fail to
convert into HTML. Document files that fail in the conversion process simply cannot be viewed in
WebAccess. The DVA is automatically installed along with the POA.

WebAccess Security Requirements

The WebAccess Application can be configured to support the level of security you have established
for your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use the WebAccess
Application on a secured intranet), you can install the WebAccess Application to any Web servers
that provide access for your users and meet the requirements listed in Section 5.2, “WebAccess
System Requirements,” on page 105.

If you plan to use the WebAccess Application to provide users with access to their mailboxes from
anywhere on the Internet (rather than only within a secured intranet), and you already have a
firewall in place to provide security, you have the following options for configuring the WebAccess
Application:

¢ Install the WebAccess Application inside your firewall and use a proxy service. See
“Configuration with a Proxy Service” on page 105. This is the recommended configuration.

¢ Install the WebAccess Application on a Web server outside your firewall and the POA and the
DVA on a server inside your firewall. See “Configuration without a Proxy Service” on page 105.
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5.2

Configuration with a Proxy Service

If your firewall includes a proxy service, you can install the WebAccess Application to a Web server
inside your firewall, while the POA and the DVA are installed on another server inside the firewall,
as shown in the following illustration.
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Configuration without a Proxy Service

If your firewall does not provide a proxy service, you need to install the WebAccess Application to a
Web server that is outside the firewall. Because the POA requires direct access to a GroupWise post
office directory, it needs to be installed to a server that is located within the firewall.
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Web Server Firewall Server Network Server
Internet with WebAccess with Post Office Agent and
Application Document Viewer Agent

The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port
number of the POA (for example, 172.16.5.18:1677).

In addition, the firewall must allow outbound IP packets to be sent from the POA to the Web server.
This requires all high ports (above 1023) to be open to outbound IP packets.

WebAccess System Requirements

¢ Section 5.2.1, “Hardware and Operating System Requirements,” on page 106

¢ Section 5.2.2, “Web Server Requirements,” on page 106
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¢ Section 5.2.3, “Software Requirements,” on page 107

¢ Section 5.2.4, “User Requirements,” on page 107

5.2.1 Hardware and Operating System Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
[ Any of the following server operating systems:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles for the Post Office Agent, the Message Transfer Agent, and the Internet Agent. By
default, the GroupWise agents run as daemons without user interfaces.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack

[ Adequate server memory as required by the operating system
[ Adequate server disk space:

¢ Approximately 127 MB for the WebAccess Application files (shared with the Calendar
Publishing Host Application and the Monitor Application when they are installed on the
same Web server; varies by platform)

5.2.2 Web Server Requirements
The Web server supported for your operating system:
(0 OES 2 Linux / SLES 10

Apache 2.2 plus:
* Tomcat 5 or later

Tomcat 5 is included with the Linux operating system. If it is not already installed, use YaST
to install it before you install the GroupWise software.

¢ IBM JRE 5 or later
¢+ ModProxy Module
00 OES11/SLES11
Apache 2.2 plus:
¢ Tomcat 6 or later

For OES 11, Tomcat 6 is included with the Linux operating system. If it is not already
installed, use YaST to install it before you install the GroupWise software.

For SLES 11, Tomcat 6 is added to the Linux server with the GroupWise software.
¢ IBM JRE 5 or later
¢ ModProxy Module
O Windows Server 2003/2003 R2
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Microsoft Internet Information Server (1IS) 6 or later plus
+ Tomcat 6
¢ IBM]JRE 5 or later
+ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

(3 Windows Server 2008/2008 R2/2012
Microsoft Internet Information Server (IIS) 7 or later plus:
+ Tomcat 6
¢+ IBM]JRE 5 or later
¢ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

5.2.3  Software Requirements

03 Any of the following environments for running the GroupWise Installation program:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers
where the X Windows System is not available.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack, plus the latest Novell Client

(3 One or more Post Office Agents (POAs) configured for SOAP and secure SSL connections

5.2.4  User Requirements

¢ “WebAccess User Requirements” on page 107

¢ “WebAccess Mobile User Requirements” on page 108

WebAccess User Requirements

Any of the following user environments:

(3 Any of the following Web browsers for GroupWise WebAccess:
* Linux: Mozilla Firefox
+ Windows: Microsoft Internet Explorer 8.0 or later; Mozilla Firefox; Google Chrome

¢ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

(3 Any mobile device that supports Wireless Access Protocol (WAP) and has a microbrowser that
supports Hypertext Markup Language (HTML) 4.0 or later
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5.3

53.1

5.3.2

WebAccess Mobile User Requirements
Any of the following tablet operating systems and devices:

(3 Apple iOS 4 or later, with the latest version of the Safari Web browser

O Android 3.2 and 4.0 with the Android Web browser, and Android 4.1 with the Chrome browser,
on any Android device

(0 RIM Tablet OS 1.0.0 or later, with the BlackBerry Playbook Web browser, on the BlackBerry
Playbook 2

Planning GroupWise WebAccess

Use the “GroupWise WebA ccess Installation Worksheet” on page 120 to record your decisions about
how to install the WebAccess Application. The topics in this section present the required information
in a convenient planning sequence. The Installation Worksheet organizes the information in the order
in which you need it during installation.

¢ Section 5.3.1, “Selecting the WebAccess Application Platform,” on page 108

¢ Section 5.3.2, “Gathering Web Server Information,” on page 108

¢ Section 5.3.3, “Determining the WebAccess Application’s Configuration,” on page 109

¢ Section 5.3.4, “Connecting the WebAccess Application with Supporting Agents,” on page 109

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
Wiki (http://wiki.novell.com/index.php/GroupWise).

Selecting the WebAccess Application Platform

The WebAccess Application can be installed to a Web server on Linux or Windows. See Section 5.2,
“WebAccess System Requirements,” on page 105 for supported Web servers.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the WebAccess Application to a Linux or
Windows Web server

Gathering Web Server Information

The WebAccess Application integrates with your Web server to pass mailbox information gathered
by the Post Office Agent to your Web browser for display in GroupWise WebAccess. The location of
the WebAccess Application files that are installed depends on the Web server that it is being
integrated with. The default Web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcat6/webapps
Apache Web Server on OES 2 Linux: /etc/opt/novell/httpd/conf.d
Tomcat on OES 2 Linux: /var/opt/novell/tomcat5/webapps
Apache Web Server on SLES 11: /etc/apache2/conf.d

Tomcat on SLES 11: /usr/share/tomcaté/webapps
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5.3.3

5.3.4

Apache Web Server on SLES 10: /etc/apache2/conf.d

Tomcat on SLES 10: /srv/www/tomcat5/base/webapps
Microsoft Internet Information Server (1IS) on Windows: c:\inetpub\wwwroot
Tomcat on Windows: c:\novell\tomcaté\webapps

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Web Server Information, select the type of Web server where you plan to install the WebAccess
Application, then specify the Web server’s root directory.

On Windows, if the Internet Information Server services more than one Web site, specify the Web site where
you want to install the WebAccess Application.

Determining the WebAccess Application’s Configuration

WebAccess Application configuration information is stored in a configuration file (webacc. c£g). The
webacc. cfg file is located in the following directories:

Linux: /var/opt/novell/groupwise/webaccess

Windows c:\novell\groupwise\webaccess

To change the WebAccess Application’s configuration, you need to manually modify the webacc.cfg
file.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under Configuration File Location, note the location for the platform where you are installing WebAccess.

Connecting the WebAccess Application with Supporting Agents

The WebAccess Agent needs to communicate with a POA and a DVA.

GROUPWISE WEBACCESS APPLICATION INSTALLATION WORKSHEET

Under POA Network Address, specify the IP address or DNS hostname of a POA that the WebAccess
Application can communicate with, along with that POA’s SOAP port number.

Under DVA Network Address, specify the IP address or DNS hostname of a DVA that the WebAccess
Application can communicate with, along with that DVA's TCP port number.

IMPORTANT: The POA that the WebAccess Application communicates with must be configured for
SOAP. A secure SSL connection between the POA and the WebAccess Application is highly
recommended.
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For instructions on preparing the POA to work successfully with the WebAccess Application, see the
following sections in “Post Office Agent” in the GroupWise 2012 Administration Guide:

¢ “Supporting SOAP Clients” in “Performing Basic POA Configuration”

¢ “Securing the Post Office with SSL Connections to the POA” in “Configuring Post Office
Security”

For instructions on preparing the DVA to work successfully with the WebAccess Application, see the
following sections in “Document Viewer Agent” in the GroupWise 2012 Administration Guide:

¢ “Multiple DVAs for WebAccess”

+ “DVA Installation on Additional Servers”

5.4  Setting Up GroupWise WebAccess

¢ Section 5.4.1, “Linux: Setting Up GroupWise WebAccess,” on page 110
¢ Section 5.4.2, “Windows: Setting Up GroupWise WebAccess,” on page 113

5.4.1 Linux: Setting Up GroupWise WebAccess

110

¢ “Preparing the Linux Server for GroupWise WebAccess” on page 110
¢ “Installing the Linux WebAccess Software” on page 110
If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for

GroupWise Administration” in the GroupWise 2012 Administration Guide before you install the GWIA
on Linux.

Preparing the Linux Server for GroupWise WebAccess

1 Make sure that the Web server where you are installing the WebAccess Application meets the
system requirements listed in Section 5.2, “WebAccess System Requirements,” on page 105.

2 Make sure that the Linux server has a static IP address.

3 Make sure that the firewall on the server has the ports open that are used by the Web server and
the WebAccess Application.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

4 Make sure that the POA that the WebAccess Application will communicate with has SOAP
enabled on a secure SSL connection, as described in Section 5.3.4, “Connecting the WebAccess
Application with Supporting Agents,” on page 109.

5 Continue with Installing the Linux WebAccess Software.

Installing the Linux WebAccess Software

1 In a terminal window on the Web server where you want to install the WebAccess Application,
log in as root, then provide the root password.

2 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the WebAccess Application software to a software distribution
directory, change to /opt/novell/groupwise/software.
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3 Run ./install.

The X Window System is required for running the GUI GroupWise Installation program. If you
are not using the X Window System, you can install GroupWise components individually, as
described in “Installing GroupWise Components Using the Text-Based Installation Program” on
page 185.

4 Select the language in which you want to run the GroupWise Installation program, then click
OK.

The main GroupWise System Installation page appears.

GroupWise

Novell. GroupWise

View the Readme Displays a web page with important information you should read
before installing.

View the Quick Start Displays a high-level ist of system requir and installation
steps to guide you through setting up your GroupWise system.

View the Installation Guide Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupVise WebAccess and GroupWise Intermnet
Agent.

Create or update a GroupWise system Launches the Group¥Wise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or
the updating of an existing Group\ise system.

Install Produects Displays the GroupWise components you can individually install once
you've created a GroupWise system.

5 Click Install Products > GroupWise WebAccess > Install WebAccess to install the WebAccess
software.

When the installation is complete, click OK.
Click Configure WebAccess.

N GroupWise Web AccesslConfiguration x|
Introduction
[ introduction Welcome to the Group'Wise Web Access Configuration
O Program. This program will da the following:
+ Configure your webserver to wark with GroupWise Weh
O ACCess
O
O
a

Cancel | | Next |
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8 Click Next, accept the License Agreement, then click Next.
9 Follow the prompts to configure the WebAccess using the following information from the
GroupWise WebAccess Installation Worksheet:

POA Network Address
DVA Network Address
Web Server Information

10 On the Configuration Complete page, click Exit to exit the WebAccess Installation program.

The WebAccess software is installed to the following directories:

/opt/novell/groupwise/webaccess
/etc/opt/novell/groupwise/webaccess
/var/opt/novell/groupwise/webaccess

It so also integrated with Tomcat.
11 Exit the GroupWise Installation program.
12 Start the DVA that you configured the WebAccess Application to communicate with.

For example, if the DVA is installed on the same server with the WebAccess Application, use:

rcgrpwise start gwdva

For more information about the DVA, see “Document Viewer Agent” in the GroupWise 2012
Administration Guide.

13 Restart Apache and Tomcat:

OES 11 rcnovell-tomcaté stop
rcapache2 stop
rcapache2 start
rcnovell-tomcaté start

OES 2 Linux: rcnovell-tomcat5 stop
rcapache2 stop
rcapache2 start
rcnovell-tomcat5 start

SLES 11 rctomcaté stop
rcapache2 stop
rcapache2 start
rctomcat6 start

SLES 10: rctomcat5 stop
rcapache2 stop
rcapache2 start
rctomcat5 start
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14 Make sure that Apache and Tomcat restart automatically when the server reboots:

OES 11: chkconfig apache2 on
chkconfig novell-tomcaté on

OES 2 Linux: chkconfig apache2 on
chkconfig novell-tomcat5 on

SLES 11: chkconfig apache2 on
chkconfig tomcaté6 on

SLES 10: chkconfig apache2 on
chkconfig tomcat5 on

15 Skip to Section 5.5, “Testing GroupWise WebAccess,” on page 116.

5.4.2 Windows: Setting Up GroupWise WebAccess

¢ “Preparing the Windows Server for GroupWise WebAccess” on page 113
¢ “Installing the Windows WebAccess Software” on page 113

Preparing the Windows Server for GroupWise WebAccess

1 Make sure that the Web server where you are installing the WebAccess Application meets the
system requirements listed in Section 5.2, “WebAccess System Requirements,” on page 105.

2 Make sure that the Windows server has a static IP address.

3 Make sure that the firewall on the server has the ports open that are used by the Web server and
the WebAccess Application.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

4 Make sure that the POA that the WebAccess Application will communicate with has SOAP
enabled on a secure SSL connection, as described in Section 5.3.4, “Connecting the WebAccess
Application with Supporting Agents,” on page 109.

5 Continue with Installing the Windows WebAccess Software.

Installing the Windows WebAccess Software

1 On the Web server where you want to install the WebAccess Application, change to the root
directory of the downloaded GroupWise 2012 software image.

or

If you have already copied the WebAccess Application to a software distribution directory,
change to that location

2 Run setup.exe.

3 (Conditional) If prompted, select the interface language for the Installation program, then click
OK.

On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.
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The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard x|
GroupWise
Grouptfize System Installation

| Displays impartant infarmation you should read before instaling Grouplafise.

X Displays a high-level checklist of system requirsments and installation steps ta guide
Wiews the Quick Stark you through setting up your Grouphise spstem.

iews the Installation Guide

Dizplaps overview and task information to help pou plan, instal, and maintain a basic
Grouplwfize gpstem and all additional components.

Inztall Groupiwise System

Creates or updates a basic Groupt/ise system, including Group\wise adrinistration,
the Post Office Agent, the Message Transfer Agent, and the Intemet Agent.

Installs or updates Groupiwise web Access, Groupwise Monitor, the Calendar
Install Mare Camponents Publishing Host, and the Groupwise Windows client.

Instaltield <Back | Hews | cancel |

4 Click Install More Components > Install WebAccess to start the WebAccess Installation program.

i'._\!-GroupWisE Web Access 5‘

Welcome to the GroupWise Web Access
Installation Program

The InstallShield{R) Wizard will allow you to modify GroupWise
Web Access. To continue, dick Next.

Novell.

< Back I Mext = I Cancel |

You can also start the WebAccess Installation program by running;:

/software image/internet/webaccess/setup.exe
5 Click Next, then follow the prompts to provide the information from your GroupWise
WebAccess Installation Worksheet.

The WebAccess Installation program provides diagrams that help you understand how the
various components interact with each other. Review the diagrams as you provide the requested
information.

Web Server Information
Post Office Information
Document Viewer Agent Information
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6 Review the Installation Summary page, then click Install.

i!_{-‘- GroupWise Web Access

Installation Summary

If you want to review or change any settings, dick Back. Click Install to begin
copying files.

x|

(=)

L1 Web Browser Installation summary:

(Conditional) If prompts appear because your Web server is running, select how you want to

Tomcat 6 to c: \novell\tomcaté, integrates it with your Web server, and automatically starts it

i GroupWise Web Access Application -l
E el Sarver Version: 2012
B Web Access L
T Application URL to log in to GroupWise Web access: hitp://172.12.67..
I I Web server
Platform: Microsoft Internet Information Server (IIS)
WebsSite: Default Web Site
Root directory: C:ynetpublwwwroot
Document Default Language is: English
Viewer Agent % The f:y::rg langauge(s) will be installed: =
4| | 3
POA
Instalshield
Installation Guide | < Back I Install I Cancel |
7
stop your Web server.
8 When the installation is complete, click Finish to exit the WebAccess Installation program.
i!_\!-GroupWisE Web Access 5‘
Web Access Installation Complete
The Web access Installation program has successfully installed
GroupWise Web Access. Click Finish.
W Launch installation summary
¥ Restart Web server
Novell.
= Back I Finish I Ganice] |
You can choose to have the WebAccess Installation program restart the Web server for you.
Along with the WebAccess Application, the WebAccess Installation program also installs
to support the WebAccess Application.
9 Click Finish to exit the GroupWise Installation program.
10

For example, if the DVA is installed on the same
Start > All Programs > GroupWise Agents > DVA.

Start the DVA that you configured the WebAccess Application to communicate with.

server with the WebAccess Application, click

For more information about the DVA, see “Document Viewer Agent” in the GroupWise 2012

Administration Guide.

11 Continue with Testing GroupWise WebAccess.
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5.5 Testing GroupWise WebAccess

¢ Section 5.5.1, “Testing WebAccess on a Workstation,” on page 116

*

Section 5.5.2, “Testing WebAccess on a Tablet Computer,” on page 117

*

Section 5.5.3, “Testing the WebAccess Basic Interface on a Mobile Device,” on page 118

*

Section 5.5.4, “Assisting Users with Login Problems,” on page 119

*

Section 5.5.5, “Monitoring the WebAccess Application,” on page 119

5,5.1 Testing WebAccess on a Workstation

1 To access GroupWise WebAccess, use the following URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

h-

Novell.
GroupWise

Usermname

2 Type your GroupWise user ID in the Username box and your GroupWise mailbox password in
the Password box.

3 (Optional) To change the WebAccess interface language, click Options, then select the language
you want from the Language drop-down list.
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4 Click Login to display the GroupWise WebAccess main window.

Novell GI‘DLIp\NiSG Mailbox Calendar Contacts Documents Logout - =
= Mail - @ Appointment Eﬂ Task |2| Reminder Note % Froxy rﬁ Folders 19 Find
2% N
7l Tabitha Hu (e T Delete [ Accept [ Decline [ Gomplete g Mark Unread g Mark Read = Gategories
(—]
Name Subject Date = Size
Unopened ltems
&5 sent tems .
Marie Barnard Gonference number 8/23/11 2:21 PM 2 KB
b Bl Galendar
Marie Bamard Please forward along to your teams 8/12/11 2:00 PM 2 KB
b & Frequent Gontacts
Marie Barnard Fwd: Meetin 8/8/11 11:39 AM 2 KB
Vi Taskiist =l g
# work In Progress
B cabinet
T Trash

5 Click Help for more information about using GroupWise WebAccess.

5.5.2 Testing WebAccess on a Tablet Computer
1 To access GroupWise WebAccess on a tablet computer such as an iPad, use the following URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

(~]

Novell.
GroupWise

Seftings »

or
(Conditional) If you have a tablet device that is not yet supported, but you want to see how well

the mobile interface works on your device, use the following URL:
http://web_server address/gw/webacc?User.interface=mobile

Replace web_server_address with the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

2 Type your GroupWise user ID in the Username box and your GroupWise mailbox password in
the Password box.
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3 (Optional) To change the WebAccess interface language, click Settings, then select the language
you want from the Language drop-down list.

4 Click Login to display the GroupWise WebAccess main window on your iPad.

2:38 PM

|

Novell GroupWise (Marie Barnard)

@B M [P | 137.65.67.217/gwiwebacc & U

Novell. GroupWise.

e

™

Wi

4]

-}

Mailbox e

George Smith 9/5/11
Training Sides

Mike Palu 8/13/11
Expense report-Delegated

Mike Palu 913111
Campaign Strategy for Product X
Marie, Please let me know ASAP what idea...

Mike Palu 9/13/11
Briefing Notes

Mike Palu 9/13/11
Market Analysis Review

Marie Barnard 8/25/11
Julio Chavez 8015557867

Marie Barnard 8/15/11
George's Birthday

Mike Palu 81111

« B @ ¥

Mail
Campaign Strategy for Product X
-Show Details-
Marie,
Please let me know ASAP what ideas you have for this campaign.

-Mike

5 Click Help for more information about using GroupWise WebAccess on your iPad.

5.5.3 Testing the WebAccess Basic Interface on a Mobile Device

118

1 To access GroupWise WebAccess in the Web browser on your mobile device, use the following

URL:

http://web_server address/gw/webacc

Replace web_server_address with the IP address or DNS hostname of your Web server. If the Web
server uses SSL, use https rather than http.

2 Follow the instructions in your mobile device’s documentation to add this URL to your Favorites
or Bookmarks so you don't need to type the URL every time you log in on your mobile device.

3 Enter your GroupWise user ID and GroupWise mailbox ID.
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5.5.4

5.5.5

5.6

The appearance of the WebAccess basic interface varies depending on the size of the screen
where it is displayed.

Novell GroupWise

=Mailbox # Compose
Folders (@jAddress Book

[calendar || Documents
4-Eind T Cptions
2 Exit

About Novell GroupWise

4 For more information about using WebAccess on your mobile device, see the WebAccess Basic
Interface Quick Start (http://www.novell.com/documentation/groupwise2012/pdfdoc/
gw2012_gs_webaccbasic/gw2012_gs_webaccbasic.pdf).

As an alternative to this limited interface, you can synchronize GroupWise data to your mobile
device using the Novell Data Synchronizer Mobility Pack. For more information, see the Novell Data
Synchronizer Documentation Web site (http://www.novell.com/documentation/datasynchronizer1).

Assisting Users with Login Problems

The WebAccess Login page includes a Can't log in link, which provides the following information to
WebAccess users by default:

If you have forgotten your GroupWise password, contact your local GroupWise
administrator.

For your convenience and for the convenience of your WebAccess users, you can customize the
information that is provided by the Can’t log in link. For set instructions, see “Helping Users Who
Forget Their GroupWise Passwords” in “WebAccess” in the GroupWise 2012 Administration Guide.

Monitoring the WebAccess Application

You can monitor the WebAccess Application from your Web browser. For more information, see
“Using the WebAccess Application Web Console” in “WebAccess” in the GroupWise 2012
Administration Guide.

What's Next

The “WebAccess” section of the GroupWise 2012 Administration Guide provides information to help
you further configure and maintain GroupWise WebAccess, including how to:

¢ Scale GroupWise WebAccess to meet the needs of your users and environment.

See “Scaling Your GroupWise WebAccess Installation”.
¢ Control users” access to GroupWise WebAccess.
See “Managing User Access” and “Helping Users Who Forget Their GroupWise Passwords”.
¢ Configure the WebAccess Application.
See “Configuring the WebAccess Application”.
¢ Monitor the WebAccess Application.
See “Monitoring the WebAccess Application”.
¢ Control logging for the WebAccess Application.
See “Using WebAccess Application Log Files”.
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5.7 GroupWise WebAccess Installation Worksheet

Installation Program Field Value for Your GroupWise Explanation

Web Server Platform

¢ Linux

+ Windows

See Section 5.3.1,
“Selecting the WebAccess
Application Platform,” on
page 108

POA Network Address

* |P address
* SOAP port
(default 7191)

See Section 5.3.4,
“Connecting the
WebAccess Application with
Supporting Agents,” on
page 109.

DVA Network Address

+ |P address
+ TCP port
(default 8301)

See Section 5.3.4,
“Connecting the
WebAccess Application with
Supporting Agents,” on
page 109.

Web Server Information:

OES 11
* Apache path

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat6/webapps

Section 5.3.2, “Gathering
Web Server Information,” on
page 108

Web Server Information:

OES 2 Linux
* Apache path

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat5/webapps

Section 5.3.2, “Gathering
Web Server Information,” on
page 108
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Installation Program Field

Value for Your GroupWise Explanation
System

Web Server Information:

SLES 11
* Apache path

/etc/apache2/
conf.d

+ Tomcat path

/usr/share/
tomcat6/webapps

Section 5.3.2, “Gathering
Web Server Information,” on
page 108

Web Server Information:
SLES 10
* Apache path
/etc/apache2/
conf.d
+ Tomcat path

/srv/www/
tomcat5/base/
webapps

Section 5.3.2, “Gathering
Web Server Information,” on
page 108

Web Server Information:
Windows

* Microsoft Internet
Information Server
(I1S) for Windows

+ Path to the Web
server’s root directory

* Web site

Section 5.3.2, “Gathering
Web Server Information,” on
page 108

Configuration File
Location:

Linux

/var/opt/novell/
groupwise/
webaccess

Windows

c:\novell\groupwise\
webac
cess

Section 5.3.2, “Gathering
Web Server Information,” on
page 108
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6.1

6.1.1

Installing the GroupWise Calendar
Publishing Host

The Novell GroupWise Calendar Publishing Host publishes GroupWise users’ personal calendars to
the Internet, so that the calendars are readily available to colleagues who are not part of the
GroupWise system. Items on users’ main GroupWise Calendars that are not included on personal
calendars are not published. The Calendar Publishing Host also returns free/busy schedule status to
Internet colleagues who want to set up appointments with GroupWise users. The free/busy search
checks the main GroupWise Calendar as well as personal calendars.

¢ Section 6.1, “GroupWise Calendar Publishing Host Overview,” on page 123
¢ Section 6.2, “Calendar Publishing Host System Requirements,” on page 126
¢ Section 6.3, “Planning a Calendar Publishing Host,” on page 128

*

Section 6.4, “Setting Up a Calendar Publishing Host,” on page 132
Section 6.5, “What's Next,” on page 147
Section 6.6, “GroupWise Calendar Publishing Host Installation Worksheet,” on page 148

*

*

GroupWise Calendar Publishing Host Overview

¢ Section 6.1.1, “Calendar Publishing Host Functionality,” on page 123
¢ Section 6.1.2, “Calendar Publishing Host Components,” on page 124
¢ Section 6.1.3, “Calendar Publishing Host Security Requirements,” on page 124

Calendar Publishing Host Functionality

The GroupWise Calendar Publishing Host enables Internet users to view GroupWise users’
published calendars and to retrieve free/busy information from their calendars to assist with
scheduling available appointment times. Internet users do not need login access to the GroupWise
system in order to view published calendars and obtain free/busy status. Information provided by
the Calendar Publishing Host is publicly available to Internet users everywhere.

For Calendar Publishing user functionality details, see the Calendar Publishing User Quick Start (http:/
/www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_qgs_calpubuser/
gw2012_gs_calpubuser.pdf).
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6.1.2

6.1.3

Calendar Publishing Host Components

The GroupWise Calendar Publishing Host includes three components: the Calendar Publishing Host
Application, which connects to the Internet through a Web server, the Post Office Agent (POA),
which connects to your GroupWise system, and an LDAP server, which provides authentication to
the Calendar Publishing Host Administration Web console:

Calendar
ﬁublishing
ost
Application > .ﬂ
20\ NoLogin POA
\?/ y ./

Web Browser Internet Web Server > i/
LDAP
Server

Calendar Publishing Host Application: The Calendar Publishing Host Application, which resides
on the Web server, provides the browser interface for users across the Internet. As users request
calendar and free/busy information from GroupWise users, the Calendar Publishing Host
Application passes the information between the Web browser and the POA.

Post Office Agent: The POA receives user requests from the Calendar Publishing Host Application,
accesses post offices and mailboxes to process the requests, and then passes information back to the
Calendar Publishing Host Application in the form of ICS (Internet Calendaring and Scheduling) files
and IFB (Internet Free Busy) files. These files can be imported into GroupWise, Outlook, and
Macintosh iCal calendaring applications.

LDAP Server: The Calendar Publishing Host has an Administration Web console for configuration
and management tasks. Authentication to the Administration Web console is through an LDAP
server.

Calendar Publishing Host Security Requirements

The GroupWise Calendar Publishing Host Application can be configured to support the level of
security you have established for your Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use the Calendar
Publishing Host Application on a secured intranet), you can install the Calendar Publishing Host
Application to any server that provides access for your users and meets the requirements listed in
Section 6.2, “Calendar Publishing Host System Requirements,” on page 126.

If you plan to use the Calendar Publishing Host Application to provide calendar and free/busy
information to users anywhere on the Internet (rather than simply within a secured intranet), and
you already have a firewall in place to provide security, you have the following options for
configuring the Calendar Publishing Host Application:

¢ Install the Calendar Publishing Host Application inside your firewall and use a proxy service, as
described in “Configuration with a Proxy Service” on page 125. This is the recommended
configuration.

¢+ Install the Calendar Publishing Host Application on a Web server outside your firewall and have
it communicate with a POA through your firewall, as described in “Configuration without a
Proxy Service” on page 125.
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Configuration with a Proxy Service

If your firewall includes a proxy service, you can install the Calendar Publishing Host Application to
a Web server inside your firewall, and it can communicate with a POA that is also inside the firewall,
as shown in the following illustration:
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Configuration without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Calendar Publishing Host
Application to a Web server that is outside the firewall. Because the POA requires direct access
(mapped drive or UNC path) to a GroupWise post office directory, the POA needs to be installed to a
server that is inside your firewall.

l\,' —

E I % d | | Firewall
-y -y -y B
Web Web Web

Browser Browser Browser

d
R
S

No Login

d

Web Server Firewall Server
with Calendar Publishing
Host Application

d

Network Server
with Post Office Agent

Internet

The firewall must allow inbound IP packets to be sent from the Web server to the POA’s internal or
external IP address and the calendar publishing port number for the POA (for example,
172.16.5.18:7171). If you are using an external IP address, all POAs that support calendar publishing
must be configured to use the same external IP address. For more information about external POA IP
addresses, see “Securing Client/Server Access through an External Proxy Server” in “Post Office
Agent” in the GroupWise 2012 Administration Guide.

In addition, the firewall must allow outbound IP packets to be sent from the POA to the Web server.
This requires all high ports (above 1023) to be open to outbound IP packets.
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6.2 Calendar Publishing Host System Requirements

¢ Section 6.2.1, “Hardware and Operating System Requirements,” on page 126
¢ Section 6.2.2, “Web Server Requirements,” on page 126
¢ Section 6.2.3, “Web Browser Requirements,” on page 127

¢ Section 6.2.4, “Software Requirements,” on page 127

6.2.1 Hardware and Operating System Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
(3 Any of the following server operating systems:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles for the Post Office Agent, the Message Transfer Agent, and the Internet Agent. By
default, the GroupWise agents run as daemons without user interfaces.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack

(3 Adequate server memory as required by the operating system
(3 Adequate server disk space:

¢ Approximately 127 MB for the Calendar Publishing Host Application files (shared with the
WebAccess Application and the Monitor Application when installed on the same Web
server; varies by platform)

¢ 50 KB per published calendar

6.2.2 Web Server Requirements
The Web server supported for your operating system:

O OES2 Linux/SLES 10

Apache 2.2 plus:
* Tomcat 5 or later

Tomcat 5 is included with the Linux operating system. If it is not already installed, use YaST
to install it before you install the GroupWise software.

¢ IBM JRE 5 or later
¢ ModProxy Module
(0 OES11/SLES11
Apache 2.2 plus:
¢ Tomcat 6 or later

For OES 11, Tomcat 6 is included with the Linux operating system. If it is not already
installed, use YaST to install it before you install the GroupWise software.
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For SLES 11, Tomcat 6 is added to the Linux server with the GroupWise software.
¢ IBM JRE 5 or later
¢+ ModProxy Module
(0 Windows Server 2003/2003 R2
Microsoft Internet Information Server (IIS) 6 or later plus:
+ Tomcat 6
¢ IBMJRE 5 or later
¢ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

J Windows Server 2008/2008 R2/2012
Microsoft Internet Information Server (IIS) 7 or later plus:
+ Tomcat 6
¢ IBM]JRE 5 or later
+ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

6.2.3 Web Browser Requirements

(3 Any of the following Web browsers for the GroupWise Calendar Publishing Host user Web
pages and the Calendar Publishing Host Administration Web console:

+ Linux: Mozilla Firefox
¢ Windows: Microsoft Internet Explorer 8.0 or later; Mozilla Firefox; Google Chrome

¢ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

6.2.4  Software Requirements

a Any of the following environments for running the GroupWise Installation program:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers
where the X Windows System is not available.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack, plus
the latest Novell Client.
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6.3 Planning a Calendar Publishing Host

Use the “GroupWise Calendar Publishing Host Installation Worksheet” on page 148 to record your
decisions about how to install and configure the Calendar Publishing Host Application. The topics in
this section present the required information in a convenient planning sequence. The Installation
Worksheet organizes the information in the order in which you need it during installation and
configuration.

¢ Section 6.3.1, “Selecting the Calendar Publishing Host Application Platform,” on page 128

¢ Section 6.3.2, “Gathering Web Server Information,” on page 128

¢ Section 6.3.3, “Determining the Configuration of the Calendar Publishing Host,” on page 129

¢ Section 6.3.4, “Connecting the Calendar Publishing Host to a POA,” on page 130

¢ Section 6.3.5, “Designing Your Calendar Browse List,” on page 130

¢ Section 6.3.6, “Selecting Calendar Publishing Settings,” on page 131

¢ Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on page 131

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
Wiki (http://wiki.novell.com/index.php/GroupWise).

6.3.1 Selecting the Calendar Publishing Host Application Platform

The GroupWise Calendar Publishing Host can be installed to a Web server on Linux or Windows. See
Section 6.2, “Calendar Publishing Host System Requirements,” on page 126 for supported Web
servers.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the Calendar Publishing Host Application to a
Linux or Windows Web server

6.3.2 Gathering Web Server Information

The Calendar Publishing Host Application integrates with your Web server to pass calendar
information gathered by the Post Office Agent to your Web browser for display. The location of the
Calendar Publishing Application files that are installed depends on the Web server that it is being
integrated with. The default Web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcat6/webapps
Apache Web Server on OES 2 Linux: /etc/opt/novell/httpd/conf.d
Tomcat on OES 2 Linux: /var/opt/novell/tomcat5/webapps
Apache Web Server on SLES 11: /etc/apache2/conf .d

Tomcat on SLES 11: /usr/share/tomcaté/webapps
Apache Web Server on SLES 10: /etc/apache2/conf.d

Tomcat on SLES 10: /srv/www/tomcat5/base/webapps
Microsoft Internet Information Server (IIS) on Windows: c:\inetpub\wwwroot

Tomcat on Windows: c:\novell\tomcaté\webapps
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6.3.3

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Web Server Information, mark the Web server you are using and specify the path to its root directory.
The default path is usually appropriate.

On Windows, if the Internet Information Server services more than one Web site, specify the Web site where
you want to install the Calendar Publishing Host.

Determining the Configuration of the Calendar Publishing Host

In ConsoleOne, the Calendar Publishing Host is identified by a unique name. The name might
include the platform or location of the Calendar Publishing Host, or perhaps the users it serves. You
specify this name when you install the Calendar Publishing Host Application and when you
configure it in ConsoleOne. The name must be specified identically in both places, including spacing
and capitalization.

IMPORTANT: Do not use any double-byte characters in the name.

The Calendar Publishing Host name is stored in the calhost . cfg file, located in the following
directories

Linux: /var/opt/novell/groupwise/calhost

Windows: c:\novell\groupwise\calhost

You typically need only one Calendar Publishing Host. However, depending on the size of your
GroupWise system and the locations of your GroupWise users, you might need several in different
locations if some users experience slowness when accessing the initial location. You specify the name
of the Calendar Publishing Host during installation and in ConsoleOne. The name must match in
both places.

The Calendar Publishing Host uses the DNS hostname of the Web server as part of its base URL.

http://web _server address:port/gwcal

Replace web_server_address with the DNS hostname of the Web server and port is the port number on
which the Calendar Publishing Host communicates with the Web server. The default port number is
80; it does not need to be specified if your Web server uses that default.

IMPORTANT: Select the URL carefully. This URL is disseminated by GroupWise users to their
Internet colleagues when they publish their personal calendars and free/busy information. If you
change the URL later, GroupWise users need to send updated information to Internet colleagues.

Create a generic URL, such as http://gwcal.novell.com/gwcal, then configure your network to
redirect incoming traffic to any of multiple Calendar Publishing Host servers

The Calendar Publishing Host also needs the IP address and TCP port number of the Web server so
that they can communicate.
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6.3.4

6.3.5

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Calendar Publishing Host Name, specify a unique name for this Calendar Publishing Host.

Under Calendar Publishing Host Configuration, list the name for the Calendar Publishing Host name again,
along with its base URL (http://web_server address/gwcal), the IP address of the Web server, and the
Web server port number (by default, 80). Make sure that the names are specified identically.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Connecting the Calendar Publishing Host to a POA

The Calendar Publishing Host connects to your GroupWise system through the POA of a post office.
For initial installation, you enable one POA for calendar publishing. As you roll out calendar
publishing to your GroupWise users, you must enable calendar publishing for the POA of every post
office where users publish calendars and free/busy information.

The initially selected POA must be configured to communicate with the Calendar Publishing Host.
The POA server’s I’ address or DNS hostname is required, along with a calendar publishing port
(7171 by default). Use the default port number unless it is already in use by another program on the
server where you plan to install the Calendar Publishing Host.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Calendar Publishing Post Office, specify the name of the post office you have chosen to enable for
calendar publishing during initial installation (for example, the POA for your own post office). Specify the IP
address or DNS hostname of the POA that services the post office, along with the calendar publishing port
number. The default port number is 7171.

Under Post Office Agent Information, transfer the IP address or DNS hostname and the calendar publishing
port. You need this information when you install the Calendar Publishing Host.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Designing Your Calendar Browse List

The Calendar Publishing Host collects a list of published calendars for Internet users to browse and
select from at the following URL:

http://web _server address/gwcal/calendar

However, by default, no calendars are displayed in the calendar browse list. You can handle the
calendar browse list in three different ways:

¢ Do not provide a calendar browse list, so that users need to notify Internet colleagues by email
of the URL to access their published calendars.
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6.3.6

6.3.7

¢ Use the calendar browse list only for calendars of general corporate interest. If you want to have
such a corporate browse list, you restrict which users can list calendars on the browse list, by
allowing only a few specific users who manage the corporate calendars to publish to the
calendar browse list.

¢ Allow most, if not all, users to publish their personal calendars on the calendar browse list. This
open approach to the calendar browse list makes users’ published calendars easily accessible to
anyone who knows the URL of the calendar browse list for your GroupWise system.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Calendar Browse List, mark whether you want to enable the calendar browse list, and if so, what
kind (corporate or open).

Selecting Calendar Publishing Settings

After you have set up the Calendar Publishing Host, you can configure how you want it to work for
your GroupWise users. The following settings are available in ConsoleOne:

¢ Enable Calendar Publishing: Select this option to let users publish personal GroupWise
calendars on the Internet. Calendar publishing is disabled by default. When you enable it, users
of the GroupWise Windows client and GroupWise WebAccess can right-click a personal
calendar, then click Publish to select options for publishing the personal calendar.

¢ Enable Rules to Move Items to a Published Calendar: Select this option so that users can create
rules to automatically transfer certain types of calendar items to specific personal calendars that
are published. Using rules is disabled by default.

¢ Enable Subscribe to Calendar: Select this option to allow users to subscribe to Internet
calendars that are updated on a regular basis, such as calendars for sporting events. Calendar
subscription is disabled by default.

¢ Enable Publish Free/Busy Search: Select this option to allow users to make their appointment
information available to external users, so that external users can perform free/busy searches on
users’ GroupWise calendars. Free/busy searching is disabled by default.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Calendar Publishing Options, mark the options you want to enable for the Calendar Publishing
Host.

Configuring Authentication to the Administration Web Console

An Administration Web console is provided for additional configuration of the Calendar Publishing
Host. To protect that Administration Web console, you must create or select at least one calendar
publishing administrator user and an administrative group for that user to belong to. For example,
you might create a user named CalPubAdmin and a group named CalPubAdminGrp. You could also
select an existing user and add this user to the administrative group. This user does not need any
special administrative rights. It does not need a GroupWise mailbox.

You can have the User object and the Group object in any convenient eDirectory container. The
container must exist before you install the Calendar Publishing Host. Because you specify the
container context during installation, you do not need to specify it each time you log in to the
Administration Web console.
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6.4

6.4.1

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under Authentication Information, specify the name of the Calendar Publishing Host administrator user (for
example, CalPubAdmin), the context of the administrator User object (for example,

ou=Users, o=yourcompanyname), and the name of the administrative group (for example,
CalPubAdminGrp). You specify the context of the user and the group when you install the Calendar Publishing
Host. You set up the User and Group objects in ConsoleOne.

As an administrator, you use the Calendar Publishing Host Administration Web console to manage
the Calendar Publishing Host. The Calendar Publishing Host uses LDAP authentication to allow you
to log in to the Administration Web console. For secure logins, configure the Calendar Publishing
Host to use SSL for the LDAP connection. During Calendar Publishing Host installation, you must
specify a trusted root certificate file that is used to establish the LDAP SSL connection. For more
information about LDAP SSL, see “Trusted Root Certificates and LDAP Authentication” in “Security
Administration” in the GroupWise 2012 Administration Guide.

GROUPWISE CALENDAR PUBLISHING HOST INSTALLATION WORKSHEET

Under LDAP Server Information, specify the IP address or DNS hostname of a server where LDAP is enabled.
Also specify the LDAP port. The default secure port is 636. Specify the full path to the SSL root certificate file.

For information about using the Administration Web console for ongoing administration, see
“Configuring the Calendar Publishing Host” in “Calendar Publishing Host” in the GroupWise 2012
Administration Guide.

Setting Up a Calendar Publishing Host

As you set up the Calendar Publishing Host, use the GroupWise Calendar Publishing Host
Installation Worksheet that you filled out in Section 6.3, “Planning a Calendar Publishing Host,” on
page 128 to provide the required information.:

¢ Section 6.4.1, “Linux: Installing the Calendar Publishing Host Application,” on page 132

¢ Section 6.4.2, “Windows: Installing the Calendar Publishing Host Application,” on page 136

¢ Section 6.4.3, “Configuring GroupWise to Support the Calendar Publishing Host,” on page 139

¢ Section 6.4.4, “Testing Calendar Publishing,” on page 145

Linux: Installing the Calendar Publishing Host Application

¢ “Preparing the Linux Server for the Calendar Publishing Host” on page 133
¢ “Installing the Linux Calendar Publishing Host Software” on page 133
If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for

GroupWise Administration” in the GroupWise 2012 Administration Guide before you install the GWIA
on Linux.
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Preparing the Linux Server for the Calendar Publishing Host

1 Make sure that the Web server where you are installing the Calendar Publishing Host
Application meets the system requirements listed in Section 6.2, “Calendar Publishing Host
System Requirements,” on page 126.

2 Make sure that the Linux server has a static IP address.

3 Make sure that the firewall on the server has the ports open that are used by the Web server and
the Calendar Publishing Host Application.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.
4 Make sure that LDAP is running on your eDirectory server.

5 Make sure that you have created the Calendar Publishing Host administrative user and group,
and that the Calendar Publishing Host server is configured for an SSL LDAP connection, as
described in Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on
page 131.

6 Continue with Installing the Linux Calendar Publishing Host Software.

Installing the Linux Calendar Publishing Host Software

1 Inaterminal window on the Web server where you want to install the Calendar Publishing Host
Application, log in as root, then provide the root password.

2 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the Calendar Publishing Host software to a software distribution
directory, change to /opt/novell/groupwise/software.

3 Run ./install.

The X Window System is required for running the GUI GroupWise Installation program. If you
are not using the X Window System, you can install GroupWise components individually, as
described in “Installing GroupWise Components Using the Text-Based Installation Program” on
page 185.

4 Select the language in which you want to run the GroupWise Installation program, then click
OK.
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The main GroupWise System Installation page appears.

GroupWise

Novell. GroupWise

View the Readme Displays a web page with important information you should read
before installing.

View the Quick Start Displays a high-level checklist of system requirements and installation
steps to guide vou through setting up your Group\ise system.

View the Installation Guide Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupWise WebAccess and GroupWise Intemet

Agent.

Create or update a GroupWise system Launches the Group¥ise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or
the updating of an existing GroupWise system.

Install Products Displays the GroupWise components you can individually install once
you've created a GroupWise system.

5 Click Install Products > GroupWise Calendar Publishing Host > Install Calendar Publishing Host to
install the Calendar Publishing Host software.

6 When the installation is complete, click OK.
7 Click Configure Calendar Publishing Host Application.

N GroupWise Calendar, Publishing Host Configuration X |

Introduction

[ ntroduction

Welcome to the GroupWise Calendar Publishing Host Configuration
Program. This program will do the fallowing:

& Configure your weh server to work with the GroupWise Calendar
Publishing Host

For more information read "Installing the GroupWise Calendar
Fublishing Host" in the GroupWise Installation Guide

OO0O000o0OaoO

Cancel | Next

8 Click Next, accept the License Agreement, then click Next.
9 Follow the prompts to configure the Calendar Publishing Host, using the following information
from the GroupWise Calendar Publishing Host Installation Worksheet:

Calendar Publishing Host Name
Post Office Agent Information
Web Server Information
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LDAP Server Information
Authentication Information

[¥] Introduction

[¥] calendar Publishing Host

To finish setting up the Calendar Publishing Host, complete
[¥] License Agreement the fallowing steps after you exit the Installation praogram

In ConsoleCne, click Tools = GroupWise System Operations =

Configuration Complete

[¥] web Server Information

Start Tomcat and Apache.

_@E |

Name Weh Calendar Publishing Haosts, then create a host with the
[l Post Office Agent exact name that you specified during installation
Information

OES Calendar Publishing Host

In ConsoleCne, click Tools = GroupWise Utilities = Client

[¥] Administration Console - Options = Enviranment > Calendar to enable Calendar
LDAP Server Information Publishing for Group'Wise clients
[¥] Administration Console - * In ConsoleQne, select each PO& object, click Properties =
Authentication Information Agent Settings, then select Enable Calendar Publishing, so
) that the POAS start looking up calendar infarmation to display
[¥] configuration Complete in users' published calendars.

| Exit

10 On the Configuration Complete page, click Exif to exit the Calendar Publishing Host Installation

11
12

program.

The Calendar Publishing Host software is installed to the following directories:

/opt/novell/groupwise/calhost
/etc/opt/novell /groupwise/calhost
/var/opt/novell/groupwise/calhost

It is also integrated with Tomcat.

Exit the GroupWise Installation program.

Restart Apache and Tomcat:

OES 11 rcnovell-tomcaté stop
rcapache2 stop
rcapache2 start
rcnovell-tomcaté start

OES 2 Linux: rcnovell-tomcat5 stop
rcapache2 stop
rcapache2 start
rcnovell-tomcat5 start

SLES 11 rctomcaté stop
rcapache2 stop
rcapache2 start
rctomcaté start

SLES 10: rctomcat5 stop
rcapache2 stop
rcapache2 start
rctomcat5 start
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13

Make sure that Apache and Tomcat restart automatically when the server reboots:
OES 11: chkconfig apache2 on
chkconfig novell-tomcaté on

OES 2 Linux: chkconfig apache2 on
chkconfig novell-tomcat5 on

SLES 11: chkconfig apache2 on
chkconfig tomcaté6 on

SLES 10: chkconfig apache2 on
chkconfig tomcat5 on

14 Skip to “Configuring the Calendar Publishing Host in ConsoleOne” on page 140.

6.4.2 Windows: Installing the Calendar Publishing Host Application

136

*

*

“Preparing the Windows Server for the Calendar Publishing Host” on page 136
“Installing the Windows Calendar Publishing Host Software” on page 136

Preparing the Windows Server for the Calendar Publishing Host

1

Make sure that the Web server where you are installing the Calendar Publishing Host
Application meets the system requirements listed in Section 6.2, “Calendar Publishing Host
System Requirements,” on page 126.

2 Make sure that the Windows server has a static IP address,

3 Make sure that the firewall on the server has the ports open that are used by the Web server and

the Calendar Publishing Host Application.
For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

Make sure that you have created the Calendar Publishing Host administrative user and group,
and that the Calendar Publishing Host server is configured for an SSL LDAP connection, as
described in Section 6.3.7, “Configuring Authentication to the Administration Web Console,” on
page 131.

Log in as an Admin equivalent to the eDirectory tree where GroupWise is installed.

Continue with Installing the Windows Calendar Publishing Host Software.

Installing the Windows Calendar Publishing Host Software

1

2
3

On the Web server where you want to install the Calendar Publishing Host Application, change
to the root directory of the downloaded GroupWise 2012 software image.

or

If you have already copied the Calendar Publishing Host Application to a software distribution
directory, change to that location

Run setup.exe.

(Conditional) If prompted, select the interface language for the GroupWise Installation program,
then click OK.
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On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.

The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard x|
GroupWize
Grouphfize Spetem [nstallation

| Displaps important information you should read before installing Grouplafise

Wiew the Quick Start

Displaps a high-level checklist of system requirements and installation steps to guide
you through setting up your Group'wise system

X Displaps overview and tazk information to help you plan, install, and maintain a basic
“iew the Installation Guide Groupiise system and all additional componerts.

| Creates or updates a basic Grouphwise system, including Group'wise administration,

Install Graupiwise System the Past Office Agent, the Message Transfer Agent. and the Intemet Agent.

Install Maore Components

Installs or updates Group'wise ‘Web Access, Groupwise Monitor, the Calendar
Fublishing Host, and the Groupwise “Windows client

InistallShield < Back | Mext » | Cancel |

4 Click Install More Components > Install Calendar Publishing Host, to start the Calendar Publishing
Host Installation program.

ilé‘- GroupWise Calendar Publishing Host x|

Welcome to the GroupWise Calendar
Publishing Host Installation Program

The Installshield(R) Wizard will allow you to modify Group\Wise
Calendar Publishing Host, To continue, dick Mext,

Novell.

< Back I Mext > I Cancel |

You can also start the Calendar Publishing Host Installation program by running:
/software image/internet/calhost/setup.exe

5 Click Next, then follow the prompts to provide the information from your GroupWise Calendar
Publishing Host Installation Worksheet.

The Calendar Publishing Host Installation program provides diagrams that help you
understand how the various components interact with each other. Review the diagrams as you
provide the requested information.

Calendar Publishing Host Name
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Web Server Information

Post Office Agent Information

LDAP Server Information

eDirectory Authentication Information

6 Review the Installation Summary page, then click Install.

i'-.% GroupWise Calendar Publishing Host

Installation Summary
If you want to review or change any settings, dick Back. Click Install to begin

copying files.
] Web Browser Installation summary:
I GroupWise Calendar Publishing Host =
Wl Web Server Version: 2012
= Calendar
A Publishing Web server
Host Application Platform: Microsoft Internet Information Server (1IS) for

Website: Default Web Site
I I Root directory: C:ynetpubiwwwroot

Application home directory

Location: C:\Movell\GroupWise\zalhost
= E .
LDAP 3

(‘.F\Pnriar Puhlishinn Host Name

Server POA

Installshisld

Installation Guide | < Back I Install I Cancel |

7 (Conditional) If prompts appear because your Web server is running, select how you want to
stop your Web server.

The Calendar Publishing Host Setup page explain the additional configuration steps that are
required after you are finished running the Calendar Publishing Host Installation program.

{&# GroupWise Calendar Publishing Host
Calendar Publishing Host Setup

Additional setup is required after you install the Calendar Publishing Host
Application.

To finish setting up the Calendar Publishing Host, complete the following steps after you
exit the Installation program:

» In Consoletne, dick Tools = GroupWise System Operations = Web Calendar
Publishing Hosts, then create a host with the exact name that you spedified during
installation:

Windows Calendar Publishing Host |

& In ConsoleOne, dick Tools > GroupWise Utilites > Client Options > Environment >
Calendar to enable Calendar Publishing for GroupWise dients.

& In ConsoleOne, select each POA object, dick Properties > Agent Settings, then
select Enable Calendar Publishing, so that the POAs start looking up calendar
information to display in users' published calendars.

Instell5hisld

Installation Guide < Back I Next > I Cancel |

8 Review the configuration steps, then click Next to continue.

138  GroupWise 2012 Installation Guide



9 When the installation is complete, click Finish to exit the Calendar Publishing Host Installation
program.

i'é“ GroupWise Calendar Publishing Host LI

Calendar Publishing Host Installation Complete

The Calendar Publishing Host Instalation program has
successfully installed GroupWise Calendar Publishing Host, Click
Finish.

¥ Launch installation summary

[¥ Restart Web server

Novell.

< Back I Firish I Cancel |

You can choose to have the WebAccess Installation program restart the Web server for you.

Along with the Calendar Publishing Host Application, the Installation program also installs
Tomcat 6 to c: \novell\tomcaté, integrates it with your Web server, and automatically starts it
to support the Calendar Publishing Host Application.

10 Click Finish to exit the GroupWise Installation program.

After installing the Calendar Publishing Host, additional configuration in ConsoleOne is still
required.

11 Continue with Configuring the Calendar Publishing Host in ConsoleOne.

6.4.3 Configuring GroupWise to Support the Calendar Publishing Host

¢ “Configuring the Calendar Publishing Host in ConsoleOne” on page 140
¢ “Enabling Calendar Publishing” on page 141

¢ “Restarting the Web Server and Tomcat” on page 143

¢ “Configuring a POA for Calendar Publishing” on page 143

¢ “Setting Up Calendar Publishing Administration” on page 144

¢ “Using the Published Calendar Browse List” on page 145
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Configuring the Calendar Publishing Host in ConsoleOne

Use the information under Calendar Publishing Host Configuration and Calendar Browse List on your
GroupWise Calendar Publishing Host Installation Worksheet as you configure the Calendar
Publishing Host.

1 In ConsoleOne, select the GroupWise System object, then click Tools > GroupWise System
Operations > Web Calendar Publishing Hosts.

2 Click Add.
Add Web Calendar Publishing Host E‘
Mame: |
URL:
Description:
IP Address: (74}
TCP Port; 80 &

3 Specify a unique name by which the Calendar Publishing Host will be known in your
GroupWise system.

IMPORTANT: This must be the identical name that you used during installation, including
spacing and capitalization, as described in Section 6.3.3, “Determining the Configuration of the
Calendar Publishing Host,” on page 129.

If you decide that you want to use a different name after you have already installed the Calendar
Publishing Host software, you must reinstall the software, then specify the identical name that
you provided during installation when you configure the Calendar Publishing Host in
ConsoleOne.

4 Specify the base URL for the Calendar Publishing Host in the following format:

http://web_server address:port/gwcal

Replace web_server address with the IP address or DNS hostname of the Web server where
you installed the Calendar Publishing Host software and port is the port number on which the
Calendar Publishing Host communicates with the Web server. The default port number is 80 and
does not need to be specified if your Web server uses that default.

The base URL does not point to information that is displayable in your browser. Displayable
URLs are listed in Section 6.3.3, “Determining the Configuration of the Calendar Publishing
Host,” on page 129.

5 Specify the IP address of the server where the Calendar Publishing Host is running.
This information enables the POA to communicate with the Calendar Publishing Host.

6 Specify the TCP port number on which the Calendar Publishing Host is configured to
communicate with the POA.

The default is 7171.
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7 Click OK to save the Calendar Publishing Host configuration information.

Configure Web Calendar Publishing Host

‘wWeb Calendar Publishing Host:

Linux Calendar Publishing Host

["] Enable Publishing of Calendars ta the Browse List

8 If you want to allow users to add their published calendars to the calendar browse list as the
default for your GroupWise system, select Enable Publishing of Calendars to the Browse List.

or

If you want to set up a corporate calendar browse list or provide no calendar browse list, leave
Enable Publishing of Calendars to the Browse List deselected.

9 Click OK when you are finished.

10 Restart the POA so that it picks up the configuration information for the new Calendar
Publishing Host.

11 Continue with Enabling Calendar Publishing.

Enabling Calendar Publishing

Use the information under Calendar Publishing Options on your GroupWise Calendar Publishing Host
Installation Worksheet as you enable calendar publishing.
1 In ConsoleOne, browse to and select post office where you want to enable calendar publishing.

For convenience in testing your Calendar Publishing Host setup, you might want to start with
your post office.

2 Click Tools > GroupWise Utilities.
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3 Click Client Options > Environment > Calendar.

Environment Options: Provol ll
General | Client Access | Wigws | File Location

Movell vibe | Tutorial | AddressBook | Conferencing |  ReckF
Cleanup | Appeatance | Reetention | Junk Mail

‘wweb Calendar Publishing Host:

|<None> LI d‘_l

Calendar publish control

™ Enable calendar publishing d‘

I~ Enable rulesibo move items to & publishied calendar d‘
FreejBusy search publish control

™ Enable publish Fresfbusy search d‘ |

~Calendar subscribe control

[~ Enable subscribe ko calendar d‘

Restore Default Settings

o I Cancel Help |

The calendar publishing options are disabled by default. As you roll out calendar publishing,
you can use Client Options to enable it at the domain, post office, and user level.

4 Select a Calendar Publishing Host from the drop-down list.

5 Set the Calendar options as you planned under Calendar Publishing Options on your
GroupWise Calendar Publishing Host Installation Worksheet.

6 Click OK to save the calendar publishing settings, then click Close.

7 Continue with Restarting the Web Server and Tomcat.
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Restarting the Web Server and Tomcat

To put the ConsoleOne settings into effect, you must restart the Web server and Tomcat.

1 Restart Apache and Tomcat:

OES 11 rcnovell-tomcaté

rcapache?2
rcapache?2

stop
start

rcnovell-tomcaté

OES 2 Linux: rcnovell-tomcats

rcapache?2
rcapache?2

stop
start

rcnovell-tomcaths

SLES 11 rctomcaté
rcapache?2
rcapache?2
rctomcaté6

SLES 10: rctomcat5s
rcapache?2
rcapache?2
rctomcat5

This loads the Calendar Publishing Host into your Web server so that it is available for use.

stop
stop
start
start

stop
stop
start
start

stop

start

stop

start

2 Make sure that Apache and Tomcat restart automatically when the server reboots:

OES 11: chkconfig
chkconfig
OES 2 Linux: chkconfig
chkconfig
SLES 11: chkconfig
chkconfig
SLES 10: chkconfig
chkconfig

apache?2
novell -

apache?2
novell-

apache?2
tomcaté

apache2
tomcat5

on
tomcat6 on

on
tomcat5 on

on
on

on
on

Continue with Configuring a POA for Calendar Publishing.

Configuring a POA for Calendar Publishing

After calendar publishing is enabled, the POA can look up calendar information and return it to the
Calendar Publishing Host in the form of ICS (Internet Calendaring and Scheduling) or IFB (Internet
Free Busy) files. Internet users can import these files into GroupWise, Outlook, and Macintosh iCal

calendaring applications.

Use the information under Calendar Publishing Post Office on your GroupWise Calendar Publishing

Host Installation Worksheet as you configure the POA.

1 In ConsoleOne, browse to and select the post office where calendar publishing is enabled, right-
click the POA object for the post office, then click Properties.

2 Click GroupWise > Agent Settings.
3 Select Enable Calendar Publishing.
4 Adjust the number in the Max Calendar Publishing Threads field as needed.
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The default maximum number of calendar publishing threads is 4. By default, the POA creates 2
calendar publishing threads and automatically creates additional threads as needed until the
maximum number is reached. You cannot set the maximum higher than 4, but you can reduce
the number of threads to conserve POA resources for other activities.

5 Click OK to save the calendar publishing configuration settings.

6 Asyou roll out calendar publishing to your GroupWise users, enable calendar publishing on the
POA for each post office where users will publish calendars and free/busy information.

To determine which POAs have been enabled for calendar publishing, see “Viewing Calendar
Publishing Status at the POA Web Console” in “Calendar Publishing Host” in the GroupWise
2012 Administration Guide.

Setting Up Calendar Publishing Administration

After calendar publishing has been enabled and the POA is communicating with the Calendar
Publishing Host, you use the Calendar Publishing Host Administration Web console to monitor the
Calendar Publishing Host and to make configuration changes as needed.

Use the information under Authentication Information on your GroupWise Calendar Publishing Host
Installation Worksheet as you set up Calendar Publishing Host administration. You now set up the
objects in ConsoleOne that correspond to the objects you specified during installation.

1 In ConsoleOne, browse to and select the container where you want to have the calendar
publishing administrator User and Group objects.
2 (Conditional) If you want to create a new User object:
2a Right-click the container, then click New > User.
2b Fill in the required fields, including a password.
2c Click OK to create the new User object.
3 Create the new administrative group:

3a Right-click the container where the administrator User object is located, then click New >
Group.

3b Fill in the required fields.

3c Click OK to create the new Group object.
4 Right-click the new User object or an existing User object, then click Properties.
5 Click Memberships > Group Membership.

6 Click Add, select the new administrative group you created in Step 3, then click OK to assign the
administrator user to the group.

7 Click OK to close the Group Membership page.
8 Continue with Using the Published Calendar Browse List.
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6.4.4

Using the Published Calendar Browse List

If you selected Enable Publishing of Calendars to the Browse List as your GroupWise system default in
Step 8 in “Configuring the Calendar Publishing Host in ConsoleOne” on page 140, skip to
Section 6.4.4, “Testing Calendar Publishing,” on page 145.

If you are planning to implement a corporate calendar browse list, you can enable publishing of
calendars to the browse list for yourself for testing purposes.

1 Browse to and right-click your User object, then click Properties.
2 Click GroupWise > Calendar Publishing.
3 Select Override, then select Enable Publishing of Calendars to the Browse List.

This give you the right to add your calendars to the calendar browse list so that you can test the
setup of the Calendar Publishing Host.

4 Continue with Testing Calendar Publishing.

Testing Calendar Publishing

Now that you have set up a Calendar Publishing Host, you can test it by:
¢ “Publishing a Personal Calendar” on page 145

¢ “Displaying the Browse List of Calendars” on page 146
¢ “Publishing Free/Busy Information” on page 147

Publishing a Personal Calendar
1 In the GroupWise Windows client, create and populate a personal calendar, as described in
“Creating a Personal Calendar” in “Calendar” in the GroupWise 2012 Windows Client User Guide.
2 Right-click the personal calendar, then click Publish.

General | Display | Sharing | Publish

E [] Publish this calendar

Time period:
through nest

3 Select Publish This Calendar.

For more information, see “Publishing Personal Calendars on the Internet” in “Calendar” in the
GroupWise 2012 Windows Client User Guide.
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This feature is also available in GroupWise WebAccess, as described in “Publishing Personal
Calendars on the Internet” in the GroupWise 2012 WebAccess User Guide.

For more information, see the GroupWise 2012 Calendar Publishing Host User Quick Start (http://
www.novell.com/documentation/groupwise2012/pdfdoc/gw2012_qgs_calpubuser/
gw2012_gs_calpubuser.pdf).

Click Send Publish Location, then address and send the resulting message, which provides the
URL from which Internet colleagues can obtain your calendar information.

The URL has the following format:

http://calpubhost server/gwcal/freebusy/user ideinternet domain
Click OK to publish the selected personal calendar.
Check your mailbox for the notification sent by the Calendar Publishing Host.

Continue with Displaying the Browse List of Calendars.

Displaying the Browse List of Calendars

1 Display the following URL:

http://web_server address/gwcal/calendar

Novell® GroupWise® Calendar Publishing Host  sep 4, 2008 (Thursday)

Owner Calendar Actions

Benji Gensomino Conference [Dowenlnad]  [Subscribe]
David Jones Personal [Dowenload]  [Subscribe]
Ishmael Yacoub Meetings [Download]  [Subscribe]

[ Digplay From Start ]|25 V|

Your newly published personal calendar should appear on the list.

2 Click your calendar to view it in its published format.

This assures you that your calendar is available for access by users across the Internet.
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Publishing Free/Busy Information

1 In the GroupWise Windows client, click Tools > Options.
2 Click Calendar > Free/Busy.

Calendar E]El
General | Work Schedule | Busy Search | Date/Time

Drefault Busy Search Options

days Dravs to search: Monday
Tuesday

~

Search range: |7
-

From: | g.np am o Wednesday
Thursday
Too [ 500 FM Friday
[ Saturday
[ Sunday

Irntemet Free/Busy
Publish my freefbusy information
Location:
hitp: ##gw novell comigucal freebusy/jbd@inovel com

Send Fiee/Busy Publish Location

3 Click Send Free/Busy Publish Location, then address and send the resulting message, which
provides the URL from which Internet colleagues can obtain your free/busy information.

4 Click OK, then click Close.
5 Check your mailbox for the notification sent by the Calendar Publishing Host.

6.5 What's Next

The “Calendar Publishing Host” section of the GroupWise 2012 Administration Guide provides
information to help you further configure and maintain the Calendar Publishing Host:

¢ Using the Administration Web console to change the configuration of the Calendar Publishing

Host.

See “Configuring the Calendar Publishing Host”.

¢ Changing the appearance of the calendar browse list to represent your company.
See “Customizing the Calendar Publishing Host Logo”.

¢ Restricting the posted list of calendars to those of corporate importance.
See “Creating a Corporate Calendar Browse List”.

¢ Monitoring the Calendar Publishing Host at the POA Web console and through Calendar
Publishing Host log files.

See “Monitoring Calendar Publishing”.
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Worksheet

6.6 GroupWise Calendar Publishing Host Installation

Installation Program Field

Value for Your
GroupWise System

Explanation

Web Server Platform:

¢ Linux

+ Windows

Section 6.3.1, “Selecting
the Calendar Publishing
Host Application
Platform,” on page 128

Calendar Publishing Host
Name:

Section 6.3.3,
“Determining the
Configuration of the
Calendar Publishing
Host,” on page 129

Post Office Agent
Information:

+ POA network address
+ |P address

+ DNS hostname

¢ Calendar publishing port

Section 6.3.4,
“Connecting the
Calendar Publishing
Host to a POA,” on
page 130

Web Server Information:

OES 11
* Apache path

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat6/webapps

Section 6.3.2,
“Gathering Web Server
Information,” on

page 128

Web Server Information:
OES 2 Linux
* Apache path

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat5/webapps

Section 6.3.2,
“Gathering Web Server
Information,” on

page 128
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Value for Your
GroupWise System

Installation Program Field

Explanation

Web Server Information:

SLES 11
* Apache path

/etc/apache2/conf.d
+ Tomcat path

/usr/share/tomcat6/
webapps

Section 6.3.2,
“Gathering Web Server
Information,” on

page 128

Web Server Information:
SLES 10
* Apache path

/etc/apache2/conf.d
+ Tomcat path

/srv/www/tomcat5/
base/webapps

Section 6.3.2,
“Gathering Web Server
Information,” on

page 128

Web Server Information:

Section 6.3.2,
“Gathering Web Server

Windows Information,” on
128
* Microsoft Internet page
Information Server (IIS) for
Windows
+ Path to the Web server’s
root directory
* Web site
LDAP Server Information: Section 6.3.7,
“Configuring

+ LDAP server address
¢ Port

* Root certificate of the
LDAP server

Authentication to the
Administration Web
Console,” on page 131

Authentication Information:

+ Administrator user name

+ User container for
contextless login

+ Administrative group that
the user must belong to

Section 6.3.7,
“Configuring
Authentication to the
Administration Web
Console,” on page 131
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Installation Program Field

Value for Your
GroupWise System

Explanation

Calendar Publishing Host
Configuration:

+ Name

+ URL

+ Description
¢ |P address

* TCP port

Section 6.3.3,
“Determining the
Configuration of the
Calendar Publishing
Host,” on page 129

Calendar Browse List:

* Yes
* Corporate (restricted)
*+ Open

* No

Section 6.3.5,
“Designing Your
Calendar Browse List,”
on page 130

Calendar Publishing Options:

+ Enable calendar publishing

+ Enable rules to move items
to a published calendar

+ Enable subscribe to
calendar

+ Enable publish free/busy
searches

Section 6.3.6, “Selecting
Calendar Publishing
Settings,” on page 131

Calendar Publishing Post
Office:

*+ Name:

¢ POA network address
* |P address
+ DNS hostname

¢ Calendar publishing port

Section 6.3.4,
“Connecting the
Calendar Publishing
Host to a POA,” on
page 130
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7.1

7.1.1

Installing GroupWise Monitor

Novell GroupWise Monitor is a monitoring and management tool that allows you to monitor
GroupWise agents and gateways from any location where you are connected to the Internet and have
access to a Web browser. Some agent administration can also be performed from your Web browser if
the agent Web console is password protected.

¢ Section 7.1, “GroupWise Monitor Overview,” on page 151

¢ Section 7.2, “Monitor System Requirements,” on page 154

*

Section 7.3, “Planning GroupWise Monitor,” on page 156

*

Section 7.4, “Setting Up GroupWise Monitor,” on page 160

*

Section 7.5, “Testing GroupWise Monitor,” on page 169

*

Section 7.6, “GroupWise Monitor Installation Worksheets,” on page 171

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, see the
GroupWise 2012 Interoperability Guide before you install Monitor.

GroupWise Monitor Overview

¢ Section 7.1.1, “GroupWise Monitor Functionality,” on page 151
¢ Section 7.1.2, “GroupWise Monitor Components,” on page 152

¢ Section 7.1.3, “One Monitor Server versus Two,” on page 152

*

Section 7.1.4, “Monitor Security Requirements,” on page 152

*

Section 7.1.5, “Monitor and the GroupWise High Availability Service on Linux,” on page 154

GroupWise Monitor Functionality

GroupWise Monitor enables you to monitor the status of all agents throughout your GroupWise
system in one convenient location. You can install Monitor on either Linux or Windows. Either
version can monitor agents on both Linux and Windows. Depending on the installation platform,
two or three different monitoring environments are available:

¢ Monitor Web Console: The Monitor Web console, provided by the Monitor Application, takes
advantage of your Web server’s capabilities to make agent status information available to you
when you are outside your firewall.

¢ Monitor Agent Web Console: The Monitor Agent Web console, provided by the Monitor Agent
itself, can be used only behind your firewall but provides capabilities not available in the
Monitor Web console. This section focuses on using the full-featured Monitor Agent Web
console.

NOTE: The Monitor Web consoles are available on both Linux and Windows.
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7.1.2

7.1.3

714

¢ Monitor Agent Server Console: The Monitor Agent server console is available only on
Windows servers. All agent configuration tasks can be performed at the Monitor Agent server
console, but some reports are not available.

Specific differences in functionality between the Monitor consoles are summarized in “Comparing
the Monitor Consoles” in “Monitor” in the GroupWise 2012 Administration Guide.

GroupWise Monitor Components

GroupWise Monitor consists of two components, the Monitor Agent and the Monitor Application.

W
Monitor MTA
Application
/_V;.‘j%,;.': X -«
.{.,: 4 "“ 3 ey

J—@ gy —y—v
D = “1  Poa

Web Browser Internet Web Server Monitor Agent

¢ Monitor Agent: The Monitor Agent continuously polls other GroupWise agents (POA, MTA,
and GWIA, as well as the Messenger Agents, and GroupWise gateways), gathers status
information from them, and displays the status information at the Monitor Agent server console.
The Monitor Agent also services requests for agent status information from the Monitor
Application.

¢ Monitor Application: The Monitor Application extends the capability of your Web server so
that agent status information can be displayed in your Web browser. Two browser-based
consoles are available:

One Monitor Server versus Two

The Monitor Agent and the Monitor Application can run together on a Linux server or a Windows
server. The server where they run together must be a Web server because the Monitor Application is
installed into the Web server installation.

The Monitor Agent and the Monitor Application can also run on different servers. The security issues
discussed in Monitor Security Requirements might determine whether you run the Monitor Agent on
the same server with the Web server and the Monitor Application.

Monitor Security Requirements

GroupWise Monitor can be configured to support the level of security you have established for your
Internet/intranet communication.

If you are not concerned about security issues (for example, you only plan to use Monitor on a
secured intranet), you can install the Monitor components to any servers that provide access for your
GroupWise administrators and that meet the requirements listed in Section 7.2, “Monitor System
Requirements,” on page 154.
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If you plan to use Monitor to provide GroupWise administrators with access to your GroupWise
system from anywhere on the Internet (rather than simply within a secured intranet), and you
already have a firewall in place to provide security, you have the following options for configuring
Monitor:

¢ Install both Monitor components inside your firewall and use a proxy service. See “Configuring
Monitor with a Proxy Service” on page 153. This is the recommended configuration.

¢ Install the Monitor Application on a Web server outside your firewall and the Monitor Agent on
a server inside your firewall. See “Configuring Monitor without a Proxy Service” on page 154.

Configuring Monitor with a Proxy Service

If your firewall includes a proxy service, you can install the Monitor Application to a Web server
inside your firewall, and the Monitor Agent to another server inside the firewall, as shown in the
following illustration.
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If desired, the Monitor Agent can also be installed to the Web server rather than a separate server, as
discussed in Section 7.1.3, “One Monitor Server versus Two,” on page 152.
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7.1.5

1.2

7.2.1

Configuring Monitor without a Proxy Service

If your firewall does not provide a proxy service, you need to install the Monitor Application to a
Web server that is outside the firewall. Because the Monitor Agent requires direct access to a
GroupWise domain directory, it needs to be installed to a server that is located within the firewall. It
should be installed to the same server where a domain directory is located.
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The firewall must allow inbound IP packets to be sent from the Web server to the IP address and port
number of the Monitor Agent (for example, 172.16.5.18:8200).

In addition, the firewall must allow outbound IP packets to be sent from the Monitor Agent to the
Web server. This requires all high ports (above 1023) to be open to outbound IP packets.

Monitor and the GroupWise High Availability Service on Linux

The Linux version of Monitor can be used with the GroupWise High Availability service (gwha) to
automatically restart GroupWise agents when they stop unexpectedly. For setup instructions, see
“Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on page 195.

There is no GroupWise High Availability service for Windows. Windows includes a mechanism for
restarting services automatically when they stop unexpectedly. For more information, see “Restarting
the Windows Agents Automatically” on page 207.

Monitor System Requirements

¢ Section 7.2.1, “Hardware and Operating System Requirements,” on page 154
¢ Section 7.2.2, “Web Server Requirements,” on page 155
¢ Section 7.2.3, “Web Browser Requirements,” on page 156

¢ Section 7.2.4, “Software Requirements,” on page 156

Hardware and Operating System Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
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(3 Any of the following server operating systems for the Monitor Agent:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI GroupWise agent server
consoles for the Post Office Agent, the Message Transfer Agent, and the Internet Agent. By
default, the GroupWise agents run as daemons without user interfaces.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack

[ Adequate server memory as required by the operating system

(3 Adequate server disk space:
¢ Approximately 38 MB for the Monitor Agent program files (varies by platform)

¢ Approximately 127 MB for the Monitor Application files (shared with the WebAccess
Application and the Calendar Publishing Host Application when installed on the same
Web server; varies by platform)

+ 50 MB to 100 MB for log files if you plan to use Monitor’s reporting capabilities that
rely on MTA message logging, as described in “Generating Reports” in “Monitor” in
the GroupWise 2012 Administration Guide

7.2.2  Web Server Requirements
The Web server supported for your operating system:
3 OES2 Linux /SLES 10

Apache 2.2 plus:
* Tomcat 5 or later

Tomcat 5 is included with the Linux operating system. If it is not already installed, use YaST
to install it before you install the GroupWise software.

¢ IBM JRE 5 or later
¢ ModProxy Module
0 OES11/SLES 11
Apache 2.2 plus:
¢ Tomcat 6 or later

For OES 11, Tomcat 6 is included with the Linux operating system. If it is not already
installed, use YaST to install it before you install the GroupWise software.

For SLES 11, Tomcat 6 is added to the Linux server with the GroupWise software.
¢ IBM JRE 5 or later
¢ ModProxy Module
(0 Windows Server 2003/2003 R2
Microsoft Internet Information Server (IIS) 6 or later plus:
+ Tomcat 6

¢+ IBM]RE 5 or later
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+ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

O Windows Server 2008/2008 R2/2012/2012 R2
Microsoft Internet Information Server (IIS) 7 or later plus:
+ Tomcat 6
¢ IBMJRE 5 or later
¢ Jakarta Connector 1.2

Tomcat 6, IBM JRE 6 Update 26, and Jakarta Connector 1.2 are installed along with the
GroupWise software if they are not already present on the Windows server.

7.2.3 Web Browser Requirements

[ Any of the following Web browsers for the GroupWise Calendar Publishing Host user Web
pages and the Calendar Publishing Host Administration Web console:

* Linux: Mozilla Firefox
+ Windows: Microsoft Internet Explorer 8.0 or later; Mozilla Firefox; Google Chrome

¢ Macintosh: The latest version of Safari for your version of Mac OS; Mozilla Firefox; Google
Chrome

7.2.4  Software Requirements

[ Any of the following environments for running the GroupWise Installation program:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers
where the X Windows System is not available.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, or Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack, plus
the latest Novell Client.

7.3 Planning GroupWise Monitor

Use the “GroupWise Monitor Installation Worksheets” on page 171 to record your decisions about
how to install GroupWise Monitor. The topics in this section present the required information in a
convenient planning sequence. The Installation Worksheets organize the information in the order in
which you need it during installation.

¢ Section 7.3.1, “Selecting the Monitor Application Platform,” on page 157

¢ Section 7.3.2, “Deciding Where to Install the GroupWise Monitor Components,” on page 157

¢ Section 7.3.3, “Determining the Monitor Agent’s Configuration,” on page 158

¢ Section 7.3.4, “Determining the Monitor Application’s Configuration,” on page 159
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71.3.2

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
Wiki (http://wiki.novell.com/index.php/GroupWise).

IMPORTANT: If you plan to install GroupWise Monitor in a clustered server environment, refer to
the GroupWise 2012 Interoperability Guide as you plan your Monitor installation.

Selecting the Monitor Application Platform

The Monitor Application can be installed to a Web server on Linux or Windows. See Section 7.2,
“Monitor System Requirements,” on page 154 for supported Web servers.

GROUPWISE MONITOR APPLICATION INSTALLATION WORKSHEET

Under Web Server Platform, mark whether you plan to install the Monitor Application to a Linux or Windows
Web server.

Deciding Where to Install the GroupWise Monitor Components

After reviewing Section 7.1, “GroupWise Monitor Overview,” on page 151 and the system
requirements listed in Section 7.2, “Monitor System Requirements,” on page 154, plan where you
want to install the Monitor components in your system.

¢ “Monitor Agent Server” on page 157
+ “Web Server” on page 158

Monitor Agent Server

The Monitor Agent runs on Linux and Windows. On Linux, the Monitor Agent runs as a daemon. On
Windows, the Monitor Agent runs as an application. The Monitor Agent cannot be run as a Windows
service.

If you want to install the Monitor Agent and the Monitor Application on the same server, you can
install them at the same time. If you want to install them on different servers, you must run the
Monitor Installation program twice, once for each server. For example, you might want to install the
Monitor Application on Linux for use with a Linux Web server, but you might want to install the
Monitor Agent on Windows so that you can use its server console, which is not available on Linux.

The Monitor Agent needs to communicate with an MTA. If possible, install the Monitor Agent on the
same server where a domain and MTA are already located. If you want to install the Monitor Agent
on its own server, consider creating a domain on that server specifically for helping the Monitor
Agent communicate with the rest of your GroupWise system.

The installation directory for the Monitor Agent depends on the platform:

Linux: The Linux Monitor Agent is automatically installed to /opt /novell/groupwise/agents.

Windows: The default installation directory is c¢: \Program Files\Novell\GroupWise
Server\Monitor.
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7.3.3

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Agent Software Platform, mark the platform (Linux or Windows) where you plan to install the Monitor
Agent.

Under Server Information, specify the directory on the Linux or Windows server where you plan to install the
Monitor Agent software.

Web Server

The Monitor Application integrates with your Web server to pass agent status information gathered
by the Monitor Agent to your Web browser for display in the Monitor Web console. The location of

the Monitor Application files that are installed depends on the Web server that it is being integrated
with. The default Web server paths vary by platform:

Apache Web Server on OES 11: /etc/opt/novell/httpd/conf.d
Tomcat on OES 11: /var/opt/novell/tomcat6/webapps
Apache Web Server on OES 2 Linux: /etc/opt/novell/httpd/conf.d
Tomcat on OES 2 Linux: /var/opt/novell/tomcat5/webapps
Apache Web Server on SLES 11: /etc/apache2/conf.d

Tomcat on SLES 11: /usr/share/tomcaté6/webapps
Apache Web Server on SLES 10: /etc/apache2/conf.d

Tomcat on SLES 10: /srv/www/tomcat5/base/webapps
Microsoft Internet Information Server (IIS) on Windows: c:\inetpub\wwwroot

Tomcat on Windows: c:\novell\tomcaté\webapps

GROUPWISE MONITOR APPLICATION INSTALLATION WORKSHEET

Under Web Server Information, select the type of Web server you want to use with Monitor, and specify the
directory path to the Web server root directory.

On Windows, if the Internet Information Server services more than one Web site, specify the Web site where
you want to install the Monitor Application.

Determining the Monitor Agent’s Configuration

As you install the Monitor Agent, you are prompted to supply the configuration information
described in the following sections:

¢ “Systems to Monitor” on page 159

¢ “Monitor Agent Network Address” on page 159

¢ “Domain Directory Path” on page 159
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Systems to Monitor

The Monitor Agent can monitor both GroupWise agents and Messenger agents. In addition, the
Monitor Agent works in conjunction with the GroupWise High Availability service on Linux to
automatically restart GroupWise and Messenger agents that go down unexpectedly

NOTE: It is not necessary to have an entire GroupWise system installed in order for the Monitor
Agent to monitor just the Messenger agents. For more information, see “Setting Up the High
Availability Service” in “Installing a Novell Messenger System” in the Novell Messenger 2.2 Installation
Guide.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under System Options, mark whether you want to monitor a GroupWise system, a Messenger system, or both.

Monitor Agent Network Address

The Monitor Agent communicates with the Monitor Application and with monitored agents by way
of TCP/IP.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Server Information, record the IP address or DNS hostname of the Linux or Windows server where you
plan to install the Monitor Agent software. Use the default port number of 8200 unless that number is already in
use on that server.

If you are installing the Monitor Application on a different server from where you are installing the Monitor
Agent, record the same information under Monitor Agent Information on the GroupWise Monitor Application
Installation Worksheet.

For a complete list of default port numbers used by the GroupWise agents, refer to “GroupWise Port
Numbers” in the GroupWise 2012 Administration Guide.

Domain Directory Path

The Monitor Agent can gather information about the locations of GroupWise agents to monitor by
reading from a domain database. Using the gathered information, the Monitor Agent can display a
list of monitored agents when you start it for the first time.

GROUPWISE MONITOR AGENT INSTALLATION WORKSHEET

Under Domain Directory, specify the directory path to a domain where a GroupWise 6.x or later MTA is running.

Determining the Monitor Application’s Configuration

Monitor Application configuration information is stored in a configuration file (gwmonitor.c£g),
located in the following directories:

Linux: /var/opt/novell/groupwise/monitor

Windows: c¢:\novell\groupwise\gwmonitor
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The default configuration information is sufficient for an initial Monitor Application installation. For
more information about configuring the Monitor Application, see “Configuring the Monitor
Application” “Monitor” in the GroupWise 2012 Administration Guide after you have installed the
Monitor Application.

7.4 Setting Up GroupWise Monitor

Follow the instructions for the platform where you are setting up GroupWise Monitor:

¢ Section 7.4.1, “Linux: Setting Up GroupWise Monitor,” on page 160
¢ Section 7.4.2, “Windows: Setting Up GroupWise Monitor,” on page 165

IMPORTANT: If you are installing GroupWise Monitor in a clustered server environment, see the
GroupWise 2012 Interoperability Guide before you install Monitor.

7.4.1 Linux: Setting Up GroupWise Monitor

160

Complete the following tasks to install GroupWise Monitor on Linux:

¢ “Preparing the Linux Server for GroupWise Monitor” on page 160
¢ “Installing and Configuring the Linux Monitor Agent” on page 160
¢ “Installing and Configuring the Linux Monitor Application” on page 162
¢ “Starting the Linux Monitor Agent as a Daemon” on page 164
If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for

GroupWise Administration” in the GroupWise 2012 Administration Guide before you install the
GroupWise Monitor on Linux.

Preparing the Linux Server for GroupWise Monitor

1 Make sure that the Linux server where you are installing the Monitor Agent meets the system
requirements listed in Section 7.2, “Monitor System Requirements,” on page 154.

2 Make sure that the Web server where you are installing the Monitor Application meets the
system requirements listed in Section 2.1.4, “Web Server Requirements,” on page 21.

3 Make sure that the Linux server has a static IP address.

4 Make sure that the firewall on the server has the ports open that are used by the Monitor Agent
and/or the Monitor Application and the Web server.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

5 Continue with Installing and Configuring the Linux Monitor Agent.

Installing and Configuring the Linux Monitor Agent

1 In a terminal window on the server where you want to install the Monitor Agent, log in as root,
then provide the root password.

2 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the Monitor Agent software to a software distribution directory,
Change to /opt/novell/groupwise/software.
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3 Run ./install.

The X Window System is required for running the GUI GroupWise Installation program. If you

are not using the X Window System, you can install GroupWise components individually, as

described in “Installing GroupWise Components Using the Text-Based Installation Program” on
page 185.

4 Select the language in which you want to run the GroupWise Installation program, then click
OK.

The main GroupWise System Installation page appears.

Novell. GroupWise

View the Readme

Yiew the Quick Start

View the Installation Guide

Create or update a GroupWise system

Install Produets

GroupWise

Displays a web page with important information you should read
before installing.

Displays a high-level ist of system requir and installation
steps to guide you through setting up your GroupWise system.

Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupWise WebAccess and GroupWise Intemet

Agent.

Launches the Group¥Wise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or
the updating of an existing Group\ise system.

Displays the GroupWise components you can individually install once
you've created a GroupWise system.

5 Click Install Products > GroupWise Monitor > Install GroupWise Monitor Agent to install the Monitor
Agent software.

6 When the installation is complete, click OK.
7 Click Configure Monitor Agent.

N

O

Oooo

[ introduction

GroupWise Manitor Agent Configuration x|

Introduction

GroupWise Manitor gent.

Cancel

Welcome to the GroupWise Maonitar Agent Canfiguratian
Program. This program will create configuration files for the

| Hext |
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8 Follow the prompts to configure the Monitor Agent, using the following information from the
GroupWise Monitor Agent Installation Worksheet.

System Options
Domain Directory

On the Configuration Complete page, Launch Monitor Agent on System Startup is selected by
default.

IMPORTANT: The Monitor Agent must be running in order for the GroupWise High
Availability service to automatically restart the GroupWise agents if they stop unexpectedly. For
more information, see “Enabling the GroupWise High Availability Service for the Linux
GroupWise Agents” on page 195.

9 Click Exit to complete the Monitor Agent installation.
The Monitor Agent software is installed to /opt /novell/groupwise/agents.

10 Continue with Installing and Configuring the Linux Monitor Application.

Installing and Configuring the Linux Monitor Application

1 (Conditional) If you are installing the Monitor Application on a different server from where you
installed the Monitor Agent:

la Ina terminal window on the Web server where you want to install the Monitor Application,
log in as root, then provide the root password.

1b Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the Monitor Application software to a software distribution
directory, change to /opt/novell/groupwise/software.

1c Run ./install.

1d Select the language in which you want to run the GroupWise Installation program, then
click OK.

le Click Install Products > GroupWise Monitor.
2 Click Install Monitor Application to install the Monitor Application software.
3 When the installation is complete, click OK.
4 Click Configure Monitor Application.

e )
Introduction
[ introduction Welcome to the Group'wise Monitor Application
Configuration Pragram. This pragram will do the following
a
O * Configure your wehserver to wark with Group'ise Monitor
[
[
Cancel Next
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Click Next, accept the License Agreement, then click Next.

Follow the prompts to configure the Monitor Application, using the following information from
the GroupWise Monitor Application Installation Worksheet:

Server Information

Web Server Information

On the Configuration Complete page, click Exit to exit the Monitor Installation program.

The Monitor Application is installed into the following directories:

/opt/novell/groupwise/monitor
/etc/opt/novell/groupwise/monitor
/var/opt/novell/groupwise/monitor

It is also integrated with Tomcat.

8 Exit the GroupWise Installation program.

9 Restart Apache and Tomcat:

OES 11 rcnovell-tomcaté stop
rcapache2 stop
rcapache2 start
rcnovell-tomcaté start

OES 2 Linux: rcnovell-tomcat5 stop
rcapache2 stop
rcapache2 start
rcnovell-tomcat5 start

SLES 11 rctomcaté stop
rcapache2 stop
rcapache2 start
rctomcaté start

SLES 10: rctomcat5 stop
rcapache2 stop
rcapache2 start
rctomcat5 start

Make sure that Apache and Tomcat restart automatically when the server reboots:
OES 11: chkconfig apache2 on

chkconfig novell-tomcaté on

OES 2 Linux: chkconfig apache2 on
chkconfig novell-tomcat5 on

SLES 11: chkconfig apache2 on
chkconfig tomcaté6 on

SLES 10: chkconfig apache2 on

chkconfig tomcat5 on

(Conditional) If you use a proxy service, follow the instructions in “Configuring Proxy Service
Support for the Monitor Web Console” in “Monitor” in the GroupWise 2012 Administration Guide.

Continue with Starting the Linux Monitor Agent as a Daemon.
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Starting the Linux Monitor Agent as a Daemon

NOTE: Unlike the other GroupWise agents, you do not need to be logged in as root in order to start
the Monitor Agent.

1 Make sure you know the path to a domain directory where a domain database (wpdomain.db) is

located or the IP address of a server where the MTA is running.

Change to the GroupWise agent bin directory.

cd /opt/novell/groupwise/agents/bin
Use one of the following commands to start the Monitor Agent:

./gwmon --home /domain directory &
./gwmon --ipa IP address --ipp port number &

The --home startup switch specifies a domain directory where the Monitor Agent can access a
domain database.

The --ipa startup switch specifies the IP address of a server where an MTA is running, which is
another way for the Monitor Agent to obtain information from a domain database. The --ipp
startup switch specifies the port number of the MTA’s HTTP port on which the Monitor Agent
communicates with the MTA.

The ampersand (&) causes the Monitor Agent to run in the background, so that the terminal
window you started it in is again available for use.

To remind yourself of these commands when you are at your Linux server, view the gwmon
man page.

The Monitor Agent does not have a --show switch. The Monitor log file (mmddmon . nnn) for status
messages is located in the /var/log/novell/groupwise/gwmon directory. The log file name
includes the month and day when it was created, along with an incrementing extension to
accommodate multiple log files on the same day.

IMPORTANT: You can also start the Monitor Agent by using its startup script (/etc/init.d/
grpwise-ma), as described in the grpwise-ma man page or you can use rcgrpwise-ma to start
the Monitor Agent in any directory.

If the Monitor Agent does not start successfully, see “Starting the Linux Agents as Daemons” on
page 188.

(Conditional) If you use a proxy service, follow the instructions in “Configuring Proxy Service
Support for the Monitor Web Console” in “Monitor” in the GroupWise 2012 Administration Guide.

After the Monitor Agent starts successfully, refer to the following sections in Chapter 8,
“Installing GroupWise Agents,” on page 175 for additional information about managing the
Monitor Agent on Linux:

¢ “Starting the Linux Agents on System Startup” on page 189

¢ “Configuring the Monitor Agent to Communicate with the GroupWise High Availability
Service” on page 199

¢ “Stopping the Linux GroupWise Agents” on page 190
¢ “Uninstalling the Linux GroupWise Agents” on page 201

For instructions on using the Monitor Web consoles, skip to Section 7.5, “Testing GroupWise
Monitor,” on page 169.
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7.4.2  Windows: Setting Up GroupWise Monitor

¢ “Preparing the Windows Server for GroupWise Monitor” on page 165
¢ “Installing the Windows GroupWise Monitor Software” on page 165

Preparing the Windows Server for GroupWise Monitor

1 Make sure that the Windows server where you plan to install Monitor meets the system
requirements listed in Section 7.2, “Monitor System Requirements,” on page 154.

2 Make sure that the Web server where you are installing the Monitor Application meets the
system requirements listed in Section 7.2.2, “Web Server Requirements,” on page 155.

3 Make sure that the Windows server has a static IP address.

4 Make sure no GroupWise agents are currently running on the Windows server where you plan
to install the Monitor Agent.

5 (Conditional) If you want to monitor non-HTTP-enabled agents (such as earlier versions of any
GroupWise agent), install the SNMP service for Windows.

This enables the Monitor Agent to use SNMP in addition to HTTP to communicate with
GroupWise agents.

For example, in Windows Server 2008:
5a In the Server Manager, right-click Features, then click Add Features.
5b Select SNMP Services, then click Next.
5¢ Click Install.

6 Continue with Installing the Windows GroupWise Monitor Software.

Installing the Windows GroupWise Monitor Software

1 Change to the root directory of the downloaded GroupWise 2012 software image.

or

If you have already copied the Monitor software to a software distribution directory, change to
that location

2 Run setup.exe.

3 (Conditional) If prompted, select the interface language for the Installation program, then click
OK.
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On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.

The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard x|
GroupWize
Grouphfize Spetem [nstallation

| Displaps important information you should read before installing Grouplafise

. Displaps a high-level checklist of system requirements and installation steps to guide
Wigw the Quick Start you through setting up your GroupiWise spstem

“iew the Installation Guide

Displaps overview and tazk information to help you plan, install, and maintain a basic
GroupWize spstem and all additional components.

Creates or updates a basic Grouphwise system, including Group'wise administration,
Install Graupiwise System the Past Office Agent, the Message Transfer Agent. and the Intemet Agent.

Install Maore Components

Installs or updates Group'wise ‘Web Access, Groupwise Monitor, the Calendar
Fublishing Host, and the Groupwise “Windows client

InistallShield < Back Mext » Cancel

4 Click Install More Components > Install Monitor.

i'-.\!" ‘GroupWis: x|
Welcome to the GroupWise Monitor
Installation Program

The InstalShield(R) Wizard will allow you to modify GroupWise
Monitor, To continue, dick MNext.

< Back I Next > I Cancel |

You can also start the Monitor Installation program by running:

/software image/admin/monitor/setup.exe
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5 Click Next to display the GroupWise Monitor Components page.

i".%“ ‘GroupWise Monitor

G pWise Monitor G its

By default, the Monitor Agent and the Monitor Application are installed together
on the same server,

] Web Browser Which component do you want to install on this server?

I v GroupWise Monitor Agent

B Veh Server Gathers and displays status information from GroupWise

[ --| -

= Monitor agents (MTA, POA and Internet Agent). Must be installed
S Application on Windows.

= !

B Monitor Agent ¥ Groupivise Monitor Application

I I I Communicates with the Web server and Monitor Agent to
display status information about Groupiise agents (MTA,
% % % POA and Internet Agent) in a Web browser. Must be
= = = installed on a Windows Web server running Microsoft
Other Internet Information Services (I15).
MTA Agents POA

Instalshield

Installation Guide | < Back I Next = I Cancel |

6 (Conditional) If you are installing the Monitor Agent, follow the prompts to provide the
information from your GroupWise Monitor Agent Installation Worksheet.

The Monitor Installation program provides diagrams that help you understand how the various
Monitor Agent components interact with each other. Review the diagrams as you provide the
requested information.

Server Information
System Options
Domain Directory

7 (Conditional) If you are installing the Monitor Application, follow the prompts to provide the
information from your GroupWise Monitor Application Installation Worksheet.

The Monitor Installation program provides diagrams that help you understand how the various
Monitor Application components interact with each other. Review the diagrams as you provide
the requested information.

Monitor Agent Information (This page does not appear when you install the Monitor Agent and
the Monitor Application together on the same server.)

Web Server Information

8 Review the Installation Summary, then click Install.

i-.‘% GroupWise Monitor

Installation Summary

If you want to review or change any settings, dick Back. Click Install to begin

copying files.

O Web Browser Installation summary:
I GroupWise Monitor Agent -
Web Serve:

E = r Version: 2012

B Monitor

D Application URL to GroupWise Monitor Agent: http:/f/172,15,518:82007

= t Server

E= Monitor Agent Installation Path: C:\Program Files (x86) Movell\GroupW

Network address: 172.15.5.18
Port number: 8200

Default language: English
EEE :
L3

‘Drma\rv

Other
MTA Agents POA
Instalishisld

Installation Guide < Back I Install I Cancel |
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9 (Conditional) If prompts appear because your Web server is running, select how you want to
stop your Web server.

10 When the installation is complete, click Finish to exit the Monitor Installation program.

il‘;‘- GroupWise Monitor 1'

Meonitor Installation Complete

The Monitor Installation program has successfully installed
GroupWise Monitor. Click Finish.

[¥ Launch installation summary
[¥ start the Groupiise Monitor Agent

[¥ Restart Web server

Novell.

< Back I Finish I Cancel |

You can choose to have the Monitor Installation program start the Monitor Agent and restart the
Web server for you.

The Monitor Agent is installed to the following directory:

c:\Program Files\Novell\GroupWise\Monitor

Along with the Monitor Application, the Monitor Installation program also installs Tomcat 6 to
c:\novell\tomcats, integrates it with your Web server, and automatically starts it to support
the Monitor Application.

11 Click Finish to exit the GroupWise Installation program.

If you chose to start the Monitor Agent immediately, the Monitor Agent server console displays
on the Windows server.

1=
Configuration View Actons Reports Log Help
[0.9] Statuz Statuz Duration | Mame | Type | Up Time | Closed Links | Queved | Platform

¥ Nomal 0d22h19m Development. Proval FOA 1d3h¥m MG Mda Linues
¥ Momal 0d22h19m Gl Provol GEwla 1d3h?m Mih Mda Lirus
¥ Nomal 0d22h19m Gl Provo? Gwila  0d22h19m MNiA M2 Windows
¥ Momal 0d19h59m GWwA Provod GEwla 0d20h1m  MéA Méa Lirues
o Nomal 0d22h19m Proval [GAEY 1d3h?m o Linues
¥ Momal 0d22h19m Provo2 MTa 0d22h21m 0 windows
¥ Momal 0d19h59m Proval MTA 0d20h1m D0 Line
¥ Momal 0d19h53m Research.Provo3 FOA 0d20h1m M Mda Lirues
% Momal 0d22h19m Sales.Provoz FOA 0d22h20m M Mda windows
2l 1]

|Next Poll: 121 seconds | |H'I'I'P: 8200 ‘Agenis: 9

If the Monitor Agent does not start successfully, see “Starting the Windows GroupWise Agents”
on page 205

12 (Conditional) If you use a proxy service, follow the instructions in “Configuring Proxy Service
Support for the Monitor Web Console” in “Monitor” in the GroupWise 2012 Administration Guide.

13 Continue with Testing GroupWise Monitor.
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7.5

7.5.1

71.5.2

Testing GroupWise Monitor

You can use GroupWise Monitor in various environments:

¢ Section 7.5.1, “Monitor Agent Server Console on a Windows Server,” on page 169

¢ Section 7.5.2, “Monitor Web Consoles in Your Web Browser,” on page 169

Monitor Agent Server Console on a Windows Server

To start the Monitor Agent on a Windows server and display the Monitor Agent server console, click
Start > All Programs > GroupWise Monitor > GroupWise Monitor. The Monitor Agent server console
appears.

Dl
Configuration View Actions Reports Log Help
[0.9] Status I Status Duration I Marne | Type | Up Time | Clased Links | GQusued | Platfarm

¥ Nomal 0d22h19m Development. Praval POA 1d3h7?m MAA Md Linus
¥ Nomal 0d22h19m Gl Proval Gwls  1d3h7m M2 Mh, Lirx
¥ Nomal 0d22h19m GWlA. Prowvo2 GWwWla  0d22h19m MN/A MAh Windaws
7 Nomal  0d19h53m G4, Prova3 Gwla  0d20him  N/A NA& Linuz
¥ Nomal 0d22h19m Proval MTA 1d3h7?m 0 Lirx
¥ Nomal 0d22h19m Provo2 MTA 0d22h2Tm 0O Windaws
¥ Nomal 0d19h59m Prowo3 MTA 0d20k1m 0O Linus
¥ Nomal 0d19h59m Research.Provald POA 0d20h1m M Mih Linus
¥ Nomal 0d22h19m Sales Provo2 POA O0d22h20m M/A Mh, ‘Windaws
< |

|Next Poll: 121 seconds ‘ | |H'I'I'P: 8200 Agents: 9

At the Monitor Agent server console, you can perform many activities, for example:

¢ Use items on the Configuration menu to configure the Monitor Agent as needed.

¢ Use items on the View menu to choose how much and what kind of agent status information to
display.

¢ Create agent groups in order to monitor related agents together.

¢ Use items on the Reports menu to check the status of links throughout your GroupWise system
and to organize status information into a format that can be emailed or printed.

¢ Use items on the Actions menu to control agent polling.

For more information about using the Monitor Agent server console, see “Monitor” in the GroupWise
2012 Administration Guide.

Monitor Web Consoles in Your Web Browser

Monitor has two different Web consoles. The Monitor Web console uses the capabilities of your Web
server to provide access from outside your firewall. The Monitor Agent Web console is provided by
the Monitor Agent itself and provides additional functionality beyond that which is available from
outside your firewall.

¢ “Monitor Web Console” on page 170

¢ “Monitor Agent Web Console” on page 170
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Monitor Web Console

To display agent status information in your Web browser from outside your firewall, enter the
Monitor Web console URL in your Web browser:

http://network address/gwmon/gwmonitor

Replace network_address with the IP address or DNS hostname of the server where your Web server
runs. The Monitor Web console appears.

GroupWises Monitor

Search Novell
- 89 Corporate Monitored agents for "Corporate” group -
@ OES Agents Total: 9 Displayed: 1-9
9/ SLES Agents Refresh [ Hide Subgroup Agents | [ Problem |[ Suspend |[ Resume ][ Weove ][ Options || Thresholds |[ Help |
<@ windows Agents
1] Name Status Status Duration Up Time Type Version Platform
Ciiie O @ Provel Mormal 0d22h23m 1d3h7m MTA 1200 (12/03/2011)  Linux
Rename | (@ DevelopmentProvol Mommal 0d22h23m 1d3h7m POA 12.0.0 (12/03/2011) Linux
::: |:| @ GWIA Provol Momal 0d22h23m 1d3h7m GWIA 12.0.0 (12/03/2011) Linux
Refresh [ @ Proves Normal 0d20h3m 0d20h1m MTA 12.0.0 (12/03/2011) Linux
telp [0 @ GwiAProves Mormal 0d20h3m 0d20h1m  GWA 1200 (12/03/2011)  Linux
O (@ ResearchProvo3 Nommal 0d20h3m 0d20h1m POA 1200 (12/03/2011) Linux
O @ Provoz Mormal 0d22h23m 0d22h21m MTA 1200 (12/3/2011) Windows
D @ GWIA Provo2 Nomal 0d22h23m 0d22h19m GWIA 1200 (12-03-11) Windows
[0 @ salesProvo2 Momal 0d22h23m 0d22h20m POA 12.0.0({12/3/2017) Windows

You can use this same URL to view the same agent status information in various browsers and
mobile devices.

You can perform many of the same monitoring activities at the Monitor Web console as you can at the
Monitor Agent server console. Refer to the online help in the Monitor Web console for additional
information about each Monitor Web console page.

For more information about using the Monitor Web console, see “Monitor” in the GroupWise 2012
Administration Guide.

Monitor Agent Web Console

To display agent status information in your Web browser from inside your firewall, enter the Monitor
Agent Web console URL in your Web browser:

http://network address:8200
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Status | Preferences | Link Trace | Link Configuration | Reports | Log | Map

@ "’Corgorate Monitored agents for Corporate
¥ OES Agents [3] Up Time: 0d 22h 27 m
¥ SLES Agents [3] [Pat |[rie= Agents |[ Problem |[ Suspend |[ Resume || Move | [ Optons |[ T
¥ windows Agents [3] 5 - - -
[~ status Status Duration Mame Type Up Time Closed Links Queued Platform Version
[T ¢ jgrmel 09220127 m Development.Provol POA 1d3h12m A MA  Linux  12.0.0 (1202/2011)
Create
T W orme 0922027 m  GWIA Frovel GWIA 1d3h12m WA MA  Linux  12.0.0 (1203/2011)
Rename ——
Move T W yorme 0922027 m  GWIA Proved GWIA 0d2Zh2dm A MA  Windows 12.0.0 {12-02-11)
2=z [T ¢ jorma) 09200 7m  GWIA Proved GWIA Dd20hEm A MA  Linux  12.0.0 {12032011)
M ¥ orme 0922027 m  Provel MTA 1d3hi1Zm o o Linux  12.0.0 (12/03/2011)
v Mormal 0d22h37m  ProvoZ MTA 0d22h26m (] (] Windows 12.0.0 {12/3/2011)
[T % jorme) 04200 7m  Froved MTA 0d20hEm o o Linux  12.0.0 (12/03/2011)
[T ¢ jormal 09200 7m  Resesrch Provod POA Dd20hBm A MA  Linux  12.0.0 (1203/2011)
T ¥ yorme 0022027 m  Sales Proves FOA 0dZZh25m A WA Windows 12.0.0 [12/3/2011)

For instructions on protecting the Monitor Agent Web console with a password, see “Configuring
Authentication and Intruder Lockout for the Monitor Web Console” in “Monitor” in the GroupWise
2012 Administration Guide.

7.6 GroupWise Monitor Installation Worksheets

¢ Section 7.6.1, “GroupWise Monitor Agent Installation Worksheet,” on page 171
¢ Section 7.6.2, “GroupWise Monitor Application Installation Worksheet,” on page 172

7.6.1  GroupWise Monitor Agent Installation Worksheet

Installation Program Field Value for Your GroupWise Explanation

System
Monitor Component: Section 7.1, “GroupWise
Monitor Overview,” on
* GroupWise Monitor page 151
Agent
Agent Software Platform: Section 7.3.2, “Deciding
) Where to Install the
¢ Linux GroupWise Monitor
+ Windows Components,” on page 157
Server Information: Section 7.3.2, “Deciding
. Where to Install the
¢ |Installation path GroupWise Monitor
+ Network address Components,” on page 157
* |P address “Monitor Agent Network

Address” on page 159
* DNS hostname

¢ TCP port
(default 8200)

Installing GroupWise Monitor 171



Installation Program Field Value for Your GroupWise Explanation

System
System Options: “Systems to Monitor” on
page 159
+ GroupWise
+ Novell Messenger
Domain Directory: “Domain Directory Path” on
page 159

7.6.2 GroupWise Monitor Application Installation Worksheet

Installation Program Field Value for Your GroupWise Explanation

System
Monitor Components: Section 7.1, “GroupWise
Monitor Overview,” on
* GroupWise Monitor page 151
Application
Web Server Platform Section 7.1, “GroupWise
) Monitor Overview,” on
¢ Linux page 151
+ Windows
Agent Information: “Monitor Agent Network
Address” on page 159
* |P address
¢ DNS hostname
¢ TCP port
(default 8200)
Web Server Information: Section 7.3.2, “Deciding
Where to Install the
OES 11 GroupWise Monitor

+ Apache path Components,” on page 157

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat6/webapps
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Installation Program Field Value for Your GroupWise Explanation

System

Web Server Information:

OES 2
* Apache path

/etc/opt/novell/
httpd/conf.d
+ Tomcat path

/var/opt/novell/
tomcat5/webapps

Section 7.3.2, “Deciding
Where to Install the
GroupWise Monitor
Components,” on page 157

Web Server Information:

SLES 11
* Apache path
/etc/apache2/
conf.d
+ Tomcat path

/usr/share/
tomcat6/webapps

Section 7.3.2, “Deciding
Where to Install the
GroupWise Monitor
Components,” on page 157

Web Server Information:

SLES 10
* Apache path
/etc/apache2/
conf.d
+ Tomcat path

/srv/www/
tomcat5/base/
webapps

Section 7.3.2, “Deciding
Where to Install the
GroupWise Monitor
Components,” on page 157

Web Server Information:
Windows

* Microsoft Internet
Information Server
(IIS) for Windows

¢ Path to the Web
server’s root directory

* Web site

Section 7.3.2, “Deciding
Where to Install the
GroupWise Monitor
Components,” on page 157
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8.1

Installing GroupWise Agents

Novell GroupWise agents are first installed and started as part of installing a basic GroupWise
system, as described in Chapter 3, “Installing a Basic GroupWise System,” on page 29. The following
sections help you install additional agents as you create new domains and post offices in your
growing GroupWise system.

¢ Section 8.1, “GroupWise Agent Overview,” on page 175

¢ Section 8.2, “Agent System Requirements,” on page 176

¢ Section 8.3, “Planning the GroupWise Agents,” on page 178

¢ Section 8.4, “Setting Up the GroupWise Agents,” on page 182

¢ Section 8.5, “What’s Next,” on page 208

¢ Section 8.6, “GroupWise Agent Installation Worksheet,” on page 208

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the
GroupWise 2012 Interoperability Guide before you install the agents.

GroupWise Agent Overview

Each time you create a new post office, you must set up at least one Post Office Agent (POA) for it.
Some of the POA’s tasks in the post office include:

¢ Connecting GroupWise clients to mailboxes through network connections (TCP/IP, IMAP,
SOAP)

¢ Sending messages to other users and delivering incoming messages into mailboxes

¢ Indexing messages and documents to support the Find feature in the GroupWise clients

By default, the POA uses its internal Document Converter Agent (DCA) to convert document
files into HTML format for indexing. You can also configure the POA to use the Document
Viewer Agent to perform the HTML conversion, as described in “Enabling the Document
Viewer Agent (DVA) for Indexing” in “Post Office Agent” in the GroupWise 2012 Administration
Guide. The DVA provides improved scalability and reliability for document conversion,
compared to the default DCA configuration.

¢ Managing disk space usage in the post office and controlling the size of messages that users are
allowed to send and receive

Each time you create a new domain, you must set up a Message Transfer Agent (MTA) for it. Some of
the MTA's tasks in the domain include:
+ Routing user messages between post offices and domains

¢ Routing administration messages throughout the GroupWise system so that databases are kept
in sync

¢ Synchronizing GroupWise user information with Novell eDirectory user information

Installing GroupWise Agents 175



The POA requires direct access to the post office directory so that it can write to the post office
database. The MTA requires direct access to the domain directory so that it can write to the domain
database.

The Document Viewer Agent (DVA) is installed along with the POA and MTA. It does not need
access to any databases because it communicates with the POA and with the WebAccess Application
using TCP/IP. It can also be installed on a separate server, where no domain or post office is located.

. g Message Transfer
Ch =
Domain \._‘ — J ) Agent
=y
F 3

v

Post Office | — Post Office
with Library = ﬁ Agent

r 3
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‘ ‘ n Users

8.2 Agent System Requirements

¢ Section 8.2.1, “Hardware and Operating System Requirements,” on page 176
¢ Section 8.2.2, “Software Requirements,” on page 177

¢ Section 8.2.3, “Agent Memory Requirements,” on page 177

8.2.1 Hardware and Operating System Requirements

The network server where you install the agents must meet the following requirements:
(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
[ Any of the following server operating systems for the GroupWise agents:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support
Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System and Open Motif are required by the GUI agent server console. By
default, the agents run as daemons without a user interface.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, or Windows Server 2012, plus the latest Service Pack

[ Adequate server memory as required by the operating system

Depending on the anticipated load on the agents, additional memory might be required, as
detailed in Section 8.2.3, “Agent Memory Requirements,” on page 177.
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8.2.2

8.2.3

[ Adequate server disk space:

¢ Approximately 117 MB for the MTA, POA, and DVA software (varies by platform)

¢ Adequate disk space for the document quarantine used by the DVA, as described in
“Enabling the DVA Document Quarantine” in “Document Viewer Agent” in the GroupWise

2012 Administration Guide.

Software Requirements

03 Any of the following environments for running the GroupWise Installation program:

¢ Novell Open Enterprise Server (OES) 2 (Linux version) or OES 11, plus the latest Support

Pack

¢ SUSE Linux Enterprise Server (SLES) 10 or SLES 11, plus the latest Service Pack

The X Window System is required by the GUI GroupWise Installation program that steps
you through the process of creating a new GroupWise system. A text-based Installation
program is also available for installing individual GroupWise components on servers

where the X Windows System is not available.

* Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows Server
2008 R2, Windows Server 2012, Windows Server 2012 R2, plus the latest Service Pack, plus

the latest Novell Client.

Agent Memory Requirements

¢ “Sample POA Memory Requirements Based on Post Office Size” on page 177

¢ “Sample Memory Requirements for Other GroupWise Agents and Applications” on page 178

Sample POA Memory Requirements Based on Post Office Size

The amount of memory used by the POA depends on the number of active users, as illustrated by the

table below:

Minimum Recommended Memory for

Concurrent Users Memory Best Performance
Required

100 active users (100-250 users in post office) 400 MB 2GB

250 active users (250-500 users in post office) 600 MB 4GB

500 active users (500-1000 users in post office) 800 MB 4GB

1000 active users (1000 - 1500 users in post office) 1GB 8GB-12GB

1500 active users (1500 - 3000 users in post office) 2GB 12 GB

The POA typically performs best with abundant cache memory available.
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Sample Memory Requirements for Other GroupWise Agents and Applications

Minimum Recommended Memory for

Agent/Application Memory Best Performance
Required

Routing MTA 200 MB 2GB

DVA 100 MB 1GB

GWIA and its MTA 400 MB 4GB

Monitor 100 MB 1GB

WebAccess Application 400 MB 4GB

Calendar Publishing Host Application 200 MB 1GB

WebAccess and Calendar Publishing Host Applications 600 MB 4GB

together

8.3 Planning the GroupWise Agents

Use the “GroupWise Agent Installation Worksheet” on page 208 to record your decisions about how
to install the GroupWise agents. The topics in this section present the required information in a
convenient planning sequence. The Installation Worksheet organizes the information in the order in
which you need it during installation.

¢ Section 8.3.1, “Selecting the Agent Platform,” on page 178

¢ Section 8.3.2, “Selecting the Agent Installation Directory,” on page 179

¢ Section 8.3.3, “Gathering Domain and Post Office Information,” on page 179

¢ Section 8.3.4, “Linux Installation Options: Automatic Startup, Document Viewer Agent
Configuration, and Clustering,” on page 179

¢ Section 8.3.5, “Windows Installation Options: SNMP Traps and Service versus Application,” on
page 180

For additional assistance in planning your GroupWise installation, visit the GroupWise Best Practices
(http://wiki.novell.com/index.php/GroupWise).

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, refer to
the GroupWise 2012 Interoperability Guide as you plan your agent installation.

8.3.1 Selecting the Agent Platform

The MTA, POA, and DVA are available as Linux executables and Windows executables.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Agent Software Platform, mark whether you plan to install the agents on Linux or Windows. Review
Section 8.2, “Agent System Requirements,” on page 176 to ensure that the specific server you have selected
meets the listed requirements.
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8.3.2

8.3.3

8.3.4

Selecting the Agent Installation Directory

The agent installation directory depends on the platform where you are installing the agents.
Consider these platform-specific guidelines:
Linux: The Linux agents are automatically installed to /opt /novell/groupwise/agents.

Windows: The default installation directory is c: \Program Files\Novell\GroupWise
Server\Agents. However, you can install the agents to any directory you want.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Installation Path, record the directory where you want to install the GroupWise agent software.

The MTA, the POA, and the DVA are installed to the specified directory.

Gathering Domain and Post Office Information

Record the following information about the domain and post office for which you are installing and
setting up the GroupWise agents:

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Domain Information, record the domain name and path to the domain directory for the new domain.

Under Post Office Information, record the post office name and path to the post office directory for the new post
office.

The domain and post office must exist before you install the agents for them. If necessary, create the
domain and post office that you are installing the agents for now. See following sections of the
GroupWise 2012 Administration Guide for instructions:

¢ “Creating a New Domain”

¢ “Creating a New Post Office”

Linux Installation Options: Automatic Startup, Document Viewer Agent
Configuration, and Clustering

When you install the Linux GroupWise agents, the following options specific to Linux are available
in the Installation program:

¢ “Automatic Startup” on page 179
¢ “Enable Document Viewer Agent” on page 180

¢ “Clustering on Linux” on page 180

Automatic Startup

The Linux GroupWise agents are Run Control compliant. You can have the Installation program
create symbolic links to the /etc/init.d/grpwise script in the re3.d and rc5. d directories so that
the agents load on restart into run level 3 or 5, depending on the configuration of your Linux system.
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8.3.5

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Agent Options, mark whether or not you want to configure the Linux server to start the GroupWise
agents automatically.

Enable Document Viewer Agent

The Document Viewer Agent is configured for high availability independently from the POA and the
MTA.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Agent Options, mark whether or not you want to configure the Linux Document Viewer gent to start
automatically.

For more information, see “Enabling the GroupWise High Availability Service for the Linux
GroupWise Agents” on page 195.

Clustering on Linux

On Linux, you can install the GroupWise agents on Novell Cluster Services. The Linux GroupWise
Installation program provides a Configure GroupWise for Clustering option that simplifies the process
of installing the Linux GroupWise agents on multiple nodes in the cluster.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Agent Options, mark whether you want to configure the Linux GroupWise agents for clustering using
Novell Cluster Services. If you do, follow the installation instructions provided in “Setting Up a Domain and a
Post Office in a Linux Cluster” in “Novell Cluster Services on Linux” in the GroupWise 2012 Interoperability
Guide, rather than the installation instructions in this guide.

Windows Installation Options: SNMP Traps and Service versus
Application

When you install the Windows agents, you have choices about how the agents interact with the
Windows operating system.

¢ “SNMP Traps” on page 180

¢ “Service versus Application” on page 181

SNMP Traps

If you want to use an SNMP manager program to monitor the agents, you must install some SNMP
components along with the Windows agent software.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Agent Options, mark Install and Configure SNMP for GroupWise Agents if you want to use an SNMP
manager program.
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If this option is dimmed during installation, the SNMP service has not been enabled on the Windows
server where you are installing the agents. If you want to monitor the agents from an SNMP
management program, the SNMP service must be enabled so you can select this option. For
instructions, see the following sections in the GroupWise 2012 Administration Guide:

+ “Setting Up SNMP Services for the POA”
+ “Setting Up SNMP Services for the MTA”

NOTE: The Linux agents rely on operating system components for SNMP functionality and do not
require this installation option.

Service versus Application

You can run the Windows MTA, POA, and DVA as Windows services or applications.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Windows Installation Options, mark whether you want to run the GroupWise agents as Windows
services.

When you run the agents as Windows services, they must run under a specific user account. The
user account you use depends on where the domain and post office directories are located:

¢ When the domain and post office directories are located on the same server where you are
installing the agents, the agents can run under the local system account and no password is
required.

When the agents run under the local system account, you can enable them to display the agent
server consoles on the server desktop on Windows Server 2003. This interaction with the
desktop is not available on Windows Server 2008 or later Windows versions.

¢ When the domain and post office directories are located on a remote Windows server, you must
specify a user with rights to access the domain and post office directories, along with the user’s
associated password.

¢ For the DVA, the user account depends on the location of the DVA home directory, as described
in “Setting the DVA Home Directory” in “Document Viewer Agent” in the GroupWise 2012
Administration Guide.

IMPORTANT: For simplicity of agent administration, running the GroupWise agents as the
Windows Administrator user is highly recommended.

As with all Windows services, you can start the agents manually or have them start automatically
each time the Windows server restarts.

GROUPWISE AGENT INSTALLATION WORKSHEET

Under Windows Service Information, record the Windows user account that the agent services will run under,
and if necessary, the password for the account. If you are using the local system account, indicate whether you
want to allow the agent services to interact with the desktop to display the agent server consoles. Select
whether you want the agent services to start automatically or manually.
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8.4

8.4.1

8.4.2

Setting Up the GroupWise Agents

After creating a new domain or post office, you need to configure the Agent object (MTA or POA)
that was automatically created with it, then follow the setup instructions for the platform where you
are installing the GroupWise agents:

¢ Section 8.4.1, “Configuring New Agent Objects in eDirectory,” on page 182

¢ Section 8.4.2, “Linux: Setting Up the GroupWise Agents,” on page 182

¢ Section 8.4.3, “Windows: Setting Up the GroupWise Agents,” on page 201

Configuring New Agent Objects in eDirectory

When you create new post offices and domains, Agent objects are automatically created for them.
Most agent configuration can be done after installation, but a few settings should be established
before you install the agent software.

1 In ConsoleOne, browse to and expand the eDirectory container where the new post office or
domain is located to display its contents.
2 Select the Post Office object or Domain object to display its contents.

3 Right-click the Agent object, then click Properties to display the agent Identification page.

N

In the Description field, type a brief description of the agent for display at the agent server
console.

In the Platform field, select Linux or Windows.
Click OK to save the new Agent object properties.

Repeat these steps for each new post office and domain for which you are installing agents.

o N o o

Continue with the installation instructions for the platform where you are installing the
GroupWise agents.

¢ Section 8.4.2, “Linux: Setting Up the GroupWise Agents,” on page 182
¢ Section 8.4.3, “Windows: Setting Up the GroupWise Agents,” on page 201

Linux: Setting Up the GroupWise Agents

¢ “Preparing the Linux Server for the GroupWise Agents” on page 183
¢ “Installing the Linux GroupWise Agents” on page 183

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the
GroupWise 2012 Interoperability Guide before you install the agents.

Refer to the following additional tasks as you maintain all the GroupWise agents on Linux:

¢ “Starting the Linux GroupWise Agents” on page 186
¢ “Running the Linux GroupWise Agents as a Non-root User” on page 192

¢ “Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195

¢ “Stopping the Linux GroupWise Agents” on page 190
¢ “Uninstalling the Linux GroupWise Agents” on page 201
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If you are new to Linux, you might want to review “Linux Commands, Directories, and Files for
GroupWise Administration” in the GroupWise 2012 Administration Guide before you install the
GroupWise agents on Linux.

Preparing the Linux Server for the GroupWise Agents

1 Ensure that the Linux server where you are installing the GroupWise agents meets the system
requirements listed in Section 8.2, “Agent System Requirements,” on page 176.

2 Ensure that the Linux operating system media is available, in case the GroupWise Installation
program needs to install supporting packages on the Linux server.

3 Ensure that the Linux server has a static IP address.

4 Ensure that the firewall on the Linux server has the ports open that are used by the MTA, the
POA, and the DVA.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

5 Continue with Installing the Linux GroupWise Agents.

Installing the Linux GroupWise Agents

¢ “Running the GUI GroupWise Installation Program” on page 183
¢ “Installing GroupWise Components Using the Text-Based Installation Program” on page 185

Running the GUI GroupWise Installation Program
1 In a terminal window on the server where you want to install the GroupWise agents, log in as
root, then provide the root password.
2 Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the agent software to a software distribution directory, change to /
opt/novell/groupwise/software.

3 Run ./install.

The X Window System is required for running the GUI GroupWise Installation program. If you
are not using the X Window System, you can install GroupWise components individually, as
described in “Installing GroupWise Components Using the Text-Based Installation Program” on
page 185.

4 Select the language in which you want to run the GroupWise Installation program, then click
OK.
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The main GroupWise System Installation page appears.

il GroupWise i

Novell. GroupWise

View the Readme Displays a web page with important information you should read
before installing.

View the Quick Start Displays a high-level checklist of system requirements and installation
steps to guide vou through setting up your Group\ise system.

View the Installation Guide Displays overview and task information that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupWise WebAccess and GroupWise Intemet

Agent.

Create or update a GroupWise system Launches the Group¥ise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or
the updating of an existing GroupWise system.

Install Products Displays the GroupWise components you can individually install once
you've created a GroupWise system.

5 Click Install Products > GroupWise Agents > Install Agents to install the GroupWise agent software.
6 When the installation is complete, click OK.

The GroupWise agent software is installed to the following directory:

/opt/novell /groupwise/agents

7 Click Configure GroupWise Agents.

N GroupWise Agents Configuration x|
Introduction

[ ntroduction Welcome to the Group'Wise Agent Configuration Program. The

0 fallowing agent software will be configured:

O hessage Transfer Agent(MTA): Routes messages hetween
damains, post offices, and

O gateways.

O Post Office Agent(POa) Delivers messages to

users' mailboxes.

Document Yiewer AgentiDyva): Processes attachments for
use with Web Access.

Cancel | Next

8 Follow the prompts to provide Linux Agent information from your GroupWise Agent
Installation Worksheet.

Domain Information
Post Office Information
Document Viewer Agent Information
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|‘.‘_’ GroupWise Agents Configuration »

[ introduction GroupWise Agent Configuration is complete.

] License Agreement B Launch GroupWise Agents an system startup
[¥] Domains/Post Offices
[¥] Document Viewer Agent

[¥] Configuration Complete

Exit

On the Configuration Complete page, Launch GroupWise Agents on System Startup is selected by
default.

IMPORTANT: If you want to configure the agents for high availability, as described in
“Enabling the GroupWise High Availability Service for the Linux GroupWise Agents” on
page 195, they must be configured to start automatically on system startup.

9 (Conditional) If you do not want the agents to start automatically when the server restarts,
deselect Launch GroupWise Agents on System Startup.

10 Click Exit to exit the GroupWise Agent Installation program.
11 Exit the GroupWise Installation program.
12 Skip to “Starting the Linux GroupWise Agents” on page 186.

Installing GroupWise Components Using the Text-Based Installation Program

If you want to install any of the GroupWise agents or applications on a server where the X Window
System is not running, you can use the text-based GroupWise Installation program. The server must
have openmotif-1libs installed. You must still use ConsoleOne to create the associated domain or
post office before you can install and configure the agent or application software.
1 Run install from the root of the downloaded GroupWise 2012 software image.
or

If you have already copied the software to a software distribution directory, run . /install from
the root of the software distribution directory to start the GroupWise Installation program.

If you need to perform the installation from a remote location, you can use ssh to access the
remote Linux server. Copy the 1inux subdirectory of the downloaded GroupWise 2012 software
image to the server where you want to install the agent software, then run the text-based
GroupWise Installation program to install the agents or applications on the Linux server.

2 Enter the number of the language you want to use for the installation.
3 Enter y if you want to configure the GroupWise components for clustering.
or
Enter n if you are not installing the GroupWise components in a cluster.
4 Enter the number of the language you want to use for reading the License Agreement.

5 Press any key to scroll through the License Agreement, then enter y to accept the License
Agreement.
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6 In the list of components, enter the number for the GroupWise component that you want to
install.

1. GroupWise Agents

2. GroupWise WebAccess

3. GroupWise Monitor

4. GroupWise Internet Agent

5. GroupWise Calendar Publishing Host
6. View the Readme
0.1 Exit

7 In the list of actions, enter 1 to install the agent or application software.

1. Install GroupWise Agents
2. Configure GroupWise Agents
0. Return

A status bar indicates progress.
8 When the installation is complete, enter y to configure the component.
9 Follow the prompts to provide the configuration information, then press any key to exit.
In the text-based Installation program, you can press Ctrl+C to return to the previous menu.

10 (Optional) To install additional components, start the text-based Installation program again.

NOTE: The text-based GroupWise Installation program does not run on all Windows versions of
ssh. An open source product named PuTTY that can be downloaded from the Internet free of charge
is compatible with the text-based GroupWise Installation program. There are several Web sites where
PuTTY is available for download.

Starting the Linux GroupWise Agents

¢ “Starting the Linux Agents with a User Interface” on page 186
¢ “Starting the Linux Agents as Daemons” on page 188

¢ “Starting the Linux Agents on System Startup” on page 189

¢ “Restarting the Linux Agents Automatically” on page 190

Starting the Linux Agents with a User Interface

1 In a terminal window, become root by entering su - and the root password.
2 Change to the GroupWise agent bin directory.
cd /opt/novell/groupwise/agents/bin
3 Enter one of the following commands to start the MTA:
Syntax:

./gwmta --show --home domain directory &
./gwmta --show @domain.mta &

Example:

./gwmta --show --home /gwsystem/domlnx &
./gwmta --show @provo.mta &

The --show startup switch starts the MTA with a server console interface similar to that provided
for the Windows MTA. This user interface requires that the X Window System and Open Motif
be running on the Linux server.

The --home startup switch specifies the domain directory and is required to start the MTA.
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The @domain.mta startup switch specifies the MTA startup file, which contains the --home
startup switch. The MTA startup file is named after the domain that the MTA services. The
Installation program created the MTA startup file in the /opt /novell/groupwise/agents/
share directory. Because the Installation program prompted you for the domain directory, it set
the --home switch for you in the startup file.

The ampersand (&) causes the MTA to run in the background, so that the terminal window you
started it in is again available for use.

To remind yourself of these commands when you are at your Linux server, view the gwmta man
page.

File Configuration Log Help
Tublinl Up Tine: 0 Days 0 Hrs 1 Hins
Groupllise Message Transfer Agent

Status Statistics
Processing * Total 10 Hinutes

Total Closed | Routed 0 0
Domains 1 0| Undeliverable 0 0
Post Offices 1 0| Errors 0 0
Gateways 2 0

I<10./12/07 0B:13:45> DIS: MTA configuration loaded

The status messages displayed on the MTA server console are also written to the MTA log file
(mmddmta.nnn) in the /var/log/novell/groupwise/domain.mta directory. The log file name
includes the month and day when it was created, along with an incrementing extension to
accommodate multiple log files on the same day.

In ConsoleOne, you can see that the MTA has updated the domain database because the Version
field on the Identification page of the Domain object shows 12 when the database update is
complete.

Wait until the domain database has been updated before you start the POA.
5 Use the following command to start the POA:

Syntax:

./gwpoa --show --home post office directory &
./gwpoa --show @post office.poa &

Example:

./gwpoa --show --home /gwsystem/polnx &
./gwpoa --show @research.poa &

The --home startup switch specifies the post office directory and is required to start the POA.

The @post_office.poa startup switch specifies the POA startup file, which contains the --home
startup switch. The POA startup file is named after the post office that the POA services. The
Installation program created the POA startup file in the /opt /novell/groupwise/agents/
share directory. Because the Installation program prompted you for the post office directory, it
set the --home switch for you in the startup file.
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To remind yourself of these commands when you are at your Linux server, view the gwpoa man

page.

= Localization.Dublin - GroupWise POA _Ox

File Configuration Log Statistics  Actions Help

Localization.Jublinl

Up Timez O Days O Hrs 1 Hins
Groupllize Post Office Agent

Status Statistics

Processing * Busy: 0 : 0 C/S Requests: 0 Total Messages: 4
llser Conmections: 0 | Requests Pending: 0 Undeliverables 0
File Queues: o | User Timed Out: 0 Problem Messages: [

03121158 936 Action Set #1 ¢ Default Mailbox/Library Structure Check

Type of Database Files to Check: User Msg Doc

Database Check Actioni Analuyze/Fixup

Level of Database Analysiz and Yerification: Structural

Delete Temporaru/Backup Files Older than {daws): 7

Event. #2 : Default Weekly Haintenance Event

Days to Perform Action(s): Sa

Time to Perform Action(s): 3:00am

Action Set #1 3 Default Mailbox/Library Structure and Content Check
Type of Database Files to Check: User Mg Doc

Database Check Action: Analuze/Fixup

Lewel of Database Analysis and Yerification: Structural/Contents
Generate Database Check Statistics

Delete Temporary<Backup Files Older than (days): 7

Action Set #2 ¢ Default Audit Report

Database Check ActioniUnknoun

Distribute Database Check Log to Administrator

472 Initializing dizpatcher
088 Initializing dispatcher
:21:58 624 MTP: Listening for inbound connections

The status messages displayed on the POA server console are also written to the POA log file
(mmddpoa . nnn) in the /var/log/novell/groupwise/post office.poa directory. The log file
name includes the month and day when it was created, along with an incrementing extension to
accommodate multiple log files on the same day. The POA also maintains a symbolic link to a
file named poa.currentlog, where poa is the name of the POA eDirectory object. This link
points to the current POA log file, regardless of the date and incrementing extension of the

actual POA log file name. This facilitates monitoring the current POA log file using the tail
command.

In ConsoleOne, you can see that the POA has updated the post office database because the

Version field on the Identification page of the Post Office object shows 12 when the database
update is complete.

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent
Problems” in GroupWise 2012 Troubleshooting 2: Solutions to Common Problems for assistance.

After the post office database has been updated, users can connect to the post office using the
Windows client or GroupWise WebAccess.

When you start the Linux agents with a user interface, you can use the agent server consoles
described in the following sections in the GroupWise 2012 Administration Guide.

¢ “Using the POA Server Console”
¢ “Using the MTA Server Console”

Starting the Linux Agents as Daemons

All of the Linux GroupWise agents except the Monitor Agent can be started as daemons by using the

grpwise script. By default, the grpwise script starts the agents without a user interface.

The Monitor Agent uses its own customized grpwise-ma script that works essentially the same way.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To start all of the Linux GroupWise agents that are installed on the server, enter the following

command:

./grpwise start
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4 To confirm that the agents have started, enter the following command:

./grpwise status

IMPORTANT: The GroupWise agents are Run Control compliant. During installation, a
symbolic link is created from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/
sbin is already on your path, so you can run rcgrpwise from any directory, rather than
changing to /etc/init.d in order to run the grpwise script. A /usr/sbin/grpwise-ma link is
also created for the Monitor Agent.

Agent status is displayed in terms of the names of the domain and post office associated with
each agent. It lists the agent locations in the following format:

POA: post_office.domain
MTA: domain
DVA: gwdva

GWIA: gwia.domain

When using the grpwise script, you refer to the agents by the location names displayed when
you list agent status, not by the names of the agent executables.

5 Use the following set of commands as needed to start the agents as daemons and verify their

status:
./grpwise start Starts the GroupWise agents that are installed on the
rcgrpwise start server

./grpwise start agent location name Starts the specified agent
rcgrpwise start agent location name

./grpwise status Displays the status of the GroupWise agents that are
rcgrpwise status installed on the server

./grpwise status agent location name  Displays the status of the specified agent
rcgrpwise status agent location name

./grpwise print Lists the contents of the gwha . conf file
rcgrpwise print

For convenience in typing the command, the agent_location_name is not case sensitive.

To remind yourself of these commands when you are at your Linux server, view the grpwise
man page.

If Novell Messenger agents are installed on the same server, the grpwise script also starts them.

6 (Optional) To cause the grpwise script to start the agents with a user interface, use the show =
yes option in the GroupWise High Availability service configuration file (gwha . conf).

For more information, see “Configuring the GroupWise High Availability Service in the
gwha.conf File” on page 196.

Starting the Linux Agents on System Startup

If you selected Launch GroupWise Agents on System Startup in the Installation program, the Installation
program configured your system so that the agents start automatically each time you restart your
server. The Agent Installation programs always creates a grpwise startup scriptin /etc/init.d for
starting the agents, as described in “Starting the Linux Agents as Daemons” on page 188. To enable
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automatic startup, the Agent Installation programs also create symbolic links named Snngrpwise in
the re3.d and rc5. d directories so that the agents load on restart into level 3 or 5, depending on the
configuration of your Linux system. The value of nn is determined by the chkconfig command
during installation so that the GroupWise agents are started in the proper sequence with other
processes running on the server.

When the grpwise script runs and starts the GroupWise agents, the agents read the agent startup
files in /opt/novell/groupwise/agents/share to check for configuration information provided by
startup switches. Because the --show switch cannot be used in the startup files, the agents do not run
with server console interfaces when started automatically when the server restarts, unless you
modify the gwha . conf file as described in “Enabling the GroupWise High Availability Service for the
Linux GroupWise Agents” on page 195.

Restarting the Linux Agents Automatically

You can use the GroupWise High Availability service, in conjunction with GroupWise Monitor, to
detect when a GroupWise agent has stopped unexpectedly and to restart it automatically. For setup
instructions, see “Enabling the GroupWise High Availability Service for the Linux GroupWise
Agents” on page 195.

Stopping the Linux GroupWise Agents

How you stop the Linux GroupWise Agents depends on how you started them.
¢ “Stopping the Linux Agents from the Agent Console User Interface” on page 190
¢ “Stopping the Linux Agents Using the grpwise Script” on page 190
¢ “Stopping the Linux Agents Manually as Daemons” on page 191

Stopping the Linux Agents from the Agent Console User Interface

When you use the --show startup switch to start the GroupWise agents, you can stop them from the
agent server console interface.

1 Click File > Exit > Yes.

Stopping the Linux Agents Using the grpwise Script

When you start the GroupWise agents with the grpwise script, you can also use the script to stop
them. This also applies for the Monitor Agent and its grpwise-ma script.

1 Make sure you are logged in as root.

2 Change to the /etc/init.d directory.

3 To stop all of the GroupWise agents installed on the server, enter the following command:
./grpwise stop

4 To confirm that the agents have stopped, enter the following command:

./grpwise status

IMPORTANT: The GroupWise agents are Run Control compliant. During installation, a
symbolic link is created from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/
sbin is already on your path, so you can run rcgrpwise from any directory, rather than
changing to /etc/init.d in order to run the grpwise script. A /usr/sbin/grpwise-ma link is
also created.
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Agent status is displayed in terms of the names of the domain and post office associated with
each agent. It lists the agent locations in the following format:

POA: post _office.domain
MTA: domain

DVA: gwdva

GWIA: gwia.domain

5 Use the following set of commands as needed to stop the agents as daemons and verify their

status:

./grpwise stop Stops the GroupWise agents that are installed on the
rcgrpwise stop server

./grpwise stop agent location name Stops the specified agent

rcgrpwise stop agent location name

./grpwise status Displays the status of the GroupWise agents that are
rcgrpwise status installed on the server

./grpwise status agent location name  Displays the status of the specified agent
rcgrpwise status agent location name

For convenience in typing the command, the agent_location_name is not case sensitive.

Stopping the Linux Agents Manually as Daemons

When you start the GroupWise agents manually on the command line (without using the grpwise
script), use the standard Linux kill command to stop them.

1 Make sure you are logged in as root.

2 Determine the process IDs (PIDs) of the agent to kill:

POA:

MTA:

DVA

ps -eaf
ps -eaf
ps -eaf

GWIA: ps -eaf

Monitor: ps -eaf

grep gwpoa
grep gwmta
grep gwdva
grep gwia

grep gwmon

All of the PIDs for the specified agent are listed.

3 Kill the first process listed for each agent:

Syntax:
kill PID
Example:

kill 1483
kill 1892
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It might take a few seconds for all agent processes to terminate.

4 Repeat the ps commands to verify that the agents have stopped.

You can also restart the MTA and the GWIA without stopping them first using the following
command:

Syntax:

kill -HUP PID

Example:

kill -HUP 1483

The -HUP (hang up) option is equivalent to using Restart in the MTA and GWIA server console or
Web console. Because the other agents do not have a Restart feature in their consoles, the -HUP
option cannot be used to restart them.

Running the Linux GroupWise Agents as a Non-root User

For security reasons, it is preferable that the GroupWise agents do not run with root user privileges.
For example, if an intruder manages to assume the identity of a GroupWise agent, the intruder gains
all the privileges of the commandeered process. If the process is running with root user privileges,
then the intruder has root access to your system. If the process is running as a user with minimal
privileges, then the intruder has only restricted access to your system. Therefore, your system is more
secure if the GroupWise agents do not run as root.

The root user still needs to start the agents, because the agents do need to access some root-only
resources on startup. However, you can configure the agents to switch to a different user after they
start. After the agents are running as the non-root user, they need adequate access to the locations
where each domain, post office, library, and software distribution directory is located.

¢ “Setting Up Typical Non-root Access” on page 192

¢ “Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux” on
page 193

¢ “Changing the Non-root User” on page 194

NOTE: You can configure the POA, MTA, and GWIA to run as a non-root user. The DVA must still
run as root. Unlike the other agents, the Monitor Agent can be started as a non-root user by default,
so no setup is required for it to run as a non-root user.

Setting Up Typical Non-root Access
To configure the GroupWise agents to switch users after startup:

1 Make sure you are logged in as root.

2 Select a Linux user for the agents to run as and make sure that the user is listed in the /etc/
passwd file.

You might want to create a new user specifically for this purpose, perhaps named gwagents.
3 Change to the groupwise directory under /etc:
cd /etc/opt/novell/groupwise

4 Create a new agents directory, then change to that directory:
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mkdir agents
cd agents

5 Create a file named uid. conf.

6 Type the selected user name in the file, for example:

gwagents

7 Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office directory structures from root to the user you specified in the uid. conf file. Then they
switch users and run as the user you specified, rather than as root.

If you list the agent processes, you can observe that they are no longer running as root.
ps -eaf | grep gw

If the post office and domain are located on different servers, you must complete the above steps
on each server.

IMPORTANT: All agents running on the same server must run as the same user. The first time
you start an agent as a non-root user, or if you change from one non-root user to another, the
agent might take longer than usual to start, because of the change in ownership of the directories
and files accessed by that agent. This is especially true of a POA that services a large post office
and that requires access to a restore area, especially a restore area on a remote server.

If you later want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 194.

Setting Up Non-root Access on an NSS Volume on Novell Open Enterprise Server Linux

When your domains, post offices, libraries, and software distribution directories are located on a
Novell Open Enterprise Server (OES) Linux NSS volume, you must set up an eDirectory user for the
agents to run as and you must Linux-enable that user. On OES Linux, you can use Novell iManager
to accomplish these tasks.

To configure the agents to switch users after startup and provide access to an NSS volume:

1 Select or create an eDirectory user for the agents to run as.

You might want to create a new user specifically for this purpose, perhaps named gwagents. The
user name must not match any local user names on the Linux server.

la From the Open Enterprise Server Welcome page in your Web browser, expand Network
Management, then click iManager 2.5.x.

1b In the iManager Links box, click Open Novell iManager 2.5.
1c To log in to iManager, specify a user name, a password, and a tree.
1d In the left pane, expand Users, then click Create User.
le Provide the required information, then click OK.
The user does not need a password
2 Linux-enable the user you just created:
2a In the left pane, expand Linux User Management, then click Enable User for Linux.
2b Browse to and select the user you just created, then click OK.

2c Select the primary group for the user to belong to (for example, admingroup).
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2d Change /bin/bash to /bin/false because the user does not need a shell.
2e Click OK to Linux-enable the user.

3 In a terminal window, change to the groupwise directory under /etc:
cd /etc/opt/novell/groupwise
4 Create a new agents directory, then change to that directory.

mkdir agents
cd agents

5 Create a file named uid. conf
6 Type the selected user name in the file, for example:
gwagents

7 Use the following command to grant the user the required rights to the directories that the
agents need to access on the local server:

rights -f /directory -r rwcemf trustee user.context.tree

The POA needs access to the post office directory. The MTA and the GWIA need access to the
domain directory.

8 Stop and then start the agents.

While starting as root, the agents automatically change the ownership of the domain and post
office directory structures from root to the user you specified in the uid. conf file. Then they
switch users and run as the user you specified, rather than as root.

If you list the agent processes, you can observe that they are no longer running as root.
ps -eaf | grep gw

If the post office and domain are located on different servers, you must complete the above steps
on each server.

IMPORTANT: All agents running on the same server must run as the same user.

If you later want to change the user that the agents are running as, follow the instructions in
“Changing the Non-root User” on page 194.

Changing the Non-root User

To prevent an agent from running as a different user than the one for which it was originally
configured, the GroupWise agents create a uid. run file in the domain or post office directory that
they service. The GWIA creates the uid. run file in its gateway directory (typically domain/wpgate/
gwia).

If, for any reason, the user specified in the uid. run file does not match the user specified in the
uid.conf file, the agent displays the following message:

Error: Running the agent with conflicting effective users

This could happen if the user specified in the uid. conf file is manually edited, or if the uid. conf file
is deleted, thus changing or removing the information about the user that the agent should run as. If

this message appears, verify that the uid. conf file specifies the desired user, then delete the uid.run
file.
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After displaying the message, the agent does not start, because it no longer has appropriate
permissions in the domain or post office directory that it needs to service. By deleting the uid.run
file, you enable the agent to reset the permissions in the domain or post office directory to
appropriate user and then start successfully.

After configuring an agent to run as a specific non-root user:

¢ If you want the agent to run as a different non-root user, modify the uid. conf file in the /etc/
opt/novell/groupwise/agents directory to specify the desired non-root user, then delete the
uid.run file from the directory serviced by the agent.

¢ If you want the agent to run as root, delete the uid. conf file from the /etc/opt/novell/
groupwise/agents directory and delete the uid. run file from the directory serviced by the
agent.

Enabling the GroupWise High Availability Service for the Linux GroupWise
Agents

The GroupWise High Availability service (gwha) makes sure that if the MTA, POA, DVA, or GWIA
goes down for any reason, it restarts automatically. On Windows, Microsoft Clustering Services
automatically restarts a service that is not responding. However, on Linux, some clustering
environments do not include this capability, so it is built into the Linux GroupWise agents.

The GroupWise High Availability service is installed automatically, starts when your server boots,
and makes sure that any GroupWise agents installed on the server restart if they go down
unexpectedly. However, the GroupWise High Availability service does not start the GroupWise
agents initially. For more information, see “Starting the Linux Agents on System Startup” on

page 189.

The GroupWise High Availability service relies on the Monitor Agent to detect when a GroupWise
agent is no longer running. The Monitor Agent notifies the GroupWise High Availability service of
any problem, then the GroupWise High Availability service immediately issues the command to start
the problem agent. The GroupWise High Availability service runs as root, as configured in the /etc/
xinetd.d/gwha file.

A single Monitor Agent can service multiple instances of the GroupWise High Availability service on
multiple servers, as long as all instances use the same user name and password to communicate with
the Monitor Agent.

¢ “Configuring the GroupWise High Availability Service in the gwha file” on page 195

¢ “Configuring the GroupWise High Availability Service in the gwha.conf File” on page 196

¢ “Creating a GroupWise High Availability Service User” on page 199

¢ “Configuring the Monitor Agent to Communicate with the GroupWise High Availability
Service” on page 199

Configuring the GroupWise High Availability Service in the gwha file

The basic configuration for the GroupWise High Availability service is contained in the /etc/
xinetd.d/gwha file:
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socket type = stream

user = root

server = /opt/novell/groupwise/agents/bin/gwha
wait = no

instances = 1

protocol = tcp

type = UNLISTED

port = 8400

disable = yes

The only option you can change in this file is the port number. By default, the GroupWise High
Availability service listens on port 8400. If that port number is already in use on the server where you
are setting up the GroupWise High Availability service, you can change the port number in the gwha
file. The GroupWise High Availability service must use the same port number on all servers where
you want it to restart the GroupWise agents.

Do not change any other options in this file.

Configuring the GroupWise High Availability Service in the gwha.conf File

The interaction between the GroupWise High Availability service and the GroupWise agents is
controlled by gwha. conf file located in the /etc/opt/novell/groupwise directory. The
configuration file provides a section for configuring SSL for communication between the GroupWise
High Availability service and the Monitor Agent. The [gwha] section is followed by sections for each
agent installed on the server, as shown below. The headings for the sections match the agent locations
listed in “Starting the Linux Agents as Daemons” on page 188.

[gwhal
ssl

key

cert
password

no

[domain name]

server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise

startup = domain name.mta

delay =2

wait = 10

[post _office name.domain namel

server = /opt/novell/groupwise/agents/bin/gwpoa
command = /etc/init.d/grpwise

startup = post_office name.poa

delay =2

wait = 10

[gwia.domain name]

server = /opt/novell/groupwise/agents/bin/gwia
command = /etc/init.d/grpwise

startup = gwia.cfg

delay =2

wait = 10

[gwdva]

server = /opt/novell/groupwise/agents/bin/gwdva
command = /etc/init.d/grpwise

startup = gwdva.dva

delay =2

wait = 10
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To set up the GroupWise High Availability service:

1 In a terminal window, become root by entering su - and the root password.

2 Before starting to configure the GroupWise High Availability service, test the agents by starting
and stopping them manually with a user interface so that their agent server consoles display:

2a Change to the root directory of the Linux server.
2b Start the GroupWise agents manually, including providing the full path to the executable

and including the --show switch, to make sure that they are set up and configured correctly.

/opt/novell/groupwise/agents/bin/gwpoa --show @post.poa
/opt/novell/groupwise/agents/bin/gwmta --show @dom.mta
/opt/novell/groupwise/agents/bin/gwia --show @gwia.cfg

2c After verifying that the agents start correctly, stop the agents.

3 (Conditional) If you use SSL, you need to modify the GroupWise High Availability service
configuration file (gwha. conf):

3a Change to the /etc/opt/novell/groupwise directory.
3b Edit the gwha . conf file in a text editor.
3c Under the [gwha] section, fill in the fields as follows:

[gwha]

ssl = yes

key = file name.key
cert = file name.crt
password = password

3d Save the file, then exit the text editor.

4 (Conditional) If you changed the port number for the GroupWise High Availability service, as
described in “Configuring the GroupWise High Availability Service in the gwha file” on
page 195, add the following line to the [gwha] section:

port = port number
Replace port_number with the new port number you specified in the gwha file.

5 (Conditional) If you want to control how the script manages starting and stopping the agents,
modify the delay = and wait = settings.

The delay = setting controls the length of time between when the script issues the command to
start an agent and when the script displays a message indicating that the agent has started. The
default delay time is 2 seconds. Under certain circumstances, an agent could encounter a
problem and fail to start after 2 seconds. In this case, you would receive the success message but
the agent would not be running. You need to increase the delay = setting to accommodate the
length of time it typically takes for the agent to start successfully on your system.

The wait = setting controls the length of time between when the script issues the command to
stop an agent and when the script kills the agent if the agent has not yet stopped. The default
wait time is 10 seconds. Under certain circumstances, an agent could take longer than 10 seconds
to perform a normal shutdown, and killing the agent under those circumstances would not be
appropriate. You need to increase the wait = setting to accommodate the length of time it
usually takes for the agent to shut down. A message notifies you if the script kills an agent
because its shutdown exceeds the wait = setting.

The default settings are usually appropriate, so you do not need to change them unless you
frequently encounter problems with starting or stopping an agent with the script.

5a Change to the /etc/opt/novell/groupwise directory.
5b Edit the gwha. conf file in a text editor
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6

10

11

Each agent has its own section in the file, for example:

[Provo2]

server = /opt/novell/groupwise/agents/bin/gwmta
command /etc/init.d/grpwise

startup Provo2.mta

delay = 2

wait = 10

5¢ Change the delay = and wait = settings as needed.
5d Save the file, then exit the text editor.

(Conditional) If you want the script to start the agents with a user interface on the Linux server,
add the show = setting in the GroupWise High Availability service configuration file

(gwha. conf). This is equivalent to using the --show startup switch on the command line when
starting the agent.

6a Change to the /etc/opt/novell/groupwise directory.
6b Edit the gwha.conf file in a text editor

Each agent has its own section in the file, for example:

[Provo2]
server = /opt/novell/groupwise/agents/bin/gwmta

command = /etc/init.d/grpwise
startup = Provo2.mta

delay = 2

wait = 10

6c Add show = yes to the section for each agent that you want to start with a user interface.

If you need to eliminate the user interface, use show = no or delete the show = line from the
file.

6d Save the file, then exit the text editor.
Enable the GroupWise High Availability service:
7a In YaST, click Network Services > Network Services (inetd).
7b (Conditional) If necessary, select Enable to activate the list of services.

7c Scroll down to the gwha line, select it, then click Toggle Status (On or Off) to change the status
to On.

7d Click Finish.
Start the agents:

rcgrpwise start

Verify agent status:

rcgrpwise status

For more information about using the grpwise script, see “Starting the Linux Agents as
Daemons” on page 188

Repeat this procedures on all servers where you want the GroupWise High Availability service
to restart the GroupWise agents.

Continue with Creating a GroupWise High Availability Service User.
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Creating a GroupWise High Availability Service User

The GroupWise High Availability service needs a login user on each server where GroupWise agents
need to be restarted.

1 Create a new user and associated password on the local Linux server to represent the
GroupWise High Availability service.

You might name it gwha.

IMPORTANT: Use a local user account for use only by the GroupWise High Availability service.
Do not use a Novell Linux-enabled user. Do not use root.

2 Create the same user on each Linux server where you want the GroupWise High Availability
service to restart the GroupWise agents.

3 Continue with Configuring the Monitor Agent to Communicate with the GroupWise High
Availability Service.

Configuring the Monitor Agent to Communicate with the GroupWise High Availability Service

After you have the GroupWise High Availability service set up and working correctly on all Linux
servers where you want it to restart the GroupWise agents, you need to configure the Linux Monitor
Agent to communicate with it and test it to make sure that you can rely on it in the future. Although
you need a GroupWise High Availability service running on each Linux server where there are
GroupWise agents, you need only one Monitor Agent to monitor all agents in your GroupWise

system.

1 Configure the Linux Monitor Agent with the --hauser and --hapassword startup switches.

If you use the grpwise-ma script to start the Monitor Agent, as described in “Starting the Linux
Monitor Agent as a Daemon” on page 164, you can edit it to include the switches:

la Change to the /etc/init.d directory, then edit the grpwise-ma script.

1b

1c
1d

Locate the following line:

#MA OPTIONS="--hauser user name --hapassword password
--hapoll 120"

Remove the pound sign (#) from the beginning of the line.

Replace user name and password with the user name and password you established in Step 1
in “Configuring the GroupWise High Availability Service in the gwha.conf File” on
page 196.

MA OPTIONS="--hauser gwha --hapassword gwagents --hapoll 120"

The Monitor Agent uses the --hauser and --hapassword switches to communicate with the
GroupWise High Availability service on port 8400, as configured in the /etc/xinetd.d/
gwha file. When the Monitor Agent notices that a GroupWise agent has stopped, it notifies
the GroupWise High Availability service. Then the GroupWise High Availability service
issues the command to restart the problem agent.

The --hapoll switch specifies that the Monitor Agent should check the status of GroupWise
agents every 120 seconds.

You can use the MA_OPTIONS variable to add any other Monitor Agent startup switches to
the grpwise-ma script as needed. For information about Monitor Agent startup switches,
see “Using Monitor Agent Startup Switches” in “Monitor” in the GroupWise 2012
Administration Guide.

le Save the script file, then exit the text editor.
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2 Start the Monitor Agent.

rcgrpwise-ma start

3 Stop one of the agents, as described in “Stopping the Linux GroupWise Agents” on page 190.
4 Check the status of the agent you stopped to make sure it is stopped.
5 Wait for the next Monitor Agent polling cycle.

You can check and, if necessary, change the Monitor Agent polling cycle in the Monitor Agent
Web console. Click Preferences, then scroll down to the HTTP Settings section.

6 After the polling cycle has passed, check the status of the agent again.

The agent that you stopped should now be running again.

Monitoring the Linux GroupWise Agents from Your Web Browser

To monitor any GroupWise agent from your Web browser, view the agent Web console by supplying
the IP address or DNS hostname and the port number of the agent. The following table lists the
default port numbers:

POA: http://server network address:7181

MTA: http://server network address:7180

GWIA: http://server network address:9850

DVA: http://server network address:8301

Monitor: http://server network address:8200

Total

0
0
0
0
0
0
0
0

C/S Users

Application Connections
Physical Connections

SOAP Sessions

Prion ueues

Normal Queues

GWCheck Auto Queues
GWCheck Scheduled Queues

hread Status

Total Busy
C/S Handler Threads 10 0
Message Worker Threads 6 0
GWcCheck Worker Threads 4 0
SOAP Threads 3 0
Calendar Publishing Threads 3 1]
Message Transfer Status Open

For more information about the agent Web consoles, including instructions on protecting the agent
Web consoles with passwords, see the following sections in the GroupWise 2012 Administration Guide.

¢ “Using the POA Web Console”

¢ “Using the MTA Web Console”

¢ “Using the DVA Web Console”

¢ “Using the GWIA Web Console”

¢ “Using the Monitor Web Console”
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8.4.3

Uninstalling the Linux GroupWise Agents

If you move the GroupWise agents to a different server, the GroupWise agent software can be
uninstalled just like any other software on Linux. To determine what GroupWise software is
currently installed on the Linux server, use the following command:

rpm -ga | grep groupwise

This lists all of the GroupWise RPM packages on the server. The POA the MTA, and the DVA are
together in the same RPM. WebAccess has its own RPM Monitor has two RPMs each, one for the
agent software and one for the application software. The following list shows all GroupWise agent
and administration RPMs that you might need to uninstall from a server:

POA, MTA, and DVA: novell-groupwise-agents-version-date
GWIA: novell-groupwise-gwia-version-date
WebAccess Application: novell-groupwise-webaccess-version-date
Monitor Agent: novell-groupwise-gwmon-version-date
Monitor Application: novell-groupwise-monitor-version-date

Calendar Publishing Host Application: novell-groupwise-calhost-version-date

GroupWise High Availability Service: novell-groupwise-gwha-version-date

GroupWise Administrator snap-ins: novell-groupwise-admin-version-date
GroupWise Check: novell-groupwise-gwcheck-version-date
GroupWise Database Copy: novell-groupwise-dbcopy-version-date

Use the following command to uninstall a GroupWise RPM package:
rpm -e novell-groupwise-package

Uninstalling the RPMs does not uninstall files created after installation by the GroupWise programs.
To see what GroupWise files are created in locations other than under /opt /novell/groupwise and
its subdirectories, see “Agent Installation Directories” in the GroupWise 2012 Troubleshooting 3:
Message Flow and Directory Structure:

¢ Agents: “Linux MTA, POA, and DVA Installation Directory”
¢+ GWIA: “Linux Internet Agent Installation Directory”

¢ Monitor: “Linux Monitor Agent Installation Directory”

Windows: Setting Up the GroupWise Agents

Complete the following tasks to set up the Windows agents. These tasks are designed to help you get
the Windows POA and MTA up and running as quickly as possible:

¢ “Preparing the Windows Server for the Windows Agents” on page 202
¢ “Installing the Windows Agent Software” on page 202

IMPORTANT: If you plan to install the GroupWise agents in a clustered server environment, see the
GroupWise 2012 Interoperability Guide before you install the agents.
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Refer to the following additional tasks as you maintain all the GroupWise agents on Windows:

*

*

*

“Starting the Windows GroupWise Agents” on page 205
“Stopping the Windows GroupWise Agents” on page 207
“Uninstalling the Windows GroupWise Agents” on page 208

Preparing the Windows Server for the Windows Agents

1

7

Make sure that the Windows server where you are installing the GroupWise agents meets the
system requirements listed in Section 8.2, “Agent System Requirements,” on page 176.

Make sure that the Windows server has a static IP address.

Make sure that the firewall on the Windows server has the ports open that are used by the MTA,
the POA, and the DVA.

For assistance, see “GroupWise Port Numbers” in the GroupWise 2012 Administration Guide.

Make sure that no other GroupWise agents are currently running on the server where you want
to install the agents.

Log in to eDirectory with Admin-equivalent rights to the eDirectory tree where you want the
Installation program to create the Agent objects.

(Optional) Enable SNMP.

If you want to monitor the GroupWise Windows agents from an SNMP manager program,
SNMP must be enabled on the Windows server where the agents are installed. If it is not already
enabled, you must enable it before you run the Installation program.

For example, in Windows Server 2008:
6a In the Server Manager, right-click Features, then click Add Features.
6b Select SNMP Services, then click Next.
6c Click Install.

Continue with Installing the Windows Agent Software.

Installing the Windows Agent Software

1

Change to the root directory of the downloaded GroupWise 2012 software image.
or

If you have already copied the agent software to a software distribution directory, change to that
location

Run setup.exe.

(Conditional) If prompted, select the interface language for the Installation program, then click
OK.

On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.
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The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard
GroupWise

Grouptfize System Installation

Ok

{View e Bedne |

| Displays impartant infarmation you should read before instaling Grouplafise.

iew the Quick Start

Displays a high-level checklist of system requirsments and installation steps ta guide
wou through setting up your Grouptise spstem.

| Dizplaps overview and task information to help pou plan, instal, and maintain a basic

“iews the Installation Guide Grouplwise system and all additional componerits.

Creates or updates a basic Groupt/ise system, including Group\wise adrinistration,
Install Groupwise Systemn the Post Office Agent, the Message Transfer Agent, and the Intemet Agent.

Irztall More Components

Installs or updates Groupiwise web Access, Groupwise Monitor, the Calendar
Publishing Host, and the Groupwise Windows client.

Instaltield <Back | Hews | cancel |

4 Click Install GroupWise System, then click Yes to accept the License Agreement and display the
Installation Type page.

GroupWise - Installshield Wizard x|
GroupWise
Inztall Type

[¥] Licerse Agreement

|:| Install Type Select a zetup tppe.

& Standard

@ Install GroupWize components and select settings.
" Fredefined
@ Install Groupwise components with settings from a previous installation,

Path ta configuration file from a previous installation:

| =

| Wse predefined settings in an edpress instal

" Uninstall

@ Femove Grouplwize components

Installation Guide | < Back |

| Cancel |

When you install the agents, you are performing a Standard installation. Other installation
options on this page are described in “Setting Up Predefined Installations” on page 68.
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5 Click Next to accept the default of Standard.

GroupWise - InstallShield Wizard
GroupWise

x|
Group'wise Compaonents @

[¥] License Agreement
[ Install Type Grouplafize system oplions:

[ Group\wise Components ¥ Create a new system
[ Software Platiom ™ Update an existing system

" Install individual components

Select the Groupiwise components you want to install.
¥ | Grouphifise &dministratior

¥ | Grouphifise &gents

I~ Groupiwise Intemnst Agent

Installation Guids | < Back |

| Cancel |

6 Select Install Individual Components, then deselect GroupWise Administration.

7 Follow the prompts to provide the Windows agent information from your GroupWise Agent
Installation Worksheet.
Installation Path
Agent Installation Options
Domain Information
Post Office Information

GroupWise - InstallShield Wizard
GroupWise Settings

x|
Summary and Modification %

[¥] License Aarsement

] Install Type odify the eettings pou wich ta change.
[¥] Groupwise Components Sefting | Walue |
[¥] Software Platform Grouphiise Agerts

Installation path C:\Program Files [«86]\Mavell..
[] Agent Installation Architecture “windows [32-bit)
[ Summary and Modification Install only MNo
[ Firish ‘Wwindows service N

Domains / Post Offices Prowo2, Sales

Edit setting |

Installation Guide | < Back

Cancel

204  GroupWise 2012 Installation Guide



8 On the Summary and Modification page:
8a Review the installation information you have provided.

8b (Conditional) If you need to change information, select the information to change, then click
Edit Setting, specify the desired information, then click OK.

9 Click Install to start the agent installation.
Status messages keep you informed about the installation progress.

The GroupWise agents are installed to the following directory:

c:\Program Files\Novell\GroupWise Server\Agents

10 Click Finish to exit the Agent Installation program.

If you want to start the agents later or if the Installation program fails to start them successfully,
see “Starting the Windows GroupWise Agents” on page 205.

11 To monitor an agent from your Web browser, view the agent Web console as described in the
following sections of the GroupWise 2012 Administration Guide:

¢ “Using the POA Web Console”
¢ “Using the MTA Web Console”
¢ “Using the DVA Web Console”

12 If you want to learn more about running the Windows agents, continue with “Starting the
Windows GroupWise Agents” on page 205 and “Stopping the Windows GroupWise Agents” on
page 207.

or

If you want to customize the configuration of the Windows agents or expand your GroupWise
system, skip to Section 8.5, “What’s Next,” on page 208.

13 Continue with Starting the Windows GroupWise Agents.

Starting the Windows GroupWise Agents

You might have one or more GroupWise agents installed on each Windows server in your
GroupWise system. You can start the GroupWise agents on Windows in several ways:
¢ “Starting the Windows Agents Manually As Applications” on page 205

¢ “Starting the Windows Agents Automatically as Applications When the Windows Server Starts”
on page 206

¢ “Starting the Windows Agents Manually or Automatically as Services” on page 206
¢ “Restarting the Windows Agents Automatically” on page 207

If you encounter any problems starting the GroupWise agents, see “Strategies for Agent Problems” in
GroupWise 2012 Troubleshooting 2: Solutions to Common Problems for assistance.

Starting the Windows Agents Manually As Applications

On the Windows desktop, click Start > All Programs, select the GroupWise agent, then start the
GroupWise agent.

You can also use desktop shortcuts to start the GroupWise agents. The GroupWise Installation
program automatically creates desktop shortcuts for the POA, the MTA, the DVA, and the GWIA.
You can easily create a desktop shortcut for Monitor by linking to its target file (c¢: \Program
Files\Novell\GroupWise Server\Monitor\gwmon.exe).
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When you start the GroupWise agents as applications, you can use the agent server consoles
described in the GroupWise 2012 Administration Guide:

¢ “Using the POA Server Console”

¢ “Using the MTA Server Console”

¢ “Using the DVA Server Console (Windows Only)”

¢ “Using the GWIA Server Console”

¢ “Using the Windows Monitor Agent Server Console”

Starting the Windows Agents Automatically as Applications When the Windows Server Starts

After the GroupWise agents are running smoothly as applications, you can configure them to start
automatically whenever you restart the Windows server. Use the Windows Task Scheduler to create a
task for each agent on the Windows server.

1 (Conditional) On Windows 2008, click Start > Administrative Tools > Task Scheduler.
(Conditional) On Windows 2003, click Start > Control Panel > Scheduled Tasks.

2 (Conditional) If you are not familiar with creating a task using the Window Task Scheduler, refer
to your Windows documentation for assistance.

3 When prompted for the GroupWise program to start, use the following commands to start any
GroupWise agents on the Windows server:

c:\Program Files\Novell\GroupWise Server\Agents\gwpoa.exe

@post _office name.poa
c:\Program Files\Novell\GroupWise Server\Agents\gwmta.exe

@domain name.mta
c:\Program Files\Novell\GroupWise Server\Agents\gwdva.exe @gwdva.dva
c:\Program Files\Novell\GroupWise Server\GWIA\gwia.exe @gwia.cfg

4 After creating the tasks to start the GroupWise agents automatically, restart the Windows server

to verify that the GroupWise agents start successfully.

Starting the Windows Agents Manually or Automatically as Services

If you installed the GroupWise agents as services, you can manage them just as you would any other
Windows services.

NOTE: The Monitor Agent cannot currently be installed as a Window service.

For example, on a Windows Server 2003 machine:

1 From the Windows desktop, click Start > Administrative Tools > Services.
2 Select the agent service, then click Start.

The POA service is named after the post office. The MTA service is named after the domain. The
GWIA service is named GWIA.

3 (Optional) Check the status of the agent service by using the Windows Event Viewer:
3a From Administrative Tools, double-click Event Viewer.
3b Click Application Log, then sort the log entries on the Source column.
3c Scroll to the agent service, then double-click a log entry to view information about it.

4 To configure the agent service to start automatically when the server reboots, right-click the
agent service, then click Properties.

5 In the Startup Type field, click Automatic, then click OK.
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NOTE: On Windows Server 2008, the user that starts the GroupWise services must have the Log on as
a service right assigned.

When running as services, the GroupWise agents typically do not display an agent console on the
Windows server where they are running. Instead, you can monitor the GroupWise agents by using
their Web consoles described in the GroupWise 2012 Administration Guide:

¢ “Using the POA Web Console”
¢ “Using the MTA Web Console”
¢ “Using the DVA Web Console”
¢ “Using the GWIA Web Console”

Restarting the Windows Agents Automatically

When you run the Windows agents as services, you can use the Windows service Recovery feature to
restart them automatically if they stop unexpectedly.

1 In Windows, click Start > Administrative Tools > Services.
2 Right-click a GroupWise agent service, then click Properties > Recovery.

3 Set the Recovery options you want, then click OK.

When you run the Windows agents as programs, you must manually restart them if they stop
unexpectedly.

Stopping the Windows GroupWise Agents

How you stop the Windows GroupWise agents depends on how you started them.
+ “Stopping the Windows Agents as Applications” on page 207
¢ “Stopping the Windows Agents as Services” on page 207

Stopping the Windows Agents as Applications

When the GroupWise agents run as applications, you can stop them from their server consoles.

POA: At the POA server console, click File > Exit.

MTA: At the MTA server console, click File > Exit.

DVA From the Windows desktop, click the title bar of the window where the DVA is running, then press F7.
GWIA  Atthe GWIA server console, click File > Exit.

Monitor: At the Monitor Agent server console, click Configuration > Exit.

If the GroupWise agent does not respond to Exit, you can close the agent server console window to
stop the agent or use the Windows Task Manager to terminate the agent task.

Stopping the Windows Agents as Services

When the GroupWise agents run as Windows services, you can stop them as you would any other
Windows services.
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8.5

8.6

For example, on a Windows Server 2003 machine:

1 From the Windows desktop, click Start > Administrative Tools > Services.
2 Select the agent service, then click Stop.

The POA service is named after the post office. The MTA service is named after the domain. The
DVA service is named GWDVA. The GWIA service is named GWIA.

Uninstalling the Windows GroupWise Agents

If you move the GroupWise agents to a different server, you can uninstall the agent software from the
old location to reclaim disk space.

POA,MTA, Stop the POA the MTA, and the DVA, then run the GroupWise Installation program (setup . exe).
and DVA:  On the Install Type page, select Uninstall, then follow the prompts

GWIA: Stop the GWIA, then run the GroupWise Installation program (setup . exe). On the Install Type
page, select Uninstall, then follow the prompts. This deletes most of the contents of the
c:\Program Files\Novell\GroupWise Server\GWIA directory and uninstalls the GWIA
as a Windows service.

Monitor: Stop the Monitor Agent. Delete the contents of the c: \Program Files\Novell\GroupWise
Server\Monitor directory.

What's Next

After you have created new domains and post offices, and installed the agents for them, you can
complete their configuration by referring to the following sections of the GroupWise 2012
Administration Guide:

¢ Refining the configuration of the agents to meet the specific needs of the new domains and post
offices.
See “Post Office Agent”, “Message Transfer Agent”, and “Document Viewer Agent”.

¢ Refining the configuration of the new domains and post offices.
See “Post Offices” and “Domains”.

¢ Adding users to the new post offices.

See “Users”.

GroupWise Agent Installation Worksheet

Installation Program Field Value for Your GroupWise Explanation

System
Agent Software Platform: Section 8.3.1, “Selecting the
) Agent Platform,” on
¢ Linux page 178
+ Windows
Installation Path: Section 8.3.2, “Selecting the
Agent Installation Directory,”
on page 179
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Installation Program Field Value for Your GroupWise
System

Explanation

Linux Installation
Options:

+ Enable Document
Viewer Agent
* Yes
+ No

¢ Launch the
GroupWise agents on
system startup

* Yes
+ No

+ Configure the
GroupWise Agents for
Clustering

* Yes

+ No

“Linux Installation Options:
Automatic Startup,
Document Viewer Agent
Configuration, and
Clustering” on page 179

Windows Installation
Options:

+ Install and configure
SNMP for GroupWise
agents

¢+ Yes
* No

+ |Install as Windows
services

* Yes

* No

“Windows Installation
Options: SNMP Traps and
Service versus Application”
on page 180

Domain Information:

¢ Name

+ Path to database

Section 8.3.3, “Gathering
Domain and Post Office
Information,” on page 179

Post Office Information:

+ Name

+ Path to database

Section 8.3.3, “Gathering
Domain and Post Office
Information,” on page 179
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Installation Program Field Value for Your GroupWise
System

Explanation

Windows Service
Information:

* User local system
account

+ Allow service to
interact with
desktop

+ Use this Windows user
account

¢ Name of
Windows user
account

+ Password
+ Startup type

+ Automatic

+ Manual

+ Disabled

Section 8.3.5, “Windows
Installation Options: SNMP
Traps and Service versus
Application,” on page 180
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9.1

9.2

9.2.1

Installing the GroupWise Client

The following sections assist you with assigning GroupWise accounts to users and with installing the
Novell GroupWise 2012 client.

¢ Section 9.1, “GroupWise Client Overview,” on page 211

¢ Section 9.2, “Setting Up GroupWise Users,” on page 211

¢ Section 9.3, “Installing and Starting the GroupWise Windows Client,” on page 214
¢ Section 9.4, “What’s Next,” on page 223

For information about client licensing requirements, see “Auditing Mailbox License Usage in the Post
Office” in “Post Offices” in the GroupWise 2012 Administration Guide.

GroupWise Client Overview

Each user with a GroupWise account has a mailbox in a post office. In a corporate workplace
environment, GroupWise users can run the GroupWise client on their workstation to access their
mailboxes and to send and receive mail.

When the users are not at their workstations, they can access their GroupWise mailboxes from a Web
browser using GroupWise WebAccess or on a tablet device using the mobile version of GroupWise
WebAccess. For more information, see Chapter 5, “Installing GroupWise WebAccess,” on page 103.

Setting Up GroupWise Users

¢ Section 9.2.1, “Assigning GroupWise Accounts to Users,” on page 211
¢ Section 9.2.2, “Implementing System-Wide Rollouts,” on page 213

Assigning GroupWise Accounts to Users

After you finish your basic GroupWise system setup, you need to add users to the post office before
they can log in to a GroupWise client. To do so, follow the instructions in one of the following
sections:

¢ “Assigning GroupWise Accounts to eDirectory Users” on page 211

¢ “Assigning GroupWise Accounts to Non-eDirectory Users” on page 212

Assigning GroupWise Accounts to eDirectory Users

To give an eDirectory user a GroupWise account in the post office:

1 In ConsoleOne, right-click the user you want to give an account to, then click Properties.
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2 Click the GroupWise tab to display the GroupWise Account page.

Properties of mpalu x|

General upiice = || Restrictions vI Memberships vl Security Equal Ta Me I Login Scrigt | NDS Rights - “ EE

Post Office; |vaol Development

Mailbos ID: |mpa\u

visibility: ISystem =
External Sync Override: Isynchronlze according ko visibilicy d
Account 1D: |

File 1D vkz2

Expiration Date: I™ Enahlz I

Gateway Access: |

[~ Disable Logins

LDAP Authertication: |

Restore Area: (Mot Set)
View Client Options I Change GroupWise Password I Delete GroupWise Account |
Page Options. .. | OF I Cancel I Apply | Help |

3 In the Post Office field, click the Browse button to select the post office.
The Mailbox ID field displays the eDirectory user name, which cannot be changed.
4 Click OK.

Assigning GroupWise Accounts to Non-eDirectory Users

You give a non-eDirectory user a GroupWise account in a post office by adding the user to eDirectory
as a GroupWise external entity.

1 In ConsoleOne, right-click the container where you want to create the GroupWise external
entity, click New, then click Object to display the New Object dialog box.

2 In the list, select GroupWise External Entity, then click OK to display the Create GroupWise
External Entity dialog box.

Create GroupWise External Entiby

x|
Groupitise Object 10:
Lask Marme: LEEII
| Help |

Grouphiise Post Office:

External Metwark, I0:

[~ Define additional properties

[~ Create another External Enkity

3 Define the following properties:
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9.2.2

GroupWise Object ID: Specify the user’s GroupWise ID. The user’s ID, along with the user’s
post office and domain, provide the user with a unique name within the GroupWise system.

Last Name: Specify the user’s last name.
GroupWise Post Office: Select the post office where you want the user’s mailbox.
External Network ID: Specify the user’s network ID for the network that he or she logs in to.

Define Additional Properties: Select this option so that you can define additional information
such as the user’s first name. The user’s first name appears in the GroupWise Address Book.

Create Another External Entity: As soon as you select Define Additional Properties, this option

becomes unavailable.
4 Click Create.
5 Specify the user’s first name in the Given Name field.

6 Fill in any other fields you want, then click OK.

The user is given a GroupWise account in the post office you selected and can access his or her

mailbox through the GroupWise client.

Logging In to GroupWise as a Non-eDirectory User

Because non-eDirectory users do not log in to eDirectory, the GroupWise clients cannot use the

GroupWise information in eDirectory to automatically log in to the users’ post office. When a non-
eDirectory user starts a GroupWise client for the first time, he or she is prompted for a GroupWise
user ID and post office location (IP address and port number). You need to provide non-eDirectory

users with this information.

If you don’t want to provide non-eDirectory users with the post office information, you can automate

the login process by creating a GroupWise name server. A GroupWise name server is a DNS

hostname entry that defines the TCP/IP address of the POA. During startup, the GroupWise client

automatically looks for the GroupWise name server in DNS. For information about creating a
GroupWise name server, see “Post Office Agent” in the GroupWise 2012 Administration Guide.

Implementing System-Wide Rollouts

For a system-wide rollout of the GroupWise client software, you might want to consider alternatives

to each user installing from a DVD, the downloaded software image, or the software distribution

directory.

For the GroupWise Windows client, if you have Novell ZENworks Content Management, you can
use it to distribute the client. Or, you can have a login script run the client Setup program with a

response file to perform a silent install on workstations.

For the GroupWise Linux client, you can use ZENworks Linux Management for a system-wide
rollout.

For more information about these and other installation methods, see “Client” in the GroupWise 2012

Administration Guide.
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9.3 Installing and Starting the GroupWise Windows Client

The GroupWise Windows client software is available in both the Windows version and the Linux
version of the downloaded GroupWise 2012 software image. A simple installation of the GroupWise
Windows client helps you test your GroupWise system as you are setting it up.

If you want, you can burn the GroupWise 2012 software image to DVDs for distribution to Windows
client users. Advanced, system-wide rollout methods for the GroupWise Windows client are also
available, as described in “Distributing the GroupWise Windows Client” in “Client” in the GroupWise
2012 Administration Guide.

¢ Section 9.3.1, “GroupWise Windows Client Workstation Requirements,” on page 214

¢ Section 9.3.2, “Installing the GroupWise Windows Client from the Windows GroupWise 2012
Software Image,” on page 214

¢ Section 9.3.3, “Installing the GroupWise Windows Client from the Linux GroupWise 2012
Software Image,” on page 217

¢ Section 9.3.4, “Implementing System-Wide Windows Client Rollouts,” on page 223
¢ Section 9.3.5, “Starting the Windows Client,” on page 223

9.3.1 GroupWise Windows Client Workstation Requirements

(3 x86-32 processor or x86-64 processor

On a 64-bit processor, GroupWise still runs as a 32-bit application.
(3 Any of the following Windows versions:
+ Windows XP on a 300 MHz or higher workstation with at least 128 MB of RAM
¢ Windows Vista on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Windows 7 on a 1 GHz or higher workstation with at least 1 GB of RAM
+ Windows 8 or 8.1 on a 1 GHz or higher workstation with at least 1 GB of RAM
(3 Approximately 200 MB of free disk space to install the GroupWise Windows client

9.3.2 Installing the GroupWise Windows Client from the Windows
GroupWise 2012 Software Image

Install the Windows client on a Windows workstation that meets the system requirements listed in
Section 2.2, “GroupWise User Requirements,” on page 22.

1 Run setup.exe from the root of the downloaded GroupWise 2012 software image.
or

If you have already copied the Windows client software to a Windows software distribution
directory, run setup.exe from the root of the software distribution directory to start the
GroupWise Installation program.

In order to install from the software distribution directory, users need a drive mapped to the
software distribution directory. Users also require Read and File Scan rights to the
drive:\grpwise\software directory to start the GroupWise Installation program and to the
drive:\grpwise\software\client\win32 directory to run the Windows Client Setup
program.
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2 Select the language in which you want to run the GroupWise Installation program, then click
OK.

All available languages are included in the multilanguage version of the downloaded GroupWise
2012 software image, but you can select which languages you want to install for the GroupWise
Windows client.

The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard 5[
GroupWize
Grouptize 5pstem [nstallation

7 3 Displays impaortant information pou should read before instaling Groupiaise.
e el Besrie

| Dizplaps a high-level checklist of system requirements and installation steps to guide

Wiew the Quick Stark wou through setting up pour Groupiwise system.

X Displays overview and task information to help you plan, instal, and maintain a basic
“Wiew the Installation Guide Groupt¥ise system and all additional components.

Creates or updates a basic Groupiwise system, including Group'Wise administration,
Install Graup'wise System the Post Office Agent, the Message Transfer Agert, and the Intermet Agent.

| Ingtalls or updates Groupiwise WWeb Access, GroupWise Monitor, the Calendar

Install Mare Components Publishing Host, and the Groupiwise ‘wWindaws client

Inistallshisld < Back | Mest » | Cancel |

3 Click Install More Components > Install GroupWise Client to start the client Setup program.
4 Select the language in which you want to run the client Setup program, then click OK.
5 Click Next to display the Setup Type dialog box.

i"-!": GroupWise - Setup Type 5'
Setup Type
v
Choosze the setup type that best suits your needs.
L

Fleaze zelect a setup type.

% Typical

GroupWise will be installed with the most common options.
Recommended for most users.

" custom

Choose which program features you want installed and where they
will be installed. Recommended for advanced users.

< Back I Next > I Cancel

6 Select one of the following options:

Typical: Installs the most commonly used components in the standard installation directory of
c:\Program Files\Novell\Groupwise without prompting for further information. By default,
this installs the software integration and Internet browser mail integration. A GroupWise icon is
added to your desktop as well as to the Quick Launch area. However, Notify is not added to
your Startup folder. This means that Notify does not run when Windows starts.
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Custom: Allows you to customize the following GroupWise Windows client functionality:

*

*

*

*

*

*

*

Languages (select as needed)

Software Integrations (enabled by default)

Internet Browser Mail Integration (enabled by default)
Program Folder (Novell GroupWise by default)

Add GroupWise to the Desktop (selected by default)
Add GroupWise to Quick Launch (selected by default)
Add Notify to the Startup folder (disabled by default)

See “Using GroupWise Windows Client Custom Installation Options” in “Client” in the
GroupWise 2012 Administration Guide for more information about installing the GroupWise
Windows client.

7 Click Next.
8 (Conditional) If you selected Typical or Upgrade:
8a Click Install to install the client files.

8b

When the client Setup program has completed, a shortcut to run GroupWise appears on
your desktop and in the Quick Launch area.

Click Finish to exit the GroupWise Installation program.

9 (Conditional) If you selected Custom:

9a Make sure each component you want to install is selected.

9b
9c

a9d
9e

of
99

9h

Languages: Select which languages to install.

Software Integrations: Select the applications for integration with GroupWise Document
Management Services for saving and retrieving files from GroupWise libraries.

Internet Browser Mail Integration: Sets GroupWise to be the default email program on the
workstation, so that whenever the user clicks an email link on a Web page or chooses the
Mail command in the browser, GroupWise starts.

Click Next.

Select the Program folder where you want to add the GroupWise icons.

The default is Novell GroupWise.

Select if you want the GroupWise icon added to your Desktop and Quick Launch.

Select if you want Notify added to the Startup folder. This starts Notify when Windows
starts.

You can also choose to start Notify when GroupWise starts, as described in “Starting Notify
When GroupWise Starts ” in “Notify” in the GroupWise 2012 Windows Client User Guide.

Click Next.
Click Install to install the client files.

When the client Setup program has completed, a shortcut to run GroupWise appears on
your desktop.

Click Finish to exit the GroupWise Installation program.

GroupWise 2012 Installation Guide



9.3.3 Installing the GroupWise Windows Client from the Linux GroupWise
2012 Software Image

Install the Windows client on a Windows workstation that meets the system requirements listed in
Section 2.2, “GroupWise User Requirements,” on page 22. The Linux GroupWise 2012 software image
includes the Windows client software.

1 On the Linux server where the Windows client software is located, set up a Samba share to
provide access to the Windows client software.
If you need assistance with this task, follow the instructions for your version of Linux
¢ “Setting up Samba on OES Linux” on page 217
¢ “Setting Up Samba on SLES” on page 221

2 On the Windows workstation where you want to install the WIndows client software, map a
drive to the Samba share that you created in Step 1

If you need assistance with this task, follow the instructions for your version of Linux:
¢ “Mapping a Drive to a Samba Share on an OES Linux Server” on page 220
¢ “Mapping a Drive to a Samba Share on SLES” on page 222
3 Change to the win32 subdirectory through the Samba share on the Linux server, then run

setup.exe.

i'-.% GroupWise - Welcome x|

Welcome to the InstallShield Wizard for
GroupWise

The InstallShield(R) Wizard will allow you to medify, repair, or
remave GroupWise. To continue, dick Next.

< Bacl: I Next = I Cancel

4 Click Next to begin the installation.

5 Skip to Step 4 in Section 9.3.2, “Installing the GroupWise Windows Client from the Windows
GroupWise 2012 Software Image,” on page 214 to continue with the standard Windows client
installation process.

Setting up Samba on OES Linux

In order to access the Windows client software on a Linux server, you can set up a Samba share to the
client directory, either in the downloaded GroupWise 2012 software image or in the software
distribution directory, if you have created one on the Linux server.

¢ “Configuring NetWare Core Protocol (NCP)” on page 218
¢ “Installing Samba” on page 218

¢+ “Logging In to iManager” on page 218

¢ “Creating a User to Manage the Samba Share” on page 219
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¢ “Configuring the eDirectory Universal Password for Samba” on page 219

¢ “Setting the eDirectory Universal Password for the Samba Administrator User” on page 219
¢ “Creating a Samba Share” on page 219

¢ “Setting the eDirectory Rights for the Samba Share” on page 220

¢ “Testing Samba on the OES Linux Server” on page 220

Configuring NetWare Core Protocol (NCP)

1 In a terminal window on the OES Linux server, become root by entering su - and the root
password.

2 Enter the following command to create the NCP volume:
ncpcon create volume volume name /directory
2a Replace volume name with a unique name for the location of the Windows client software
2b Replace directory with the full path to the Windows client software, for example:
/opt/novell/groupwise/software/client
3 Verify that the volume has been created:
more /etc/opt/novell/ncpserv.conf
The new volume should be listed at the end of the NCP server configuration file.
4 Restart the Novell eDirectory daemon:
rcndsd restart

5 Continue with Installing Samba.

Installing Samba
If you installed Samba when you installed OES Linux, skip to “Logging In to iManager” on page 218.
If you did not install Samba when you installed OES Linux, install it now:

1 Start YaST.

2 Under Groups, click Open Enterprise Server, then click OES Install and Configuration.
3 Under OES Services, select Novell Samba, then click Accept.

4 Follow the prompts to install Novell Samba.

5 Continue with Logging In to iManager.

Logging In to iManager
1 Access the following URL:

https://ip address/nps/servlet/webacc?taskid=fw Startup

Replace ip_address with the IP address of the OES Linux server.

2 Specify the eDirectory administrator user name, such as admin.users.novell, the password for
the user name, and the IP address of the eDirectory tree, then click Login.

3 Continue with Creating a User to Manage the Samba Share.
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Creating a User to Manage the Samba Share

1 IniManager, click Users > Create User.

2 In the Username field, specify a unique user name for accessing the Samba share from Windows,
such as gwclient.

3 In the Last name field, provide a last name because it is a required field.

4 In the Context field, browse to and client the eDirectory context where you want to create the
new User object.

5 Type, then retype the password for the new user.

IMPORTANT: Any users who map a drive to the Samba share need to know this user name and
password in order to map the drive.

6 Click OK to create the Samba user for the Windows client Samba share.
7 Click Users to close the Users menu.

8 Continue with Configuring the eDirectory Universal Password for Samba.

Configuring the eDirectory Universal Password for Samba

1 Click Passwords > Password Policies.
2 Click Samba Default Password Policy.

3 On the Policy Assignment tab, browse to and click the name of the Samba User object that you
created in “Creating a User to Manage the Samba Share” on page 219, then click OK to add the
user to the list.

4 Click OK to complete the process.

5 Continue with Setting the eDirectory Universal Password for the Samba Administrator User.

Setting the eDirectory Universal Password for the Samba Administrator User

1 Under Passwords, click Set Universal Password.

2 Browse to and click the name of the Samba User object, then click OK.

3 Specify the password for the Samba user, retype the password for confirmation, then click OK.
4 Click Passwords to close the Passwords menu.

5 Continue with Creating a Samba Share.

Creating a Samba Share

1 Click File Protocols, then click Samba.
2 Browse to and click the name of the Server object where you are setting up the Samba share.
3 On the Shares tab, create a new Samba share for the client directory on the Linux server:
3a Click New.
3b Specify a unique name for the Samba share, such as gwclient.

3c Specify the full path name to the client directory on the Linux server, for example:

/opt/novell/groupwise/software/client

3d Select Read-Only.

Write access is not required in order to install the Windows client software from the Linux
server.

Installing the GroupWise Client 219



220

3e Click OK to add the location to the list of Samba shares, then click Close.
3f Click File Protocols to close the File Protocols menu.

4 Continue with Setting the eDirectory Rights for the Samba Share.

Setting the eDirectory Rights for the Samba Share

1 Click Files and Folders, then click Properties.

2 Browse to and click the name of the Linux partition or directory where you created the new
share, then click OK.

3 Click Rights.

4 In the Add Trustee field, browse to and click the name of the Samba User object, then click OK.
5 Under Inherited Rights Filter, select Read, then click OK.

6

Continue with Testing Samba on the OES Linux Server.

Testing Samba on the OES Linux Server

1 Double-click the Home Directory icon on the Linux desktop.
2 Click @

3 In the Location field, type smb://user nameeip address
3a Replace user name with the user name of the Samba administrator user.
3b Replace ip_address with the IP address of the Linux server.

The File Browser should display all Samba shares, including the new one that you created
for the Windows client software.

4 Return to Step 2 in Section 9.3.3, “Installing the GroupWise Windows Client from the Linux
GroupWise 2012 Software Image,” on page 217

Mapping a Drive to a Samba Share on an OES Linux Server

1 On the Windows server, right-click N on the Windows taskbar, then click Novell Map Network
Drive.

2 Select the drive letter to map to the NCP volume on the OES Linux server.
3 Specify the network path to the NCP volume in the following format:

\\linux hostname\ncp volume
3a Replace linux_hostname with the hostname of the OES Linux server.
3b Replace ncp volume with the name of the NCP volume that you just created.

4 For the network user name, specify the fully qualified Samba user name for eDirectory., such as
gwclient.users.novell.

5 Click Map.
6 Click OK.

The mapped drive to the OES Linux server opens in Windows Explorer and can now be accessed
from Windows.

7 Return to Step 3 in Section 9.3.3, “Installing the GroupWise Windows Client from the Linux
GroupWise 2012 Software Image,” on page 217.
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Setting Up Samba on SLES

In order to access the Windows client software on a Linux server, you can set up a Samba share on the
Linux server to the client directory, either in the downloaded GroupWise 2012 software image or in

the software distribution directory, if you have created one on the Linux server.

¢ “Preparing Your Firewall to Allow Samba Connections” on page 221

¢ “Configuring the Samba Server” on page 221

¢ “Configuring the Samba Web Administration Tool (SWAT)” on page 221
¢ “Accessing SWAT” on page 221

¢ “Setting the Samba User Name and Password” on page 222

¢ “Creating a Samba Share” on page 222

Preparing Your Firewall to Allow Samba Connections

1 In YaST, click Firewall, then click Interfaces.
2 Click Change, select Internal Zone, then click OK.
3 Click Next to view the summary, then click Finish.

4 Continue with Configuring the Samba Server.

Configuring the Samba Server

1 In YaST, click Network Services > Samba Server.

2 Specify a workgroup or domain name, then click Next.

For use in your GroupWise system, the Samba server does not need to be part of a workgroup or

domain, so it does not matter what you put in this field. For example, you could use
GWCLIENT.

3 Select Not a Domain Controller, then click Next.

For use in your GroupWise system, the Samba server does not need to be a domain controller.

4 Under Service Start, select During Boot.

Because you prepared the firewall in “Preparing Your Firewall to Allow Samba Connections” on

page 221, the Firewall Settings section shows that the firewall port for Samba is already open.
5 Click OK to finish the basic configuration of the Samba server.
6 Continue with Configuring the Samba Web Administration Tool (SWAT)

Configuring the Samba Web Administration Tool (SWAT)

1 In YaST, click Network Services > Network Services (xinetd).

2 Select Enable.

3 In the Currently Available Services list, select swat, then click Toggle Status (On or Off).
SWAT is off by default; this turns it on.

4 Click Finish.

5 Continue with “Accessing SWAT” on page 221

Accessing SWAT

1 Display SWAT in your Web browser with the following URL:

Installing the GroupWise Client

221



http://localhost:901

2 Specify the root user name and password, then click OK.

3 On the SWAT toolbar, click Status to verify that smbd and nmbd are running.
It is not necessary for winbindd to be running.

4 Continue with Setting the Samba User Name and Password.

Setting the Samba User Name and Password

1 On the SWAT toolbar, click Password.

2 In the User Name field, specify a unique user name for use when mapping a drive to the Samba
share, such as gwclient.

3 Type, then retype, the password for the new user, then click Add User.

IMPORTANT: Any users who map a drive to the Samba share need to know this user name and
password in order to map the drive.

4 Continue with Creating a Samba Share.

Creating a Samba Share

1 On the SWAT toolbar, click Shares.

2 In the Create Share field, type a unique name for the share, such as gwclient, then click Create
Share.

3 In the Path field, specify the full path name to the client directory on the Linux server.
4 Leave the Read Only field set to the default of Yes.

Write access is not required in order to install the Windows client software from the Linux
server.

5 In the Available field, select Yes.
6 Click Commit Changes.
The Samba share on the Linux server is now ready for access from a Windows workstation.

7 Return to Step 2 in Section 9.3.3, “Installing the GroupWise Windows Client from the Linux
GroupWise 2012 Software Image,” on page 217.

Mapping a Drive to a Samba Share on SLES

1 In Windows Explorer, right-click the Computer object, then click Map network drive.
2 In the Drive field, select the drive letter for the new Samba share.

3 In the Folder field, specify the location of the Samba share in the following format:

\\ip address\share name

3a Replace ip address with the IP address of the Linux server.

3b Replace share name with the name of the new Samba share where the Windows client
software is available.

4 Deselect Reconnect to logon.
5 Select Connect using different credentials.

6 Specify the Samba share user name and password, then click OK.
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9.3.4

9.35

9.4

The Samba share for the OES Linux file system opens in Windows Explorer and can now be
accessed from Windows.

7 Return to Step 3 in Section 9.3.3, “Installing the GroupWise Windows Client from the Linux
GroupWise 2012 Software Image,” on page 217.

Implementing System-Wide Windows Client Rollouts

For a system-wide rollout of the GroupWise client software, see “Distributing the GroupWise
Windows Client” in “Client” in the GroupWise 2012 Administration Guide.

Starting the Windows Client

At startup, the GroupWise Windows client needs to know the location (IP address/hostname and
port number) of the user’s post office. There are three ways that the client can get this information:

¢ If the user is logged into eDirectory, the GroupWise client can read eDirectory for the post

office’s location.

¢ If the user is not logged into eDirectory, the GroupWise client can use a GroupWise name server
to get the user’s post office location.

A GroupWise name server is a DNS hostname entry that defines the IP address of the post
office’s POA. During startup, the GroupWise client automatically looks for the GroupWise name
server in DNS. For information about creating a GroupWise name server, see “Post Office
Agent” in the GroupWise 2012 Administration Guide.

¢ The user can provide the post office location when prompted.
To start the GroupWise Windows client for the first time:

1 Double-click the GroupWise icon on the Windows desktop.

2 Enter the password and post office address information, then click OK.

See also “Getting Started” in the GroupWise 2012 Windows Client User Guide.

What's Next

For information about using the features in the GroupWise Windows client, click Help > Help Topics,
or Help > User Guide in the client. The user guides are also available on the GroupWise 2012
Documentation Web site (http://www.novell.com/documentation/groupwise2012).
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Using Novell Messenger with GroupWise

Novell Messenger is a corporate-based, secure instant messaging solution that supports instant
messaging, presence, and archiving of conversations. The Messenger client integrates with the
GroupWise Windows client to provide access to instant messaging features from within the
GroupWise Windows client.

Novell Messenger is installed separately from GroupWise and does not rely on your GroupWise
system. All Messenger information is stored in eDirectory, not in GroupWise databases. For more
information, see:

¢ Novell Messenger 2.2 Installation Guide

¢ GroupWise and Messenger Quick Start (http://www.novell.com/documentation/groupwise2012/
pdfdoc/gw2012_gs_messenger22/gw2012_qs_messenger22.pdf)
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Using the Novell Data Synchronizer
Mobility Pack with GroupWise

You can use Novell Data Synchronizer to synchronize email and other Personal Information Manager
(PIM) data from Novell GroupWise to mobile devices. The Mobility Pack includes Data
Synchronizer, the GroupWise Connector, and the Mobility Connector. Additional connectors can be
added to a Synchronizer system to synchronize GroupWise data to other supported applications.

For more information, see:

¢ Novell Data Synchronizer Documentation Web site (http://www.novell.com/documentation/
datasynchronizerl)

¢ Novell Data Synchronizer Connectors Documentation Web site (http://www.novell.com/
documentation/datasync_connectors1)
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Using Novell Vibe with GroupWise

Novell Vibe enhances GroupWise by providing easy document management and document sharing,
team calendars and task lists, workflows, discussion threads, wikis, blogs, RSS feeds, and more.

For more information, see:
¢ Novell Vibe 3 Documentation Web site (http://www.novell.com/documentation/vibe32)

¢ “Configuring GroupWise for Use with Novell Vibe” in the GroupWise 2012 Interoperability Guide

¢ GroupWise and Vibe Quick Start (http://www.novell.com/documentation/groupwise2012/pdfdoc/
gw2012_gs_vibe/gw2012_gs_vibe.pdf)
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I I I Update

¢ Chapter 13, “What’s New in GroupWise 2012,” on page 233

¢ Chapter 14, “Understanding the Update Process,” on page 239

¢ Chapter 15, “Migrating Away from NetWare,” on page 245

¢ Chapter 16, “Preparing Your GroupWise 8 System for the Update,” on page 249
¢ Chapter 17, “Installing the GroupWise 2012 Software,” on page 251

¢ Chapter 18, “Updating the Primary Domain,” on page 257

¢ Chapter 19, “Updating Secondary Domains,” on page 259

¢ Chapter 20, “Updating Post Offices,” on page 261

¢ Chapter 21, “Updating the GroupWise Internet Agent,” on page 265

¢ Chapter 22, “Updating GroupWise WebAccess,” on page 267

¢ Chapter 23, “Updating the Calendar Publishing Host,” on page 273

¢ Chapter 24, “Updating GroupWise Monitor,” on page 277

¢ Chapter 25, “Updating Users” GroupWise Windows Clients,” on page 281

¢ Chapter 26, “Updating Earlier GroupWise Systems to Version 2012,” on page 283
¢ Chapter 27, “Facilitating Coexistence with NetWare,” on page 285
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13.1

What’s New in GroupWise 2012

GroupWise 2012 provides substantial improvements over GroupWise 8 in six areas:

¢ Section 13.1, “GroupWise Windows Client,” on page 233

¢ Section 13.2, “GroupWise WebAccess,” on page 234

Section 13.3, “GroupWise WebAccess Mobile,” on page 234
Section 13.4, “GroupWise Agents and Applications,” on page 234

*

*

*

Section 13.5, “GroupWise Administration,” on page 236

¢ Section 13.6, “GroupWise Video Demonstrations,” on page 237

GroupWise Windows Client

Substantial functionality has been added to the GroupWise Windows client to bring new
convenience to frequently used features and to add new functionality. When you modify existing
appointments by changing the subject, body text, attachments, and so on, changes display
automatically in recipients’ Calendars. However, when you modify the date, time, or place, recipients
have the opportunity to re-accept the appointment. Appointment modifications also carry through to
delegated appointments. The Multi-User Calendar now includes week, month, and year views, with
adjustable columns. Scheduling recurring appointments is much easier, as is editing attached
documents. Those who share folders can enjoy sharing an entire folder tree in a single operation.
Name completion remembers who you selected last time and displays the most relevant users first.
Integrations have been added for Skype and the Windows 7 taskbar. Speller technology has been
upgraded to provide higher quality for all supported languages.

For information about using new features in the GroupWise Windows client, click Help > What’s New,
or see “What’s New in the GroupWise 2012 Windows Client” in the GroupWise 2012 Windows Client
User Guide.

The following Windows client enhancements have been added for administrators:

¢ The GroupWise Windows client software has been added to the downloaded Linux GroupWise
2012 software image to simplify distribution of the Windows client.

See Section 9.3.3, “Installing the GroupWise Windows Client from the Linux GroupWise 2012
Software Image,” on page 217.

¢ The GroupWise SetupIP software has been added to the downloaded Linux GroupWise 2012
software image to simplify distribution of the Windows client.

See “Using GroupWise AutoUpdate and SetuplIP to Distribute the GroupWise Windows Client”
in “Client” in the GroupWise 2012 Administration Guide.

¢ The GroupWise Windows client software has been enhanced so that it is much easier to install
using ZENworks Configuration Management.

See “Using ZENworks Configuration Management to Distribute the GroupWise Windows
Client” in “Novell ZENworks” in the GroupWise 2012 Interoperability Guide.
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13.3

13.4

¢ Video demonstrations are available for installing the GroupWise 2012 Windows client:

¢+ Windows Client Installation on Windows 7 from a Linux Server (https://
www.youtube.com/watch?v=wNxvvEF9xnM)

¢ Windows Client Installation on Windows 7 from the GroupWise Media (https://
www.youtube.com/watch?v=6]qKA5joXQ8)

¢ Windows Client Installation on Windows XP from a Linux Server (http://
www.youtube.com/watch?v=a3tmY1lmeL_E)

+ Windows Client Installation on Windows XP from the GroupWise Media (http://
www.youtube.com/watch?v=M363C_5uSSA)

GroupWise WebAccess

Substantial functionality has been added to GroupWise WebAccess to bring it closer to the
functionality available in the GroupWise Windows client. The Messages list can be sorted by any
column, in ascending or descending order. Addressing messages is easier with the new Address
Selector, rather than going into the Address Book. Photos can be added to contacts in your personal
address books. Managing personal groups is easier. You can schedule recurring appointments. You
can create HTML and plain text signatures, and the same signatures are available in WebAccess and
in the Windows client. The Busy Search interface has been substantially improved.

For information about using new features in GroupWise WebAccess, click E3 Help > What’s New in
GroupWise 2012 WebAccess, or see “What’s New In GroupWise 2012 WebAccess” in the GroupWise
2012 WebAccess User Guide.

The following WebAccess enhancements have been added for administrators:
¢ As an administrator, you can provide contact information for users who forget their passwords.
See “Helping Users Who Forget Their GroupWise Passwords” in “WebAccess” in the GroupWise
2012 Administration Guide.
¢ A video demonstration is available for installing GroupWise 2012 WebAccess on Linux:

¢ Linux WebAccess Installation (https://www.youtube.com/watch?v=gaeXakwmXpM)

GroupWise WebAccess Mobile

GroupWise 2012 includes a new WebAccess interface designed for use on the Apple iPad. It enables
you to access your GroupWise mailbox from your iPad with the standard iPad look and feel. You can
compose, retract, read, reply to, and forward email messages, as well as check the status of sent items.
You can schedule appointments for yourself and others, as well as accept, decline, and delegate
appointments. You can create tasks for yourself and others, and view the Tasklist folder. Robust
search capabilities are available.

For information about using GroupWise WebAccess on tablets such as the Apple iPad, click More >
Help in WebAccess, or see the GroupWise 2012 WebAccess Mobile User Guide.

GroupWise Agents and Applications

¢ Section 13.4.1, “Message Transfer Agent,” on page 235
¢ Section 13.4.2, “Post Office Agent,” on page 235
¢ Section 13.4.3, “Document Viewer Agent,” on page 235
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¢ Section 13.4.4, “GroupWise Internet Agent,” on page 236
Section 13.4.5, “GroupWise WebAccess,” on page 236

*

*

Section 13.4.6, “GroupWise Calendar Publishing Host,” on page 236

*

Section 13.4.7, “GroupWise Monitor,” on page 236

*

Section 13.4.8, “Demonstration Videos for Installing the Agents and WebAccess,” on page 236

13.4.1 Message Transfer Agent

The GroupWise 2012 Message Transfer Agent (MTA) includes no changes from the previous release.

13.4.2  Post Office Agent

¢ The GroupWise 2012 Post Office Agent (POA) supports the WebAccess Application as a SOAP
client, eliminating the need for the WebAccess Agent.
See the following sections of the GroupWise 2012 Administration Guide for configuration details:
¢ “Supporting SOAP Clients” in “Post Office Agent”
¢ “Multiple POAs for a WebAccess Application” in “WebAccess”

¢ The GroupWise 2012 POA can be configured to use the newly independent Document Viewer
Agent (DVA) to convert attached documents into HTML format for indexing, instead of the
Document Converter Agent (DCA) that is integrated into the POA.

See “Enabling the Document Viewer Agent (DVA) for Indexing” in “Post Office Agent” in the
GroupWise 2012 Administration Guide.

¢ The GroupWise 2012 POA maintains a symbolic link to a file named poa. currentlog, where
poa is the name of the POA eDirectory object file. This link points to the current POA log file,
regardless of the POA log file name, which includes the log file creation date and an
incrementing extension for multiple log files created on the same date. This facilitates
monitoring the current POA log file using the tail command.

See “Viewing POA Log Files” in “Post Office Agent” in the GroupWise 2012 Administration Guide.

¢ In the GroupWise 2012 POA Web console, the POA displays thread IDs, so that you can track the
activity of specific threads through one or more POA log files.

See “Monitoring and Tracking POA Threads” in “Post Office Agent” in the GroupWise 2012
Administration Guide.

13.4.3 Document Viewer Agent

¢ The Document Viewer Agent (DVA) that was previously part of WebAccess is now an
independent agent, so that its capabilities can be used by the POA as well as by WebAccess.
See Section 8.1, “GroupWise Agent Overview,” on page 175.

¢ You can set up multiple DVAs to provide improved responsiveness for WebAccess users.

See “Scaling Your DVA Installation” in “Document Viewer Agent” in the GroupWise 2012
Administration Guide.

¢ The DVA can be installed along with the POA, or it can be installed separately.

See “DVA Installation on Additional Servers” in “Document Viewer Agent” in the GroupWise
2012 Administration Guide.
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13.4.5

13.4.6

13.4.7

13.4.8

13.5

GroupWise Internet Agent

¢ When the GroupWise 2012 Internet Agent (GWIA) is configured to use a relay server and an
outbound message is undeliverable, the GWIA transfers the undeliverable message received
from the relay server into the sender’s GroupWise mailbox. This improved functionality makes
undeliverable status more readily available to GroupWise users, as opposed to needing to check
the properties of the sent item to see whether it has been delivered.

GroupWise WebAccess

¢ To simplify WebAccess administration, the WebAccess Agent has been eliminated in GroupWise
2012. The WebAccess Application now communicates directly with the Post Office Agent.

See Section 5.1, “GroupWise WebAccess Application Overview,” on page 103.

¢ GroupWise WebAccess is no longer configured in ConsoleOne. Instead, it is configured in the
webacc. cfg file.

See “WebAccess” in the GroupWise 2012 Administration Guide.

GroupWise Calendar Publishing Host

¢ The GroupWise 2012 Calendar Publishing Host includes two new configuration settings:
¢ Auto-refresh capability for published calendars

¢ Selection of a default published calendar view

See “Configuring the Calendar Publishing Host” in “Calendar Publishing Host” in the
GroupWise 2012 Administration Guide.

GroupWise Monitor

¢ The GroupWise Monitor Application is no longer configured in ConsoleOne. Instead, it is
configured in the gwmonitor. cfg file.

See “Configuring the Monitor Application” in “Monitor” in the GroupWise 2012 Administration
Guide.

Demonstration Videos for Installing the Agents and WebAccess

Video demonstrations are available for installing the GroupWise 2012 agents and WebAccess:

¢ Linux MTA and POA Installation (http://www.youtube.com/watch?v=8F3GIfF5qQw)

¢ Linux GWIA Installation (http://www.youtube.com/watch?v=1aO3RTirEUU)

+ Windows MTA, POA, and GWIA Installation (http://www.youtube.com/watch?v=0zPqfgs9Eew)
¢ Linux WebAccess Installation (https://www.youtube.com/watch?v=gaeXakwmXpM)

GroupWise Administration

* You can define the URL where free/busy schedule status is published for a user or a resource in
an external email system. This enables GroupWise users to receive Busy Search results from the
external user or resource along with Busy Search results from other GroupWise users.
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13.6

13.6.1

13.6.2

See “Configuring External Users and Resources to Appear in GroupWise Busy Searches” in
“System” in the GroupWise 2012 Administration Guide.

In the GroupWise Windows client, users can set the format that they want to use for replies to
GroupWise items. The Reply Format options in ConsoleOne control which reply format options
are available to users in the GroupWise client.

See “Environment Options: Reply Format” in “Client” in the GroupWise 2012 Administration
Guide.

By default, the POA automatically updates the post office database (wphost . db) with changes to
the Address Book as they occur. As a result, whenever a Caching or Remote client connects to
the GroupWise system, it automatically downloads any updates to the Address Book that have
occurred since the last time it connected. Because the Address Book updates are stored as
records in the post office database, this feature causes the post office database to grow in size as

time passes. You can now disable this functionality, if necessary.

See “Controlling Address Book Synchronization for Caching and Remote Client Users” in
“Systemin the GroupWise 2012 Administration Guide”.

¢ The online help in the GroupWise agent server consoles, agent Web consoles, and utilities has

been improved to link directly to specifically related topics in the GroupWise online

documentation, instead of linking to the GroupWise Documentation Web site. This provides

more convenient access to detailed documentation for the GroupWise agents and utilities.

GroupWise Video Demonstrations

Video demonstrations help you use the new features in GroupWise 2012 quickly and easily.

¢ Section 13.6.1, “Agent Installation Demonstrations,” on page 237
¢ Section 13.6.2, “Windows Client Installation Demonstrations,” on page 237
¢ Section 13.6.3, “Windows Client Demonstrations,” on page 238

¢ Section 13.6.4, “WebAccess Demonstrations,” on page 238

Agent Installation Demonstrations

GroupWise 2012 Beta videos by our GroupWise trainer:

+ Linux MTA and POA Installation
+ Linux GWIA Installation
+ Windows MTA, POA, and GWIA Installation

+ Linux WebA-ccess Installation

Windows Client Installation Demonstrations

GroupWise 2012 Beta videos by our GroupWise trainer:

+ Windows Client Installation on Windows 7 from a Linux Server
¢ Windows Client Installation on Windows 7 from the GroupWise Media

+ Windows Client Installation on Windows XP from a Linux Server

¢ Windows Client Installation on Windows XP from the GroupWise Media
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13.6.3 Windows Client Demonstrations

GroupWise 2012 What's New videos:

¢ Appointment Modification When Changing the Subject, Message, or To List
¢ Appointment Modification When Changing the Place or Time
¢ Appointment Modification for Delegated Appointments
¢ Appointment Duplication for Creating Appointment Templates
¢ Appointment Conflict Resolution for Auto-Accepted Appointments
¢ Recurring Appointments
¢ Multi-User Calendar
¢ Folder-Tree Sharing
¢ Relevance in Name Completion, Category Lists, and Favorites Folder
¢ Save As Dialog
¢ Sent Item Properties
¢ SMS, Skype, Click-to-Call
¢ Windows 7 Taskbar Integration
For additional videos and to get acquainted with some GroupWise engineers and testers, see

GroupWise 2012 Windows Client “How To” Demos (http://www.novell.com/products/groupwise/
resource-library.html#windowsdemos).

13.6.4 WebAccess Demonstrations

GroupWise 2012 What's New videos:

¢ Contact Enhancements
¢ General Enhancements
¢ Graphical Busy Search
¢+ HTML Signatures
¢ Recurring Appointments
* WebAccess Mobile (Tablet Interface)
For additional videos and to get acquainted with some GroupWise engineers and testers, see

GroupWise 2012 WebAccess “How To” Demos (http://www.novell.com/products/groupwise/
resource-library.html#webdemos).
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Understanding the Update Process

You can update a Novell GroupWise 5.x, 6.x, 7, or 8 system to GroupWise 2012.

NOTE: To update a GroupWise 4.x system to GroupWise 2012, you must first update the system to at
least GroupWise 5.x. The functionality to update from GroupWise 4.x is not part of the GroupWise
2012 Administrator snap-ins to ConsoleOne.

If you are not updating from GroupWise 8, review Chapter 26, “Updating Earlier GroupWise
Systems to Version 2012,” on page 283 before beginning the update process.

Before you begin updating any aspect of your GroupWise system to GroupWise 2012, review the
following sections to help you plan a successful update strategy:

¢ Section 14.1, “Understanding How to Handle NetWare in Your Existing GroupWise System,” on
page 240

¢ Section 14.2, “Understanding eDirectory Schema Extensions,” on page 240

¢ Section 14.3, “Understanding GroupWise Software Updates,” on page 240

¢ Section 14.4, “Understanding Domain and Post Office Database Updates by the GroupWise
Agents,” on page 241

¢ Section 14.5, “Understanding GroupWise Client Updates,” on page 242

¢ Section 14.6, “Understanding Internet Agent Updates,” on page 242

¢ Section 14.7, “Understanding WebAccess Updates,” on page 242

¢ Section 14.8, “Understanding Calendar Publishing Host Updates,” on page 243
¢ Section 14.9, “Understanding Monitor Updates,” on page 243

¢ Section 14.10, “Understanding GroupWise Gateway Compatibility,” on page 243

IMPORTANT: After you understand the update process in general, you are ready to update specific
components of your existing GroupWise system. Do not start updating your GroupWise system until
you have a solid understanding of the entire process.

For a large GroupWise system, you might need to maintain a mixed-version environment as you roll
out GroupWise 2012. For a table showing which GroupWise 7 and 8 components can be used with
GroupWise 2012, see Appendix A, “GroupWise Version Compatibility,” on page 289.
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14.1

14.2

14.3

14.3.1

14.3.2

Understanding How to Handle NetWare in Your Existing
GroupWise System

GroupWise 2012 does not include GroupWise agents that run on NetWare, because NetWare has
entered the Extended Support phase of the Novell Support Life cycle. For more information, see TID
7003092, “NetWare Support,” in the Novell Support Knowledgebase (http://www.novell.com/
support). If you do not have any NetWare servers in your GroupWise system, skip to Section 14.2,
“Understanding eDirectory Schema Extensions,” on page 240.

If you currently have NetWare servers in your GroupWise system, you must decide how to handle
them as you move forward with your GroupWise 2012 update. You have several alternatives:

¢ Migrate NetWare servers to OES Linux.

¢ Move domains and post offices from NetWare servers to supported Linux servers.

¢+ Move domains and post offices from NetWare servers to supported Windows servers.
You might decide to use one or more of these alternatives as you update your GroupWise system to
GroupWise 2012. Instructions for each alternative are provided in Chapter 15, “Migrating Away from

NetWare,” on page 245. However, it is important that you understand the overall update process
before you begin making any changes to the servers in your existing GroupWise system.

Understanding eDirectory Schema Extensions

GroupWise 2012 does not include any new eDirectory schema extensions compared with GroupWise
8.

Understanding GroupWise Software Updates

The GroupWise 2012 system requirements are different from previous GroupWise system
requirements. To review the system requirements, see Chapter 2, “GroupWise System
Requirements,” on page 19.

¢ Section 14.3.1, “Software Distribution Directory,” on page 240
¢ Section 14.3.2, “ConsoleOne,” on page 240

Software Distribution Directory

The GroupWise Installation program helps you copy the GroupWise 2012 software (administration,
agents, Windows client, and so on) to a GroupWise software distribution directory. This can be an
existing software distribution directory or a new software distribution directory.

ConsoleOne

GroupWise 2012 is administered through ConsoleOne, using the version listed in Section 2.1,
“GroupWise Administration Requirements,” on page 19. You can use the same version of
ConsoleOne to administer earlier GroupWise components in your GroupWise system. However,
earlier versions of ConsoleOne should not be used to administer GroupWise 2012 domains, post
offices, agents, or other GroupWise 2012 objects.

The Linux and Windows versions of ConsoleOne are included in the downloaded GroupWise 2012
software image.
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IMPORTANT: You must use the version of ConsoleOne that is included with GroupWise 2012. It is
not the same as the version of ConsoleOne that comes with OES Linux or that can be downloaded
from Novell Downloads.

You can install the GroupWise 2012 version of ConsoleOne at the same time as the other GroupWise
2012 software. For instructions, see “ConsoleOne” on page 32.

For more information about ConsoleOne, see “ConsoleOne Administration Tool” in “System” in the
GroupWise 2012 Administration Guide.

Understanding Domain and Post Office Database Updates
by the GroupWise Agents

Functionality enhancements in GroupWise 2012 require the GroupWise domain and post office
databases to be updated with new records and fields, similar to the schema extensions that are
sometimes required for eDirectory. Each domain is updated when you install and start the
GroupWise 2012 MTA. Each post office is updated when you install an start the GroupWise 2012
POA.

The following diagram illustrates the required update sequence.

GroupWise 2012 Primary
MTA Domain
e o Secondary GroupWise 2012
&) > &

Domain MTA
( N
&

g
4

P—rwe HF—rw 0 y—¢@P

GroupWise 2012 Post Office  GroupWise 2012  Post Office  Post Office  GroupWise 2012
POA POA POA

1. Update the primary domain first, so that correct replication of GroupWise 2012 information can
take place as you update secondary domains and post offices.

2. Update the post offices in the primary domain.
or
Update secondary domains.

3. Update the post offices in the updated secondary domains.

The first time you run the GroupWise 2012 MTA against a domain, the MTA rebuilds the domain
database (wpdomain.db), so that the database includes the records required for new GroupWise 2012
information. The MTA uses a new domain dictionary file (gwdom. dc) to rebuild the database for use
with GroupWise 2012.

Likewise, the first time you run the GroupWise 2012 POA against the post office, the POA rebuilds
the post office database (wphost . db), so that the database includes the new records required for
GroupWise 2012 information. The POA uses a new post office dictionary file (gwpo . dc), which it
requests from the MTA in the updated owning domain, to rebuild the database for use with
GroupWise 2012. A user cannot run GroupWise 2012 Windows client until his or her post office has
been updated.
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14.5

14.6

14.7

Understanding GroupWise Client Updates

After a post office is updated to version 2012, users can run the GroupWise 2012 Windows client on
workstations that meet the requirements listed in Section 2.2, “GroupWise User Requirements,” on
page 22. If necessary, they can also continue to run their older GroupWise Windows client, but they
will not have GroupWise 2012 functionality.

IMPORTANT: Users who need to proxy into other users’ mailboxes should not update to the
GroupWise 2012 Windows client until the proxy users’ post office has been updated to version 2012.
GroupWise 2012 Windows client users cannot proxy into users’ mailboxes that have not been
updated to GroupWise 2012.

For a list of new features in the GroupWise 2012 Windows client, see Chapter 13, “What’s New in
GroupWise 2012,” on page 233.

Understanding Internet Agent Updates

Older GWIAs can run against GroupWise 2012 domains and post offices, which means that you can
continue to use older GWIAs until all domains and post offices are updated to version 2012.

For a list of new features in the GroupWise 2012 GWIA, see Chapter 13, “What’s New in GroupWise
2012,” on page 233.

IMPORTANT: If you are updating to GroupWise 2012 from GroupWise 7 or earlier, you need to
understand the important changes to where GWIA configuration information is stored that occurred
in GroupWise 8. To understand the changes, see “Using Internet Agent Startup Switches” in
“Internet Agent” in the GroupWise 8 Administration Guide.

Understanding WebAccess Updates

As you plan how to update GroupWise WebAccess, you need to understand that the WebAccess
Agent is no longer part of GroupWise 2012. For a discussion of the new architecture, see Section 5.1,
“GroupWise WebAccess Application Overview,” on page 103.

Linux: When you update any software to GroupWise 2012 on a Linux server where the WebAccess
Agent is installed, you are prompted to remove it. You should let the WebAccess Installation
program remove the obsolete WebAccess Agent software for you, because removing the software
is required for the update.

Windows: On a Windows server where the WebAccess Agent is installed, the WebAccess Installation
program does not remove the WebAccess Agent software. You must manually remove it, as
described in Section 22.2.3, “Removing the WebAccess Agent Software,” on page 270.

The Installation program does not remove the associated WebAccess eDirectory objects. You will
manually remove these objects later, as described in Section 22.2.2, “Deleting Obsolete WebAccess
eDirectory Objects,” on page 269.

In GroupWise 8, the WebAccess Agent was responsible for handling access control for WebAccess
users, as described in “Controlling User Access to Mailboxes” in “WebAccess” in the GroupWise 8
Administration Guide. Because GroupWise 2012 no longer has the WebAccess Agent, access control for
WebAccess is handled differently, as described in “Controlling WebAccess Usage” in “WebAccess” in
the GroupWise 2012 Administration Guide.
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14.8

14.9

14.10

For a list of new features in GroupWise 2012 WebAccess, see Chapter 13, “What's New in GroupWise
2012,” on page 233.

IMPORTANT: As long as your GroupWise 2012 system includes GroupWise 8 or earlier domains
that still include WebAccess Agent and WebAccess Application objects in eDirectory, you must run
the version of ConsoleOne that matches the version of the domain and WebAccess components. The
GroupWise 2012 version of ConsoleOne cannot be used to modify WebAccess eDirectory objects.

Understanding Calendar Publishing Host Updates

The Calendar Publishing Host can be updated to GroupWise 2012 at any time after the POA that it
communicates with has been updated.

Understanding Monitor Updates

GroupWise Monitor is not dependent on any other GroupWise agents, so it can be updated to
GroupWise 2012 at any time. GroupWise 2012 Monitor does not include any functionality
enhancements, although it no longer relies on eDirectory objects for its configuration information. All
configuration information is located in the gwmonitor. cfg file instead.

The Installation program does not remove the associated Monitor eDirectory objects. You will
manually remove these objects later, as described in Section 24.2.1, “Deleting Obsolete Monitor
eDirectory Objects,” on page 278.

Understanding GroupWise Gateway Compatibility

There are no known issues with using GroupWise gateways with GroupWise 2012, although
GroupWise gateways are legacy products that are not supported with the current GroupWise
version.
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15.1

Migrating Away from NetWare

GroupWise 2012 does not include GroupWise agents that run on NetWare because NetWare is in the
Extended Support phase of the Novell Support Life cycle. For more information, see TID 7003092,
“NetWare Support,” in the Novell Support Knowledgebase (http://www.novell.com/support).

When your GroupWise system includes NetWare GroupWise agents, you have several alternatives
for updating to GroupWise 2012:
¢ Section 15.1, “Migrating NetWare Servers to OES Linux,” on page 245

¢ Section 15.2, “Migrating Domains and Post Offices from NetWare Servers to Linux Servers,” on
page 246

¢ Section 15.3, “Moving Domains and Post Offices from NetWare Servers to Windows Servers,” on
page 246

¢ Section 15.4, “Re-establishing eDirectory User Synchronization after Migration,” on page 247

¢ Section 15.5, “Migrating a Remote Document Storage Area from a NetWare Server to a Linux or
Windows Server,” on page 247

For assistance with managing your GroupWise system during the migration process, see Chapter 27,
“Facilitating Coexistence with NetWare,” on page 285.

Migrating NetWare Servers to OES Linux

Novell Open Enterprise Server (OES) includes complete instructions for migrating from the NetWare
version or OES to the Linux version or OES. For instructions, see the documentation for the
supported versions of OES Linux:

¢ Open Enterprise Server 2 SP3 Documentation Web site (http://www.novell.com/documentation/
oes2/)

¢ Open Enterprise Server 11 Documentation Web site (http://www.novell.com/documentation/
oesl1l)

In particular, refer to the Migration Best Practices Guide.

IMPORTANT: After the migration from NetWare to OES Linux and before you update to
GroupWise 2012, ensure that your GroupWise system functions correctly with the original version of
the GroupWise software. Ensure that eDirectory user synchronization is functioning on Linux, as
described in Section 15.4, “Re-establishing eDirectory User Synchronization after Migration,” on
page 247.

After you have migrated the NetWare servers where domains and post offices are located to OES
Linux, you are ready to update your GroupWise system to GroupWise 2012. Skip to Chapter 16,
“Preparing Your GroupWise 8 System for the Update,” on page 249.
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15.2

15.3

Migrating Domains and Post Offices from NetWare Servers
to Linux Servers

You can use the GroupWise Server Migration Utility to move domains and post offices from NetWare
servers to Linux servers. For instructions, see the GroupWise Server Migration Guide.

IMPORTANT: After you migrate the domains and post offices to the supported version of Linux and
before you update to GroupWise 2012, ensure that your GroupWise system functions correctly with
the original version of the GroupWise software. Ensure that eDirectory user synchronization is
functioning on Linux, as described in Section 15.4, “Re-establishing eDirectory User Synchronization
after Migration,” on page 247.

After you have migrated the domains and post offices from NetWare to Linux, you are ready to
update your GroupWise system to GroupWise 2012. Skip to Chapter 16, “Preparing Your GroupWise
8 System for the Update,” on page 249.

Moving Domains and Post Offices from NetWare Servers to
Windows Servers

The Windows server where you move domains and post offices must be running a supported version
of Windows Server.
1 Stop all NetWare GroupWise agents on the NetWare server.

2 Map a drive from the Windows server where you want to move the domain and/or post office to
the NetWare server where the domain or post office currently resides.

3 Copy the entire directory structure for the domain and/or post office from the NetWare server to
the Windows server.

For detailed instructions for the copy procedure, see “Moving a Domain” and “Moving a Post
Office” in the GroupWise 2012 Administration Guide:

4 Install the existing version of the GroupWise agents (MTA and POA) on the Windows server,
specifying the new location for the domain and/or post office during the installation process.

NOTE: It is not necessary to install the existing version of the GWIA and WebAccess on the
Windows server. You will simply install the GroupWise 2012 versions at the appropriate time in
the update process.

5 In ConsoleOne, edit the GroupWise Agent objects to use the IP address or DNS hostname of the
Windows server.

6 Make sure that the existing versions of the agents run successfully for the domain and/or post
office in the new Windows location.

IMPORTANT: After the after the move from NetWare to Windows and before you update to
GroupWise 2012, ensure that your GroupWise system functions correctly with the original version of
the GroupWise software. Ensure that eDirectory user synchronization is functioning on Windows, as
described in Section 15.4, “Re-establishing eDirectory User Synchronization after Migration,” on
page 247.

After you have moved the domains and post offices from NetWare to Windows, you are ready to
update your GroupWise system to GroupWise 2012. Continue with Preparing Your GroupWise 8
System for the Update.
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15.4

15.4.1

15.4.2

15.5

Re-establishing eDirectory User Synchronization after
Migration

After you have migrated the MTA from NetWare to Linux or Windows, you must ensure that
eDirectory user synchronization continues uninterrupted.

¢ Section 15.4.1, “Setting the New Agent Platform,” on page 247

¢ Section 15.4.2, “Reconfiguring eDirectory User Synchronization,” on page 247

Setting the New Agent Platform

1 In ConsoleOne, browse to and right-click the MTA object for each migrated MTA, then click
Properties.

2 In the Platform field, change NetWare to Linux or Windows as needed, then click OK.

3 Continue with Reconfiguring eDirectory User Synchronization.

Reconfiguring eDirectory User Synchronization

1 Click Tools > GroupWise System Operations > eDirectory User Synchronization.

2 In the Status column, make sure that at least one MTA displays eDirectory user synchronization

as Enabled.
3 Adjust the assignments for other migrated MTAs as needed.

For complete instructions on using the eDirectory User Synchronization feature in ConsoleOne,

see “Using eDirectory User Synchronization” in “Message Transfer Agent” in the GroupWise
2012 Administration Guide.

4 Click OK to save the updated eDirectory user synchronization configuration.

Migrating a Remote Document Storage Area from a
NetWare Server to a Linux or Windows Server

Refer to TID 7010085, “Remote Documents Migration Procedure,” in the Novell Support
Knowledgebase (http://www.novell.com/support).

Migrating Away from NetWare
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Preparing Your GroupWise 8 System for
the Update

To prepare your GroupWise system to be updated to version 2012, complete the following tasks:

¢ If you are updating from a version of GroupWise earlier than GroupWise 8, update the
eDirectory schema for all trees that contain GroupWise objects, as described in Section 14.2,
“Understanding eDirectory Schema Extensions,” on page 240.

¢ Validate your domain and post office databases to make sure that there are no physical
inconsistencies with the database. If problems exist, you should recover or rebuild the database.
For information about validating, recovering, or rebuilding a database, see the documentation
for your current GroupWise version at the Novell Documentation Web site (http://
www.novell.com/documentation).

¢ Back up each domain or post office immediately before updating it. For information about
backing up your GroupWise databases, see the documentation for your current GroupWise
version at the Novell Documentation Web site (http://www.novell.com/documentation).

¢ Collect the information about your GroupWise system that the GroupWise Installation program
prompts you for as your update the GroupWise software. If you are not completely familiar with
all aspects of your GroupWise system, you might find it helpful to record the information on the
worksheets provided for an initial installation:

¢ “Basic GroupWise System Worksheet” on page 72 (includes administration, domain, post
office, and agent information)

¢ “GroupWise Internet Agent Installation Worksheet” on page 99

¢ “GroupWise WebAccess Installation Worksheet” on page 120

¢ “GroupWise Calendar Publishing Host Installation Worksheet” on page 148
¢ “GroupWise Monitor Installation Worksheets” on page 171

¢ “GroupWise Agent Installation Worksheet” on page 208

¢ Ensure that all GroupWise Windows client user workstations are running a supported version of
Windows.

Preparing Your GroupWise 8 System for the Update = 249


http://www.novell.com/documentation
http://www.novell.com/documentation

250  GroupWise 2012 Installation Guide



17.1

Installing the GroupWise 2012 Software

Before installing the GroupWise 2012 software, review the background information provided in

Chapter 14, “Understanding the Update Process,” on page 239 and complete the tasks listed in

Chapter 16, “Preparing Your GroupWise 8 System for the Update,” on page 249. Then follow the

installation instructions provided for the platform where your GroupWise system is located.

¢ Section 17.1, “Linux: Installing the GroupWise 2012 Software,” on page 251

¢ Section 17.2, “Windows: Installing the GroupWise 2012 Software,” on page 254

Linux: Installing the GroupWise 2012 Software

1 (Conditional) If you are updating from a version of GroupWise earlier than GroupWise 8, make
sure that you have updated the eDirectory schema for eDirectory trees that contain GroupWise
objects, as described in Section 14.2, “Understanding eDirectory Schema Extensions,” on

page 240.

a A W N

OK.

In a terminal window, become root by entering su - and the root password.
Stop the MTA for the primary domain of your GroupWise system.
Run ./install from the root of the downloaded GroupWise 2012 software image.

Select the language in which you want to run the GroupWise Installation program, then click

Novell. GroupWise

View the Readme

View the Quick Start

View the Installation Guide

Create or update a GroupWise system

Install Products

Displays a web page with important information you should read

Displays a high-level checklist of system requirements and installation
steps to guide you through setting up your GroupWise system.

Displays overview and task infonmation that will help you plan, install,
and update a GroupWise system, as well as install additional
components such as GroupVAse WebAccess and GroupWise Intemet

Launches the GroupWise Installation and Setup Advisors. These
advisors step you through the creation of a new GroupWise system or

isting GroupWise syst

Displays the GroupWise components you can individually install once
you've created a GroupWise system.

Installing the GroupWise 2012 Software
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6 Click Create or Update a GroupWise System.

7
8

10

N e e
Introduction
[ ntroduction Welcome to the GroupWwise &dministration Configuration
Program. This program will do the following:
0 9 prog 9
0 ® Install Administration and Agent software
O & Setup the software distribution directory
O * Update an existing Group'ise system or launch
ConsoleCne to allow creation of a new GroupWise system
O
O
Cancel Next

Accept the License Agreement, then click Next.

Follow the prompts to provide the following information from your Basic GroupWise System
Worksheet.

Software Distribution Directory
Software Selection

If the Installation program detects that the WebAccess Agent is installed on the server, it notifies
you that the WebAccess Agent needs to be removed.

(Conditional) If you are prompted to remove the WebAccess Agent from the server, click Yes.

Because this is the primary domain, you must remove an existing WebAccess Agent in order to
update the primary domain to GroupWise 2012. When you update secondary domains, you can
choose to retain an earlier version of WebAccess, including the WebAccess Agent, after you have
updated the domain to GroupWise 2012.

If the Installation program detects that multiple GroupWise components are installed on the
server, a message lists the installed components and prompts you to update all of them. All
components on the server must be updated to GroupWise 2012 at the same time.

(Conditional) If you are prompted to update all GroupWise components on the server, click Yes.

This process updates the software but does not change the configuration of any of the
components. Depending on the number of components to update, this process might take
several minutes.
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11 When the software copying is complete, click Next.

GroupWise Administration Configuration

Create or Update a GroupWise System

[¥] Introduction &re you

[¥] License Agreement ~ Creating a new GroupWise system?

[¥] Softurare Distribution # Updating an existing GroupWise system?
Directory

[¥] Select Software
[¥] Install & Copy Files

[ create or Update a
GroupWise System

a

Cancel | | Hext

12 Retain the default of Updating an Existing GroupWise System, then click Next.

13

14
15

16

On the Update an Existing System page, carefully review the steps that are involved in updating
your GroupWise system from a previous version to GroupWise 2012.

o ‘Groupiise Administration Configuration x

Create or Update a Group¥fise system

[¥] Introduction To update an exisfing Groupvdse sustem, wou must perfom the fallawing steps in order.

[¥] Ucense Agreement
1. Elick Update 1o update ll agants in he primasy domaln. AMeys FIn he W14 b updefe the

o domair databiase firstand e i he POAs o Upda e pist ofics datsbases

[¥] Software Distribution

Directory
[¥] Select Software

2. After verifing thatthe primane domain has been updaded successfully, tun instll fo update
all agents in each secondary domain.

[¥] Copy Files

[¥] Hext Step

5. Users can update the Grouptise client after won’ ve updated their postofiice.

[ create or Update a
GroupWise system

Enter the locafion of the primary domain.

Il J=]

Cancel Previous Update |

More detailed instructions are provided in the sections following the software update
instructions.

Browse to and select the primary domain directory, then click Update.

By specifying the primary domain directory, you inform the GroupWise Installation program
where to copy the GroupWise 2012 data dictionary (. dc) files. Without the GroupWise 2012 .dc
files, the GroupWise MTA cannot rebuild the primary domain database into the structure
required for GroupWise 2012. Having the GroupWise 2012 . dc files in the domain directory is
critical to a successful GroupWise system update.

Click OK to confirm the copying of the .dc files

Install the GroupWise 2012 MTA for the primary domain, as described in “Installing the Linux
GroupWise Agents” on page 183.

(Conditional) If your update to GroupWise 2012 includes migrating to OES Linux, follow the
instructions in “Enabling File Locking on OES Linux” in “System” in the GroupWise 2012
Administration Guide.
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This prepare the OES Linux server for running ConsoleOne with the type of file locking between
servers that protects the integrity of GroupWise databases.

17 Skip to Chapter 18, “Updating the Primary Domain,” on page 257.
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1 (Conditional) If you are updating from a version of GroupWise earlier than GroupWise 8, make

sure that you have updated the eDirectory schema for eDirectory trees that contain GroupWise
objects, as described in Section 14.2, “Understanding eDirectory Schema Extensions,” on
page 240.

Stop the MTA for the primary domain of your GroupWise system.

At a Windows workstation, log in as an Admin equivalent to the eDirectory tree in which you
are updating GroupWise.

Run setup.exe from the root of the downloaded GroupWise 2012 software image.

5 (Conditional) If prompted, select the interface language for the GroupWise Installation program,

then click OK.

On Windows, the GroupWise 2012 software image can be downloaded in a multilanguage
version or an English-only version. When you install from the multilanguage version, all
languages are always installed, regardless of the specific language that you select for running
the Installation program.

The main GroupWise System Installation page appears.

GroupWise - InstallShield Wizard x|

GroupWise 2
Grouphfize Spetem [nstallation

| Displaps important information you should read before installing Grouplafise

| Displaps a high-level checklist of system requirements and installation steps to guide

Wiews the Quick Stark vou through setting up your Groupiwise spstem.

X Displaps overview and tazk information to help you plan, install, and maintain a basic
“iew the Installation Guide Groupiise system and all additional componerts.

Creates or updates a basic Grouphwise system, including Group'wise administration,
Install Groupiwise System the Post Office Agent, the Message Transfer Agent, and the Intemet Agent

| Installs or updates Group'wise ‘Web Access, Groupwise Monitor, the Calendar

Install Mare Camponents Publishing Host, and the Groupiwise ‘Windows client

InistallShield < Back | Mext » | Cancel

6 Click Install GroupWise System, then click Yes to accept the license agreement.

When you update your GroupWise system, you are performing a Standard installation.
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7 Click Next to accept the default of Standard.

GroupWise - InstallShield Wizard

GroupWise
Groupwize Components

IE License Agreement

IE Install Type

D Grouptfize Components
[ Software Plattormn

Installation Guide

Groupwize spstem options:

" Create a new system

" Update an existing system

" Install individual components

Select the Group'wise components you want to install
W

W

[ GroupWise Internet Agent

< Back | Mexst > Cancel

T =

8 Select Update an Existing System, then click Next.

9 Follow the prompts to provide the following information from your Basic GroupWise System

Worksheet.

Software Platform

Administration Options

ConsoleOne Path

Software Distribution Directory

Software Selection
Installation Path

Windows Installation Options

Domain Information
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10

11

12

13
14

When you reach the Update an Existing System page, carefully review the steps that are
involved in updating your GroupWise system from a previous version to GroupWise 2012.

GroupWise - InstallShield Wizard E\
System Update —
Update an existing system C
[¥] License Agreemert . .
[ Install Type l&;pdale an existing Group\Aise spstem, you must perform the following steps in
E Grouptwize Companents . . .
1. Update all agents in the primary domain. Always run the MTA to update the
E Software Platborm domain database first, then run the POAs to update the post office databases.
[¥] Administration Installation
IE Agent Installation 2. After verifying that the primary domain has been updated successfully, update all
agents in the secondary domains
[¥]  Installation Path
] Diomainz / Post Offices 3. Uszers can update the Group'wize client after pou've updated their post offices.
D Spstem Update
Specily the location of the pri domai
D Summary and Modification pecily the location of B prnmary domair.
O Finish | o
Installation Guide < Back | Mest > | Cancel |

More detailed instructions are provided in the sections following the software update
instructions.

Browse to and select the primary domain directory, then click Next.

By specifying the primary domain directory, you inform the GroupWise Installation program
where to copy the GroupWise 2012 data dictionary (. dc) files. Without the GroupWise 2012 .dc
files, the GroupWise MTA cannot rebuild the primary domain database into the structure
required for GroupWise 2012. Having the GroupWise 2012 . dc files in the domain directory is
critical to a successful GroupWise system update.

On the Summary and Modification page, review the information you have provided to the
GroupWise Installation program for your update to GroupWise 2012, modifying information if
needed.

When you are satisfied with the information you have provided, click Install to update your
primary domain to GroupWise 2012.

When the installation is completed, click Finish.

Continue with Chapter 18, “Updating the Primary Domain,” on page 257.
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Updating the Primary Domain

By following the instructions in Section 17, “Installing the GroupWise 2012 Software,” on page 251,
you have installed the GroupWise 2012 MTA for the primary domain. You have also copied the
GroupWise 2012 data dictionary (. dc) files to the primary domain. To finish updating the primary
domain, you need to start the GroupWise 2012 MTA. The MTA uses the new domain dictionary file
(gwdom. dc) to update the domain database to version 2012.

1 Stop the previous version of the GroupWise MTA in the primary domain.

2 Follow the instructions for your platform to start the GroupWise 2012 MTA for your primary
domain.

¢ “Starting the Linux GroupWise Agents” on page 186
¢ “Starting the Windows GroupWise Agents” on page 205
The MTA then updates the primary domain database (wpdomain.db) to GroupWise 2012.

IMPORTANT: Before you update post offices in the primary domain or any secondary domains
in your system, make sure that the primary domain database has been updated.

3 In ConsoleOne:
3a Select the GroupWise System object, then select Domains in the drop-down list.

3b Click View > Edit Columns, move Database Version from the Available Fields list to the Selected
Columns list, then click OK.

Novell ConsoleOne 10l x|
File Edit  Wiew Tools Help
Tt| 0|52 @] 3] 21| [ vorers |
l@ My WWarld Dormain Mame I Domain Type Database Yersian I
EJ§ HNDS @ Proval Primary 12 d
?‘ CORP_TREE (& Provoz Secondary g
BB Groupise Syster % Fravos Secandary a
-8} Provol
-8 Provo2
- Provo3
Corporate Proval |\\jbd-oas\,gwsystem\provn1

When the database version for the primary domains displays 12 (short for 2012), you are
ready to proceed further with the update process.

Updating the Primary Domain 257



IMPORTANT: Updating a large domain database can take 20 minutes or more. If you do
not wait until the update runs to completion, you might encounter database versioning
discrepancies. If such discrepancies occur, see “MTA Fails to Update the Domain Database
Version” in “Strategies for Agent Problems” in GroupWise 2012 Troubleshooting 2: Solutions to
Common Problems.

4 To update secondary domains, continue with the next section, Updating Secondary Domains.
or

To update post offices in the primary domain, skip to Chapter 20, “Updating Post Offices,” on
page 261.

or

To update additional GroupWise agents or applications in the primary domain, see:

*

Chapter 21, “Updating the GroupWise Internet Agent,” on page 265

*

Chapter 22, “Updating GroupWise WebAccess,” on page 267
Chapter 23, “Updating the Calendar Publishing Host,” on page 273
Chapter 24, “Updating GroupWise Monitor,” on page 277

*

*
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Updating Secondary Domains

After you have updated the primary domain in your GroupWise system, you can update secondary
domains in your GroupWise system in any order that is convenient for you. For information about
update issues that you should consider, see Section 14.4, “Understanding Domain and Post Office
Database Updates by the GroupWise Agents,” on page 241.

To update a secondary domain, you need to install the GroupWise 2012 MTA and run it for the
domain. The MTA uses a new GroupWise 2012 version of the domain dictionary file (gwdom.dc) to
update the database to version 2012.

IMPORTANT: The MTA for the domain that the secondary domain links to must be updated and
running before you update each secondary domain. Each secondary domain must be updated before
you update any post offices in the secondary domain.

1 (Conditional) If you are updating a secondary domain on Linux, and if the GroupWise 2012
version of ConsoleOne and the GroupWise Administrator snap-ins are not yet installed on the
server where the secondary domain is located, install them now, as described in “ConsoleOne on
Linux” in “System” in the GroupWise 2012 Administration Guide.

On Linuy, it is very helpful to have ConsoleOne and the GroupWise Administrator snap-ins
installed on each server where a domain is located. On Windows, ConsoleOne can conveniently
be run on any Windows server or workstation where drives are mapped to servers where
domains are located. On Linux, the process of mounting file systems to gain access to remote
domain databases is not quite so straightforward as drive mapping is on Windows, so it is
helpful to have a local installation of Linux ConsoleOne on each domain server.

2 Stop the previous version of the GroupWise MTA in the secondary domain.

3 Install the updated MTA software in the secondary domain, as described in Section 8.4, “Setting
Up the GroupWise Agents,” on page 182.

4 Start the updated MTA in the secondary domain.
This updates the domain database (wpdomain.db) to GroupWise 2012.
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5 Ensure that the database in the secondary domain is updated to the GroupWise 2012 version:

5a In ConsoleOne, select the GroupWise System object, then select Domains in the drop-down
list.

5b (Conditional) If you have not already done so, click View > Edit Columns, move Database
Version from the Available Fields list to the Selected Columns list, then click OK.

Novell ConsoleOne 10l x|
File Edit  Wiew Tools Help
Tt| 05| @] 3] 21| [ vorers |
My WWarld Dormain Mame I Domain Type Database Yersian I
E‘ % NDS a Proval Primary 12 d
i : (& Provoz Secondary iz
) Proves Secondary g
@ Prova?
-8 Provo3
-]
Caorporate Provol |\\jbd-nas\,gwsystem\,provn1

When the database version for the secondary domains displays 12 (short for 2012), you are
ready to proceed with the update process.

IMPORTANT: Updating a large domain database can take 20 minutes or more. If you do
not wait until the update runs to completion, you might encounter database versioning
discrepancies. If such discrepancies occur, see “MTA Fails to Update the Domain Database

Version” in “Strategies for Agent Problems” in GroupWise 2012 Troubleshooting 2: Solutions to
Common Problems.

6 To update post offices in the secondary domain, continue with Chapter 20, “Updating Post
Offices,” on page 261.

or
To update additional GroupWise agents or applications in the secondary domain, see:
¢ Section 21, “Updating the GroupWise Internet Agent,” on page 265
¢ Section 22, “Updating GroupWise WebAccess,” on page 267
¢ Chapter 23, “Updating the Calendar Publishing Host,” on page 273
¢ Section 24, “Updating GroupWise Monitor,” on page 277
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20.1

Updating Post Offices

You can update post offices after you have updated the primary domain and the secondary domain
that owns the post offices that you want to update. For information about update issues that you
should consider, see Section 14.4, “Understanding Domain and Post Office Database Updates by the
GroupWise Agents,” on page 241.

To update a post office, you need to install the GroupWise 2012 POA and run it for the post office.
The POA uses a new GroupWise 2012 version of the post office dictionary file (gwpo.dc) to update
the post office database to version 2012.

IMPORTANT: The MTA for the domain that the post office belongs to must be updated and running
before you update any post offices in the domain.

¢ Section 20.1, “Installing and Starting the POA,” on page 261
¢ Section 20.2, “Copying the GroupWise Views to the Post Office Directory,” on page 262

Installing and Starting the POA

IMPORTANT: The POA must not be running while you update the post office. Therefore, users
cannot access the post office during the update process.

1 Stop the previous version of the GroupWise POA in the post office.

2 Install the updated POA software in the post office, as described in Section 8.4, “Setting Up the
GroupWise Agents,” on page 182.

3 Start the updated POA in the post office.
This updates the post office database (wphost . db) to GroupWise 2012.
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4 Ensure that the post office database is updated to the GroupWise 2012 version:

4a In ConsoleOne, select the GroupWise System object, then select Post Offices in the drop-
down list.

4b (Conditional) If you have not already done so, click View > Edit Columns, move Database
Version from the Available Fields list to the Selected Columns list, then click OK.

1=
File Edt ‘iew Tools Help
T ||| @] | 21 [ rest oriees =
l@ My Yol d Paost Office Mame | Domain Mame Database Yersion |
E‘* MNDE % Development Proval 12 ;I
g co [ Research Provo3 3
B @ Groupli [T Sales Provoz g
-3 Provo
- Prova2
@ Provo3
=
|Cnrporata |Prov01 |I\jbdfnes\gwsvstem\provo1

When the database version for the post office displays 12 (short for 2012), you are ready to
proceed with the update process.

IMPORTANT: Updating a large post office database can take 20 minutes or more. If you do
not wait until the update runs to completion, you might encounter database versioning
discrepancies. If such discrepancies occur, see “POA Fails to Update the Post Office
Database Version” in “Strategies for Agent Problems” in GroupWise 2012 Troubleshooting 2:
Solutions to Common Problems.

5 (Conditional) If you want to configure the POA to use the new GroupWise 2012 Document
Viewer Agent (DVA) instead of the standard Document Converter Agent (DCA), follow the
instructions in “Enabling the Document Viewer Agent (DVA) for Indexing” in “Post Office
Agent” in the GroupWise 2012 Administration Guide.

6 Continue with Copying the GroupWise Views to the Post Office Directory.

20.2 Copying the GroupWise Views to the Post Office Directory

GroupWise 2012 includes new view files for the GroupWise Windows client. When the POA starts, it
updates the post office database and also attempts to update the Windows client view files (. vew) in
the post office directory, regardless of whether the post office located on Windows or Linux. To do so,
the POA requires access to the post offices’s software distribution directory, regardless of whether the
software distribution directory is located on Windows or Linux. If the POA does not have access to
the software distribution directory, you can manually copy the view files.

You can check whether or not the POA was able to update the view files by verifying the dates of the
files in the /post_office/ofviews/win directory, where post_office is the path to the post office
directory.

If the files have older dates, copy all files from

/software/client/win32/ofviews/win
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to
/post_office/ofviews/win

Replace /software with the path to the software distribution directory and replace /post_office
with the path to the post office directory.

You can also perform this task in ConsoleOne. See “Refreshing the Client View Files in the Post
Office” in “Post Offices” in the GroupWise 2012 Administration Guide.
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Updating the GroupWise Internet Agent

After you have updated your domains and post offices to GroupWise 2012, you can update the
Internet Agent (GWIA). For information about update issues that you should consider, see
Section 14.6, “Understanding Internet Agent Updates,” on page 242.

1 Stop the previous version of the GWIA.

2 To update the GWIA to GroupWise 2012, follow the standard installation instructions in
Chapter 4, “Installing the GroupWise Internet Agent,” on page 77.

Updating the GroupWise Internet Agent
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Updating GroupWise WebAccess

After you have updated a domain and post office to GroupWise 2012, you can update WebAccess for
that domain. For information about update issues that you should consider, see Section 14.7,
“Understanding WebAccess Updates,” on page 242.

IMPORTANT: The POA that the GroupWise 2012 WebAccess Application communicates with must
be configured for SOAP. A secure SSL connection between the POA and the WebAccess Application
is highly recommended.

¢ Section 22.1, “Installing the WebAccess Application,” on page 267

¢ Section 22.2, “Cleaning Up the WebAccess Server after Updating to GroupWise 2012,” on
page 268

¢ Section 22.3, “Clearing User Browser Caches to Display GroupWise 2012 WebAccess Correctly,”
on page 272

¢ Section 22.4, “Updating Access Control for WebAccess Users,” on page 272

22.1 Installing the WebAccess Application

1 Prepare the POA to work successfully with the WebAccess Application, as described in the
following sections in “Post Office Agent” in the GroupWise 2012 Administration Guide:

¢ “Supporting SOAP Clients”
¢ “Securing the Post Office with SSL Connections to the POA”
2 Stop the existing WebAccess Agent.

3 (Conditional) On Linux, stop Tomcat.

OES 11: rcnovell-tomcaté stop
OES 2 Linux: rcnovell-tomcat5 stop
SLES 11: rctomcat6 stop

SLES 10: rctomcat5 stop

On Windows, the WebAccess Installation program does this for you.

4 To update WebAccess to GroupWise 2012, follow the standard installation instructions in
Chapter 5, “Installing GroupWise WebAccess,” on page 103.

IMPORTANT: If more than one Web-based GroupWise component (WebAccess, Calendar
Publishing Host, and/or Monitor) is installed on the same server, you must update all Web-
based GroupWise components at the same time.
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22.2

22.2.1

268

5

The Windows WebAccess Installation program detects additional Web-based GroupWise
components on the server and leads you conveniently from the installation of one component to
the next.

On Linux, you must manually start the Installation program for each Web-based component on
the server. After one existing Web-based component has been updated to GroupWise 2012, other
Web-based components on the server do not work until they also are updated to GroupWise
2012.

After you install GroupWise 2012 WebAccess, complete the following cleanup tasks:

¢ Section 22.2, “Cleaning Up the WebAccess Server after Updating to GroupWise 2012,” on
page 268

¢ Section 22.3, “Clearing User Browser Caches to Display GroupWise 2012 WebAccess
Correctly,” on page 272

Cleaning Up the WebAccess Server after Updating to

GroupWise 2012

The GroupWise 2012 WebAccess Installation program updates the existing WebAccess installation,
but it does not delete any parts of the previous version of WebAccess that are no longer necessary. To
avoid confusion in the future, you should remove the obsolete parts of WebAccess from eDirectory
and from the WebAccess server.

*

*

*

*

*

Section 22.2.1, “Exporting WebAccess Access Control Information,” on page 268
Section 22.2.2, “Deleting Obsolete WebAccess eDirectory Objects,” on page 269
Section 22.2.3, “Removing the WebAccess Agent Software,” on page 270

Section 22.2.4, “Removing Obsolete WebAccess Application Software,” on page 270

Section 22.2.5, “Accommodating Earlier GroupWise Versions,” on page 271

Exporting WebAccess Access Control Information

If you used classes of service to control user access to WebAccess in an earlier version of GroupWise,
you can export your existing access control information for use with GroupWise 2012 WebAccess.

1

o 01 A W N

In ConsoleOne with the GroupWise 2012 snap-ins installed, browse to and select the Domain
object where the WebA ccess eDirectory objects are located.

Right-click the WebAccess Agent object, then click Properties.

Click Access Control.

Review your existing access control information to ensure that it is current and accurate.
Click Export, then close the Access Control tab.

Change to the WebAccess Gateway directory (domain/wpgate/webac80a), then list the contents
of the directory.

A gwac.xml file has been created that captures your existing WebAccess access control
information in XML format for use with GroupWise 2012.
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22.2.2

7 Copy the gwac.xml file to the same directory where the GroupWise 2012 webacc . cfg file is

located.

8 Restart Tomcat to implement the same access control for GroupWise 2012 WebAccess that you
had for your earlier version of GroupWise.

OES 11: rcnovell-tomcaté stop
rcnovell-tomcaté start
OES 2 Linux: rcnovell-tomcat5 stop
rcnovell-tomcat5 start
SLES 11: rctomcaté stop
rctomcat6 start
SLES 10: rctomcat5 stop
rctomcat5 start
Windows: 1. At the Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 6, then click Restart.

9 For instructions on using the gwac .xml file in the future as you access control needs change, see

“Controlling WebAccess Usage” in “WebAccess” in the GroupWise 2012 Administration Guide.

Deleting Obsolete WebAccess eDirectory Objects

Because WebAccess configuration information is no longer stored in WebAccess eDirectory objects,
you should delete the WebAccess eDirectory objects from domains that you have updated go

GroupWise 2012.

IMPORTANT: If you need to configure WebAccess in domains that have not yet been updated to

GroupWise 2012, use the version of ConsoleOne that corresponds to the domain where the
WebAccess eDirectory objects are located. The GroupWise 2012 version of ConsoleOne cannot
administer WebAccess eDirectory objects.

1 In ConsoleOne, browse to and select the Domain object for the domain where you have updated

WebAccess.

2 Review the properties of the existing WebAccess objects, and make notes about any
customizations that you have made:

¢ WebAccess Agent (WEBACS0A)
+ WebAccess Application (GroupWiseWebAccess)
¢ WebPublisher Application (GroupWiseWebPublisher)

NOTE: WebPublisher is not part of GroupWise 2012. To continue using WebPublisher,

maintain an existing domain with the existing version of WebAccess to support your
WebPublisher needs until comparable functionality becomes available.

¢ GroupWise Service Provider (GroupWiseProvider)
¢ LDAP Service Provider (LDAPProvider)

¢ Document Service Provider (GroupWiseDocumentProvider)

3 Delete the obsolete WebAccess objects from eDirectory.

4 Use the webacc. cfg file to configure GroupWise 2012 WebAccess.
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22.2.3

22.2.4

Many of the customizations that could be made in the properties of the WebAccess eDirectory
objects can be made in the webacc. cfg file, as described in “Configuring the WebAccess
Application” in “WebAccess” in the GroupWise 2012 Administration Guide.

5 Continue with Removing the WebAccess Agent Software.

Removing the WebAccess Agent Software

Because the GroupWise 2012 WebAccess Application communicates directly with the POA, the
WebAccess Agent is no longer part of GroupWise. Therefore, it must be removed from the
WebAccess server.

¢ “On Linux” on page 270
¢ “On Windows” on page 270

On Linux

For a listing of the software files associated with the GroupWise 8 WebAccess Agent on Linux, see
“Linux WebAccess Agent Installation Directory” in “Directory Structure Diagrams” inGroupWise 8
Troubleshooting 3: Message Flow and Directory Structure.

The Linux GroupWise 2012 WebA ccess Installation program automatically removes obsolete
WebAccess Agent files from these directories.

On Windows

For a listing of the software files associated with the GroupWise 8 WebAccess Agent on Windows, see
“Windows WebAccess Agent Installation Directory” in “Directory Structure Diagrams” inGroupWise
8 Troubleshooting 3: Message Flow and Directory Structure.

The Windows GroupWise 2012 WebAccess Installation program does not delete the obsolete
WebAccess Agent service or the directory where the obsolete WebAccess Agent software is installed.

To remove the WebAccess Agent service and software from the WebAccess server:
1 Stop the WebAccess Agent:
net stop "WebAccess (webaccess agent name)"
2 Remove the WebAccess Agent service:
sc delete "WebAccess (webaccess_agent name)"
3 Delete the following directory:

c:\Program Files\Novell\GroupWise Server\WebAccess

Removing Obsolete WebAccess Application Software

All GroupWise Web-based components (WebAccess, Calendar Publishing Host, and Monitor) rely on
a platform-specific Web server and on Tomcat for their Web-based functionality.

GroupWise 2012 WebAcccess uses Tomcat 6 instead of Tomcat 5 on OES 11, SLES 11, and Windows. If
no other non-GroupWise Web services are using the old version of Tomcat, you can remove it from
the Web server.
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22.2.5

NOTE: Tomcat 5 is still used on OES 2 Linux and SLES 10, so no cleanup is required on these Linux
versions.

¢ “On OES 11 and SLES 11” on page 271
¢+ “On Windows” on page 271

On OES 11 and SLES 11

For earlier versions of GroupWise, Tomcat 5 is located in the following platform-specific directory:

OES: /var/opt/novell/tomcat5s

SLES: /srv/www/tomcats

If a Tomcat 5 directory exists on a Linux server that you have updated to GroupWise 2012, use YaST
to remove Tomcat 5. This also removes the obsolete WebAccess Application from the server.

On Windows

For earlier versions of GroupWise, Tomcat 5 is located in the following directory:

c:\novell\groupwise\tomcat5.5

If a Tomcat 5 directory exists on a Windows server that you have updated to GroupWise 2012, delete
the Tomcat 5 directory in order to remove the obsolete WebAccess Application from the server.

Accommodating Earlier GroupWise Versions

As you update your GroupWise system to GroupWise 2012, you might not be able update all post
offices at one time. The GroupWise 2012 WebAccess Application cannot communicate with an earlier
version of the POA. When a user whose post office is still on a earlier GroupWise version tries to log
in to WebAccess, the WebAccess Application can redirect that user to an earlier version of WebAccess
to match the post office where the user’s mailbox is located.

To provide a redirection URL:

1 Open the webacc. cfg file in a text editor.

2 Search to find the following line:

#Redirect.url=http://gw8.novell.com/gw/webacc

Remove the pound sign (#) to activate the setting.
Replace the sample URL with the URL for an earlier version of GroupWise WebAccess.

Save the webacc.cfg file.

o 0~ W

Restart Tomcat.
OES 11: rcnovell-tomcaté stop
rcnovell-tomcaté start

OES 2 Linux: rcnovell-tomcat5 stop
rcnovell -tomcat5 start

SLES 11: rctomcat6 stop
rctomcaté start
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22.3

22.4

SLES 10: rctomcat5 stop
rctomcat5 start

Windows: 1. Atthe Windows server, click Start > Administrative Tools > Services.

2. Right-click Tomcat 6, then click Restart.

Clearing User Browser Caches to Display GroupWise 2012
WebAccess Correctly

After you have updated the WebAccess Application to GroupWise 2012, notify your GroupWise
WebAccess users that they should clear their browser caches before logging into their mailboxes with
the updated version of GroupWise WebAccess. If old GroupWise WebAccess files are used from
users’ browser caches, they might not be compatible with the updated files from the Web server. The
results can be unpredictable and undesirable.

Updating Access Control for WebAccess Users

If you used the WebAccess Agent class of service functionality to provide access control for
WebAccess, you must implement the new access control functionality provided in GroupWise 2012.
Follow the instructions in “Controlling WebAccess Usage” in “WebAccess” in the GroupWise 2012
Administration Guide.
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Updating the Calendar Publishing Host

After you have updated at least one domain and post office to GroupWise 2012, you can update the

Calendar Publishing Host for that post office. For information about update issues that you should
consider, see Section 14.8, “Understanding Calendar Publishing Host Updates,” on page 243.

¢ Section 23.1, “Installing the Calendar Publishing Host Application,” on page 273

¢ Section 23.2, “Cleaning Up the Calendar Publishing Host Server after Updating to GroupWise
2012,” on page 274

¢ Section 23.3, “Clearing User Browser Caches to Display Published Calendars Correctly,” on
page 275

Installing the Calendar Publishing Host Application

1 (Conditional) On Linux, stop Tomcat.

OES 2: rcnovell-tomcat5 stop
OES 11: rcnovell-tomcat6 stop
SLES 10: rctomcat5 stop

SLES 11: rctomcaté6 stop

On Windows, the Calendar Publishing Host Installation program does this for you.

2 To update the Calendar Publishing Host to GroupWise 2012, follow the standard installation
instructions in Chapter 6, “Installing the GroupWise Calendar Publishing Host,” on page 123.

IMPORTANT: If more than one Web-based GroupWise component (Calendar Publishing Host,

WebAccess, and/or Monitor) is installed on the same server, you must update all Web-based
GroupWise components at the same time.

The Windows Calendar Publishing Host Installation program detects additional Web-based
GroupWise components on the server and leads you conveniently from the installation of one
component to the next.

On Linux, you must manually start the Installation program for each Web-based component on
the server. After one earlier version of a Web-based component has been updated to GroupWise

2012, other Web-based components on the server do not work until they also are updated to
GroupWise 2012.
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273



23.2

23.2.1

23.2.2

3 After you install the GroupWise 2012 Calendar Publishing Host, complete the following cleanup
tasks:

¢ Section 23.2, “Cleaning Up the Calendar Publishing Host Server after Updating to
GroupWise 2012,” on page 274

¢ Section 23.3, “Clearing User Browser Caches to Display Published Calendars Correctly,” on
page 275

Cleaning Up the Calendar Publishing Host Server after
Updating to GroupWise 2012

All GroupWise Web-based components (WebAccess, Calendar Publishing Host, and Monitor) rely on
a platform-specific Web server and on Tomcat for their Web-based functionality.

The GroupWise 2012 Calendar Publishing Host uses Tomcat 6 instead of Tomcat 5 on OES 11, SLES
11, and Windows. If no other non-GroupWise Web services are using the old version of Tomcat, you
can remove it from the Web server.

NOTE: Tomcat 5 is still used on OES 2 Linux and SLES 10, so no cleanup is required on these Linux
versions.

¢ Section 23.2.1, “On OES 11 and SLES 11,” on page 274
¢ Section 23.2.2, “On Windows,” on page 274

On OES 11 and SLES 11

For earlier versions of GroupWise, Tomcat 5 s located in the following platform-specific directory:

OES: /var/opt/novell/tomcat5s
SLES: /srv/www/tomcats
If a Tomcat 5 directory exists on a Linux server that you have updated to GroupWise 2012, use YaST

to remove Tomcat 5. This also removes the obsolete Calendar Publishing Host Application from the
server.

On Windows

For earlier versions of GroupWise, Tomcat 5 is located in the following directory:

c:\Novell\GroupWise\Tomcat5.5

If a Tomcat 5 directory exists on a Windows server that you have updated to GroupWise 2012, delete
the Tomcat 5 directory in order to remove the obsolete Calendar Publishing Host Application from
the server.
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23.3 Clearing User Browser Caches to Display Published
Calendars Correctly

After you have updated the Calendar Publishing Host Application to GroupWise 2012, notify your
GroupWise users that they should clear their browser caches before accessing published calendars. If
old Calendar Publishing files are used from users’ browser caches, they might not be compatible with
the updated files from the Web server. The results can be unpredictable and undesirable.

External users of published calendars might not see some aspects of the GroupWise 2012 Calendar
Publishing interface until after they clear their browser caches.
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Updating GroupWise Monitor

After you have updated at least one domain to GroupWise 2012, you can update GroupWise Monitor.
For information about update issues that you should consider, see Section 14.9, “Understanding
Monitor Updates,” on page 243.

¢ Section 24.1, “Installing the Monitor Software,” on page 277
¢ Section 24.2, “Cleaning Up the Monitor Server after Updating to GroupWise 2012,” on page 278

¢ Section 24.3, “Clearing Browser Caches to Display GroupWise 2012 Monitor Correctly,” on
page 279

Installing the Monitor Software

1 Stop the existing Monitor Agent.

2 (Conditional) On Linux, stop Tomcat.

OES 2: rcnovell-tomcat5 stop
OES 11: rcnovell-tomcaté stop
SLES 10: rctomcat5 stop

SLES 11: rctomcat6 stop

On Windows, the Monitor Installation program does this for you.

3 To update Monitor to GroupWise 2012, follow the standard installation instructions in
Chapter 7, “Installing GroupWise Monitor,” on page 151.

IMPORTANT: If more than one Web-based GroupWise component (Monitor, WebAccess, or
Calendar Publishing Host) is installed on the same server, you must update all Web-based
GroupWise components at the same time.

The Windows Monitor Installation program detects additional Web-based GroupWise
components on the server and leads you conveniently from the installation of one component to
the next.

On Linux, you must manually start the Installation program for each Web-based component on
the server. After one earlier version of a Web-based component has been updated to GroupWise
2012, other Web-based components on the server do not work until they also are updated to
GroupWise 2012.

4 After you install GroupWise 2012 Monitor, complete the following cleanup tasks:

¢ Section 24.2, “Cleaning Up the Monitor Server after Updating to GroupWise 2012,” on
page 278

¢ Section 24.3, “Clearing Browser Caches to Display GroupWise 2012 Monitor Correctly,” on
page 279
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24.2.1

24.2.2

Cleaning Up the Monitor Server after Updating to
GroupWise 2012

The GroupWise 2012 Monitor Installation program updates the existing Monitor installation, but it
does not delete any parts of the previous version of Monitor that are no longer necessary. To avoid
confusion in the future, you should remove the obsolete parts of Monitor from eDirectory and from
the WebAccess server.

¢ Section 24.2.1, “Deleting Obsolete Monitor eDirectory Objects,” on page 278
¢ Section 24.2.2, “Removing Obsolete Monitor Application Software,” on page 278

Deleting Obsolete Monitor eDirectory Objects

The GroupWise 2012 Monitor Installation program updates the existing Monitor installation, but it
does not delete any parts of the previous version of Monitor that are no longer necessary. To avoid
confusion in the future, you should remove the obsolete parts of Monitor from eDirectory and from
the WebAccess server.

Because Monitor Application configuration information is no longer stored in Monitor eDirectory
objects, you should delete the Monitor Application eDirectory objects from domains that you have
updated to GroupWise 2012.

IMPORTANT: If you need to configure the Monitor Application in domains that have not yet been
updated to GroupWise 2012, use the version of ConsoleOne that corresponds to the domain where
the Monitor Application eDirectory objects are located. The GroupWise 2012 version of ConsoleOne
cannot administer Monitor Application eDirectory objects.

1 In ConsoleOne, browse to and select the Domain object for the domain where you have updated
to GroupWise 2012 and where Monitor is installed.

2 Review the properties of the existing Monitor Application objects, and make notes about any
customizations that you have made:

¢ GroupWise Monitor Application (GroupWiseMonitor)
¢ GroupWise Monitor Provider (MonitorProvider)
3 Delete the existing Monitor Application objects.

4 Use the gwmonitor. cfg file to configure GroupWise 2012 Monitor, as described in “Configuring
the Monitor Application” in “Monitor” in the GroupWise 2012 Administration Guide.

Removing Obsolete Monitor Application Software

All GroupWise Web-based components (WebAccess, Calendar Publishing Host, and Monitor) rely on
a platform-specific Web server and on Tomcat for their Web-based functionality.

GroupWise 2012 Monitor uses Tomcat 6 instead of Tomcat 5 on OES 11, SLES 11, and Windows. If no
other non-GroupWise Web services are using the old version of Tomcat, you can remove it from the
Web server.

NOTE: Tomcat 5 is still used on OES 2 Linux and SLES 10, so no cleanup is required on these Linux
versions.

¢ “On OES 11 and SLES 11” on page 279
¢ “On Windows” on page 279
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On OES 11 and SLES 11

For earlier versions of GroupWise, Tomcat 5 is located in the following platform-specific directory:

OES: /var/opt/novell/tomcat5s
SLES: /srv/www/tomcath

If a Tomcat 5 directory exists on a Linux server that you have updated to GroupWise 2012, use YaST
to remove Tomcat 5. This also removes the obsolete Monitor Application from the server.

On Windows

For earlier versions of GroupWise, Tomcat 5 was locating in the following directory:

c¢:\Novell\GroupWise\Tomcat5.5

If a Tomcat 5 directory exists on a Windows server that you have updated to GroupWise 2012, delete
the Tomcat 5 directory in order to remove the obsolete Monitor Application from the server.

Clearing Browser Caches to Display GroupWise 2012
Monitor Correctly

After you have updated the Monitor Application to GroupWise 2012, clear your browser cache before
accessing the updated version of GroupWise Monitor. If old GroupWise Monitor files are pulled from
your browser cache, they might not be compatible with the updated files pulled from the Web server.
The results can be unpredictable and undesirable.
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Updating Users’ GroupWise Windows
Clients

After a post office is updated to GroupWise 2012, users who have accounts in that post office can start
using the GroupWise 2012 Windows clients. You can give users access to a GroupWise 2012 software
distribution directory, so that they can install the GroupWise client themselves, or you can use the
other methods of client software distribution described in “Distributing the GroupWise Windows
Client” in “Client” in the GroupWise 2012 Administration Guide.

When you used the GroupWise Installation program as described in Section 17, “Installing the
GroupWise 2012 Software,” on page 251, you had the opportunity to update one software
distribution directory. To fully implement GroupWise 2012 throughout your GroupWise system, you
must update all of your software distribution directories.

IMPORTANT: Before you update a software distribution directory, ensure that all post offices that
use the software distribution directory have been updated. The GroupWise 2012 Windows client
cannot access a post office that still uses an earlier version of GroupWise. Users who update to the
GroupWise 2012 Windows client before their post office has been updated are locked out of the post
office.

1 To update a GroupWise software distribution directory to GroupWise 2012, follow the
instructions in “Updating a Software Distribution Directory” in “System” in the GroupWise 2012
Administration Guide.

The GroupWise 2012 Windows client is available as part of the Linux GroupWise 2012 software image.
For more information about installing the GroupWise 2012 Windows client from a Linux server, see
Section 9.3.3, “Installing the GroupWise Windows Client from the Linux GroupWise 2012 Software
Image,” on page 217.
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Updating Earlier GroupWise Systems to
Version 2012

The process and procedures for updating a GroupWise 5.x, 6.x, or 7 system to version 2012 are
essentially the same as updating a GroupWise 8 system to version 2012. Refer to the following
sections for to prepare for the update:

¢ Chapter 14, “Understanding the Update Process,” on page 239

¢ Chapter 15, “Migrating Away from NetWare,” on page 245

¢ Chapter 16, “Preparing Your GroupWise 8 System for the Update,” on page 249
The GroupWise features and functionality that are new to you depend on the version of GroupWise

that you are updating from. For example, if you are updating from GroupWise 6.5, the new features
and functionality added in versions 7 and 8 are all new.

Chapter 13, “What’s New in GroupWise 2012,” on page 233 includes only the changes made since
GroupWise 8. For changes made in earlier versions, refer to the following:

¢ Version 7 to 8: “What’s New in GroupWise 8”

26.1 Version-Specific Update Procedures

See the following sections for some important administrative procedures that you might need to
perform, depending on the GroupWise version that you are updating from:

¢ Section 26.1.1, “eDirectory Schema Extension,” on page 283

¢ Section 26.1.2, “Trusted Application Keys,” on page 284

¢ Section 26.1.3, “Internet Agent Configuration Information,” on page 284

26.1.1 eDirectory Schema Extension

GroupWise 8 included functionality that required you to extend the schema of any Novell eDirectory
trees where you have GroupWise objects. The GroupWise 2012 Installation program does not extend
the eDirectory schema for you. Use GroupWise 2012 ConsoleOne to extend the eDirectory schema
before installing other GroupWise 2012 components.

1 Install the GroupWise 2012 snap-ins to ConsoleOne.

2 In ConsoleOne, select an eDirectory tree that contains GroupWise objects.

3 Click Tools > GroupWise Utilities > Check eDirectory Schema.

If the schema is not current, this utility extends the schema for you.

4 Repeat this procedure for each eDirectory tree that contains GroupWise objects.
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26.1.2

26.1.3

Trusted Application Keys

Before GroupWise 8 Support Pack 1, trusted application keys needed to be created by the third-party
program developer, using the GroupWise Trusted Application API (http://developer.novell.com/wiki/
index.php/GroupWise_Trusted_Application_API) at the Novell Developer Kit Web site (http://
developer.novell.com/wiki/index.php/Category:Novell_Developer_Kit).

Starting with GroupWise 8 Support Pack 1, you can create a trusted application and its associated key
in ConsoleOne for use with both Linux and Windows trusted applications, as described in “Creating
a Trusted Application and Key” in “System” in the GroupWise 2012 Administration Guide.

Internet Agent Configuration Information

Before GroupWise 7 SP1, GWIA configuration information was stored both in eDirectory, as
properties of the GWIA object, and in the GWIA configuration file (gwia. cfg). Starting in
GroupWise 7 SP1, all primary configuration settings have been consolidated into the properties of the
GWIA object. Secondary settings are still available only through the startup file.

When you update a GroupWise 7 GWIA to a later version of GroupWise and access the GWIA object
in ConsoleOne, all primary configuration settings are moved from the startup file into eDirectory.
ConsoleOne no longer writes configuration settings to the startup file. Switches in the startup file can
be used to override the settings in ConsoleOne.
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Facilitating Coexistence with NetWare

In Chapter 15, “Migrating Away from NetWare,” on page 245, you considered your alternatives for

replacing your NetWare servers with Linux servers or Windows servers. Depending on the size of

your GroupWise system, the migration away from NetWare might take a substantial amount of time.
¢ Section 27.1, “Administering NetWare Domains from Linux,” on page 285

¢ Section 27.2, “Administering NetWare Domains from Windows,” on page 285

27.1 Administering NetWare Domains from Linux

1 When you need to access domains on NetWare servers from Linux ConsoleOne, use the
following mount command on the Linux server where you run ConsoleOne:

mount -t ncpfs netware server/fully qualified admininstrator user
/linux mount directory -o ipserver=netware server ip address

la Replace netware_ server with the fully qualified DNS hostname of the NetWare server that
you are mounting to the local Linux server, such as gwmail.provol.novell.com.

1b Replace fully qualified admininstrator user with the user name and eDirectory
context of a user that can log in to eDirectory and access the NetWare server, such as
admin.users.novell

1lc Replace 1inux mount_directory with the full path for the directory where you plan to
mount the NetWare server, such as /mnt/gwmail.

1d Replace netware server ip address with the IP address of the NetWare server.
2 Create the Linux mount directory referenced in Step 1c.

3 Create a script in the /mnt directory with the resulting mount command, then run the script to
mount the NetWare server to the local Linux server.

4 To make the mount persistent, so that it is automatically available whenever you reboot the
Linux server, edit the /etc/fstab (http://en.wikipedia.org/wiki/Fstab) file with the same
information that you used in the mount command.

27.2 Administering NetWare Domains from Windows

If you are not migrating into a completely Linux environment, you can continue to run Windows
ConsoleOne, accessing NetWare servers across mapped drives, for as long as NetWare servers
remain in your GroupWise system.
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Appendixes

¢ Appendix A, “GroupWise Version Compatibility,” on page 289
¢ Appendix B, “GroupWise Linux Executables,” on page 297

*

Appendix C, “Third-Party Materials,” on page 329

*

Appendix D, “Documentation Updates,” on page 341
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GroupWise Version Compatibility

Use the tables in this section to determine compatibility among the following GroupWise versions:

¢ Section A.1, “GroupWise 2012 on Linux,” on page 289
¢ Section A.2, “GroupWise 2012 on Windows,” on page 291

¢ Section A.3, “GroupWise 2012 in a Cross-Platform Environment,” on page 293

IMPORTANT: GroupWise 5.x, 6.x, and 7 versions have entered the end-of-life phase and are no
longer actively supported. For update instructions, see Chapter 26, “Updating Earlier GroupWise
Systems to Version 2012,” on page 283.

For each GroupWise version, the tables indicate compatibility for:

¢ Administrative components: Domain and post office database platforms and versions,
eDirectory platforms, and GroupWise snap-ins to ConsoleOne platforms and versions.

¢ Agents: Domain and post office database platforms and versions, agent platforms and versions.

¢ Clients: Post office directory platforms and access, POA platforms and versions, client modes.

In the compatibility tables, cells with combinations that are not applicable are marked N/A. For
example, the POA never communicates with the Internet Agent, so that table cell is N/A.

For information about what operating system versions are supported for GroupWise 2012 on Linux
and Windows, refer to “GroupWise System Requirements” on page 19. For information about earlier
versions of GroupWise, refer to:

¢ GroupWise 8 Installation Guide

For information about the features that each GroupWise version includes, see Novell GroupWise
Feature Comparison (http://www.novell.com/products/groupwise/compare.html).

A.1 GroupWise 2012 on Linux

Select the GroupWise version that you want to determine GroupWise 2012 compatibility with:

¢ Section A.1.1, “Compatibility with GroupWise 8 on Linux,” on page 289
¢ Section A.1.2, “Compatibility with GroupWise 7 on Linux,” on page 291

A.1.1 Compatibility with GroupWise 8 on Linux

¢ “GroupWise 8 Administrative Components with GroupWise 2012 on Linux” on page 290
+ “GroupWise 8 Agents with GroupWise 2012 on Linux” on page 290
¢ “GroupWise 8 Windows Client with GroupWise 2012 on Linux” on page 291
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GroupWise 8 Administrative Components with GroupWise 2012 on Linux

GroupWise 2012 GroupWise 8 GW 8 Objects in ConsoleOne +

Components Domain and Post Office eDirectory GW 8 Snap-Ins
Databases

GW 2012 Domain and Post  N/A N/A Not Supported

Office Databases

GW 2012 Obijects in N/A N/A Not Supported

eDirectory

ConsoleOne + Supported Supported N/A

GW 2012 Snap-Ins

Table Summary: ConsoleOne with the GroupWise 2012 snap-ins can be used to access GroupWise 8
databases for domains and post offices and GroupWise 8 eDirectory objects. However, ConsoleOne
with the GroupWise 8 snap-ins should not be used to access GroupWise 2012 databases and
GroupWise 2012 eDirectory objects.

The general rule is that later GroupWise snap-ins can administer earlier GroupWise system
components, but earlier GroupWise snap-ins should not be used to administer later GroupWise
system components. The exception in GroupWise 2012 is that the GroupWise 2012 snap-ins cannot be
used to administer GroupWise 8 WebAccess eDirectory objects, because WebAccess configuration
information is not stored in eDirectory objects in GroupWise 2012. Continue to use the GroupWise 8
snap-ins to administrator GroupWise 8 WebAccess eDirectory objects.

NOTE: If your GroupWise administration includes Novell Identity Manager, see “Identity Manager
Driver Version Compatibility” in the GroupWise 2012 Readme (http://www.novell.com/
documentation/groupwise2012/gw2012_readme_full/data/gw2012_readme_full.html#bwgjm9e).

GroupWise 8 Agents with GroupWise 2012 on Linux

GroupWise8 GW8MTA GW8POA GW8GWIA GW 8 GW 8
G Wise 2012 Domain and WebAccess Monitor
Aroup Ise Post Office Agent Agent

gents Databases

GW 2012 Domain N/A Not Not Not Supported N/A Not
and Post Office Supported Supported Supported
Databases
GW 2012 MTA Supported Supported Supported  Supported N/A Supported
GW 2012 POA Supported Supported N/A N/A N/A Supported
GW 2012 DVA N/A N/A N/A N/A N/A N/A
GW 2012 GWIA  Supported Supported N/A Not Supported N/A Supported
GW 2012 Monitor Supported Supported Supported  Supported N/A N/A
Agent
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Al2

A2

A21

Table Summary: GroupWise 8 agents cannot access domain and post office databases that have been
updated to GroupWise 2012. When a GroupWise 2012 MTA or POA accesses a GroupWise 8
database, it automatically updates the database to GroupWise 2012.

The Document Viewer Agent (DVA) is new in GroupWise 2012 and does not interact with any
GroupWise 8 agents. The WebAccess Agent that was part of GroupWise 8 is not part of GroupWise
2012.

GroupWise 8 Windows Client with GroupWise 2012 on Linux

GroupWise 2012 GW 2012 POA GW 2012 POA GW 2012 POA
GroupWise 8 Post Office Client/Server Client/Server Dial-Up Access
Windows Client Direct Access Access Access Remote Mode
Online Mode Caching Mode
Windows Not Supported Supported Supported Supported

Client

Table Summary: The GroupWise 8 Windows client can communicate with the GroupWise 2012
POA, but it cannot access a GroupWise 2012 post office directly. The general rule is that later POAs
can always communicate with earlier GroupWise clients, but earlier POAs cannot communicate with
later GroupWise clients.

Compatibility with GroupWise 7 on Linux

GroupWise 7 components should work with GroupWise 2012 in the same way that GroupWise 8
works with GroupWise 2012. However, extended support of GroupWise 7 ended on September 30,
2012. Self-support is still available. For more information, see the Novell Support Product Support
Lifecycle Web page (http://support.novell.com/lifecycle).

GroupWise 2012 on Windows

Select the GroupWise version that you want to determine GroupWise 2012 compatibility with:

¢ Section A.2.1, “Compatibility with GroupWise 8 on Windows,” on page 291
¢ Section A.2.2, “Compatibility with GroupWise 7 on Windows,” on page 293

Compatibility with GroupWise 8 on Windows

¢ “GroupWise 8 Administrative Components with GroupWise 2012 on Windows” on page 292
¢ “GroupWise 8 Agents with GroupWise 2012 on Windows” on page 292
+ “GroupWise 8 Windows Client with GroupWise 2012 on Windows” on page 293
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GroupWise 8 Administrative Components with GroupWise 2012 on Windows

GroupWise 8 GW 8 Objects in ConsoleOne +
GroupWise 2012 Domain and Post Office eDirectory GW 8 Snap-Ins
Components Databases
GW 2012 Domain and Post  N/A N/A Not Supported
Office Databases
GW 2012 Objects in N/A N/A Not Supported
eDirectory
ConsoleOne + Supported Supported N/A

GW 2012 snap-ins

Table Summary: ConsoleOne with the GroupWise 2012 snap-ins can be used to access GroupWise 8
databases for domains and post offices and GroupWise 8 eDirectory objects. However, ConsoleOne
with the GroupWise 8 snap-ins should not be used to access GroupWise 2012 databases and
GroupWise 2012 eDirectory objects.

The general rule is that later GroupWise snap-ins can administer earlier GroupWise system
components, but earlier GroupWise snap-ins should not be used to administer later GroupWise
system components. The exception in GroupWise 2012 is that the GroupWise 2012 snap-ins cannot be
used to administer GroupWise 8 WebAccess eDirectory objects, because WebAccess configuration
information is not stored in eDirectory objects in GroupWise 2012. Continue to use the GroupWise 8
snap-ins to administrator GroupWise 8 WebAccess eDirectory objects.

NOTE: If your GroupWise administration includes Novell Identity Manager, see “Identity Manager
Driver Version Compatibility” in the GroupWise 2012 Readme (http://www.novell.com/
documentation/groupwise2012/gw2012_readme_full/data/gw2012_readme_full.html#bwgjm9e).

GroupWise 8 Agents with GroupWise 2012 on Windows

GroupWise8 GW8MTA GW8POA GW8GWIA GW 8 GW 8
Domain and WebAccess Monitor
GroupWise 2012 Post Office Agent Agent
Agents Databases
GW 2012 Domain N/A Not Not Not Supported  N/A Not
and Post Office Supported Supported Supported
Databases
GW 2012 MTA Supported Supported Supported  Supported N/A Supported
GW 2012 POA Supported Supported N/A N/A N/A Supported
GW 2012 DVA N/A N/A N/A N/A N/A N/A
GW 2012 GWIA  Supported Supported N/A Not Supported  N/A Supported
GW 2012 Monitor Supported Supported Supported  Supported N/A N/A
Agent
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A22

A3

Table Summary: GroupWise 8 agents cannot access domain and post office databases that have been
updated to GroupWise 2012. When a GroupWise 2012 MTA or POA accesses a GroupWise 8
database, it automatically updates the database to GroupWise 2012.

The Document Viewer Agent (DVA) is new in GroupWise 2012 and does not interact with any
GroupWise 8 agents. The WebAccess Agent that was part of GroupWise 8 is not part of GroupWise
2012.

GroupWise 8 Windows Client with GroupWise 2012 on Windows

GroupWise 2012 GW 2012 POA GW 2012 POA GW 2012 POA
GroupWise 8 Post Office Client/Server Client/Server Dial-Up Access
Windows Client Direct Access Access Access Remote Mode
Online Mode Caching Mode
Windows Not Supported Supported Supported Supported

Client

Table Summary: The GroupWise 8 Windows client can communicate with the GroupWise 2012
POA, but it cannot access a GroupWise 2012 post office directly. The general rule is that later POAs
can always communicate with earlier GroupWise clients, but earlier POAs cannot communicate with
later GroupWise clients.

Compatibility with GroupWise 7 on Windows

GroupWise 7 components should work with GroupWise 2012 in the same way that GroupWise 8
works with GroupWise 2012. However, extended support of GroupWise 7 ended on September 30,
2012. Self-support is still available. For more information, see the Novell Support Product Support
Lifecycle Web page (http://support.novell.com/lifecycle).

GroupWise 2012 in a Cross-Platform Environment

¢ Section A.3.1, “GroupWise 2012 Linux Administrative Components with GroupWise 2012 on
Windows,” on page 294

¢ Section A.3.2, “GroupWise 2012 Windows Administrative Components with GroupWise 2012
on Linux,” on page 294

¢ Section A.3.3, “GroupWise 2012 Agents on Linux and Windows,” on page 295
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A.3.1 GroupWise 2012 Linux Administrative Components with GroupWise
2012 on Windows

GroupWise 2012 GW 2012 Objects Windows
GroupWise 2012 on Domain and Post in eDirectory on  ConsoleOne

Linux Office Databases = Windows + GW 2012 Snap-
Administrative on Windows Ins
Components

GW 2012 Domain and N/A N/A Supported
Post Office Databases

on Linux

GW 2012 Obijects in N/A N/A Supported
eDirectory on Linux

Linux ConsoleOne +  Supported Supported N/A

GW 2012 Snap-ins on

Linux

Table Summary: Linux ConsoleOne with the GroupWise snap-ins can be used to access GroupWise
databases for domains and post offices and GroupWise objects in eDirectory located on Linux or
Windows. When using Linux ConsoleOne to administer domains and post offices, you must mount
the Linux or Windows server to your Linux machine. For setup instructions, see “ConsoleOne on
Linux” in “System” in the GroupWise 2012 Administration Guide.

A.3.2 GroupWise 2012 Windows Administrative Components with
GroupWise 2012 on Linux

GroupWise 2012  GW 2012 Objects Linux ConsoleOne
GroupWise 2012 on Domain and Post in eDirectory on  + GW 2012 Snap-
Windows Office Databases  Linux Ins
Administrative on Linux
Components

GW 2012 Domain and N/A N/A Supported
Post Office Databases
on Windows

GW 2012 Obijects in N/A N/A Supported
eDirectory on
Windows

Linux ConsoleOne +  Supported Supported N/A
GW 2012 Snap-ins on
Linux

Table Summary: Windows ConsoleOne with the GroupWise snap-ins can be used to access
GroupWise databases for domains and post offices and GroupWise objects in eDirectory located on
Linux or Windows. When using WIndows ConsoleOne to administer domains and post offices on
Windows servers, you use a mapped drive to access the Windows server. When using Windows

294  GroupWise 2012 Installation Guide



ConsoleOne to administer domains and post offices on Linux servers, you can use a Samba share to
access the Linux server from your Windows machine. For Samba setup instructions, see
“ConsoleOne on Windows” in “System” in the GroupWise 2012 Administration Guide.

A.3.3 GroupWise 2012 Agents on Linux and Windows

GroupWise GW 2012 GW 2012 GW 2012 GW 2012 GW

GroupWise 2012 MTA on POAon DVAon GWIAon 2012
2012 on Linux Domain or Windows Windows WiIndows Windows Monitor
Agents Post Office Agent
Databases on
on Window
Windows s
GW 2012 N/A Supporte  Supporte  N/A Supported Supporte
Domain and d d d
Post Office
Databases
on Linux
GW 2012 MTA Supported  Supporte Supporte N/A Supported Supporte
on Linux d d d
GW 2012 POA Supported Supporte N/A Supporte  N/A Supporte
on Linux d d d
GW 2012 Supported  Supporte  N/A N/A Supported Supporte
GWIA d d
on Linux
GW 2012 Supported  Supporte  Supporte  N/A Supported N/A
Monitor Agent d d
on Linux

Table Summary: Domains and post offices can be located on Linux or Windows. Run the version of
the GroupWise agents that matches the platform where the domains and post offices are located. All
the Linux GroupWise agents can communicate as usual with the Windows GroupWise agents.

Existing domains on NetWare servers can be moved to Linux or Windows servers, so that the
GroupWise 2012 agents can update them. For assistance, see Chapter 15, “Migrating Away from
NetWare,” on page 245.
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B GroupWise Linux Executables

This section contains the information in the GroupWise man pages that are available on your Linux
server.

+ “grpwise(1)” on page 298

¢ “grpwise-ma(l)” on page 301

¢ “gwpoa(l)” on page 303

¢ “gwmta(l)” on page 305

¢ “gwdva(l)” on page 307

¢ “gwia(1)” on page 309

¢ “gwmon(1)” on page 311

¢ “gwcheck(1l)” on page 313

¢ “gwcheckt(1)” on page 317

¢ “dbcopy(1)” on page 319

¢ “gwtmstmp(1)” on page 323

¢ “gwcsrgen(l)” on page 326
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grpwise(1)

Name

grpwise - GroupWise Script

Syntax

grpwise start [object]
grpwise status [object]
grpwise stop [object]
grpwise restart [object]
grpwise print [object]

The agent objects are:

POA: post_office name.domain name
MTA: domain name

DVA: gwdva

GWIA: gwia.domain name

NOTE: The Monitor Agent is not controlled by the grpwise script. It has its own script named
grpwise-ma, which works essentially the same as the grpwise script.

Description

The grpwise script is created during installation and can control any agents installed on the local
server. It is created in the /etc/init.d directory. It works in conjunction with the gwha . conf file,
which is created in the /etc/opt/novell/groupwise directory. The gwha. conf file lists the agents
installed on the local server so that the grpwise script knows what agents to start.

The GroupWise agents are Run Control compliant. During installation, a symbolic link is created
from /etc/init.d/grpwise to /usr/sbin/rcgrpwise. Typically, /usr/sbin is already on your
path, so you can run rcgrpwise from any directory, rather than changing to /etc/init.din order to
run the grpwise script.

Options

Usage Options:

start

Starts all GroupWise agents on the local server or the GroupWise agent specified in the grpwise
command. A green “done” indicates that an agent is running. If a green “done” does not appear,
the agent was unable to start.

status

Displays status for all GroupWise agents on the local server or for the GroupWise agent
specified in the grpwise command. A green “running” indicates that an agent is running. A
black “unused” indicates that an agent is not running.
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stop
Stops all GroupWise agents on the local server or the GroupWise agent specified in the grpwise
command. A green “done” indicates that an agent is stopped. A black “unused” indicates that
an agent is not running and therefore cannot be stopped.

restart
Stops all GroupWise agents on the local server or the GroupWise agent specified in the grpwise
command. A green “done” indicates that an agent is stopped. A black “unused” indicates that
an agent is not running and therefore cannot be stopped. The agents then start again with the
standard start status indicators.

print
Lists settings for all GroupWise agents in the gwha . conf file or for the GroupWise agent
specified in the grpwise command.

post office name.domain name
Specifies the POA to stop. The syntax allows for multiple POAs running on the same server and
specifies which POA to stop.

domain name
Specifies the MTA to stop. The syntax allows for multiple MTAs running on the same server and
specifies which MTA to stop.

gwdva
Stops the DVA. The syntax stops all DVAs on the server.

gwia.domain name

Specifies the GWIA to stop. The syntax allows for multiple GWIAs running on the same server
and specifies which GWIA to stop.

Help Options:

--help, -?

Displays the help information and exits.

Files

/etc/opt/novell/groupwise/gwha.conf

GroupWise High Availability service configuration file. This configuration file lists all
information necessary to start and stop each GroupWise agent that is installed on the server. For
example, an entry for an MTA might look similar to this example:

server = /opt/novell/groupwise/agents/bin/gwmta
command = /etc/init.d/grpwise

startup = provol.mta

delay =2

wait = 10

The server = setting specifies the full path to the agent executable.
The command = setting specifies the full path to the grpwise script.

The startup = setting specifies the name of the agent startup file. All agent startup files are
located in the /opt /novell/groupwise/agents/share directory. In a cluster, the startup files
are on the shared resource.
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The delay = setting controls the length of time between when the script issues the command to
start an agent and when the script displays a message indicating that the agent has started. The
default delay time is 2 seconds.

The wait = setting controls the length of time between when the script issues the command to
stop an agent and when the script kills the agent if the agent has not yet stopped. The default
wait time is 10 seconds.

By default, the grpwise script starts the agents as daemons with no user interface. If you want a
user interface, you can add a show = yes line for each agent that you want to have a user
interface.

Examples

This script must be run as root. If you have configured the GroupWise agents to run as a non-root
user, they switch over to that user after they have started.
/etc/init.d/grpwise start

Starts all GroupWise agents that are installed on the server.

/etc/init.d/grpwise status development.provol
Shows the status of the Development post office POA. The Development post office belongs to
the Provol domain.

/etc/init.d/grpwise stop gwia.provol
Stops the GWIA that belongs to the Provol domain.

NOTE: In all examples, /etc/init.d/grpwise can be replaced with regrpwise to run the script
from any directory.

Diagnostics

If a GroupWise agent fails to start when using the grpwise script, try starting the agent manually, as
described in the man page for each agent. You might receive an error message indicating why the
agent is failing to start.

If you have changed the non-root user that you want the agent to run by modifying the /etc/opt/
novell/groupwise/agents/uid.conf file, you might have forgotten to delete the corresponding
uid.run file in the domain or post office directory that the agent services. Delete the uid. run file,
then use the grpwise script to try to start the agent again.

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
gwpoa(l), gwmta(l), gwia(1), gwdva(l).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).

GroupWise 2012 Installation Guide


http://www.novell.com
http://bugzilla.novell.com

grpwise-ma(l)

Name

grpwise-ma - GroupWise Monitor Script.

Syntax

grpwise-ma [start] [stop] [status] [restart]

Description

The grpwise-ma script is created during installation and controls the Monitor Agent. (The grpwise
script controls the other four GroupWise agents.) The grpwise-ma script is created in the /etc/
init.d directory. It works in conjunction with the monitor.xml file, which is created in the /opt/
novell/groupwise/agents/share directory. The monitor.xml file points the Monitor Agent to a
domain database (wpdomain.db) where it can access a list of agents to monitor in your GroupWise
system.

The grpwise-ma script includes an MA_OPTIONS variable where you can specify Monitor Agent
startup switches. This is convenient because the Monitor Agent does not use a startup file as the other
GroupWise agents do.

The Monitor Agent is Run Control compliant. During installation, a symbolic link is created from /
etc/init.d/grpwise-ma to /usr/sbin/rcgrpwise-ma. Typically, /usr/sbin is already on your
path, so you can run rcgrpwise-ma from any directory, rather than changing to /etc/init.din
order to run the grpwise-ma script.

Options

Usage Options:

start
Starts the Monitor Agent as a daemon on the local server. A green “done” indicates that the
agent is running. If a green “done” does not appear, then the agent was unable to start.

status
Displays status for the Monitor Agent. A green “running” indicates that the agent is running. A
black “unused” indicates that the agent is not running.

stop
Stops the Monitor Agent. A green “done” indicates that the agent is stopped. A black “unused”
indicates that the agent is not running and therefore cannot be stopped.

restart

Stops the Monitor Agent. A green “done” indicates that the agent is stopped. A black “unused”
indicates that the agent is not running and therefore cannot be stopped. The Monitor Agent then
starts again with the standard start status indicators.
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Help Options:

—help, -?

Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/monitor.xml

Monitor Agent configuration file. Provides a domain directory where the Monitor Agent can
determine what GroupWise and Messenger agents to monitor. The monitor.xml file is created
during installation.

/var/opt/novell/groupwise/monitor/gwmonitor.cfg

Monitor Application configuration file. Provides integration information for passing agent
status information gathered by the Monitor Agent to your Web browser for display in the
Monitor Web console.

Examples

This script does not run as root.

/etc/init.d/grpwise-ma start
Starts the Monitor Agent.
You can view the Monitor Agent Web console at the following URL:
http://localhost:8200
You can view the Monitor Web console at the following URL:

http://localhost/gwmon/gwmonitor

NOTE: In the example, /etc/init.d/grpwise-ma can be replaced with regrpwise-ma to run the
script from any directory.

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
gwmon(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwpoa(l)

Name

gwpoa - GroupWise Post Office Agent.

Syntax

gwpoa [--show] --home post office directory
gwpoa [--show] @startup file
Description

A post office is a collection of user mailboxes and GroupWise objects. Messages are delivered to
mailboxes by the Post Office Agent (POA).

You can provide POA startup switches on the command line or in a startup file. By default, the
startup file is named after the post office and has a . poa extension. It is located in the /opt /novell/
groupwise/agents/share directory.

Options

Usage Options:

--home post office directory

Specifies the post office directory, where the POA can access message and user databases. There
is no default location. You must use this switch in order to start the POA. During installation, the
--home switch is automatically set to the post office directory in the POA startup file.

@startup file

Specifies the location of the POA startup file. By default, the POA startup file is created in the /
opt/novell/groupwise/agents/share directory and is named after the post office, with a
.poa extension. The startup file includes the --home switch and must reside on the same server
where the POA is installed. For information about startup switches, see the GroupWise
Administration Guide (http://www.novell.com/documentation/groupwise2012).

- -show

Starts the POA with a user interface similar to that provided for the Windows POA. By default,
no user interface is provided for the POA on Linux. The --show startup switch can be used on
the command line or in the gwha . conf file used by the GroupWise High Availability Service; it
cannot be placed in the POA startup file.

Help Options:

--help, -?

Displays the help information and exits.
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Files
/opt/novell/groupwise/agents/share/post office name.poa
Startup file where startup switches are specified.

/var/log/novell/groupwise/post office.poa/mmddpoa.nnn

Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the
GroupWise Installation Guide (http://www.novell.com/documentation/groupwise2012) to set up the
POA to run as a non-root user.

/opt/novell/groupwise/agents/bin/gwpoa --home /gwsystem/acct
Starts the POA by specifying the post office directory.

/opt/novell/groupwise/agents/bin/gwpoa @acct.poa
Starts the POA by specifying the POA startup file.

/opt/novell/groupwise/agents/bin/gwpoa --show @acct.poa
Starts the POA with a user interface.

Diagnostics

If you use the --show startup switch, error messages are displayed in the Log Message box of the
POA server console where the POA is running. By default, error messages are also written to the
POA log file located in the /var/log/novell/groupwise/post office.poa directory.

Typically you find multiple log files in this directory. The first four characters of each file name
represent the date. The next three identify the agent. A three-digit extension allows for multiple log
files created on the same day. For example, a log file named 0518poa. 001 indicates that it is a POA
log file created on May 18. If you restart the POA on the same day, a new log file is created, named
0518poa.002.

For information about POA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
grpwise(1)

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwmta(l)

Name

gwmta - GroupWise Message Transfer Agent

Syntax

gwmta [--show] --home domain directory
gwmta [--show] @startup file
Description

A domain organizes post offices into a logical grouping for addressing, routing, and administration
purposes in your GroupWise system. Messages are transferred between post offices and domains by
the Message Transfer Agent (MTA).

You can provide MTA startup switches on the command line or in a startup file. By default, the
startup file is named after the domain and has a .mta extension. It is located in the /opt/novell/
groupwise/agents/share directory.

Options

Usage Options:

--home domain directory

Specifies the domain directory, where the MTA can access the domain database (wpdomain.db).
There is no default location. You must use this switch in order to start the MTA. The Agent
Installation program automatically sets the --home switch to the domain directory in the MTA
startup file.

@startup file

Specifies the location of the MTA startup file. By default, the MTA startup file is created in the /
opt/novell/groupwise/agents/share directory and is named after the domain, with a .mta
extension. The startup file includes the --home switch and must reside on the same server where
the MTA is installed. For information about startup switches, see the GroupWise Administration
Guide (http://www.novell.com/documentation/groupwise2012).

- -show

Starts the MTA with a user interface similar to that provided for the Windows MTA. By default,
no user interface is provided for the MTA on Linux. The --show startup switch can be used on
the command line or in the gwha . conf file used by the GroupWise High Availability Service; it
cannot be placed in the MTA startup file.

Help Options:

--help, -?

Displays the help information and exits.
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Files
/opt/novell/groupwise/agents/share/domain name.mta
Startup file where startup switches are specified.

/var/log/novell/groupwise/domain.mta/mmddmat.nnn

Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the
GroupWise Installation Guide (http://www.novell.com/documentation/groupwise2012) to set up the
MTA to run as a non-root user.

/opt/novell/groupwise/agents/bin/gwmta --home /gwsystem/provol
Starts the MTA by specifying the domain directory.

/opt/novell/groupwise/agents/bin/gwmta @provol.mta
Starts the MTA by specifying the MTA startup file.

/opt/novell/groupwise/agents/bin/gwmta --show @provol.mta

Starts the MTA with a user interface.

Diagnostics

If you use the --show startup switch, error messages are displayed in the Alert box of the MTA server
console where the MTA is running. By default, error messages are also written to the MTA log file
located in the /var/log/novell/groupwise/domain name.mta directory.

Typically you find multiple log files in this directory. The first four characters of each file name
represent the date. The next three identify the agent. A three-digit extension allows for multiple log
files created on the same day. For example, a log file named 0518mta. 001 indicates that it is an MTA
log file created on May 18. If you restart the MTA on the same day, a new log file is created, named
0518mta.002.

For information about MTA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwdva(l)

Name

gwdva - GroupWise Document Viewer Agent

Syntax

gwdva [@gwdva.dval]

Description

The Document Viewer Agent (DVA) converts documents from a wide variety of formats into HTML
format for viewing in GroupWise WebAccess. You can run as many as three DVAs to service
conversion requests for a single instance of the WebAccess Application. Each DVA must be installed
on a different server.

NOTE: The DVA can also optionally be used for converting documents into HTML format, so that
the Post Office Agent (POA) can index them. By default, the POA uses the Document Converter
Agent (DCA) to convert documents into HTML format for indexing.

The DVA consists of a master DVA process, and multiple worker DVA processes. The master DVA
process communicates with the WebAccess Application (and optionally with the POA) to transfer
documents back and forth for conversion. Each worker process converts a single document. Because
some documents contain unexpected data, they cannot be successfully converted. Such a conversion
failure terminates a worker process, but does not affect the stability of the master DVA process.

You can provide DVA startup switches on the command line or in a startup file. By default, the
startup file is gwdva.dva.

Options

NOTE: The --show switch that is available for other GroupWise agents to provide a user interface is
not available for the Linux DVA.

Usage Options:

--home directory

Specifies the path to the DVA working directory. The default location is /opt /novell/
groupwise/agents/bin/gwdva.dir. A more convenient, recommended location is /opt/
novell/groupwise/gwdva.

@startup file

Specifies a startup file to use, by default, gwdva.dva. You can add any of the DVA startup
switches to the startup file and then reference the file when starting the DVA. For information
about startup switches, see the GroupWise Administration Guide (http://www.novell.com/
documentation/groupwise2012).
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Help Options:

--help, -?

Displays the help information and exits.

Files

/opt/novell/groupwise/share/gwdva.dva

Startup file where startup switches are specified.

/var/log/novell/groupwise/dva/cdgwgwmmdddva.nnn

Log file where error messages are written.

Examples

This program must run as root.

/opt/novell/groupwise/agents/bin/gwdva
Starts the DVA using its default configuration.

/opt/novell/groupwise/agents/bin/gwdva --home /opt/novell/groupwise/gwdva
Starts the DVA and specifies its working directory.

/opt/novell/groupwise/agents/bin/gwdva @gwdva.dva
Starts the DVA by specifying its startup file.

Diagnostics

The DVA creates a new log file each day and each time it is started. The log file is named

mmdddva . nnn, where mm is the month, dd is the day, and nnn is a sequenced number (001 for the first
log file of the day, 002 for the second, and so on). The default location for the log files is the /var/
log/novell/groupwise/gwdva directory.

For information about DVA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwia(l)

Name

gwia - GroupWise Internet Agent

Syntax

gwia [--show] --home gateway directory
gwia [--show] @startup file

gwia [--show] --dhome SMTP directory
gwia [--show] --hn hostname
Description

The GroupWise Internet Agent (GWIA) enables you to send and receive messages over the Internet.

You can provide GWIA startup switches on the command line or in a startup file. At startup, the
GWIA reads its startup file, gwia. cfg. It is located in the /opt/novell/groupwise/agents/share
directory.

Options

Usage Options:

--home gateway directory

Points the GWIA to the GWIA’s gateway directory. Normally, this is the domain directory/
wpgate/gwia directory.

@startup file

Specifies the location of the GWIA configuration file, which is gwia.cfg by default. The GWIA
looks for gwia.cfgin the /opt /novell/groupwise/agents/share directory. For information
about startup switches, see the GroupWise Administration Guide (http://www.novell.com/
documentation/groupwise2012).

--dhome SMTP directory
Points to the SMTP service work area. This is normally the same as the GWIA’s gateway
directory (domain directory/wpgate/gwia).

--hn hostname

Provides the hostname that is displayed when someone connects to your GWIA via a Telnet
session. You should enter the hostname assigned to you by your Internet service provider.
Normally, the GWIA can get the information from another source and does not need this switch.
If you receive a message that the --hn switch is required, you must use the switch.

- -show

Starts the GWIA with a user interface similar to that provided for the Windows GWIA. By
default, no user interface is provided for the GWIA on Linux. The --show startup switch can
only be used on the command line; it cannot be placed in the startup file.
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Help Options:

--help, -?

Displays the help information and exits.

Files
/opt/novell/groupwise/agents/share/gwia.cfg
Startup file where startup switches are specified.

/var/log/novell/groupwise/gwia.domain name/mmddgwia.nnn

Log file where error messages are written.

Examples

By default, this program runs as root, but it is preferable to run it as a non-root user. See the
GroupWise Installation Guide (http://www.novell.com/documentation/groupwise2012) to set up the
GWIA to run as a non-root user.

/opt/novell/groupwise/agents/bin/gwia --home /gwsystem/provol/wpgate/gwia
Starts the GWIA by specifying its gateway directory in the domain.

/opt/novell/groupwise/agents/bin/gwia @gwia.cfg
Starts the GWIA by specifying its startup file.

/opt/novell/groupwise/agents/bin/gwia --show @gwia.cfg
Runs the GWIA with a user interface.

Diagnostics

If you have used the --show startup switch, error messages are displayed in the Log Message box of
the GWIA server console where it is running. By default, error messages are also written to the GWIA
log file located in the /var/log/novell/groupwise/domain_name.gwia directory.

Log files are named according to the date they are created. If the GWIA restarts during the day, the
file extension indicates which session is logged (for example 0518gwia. 003 indicates the third
session logged for May 18).

For information about GWIA error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
grpwise(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwmon(1)

Name

gwmon - GroupWise Monitor Agent.

Syntax

gwmon --home domain directory

Description

The Monitor Agent is a monitoring and management tool that allows you to monitor GroupWise
agents and gateways, along with Messenger agents, from any location where you are connected to
the Internet and have access to a Web browser. Some agent administration can also be performed
from your Web browser.

Monitor Agent configuration information is stored in the monitor.xml file in the /opt/novell/
groupwise/agents/share directory.

Options

NOTE: The --show switch that is available for other GroupWise agents to provide a user interface is
not available for the Linux Monitor Agent.

Usage Options:

--home domain directory

Specifies a domain directory where the Monitor Agent can access a domain database
(wpdomain.db). From the domain database, the Monitor Agent can determine which agents to
monitor, what user names and passwords are necessary to access them, and so on. For more
information about startup switches, see the GroupWise Administration Guide (http://
www.novell.com/documentation/groupwise2012).

Help Options:

--help, -?

Displays the help information and exits.

Files

/opt/novell/groupwise/agents/share/monitor.xml

Monitor Agent configuration file. Provides a domain directory where the Monitor Agent can
determine what GroupWise and Messenger agents to monitor. The monitor.xml file is created
during installation.

/var/log/novell/groupwise/gwmon/mmddmon . nnn

Log file for Monitor Agent events.
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/var/log/novell/groupwise/gwmon/mmddhist.nnn

Log file for dumps of monitored agent MIB values.

Examples

This program can run as any user.

/opt/novell/groupwise/agents/bin/gwmon --home /gwsystem/provol

Starts the Monitor Agent by accessing the domain database in the specified domain directory.

Diagnostics

The Monitor Agent writes to two different types of log files. Event log files record error messages,
status messages, and other types of event-related messages. History log files record dumps of all MIB
values gathered during each poll cycle of monitored agents. By default, both types of log files are
created in the /var/log/novell/groupwise/gwmon directory.

Typically you find multiple log files in this directory. The first four characters of each file name
represent the date. The following characters are mon for event log files and hist for history log files.
A three-digit extension allows for multiple log files created on the same day. For example, a log file
named 0518mon. 001 indicates that it is a Monitor Agent event log file created on May 18. If you
restart the Monitor Agent on the same day, a new event log file is created, named 0518mon. 002.

For information about Monitor Agent error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also
grpwise-ma(l).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).

GroupWise 2012 Installation Guide


http://www.novell.com/documentation/groupwise2012
http://www.novell.com
http://bugzilla.novell.com

gwcheck(1)

Name

gwcheck - GroupWise Check utility.

Syntax

gwcheck [--opt=[/path name/]options file [--batch] ]

Description

[--po=post_office directoryl]
[--pa=archive directoryl
[--pr=remote mailbox directory]

GroupWise Check (GWCheck) is a tool provided for GroupWise to check and repair GroupWise user,
message, library, and resource databases without needing ConsoleOne. In addition to checking and
repairing databases in the post office, it also checks and repairs users’ remote, caching, and archive
databases on user workstations or other personal locations.

GWCheck provides a user interface similar to the Mailbox/Library Maintenance feature in
ConsoleOne. The list below illustrates the types of database repair that you can perform using
GWCheck. Click Help in GWCheck for more information about the database repair options that are

available.

Analyze/Fix Databases

Structure
Index Check
Contents
Collect Statistics
Attachment File Check
Fix Problems
Update User Disk Space Totals

Expire/Reduce Messages

Reduce Only
Expire and Reduce
Items Older Than
Downloaded Items Older Than
Items Larger Than
Trash Older Than
Reduce Mailbox To
Reduce Mailbox to Limited Size
Include
Received Items
Sent Items
Calendar Items
Only Backed-Up Items
Only Retained Items
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Mailbox Statistics

Mailbox Statistics
Box Limit
Expire Statistics
(same as the Expire and Reduce options)

Archive/Delete Documents

(no options)

Delete Activity Logs

Delete Logs Older Than nn Days

Analyze/Fix Library

Verify Library

Fix Document/Version/Element

Verify Document Files

Validate All Document Security

Synchronize User Name

Remove Deleted Storage Areas
Move Documents First

Reassign Orphaned Documents
New Author

Reset Word Lists

Audit Report

Log Accounts without Activity for Previous nn Days

GWCheck Options File

If you repeatedly use the same set of database repair options, you can save them in an options file. To
create an options file, start GWCheck, select database repair options as needed, then click Save. By
default, the options file is named gwcheck. opt and is saved in your home directory. You can change
the file name and location as needed. You can retrieve the options file from the user interface or you
can specify the options file on the command line. The options file is created in XML format on all
platforms. Therefore, you can create the options file on any platform and use it on any platform
interchangeably.

After you have created one or more options files, you can run GWCheck as a script, rather than using
the user interface.

Options

Usage Options:

--opt=options file

Specifies the name of the options file. By default, this file is saved in your home directory. If you
want to save it to another directory, specify a path relative to your home directory or specify an
absolute path.
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--batch

Runs GWCheck in the background, without a user interface. Use an options file to specify the
database repair options.

--po=post office directory

Specifies the path to the post office directory.

--pa=archive directory

Specifies the path to the archive directory.

--pr=remote mailbox directory

Specifies the path to the remote mailbox database.

Help Options:

--help, -?

Displays the help information and exits.

Files

[/path name/]gwcheck.opt

Options file. Create this file by setting database repair options in GWCheck, then click Save. The
options file is created in XML format on all platforms. Therefore, you can create the options file
on any platform and use it on any platform interchangeably.

Examples

This program normally runs as root.

/opt/novell/groupwise/gwcheck/bin/gwcheck
Starts the GUI GWCheck.

/opt/novell/groupwise/gwcheck/bin/gwcheck --opt=gwcheck.opt --batch

Starts GWCheck with an options file that provides default database repair options and runs it in
batch mode so that there is no user interface.

/opt/novell/groupwise/gwcheck/bin/gwcheck --opt=gwcheck.opt --pa=/home/gsmith/
gwarchive

Runs GWCheck for an archive mailbox.

Diagnostics

For information about GWCheck error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.
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See Also

gwcheckt(1).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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gwcheckt(1)

Name

gwcheckt - Text-Based GroupWise Check

Syntax

gwcheckt options file [--dump]

Description

Text-Based GroupWise Check (GWCheckT) is a tool provided for GroupWise to check and repair
GroupWise user, message, library, and resource databases without needing ConsoleOne or any GUI
environment. Text-Based GWCheckT can perform all of the same types of database repair as the GUI
GWCheck, but in a text-only environment.

Text-Based GWCheckT has no user interface. You must create the required options file by using the
GUI GroupWise Check (GWCheck), or by using the Mailbox/Library Maintenance feature in
ConsoleOne.

To create the required options file, start the GUI GWCheck in an environment where the X Window
System is available, select database repair options as needed, then click Save. By default, the options
file is named gwcheck . opt and is saved in your home directory. You can change the file name and
location as needed.

Options

Usage Options:

[/path name/]loptions file

Specifies the name of the options file. By default, this file is saved by the GUI GWCheck in your
home directory. If you saved it to another directory, specify a path relative to your home
directory or specify an absolute path.

- -dump

Displays the contents of the options file so that you can see what database repair options have
been selected.

Help Options:

--help, -?

Displays the help information and exits.

Files

options file

(Required) Use the GUI GWCheck to select and save database repair options in the gwcheck . opt
file, then run the Text-Based GWCheckT with the options file to execute the database repair
options.
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Examples

This program normally runs as root.

/opt/novell/groupwise/gwcheck/bin/gwcheckt gwcheck.opt

Runs GWCheckT in a text only environment, based on the database repair options provided in
the options file created in the GUI GWCheck.

/opt/novell/groupwise/gwcheck/bin/gwcheckt gwcheck.opt --dump
Lists the settings of the database repair options in the specified options file.
Diagnostics

For information about GWCheck error messages, see Troubleshooting 1: Error Messages (http://
www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also

gwcheck(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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dbcopy(1)

Name

dbcopy - GroupWise Database Copy utility

Syntax

dbcopy /source directory /destination directory
dbcopy [-b] [-i] [-t] [-v] [-w] /source directory /destination directory
dbcopy -m [-d] [-p] [-f] [-s] [-a]l [-ul [-k] [-o] [-1]

/source directory /destination directory

Description

The GroupWise Database Copy utility (DBCopy) copies files from a live GroupWise domain, post
office, or remote document storage area to a static location for backup. During the copy process, it
prevents the files from being modified, using the same locking mechanism used by other GroupWise
programs that access databases. This ensures that the backed-up versions are consistent with the
originals even when large databases take a substantial amount of time to copy.

The DBCopy utility is not installed automatically with the rest of the GroupWise software. The
DBCopy RPM is located in the admin subdirectory of your software distribution directory (/opt/
novell/groupwise/software). When you install the RPM, the dbcopy executable is placed in the /
opt/novell/groupwise/agents/bin directory.

In addition to backups, the DBCopy utility is used in conjunction with the GroupWise Server
Migration Utility (http://www.novell.com/documentation/groupwise2012), which helps you migrate
GroupWise data from NetWare or Windows to Linux. Some startup switches can be used for both
backups and migration. Other startup switches are used only for migration.

Options

General Usage Options:

source directory
Specifies the full path to the domain directory, post office directory, or remote document storage
area directory.

destination directory

Specifies the full path to the directory where you want to copy the domain, post office, or remote
document storage area.

Usage Option for Backups Only:
-i mm-dd-yyyy

Indicates that you are performing an incremental backup of only those files with the specified
date or newer.
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7
Raises the priority of DBCopy processing. By default, if DBCopy detects that a POA is running,
it lowers its own priority so that it does not interfere with POA processing. If DBCopy runs at
night, when GroupWise users are not active, use the -j switch so that DBCopy does not lower its
own priority. This speeds up DBCopy processing.

Usage Options for Backups and Migration:

-b

Copies a remote document storage area associated with a library, including all subdirectories
and compressed BLOB (binary large object) files in which library documents are stored.

-t threads

Specifies the number of copy threads. The default is 5. Valid values range from 1 to 10.

Turns on verbose logging. The DBCopy log file is named mmddgwbk . nnn. The first four
characters represent the date. A three-digit extension allows for multiple log files created on the
same day. The log file is created at the root of the destination domain, post office, or document
storage area directory. In addition to status and error messages, it lists any remote document
storage areas associated with a post office.

Turns on continuous logging to the screen.

Usage Options for Migration Only:

-m
Copies all directories and files associated with a domain, post office, or document storage area
as part of a migration; also ensure that all directory names and file names are in lowercase.
-d
Indicates migration of a domain.
-pP
Indicates migration of a post office.
-f
Indicates that this is the first pass of the migration process.
-8

Indicates that this is the second pass of the migration process.

-a ip address

Specifies the IP address to bind to for the migration process. The default is all available IP
addresses.

-u port number

Specifies the TCP port number for status requests during the migration.

Skips collecting database size information during the migration.
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Skips the second copy of the post office of files directory during the migration

-1 /source directory

Performs the GroupWise Check function of storelowercase on the migrated GroupWise
databases. Its purpose is to do an “in-place” conversion of files and directories to lowercase,
rather than as part of a copy operation. For a post office, it also updates the guardian database
with the new, lowercase names.

For example, you could use this functionality if you have a domain or post office located on a
SAN that was mounted for access by the GroupWise NetWare agents, but you now want to run
the GroupWise Linux agents for the domain or post office, because NetWare is not supported for
GroupWise 2012.

Do not use other switches with the -1 switch.

Help Options:

-h, --help, -?

Displays the help information and exits.

Files

/path name/mmddgwbk.nnn

Log file created at the root of the destination directory.

Examples

This program normally runs as root.

Backup Examples:

/opt/novell/groupwise/agents/bin/dbcopy /gwsystem/acct /backups/acct

Copies a post office to a backup location.
/opt/novell/groupwise/agents/bin/dbcopy --b /gwsystem/acct library /backups/
acct library

Copies a library to a backup location.

Migration Examples:

/opt/novell/groupwise/agents/bin/dbcopy -m -f /post office directory /
destination directory

Performs the first migration pass for a post office.
/opt/novell/groupwise/agents/bin/dbcopy -m -s /post office directory /
destination directory

Performs the second migration pass for a post office.
/opt/novell/groupwise/agents/bin/dbcopy -m /domain directory /
destination directory

Migrates a domain.
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/opt/novell/groupwise/agents/bin/dbcopy -m -b /storage area directory /
destination directory

Migrates a document storage area.

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also

gwtmstmp(1).

To report problems with this software or its documentation, visit Novell Bugzilla (http://
bugzilla.novell.com).
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gwtmstmp(1)

Name

gwtmstmp - GroupWise Time Stamp utility.

Syntax
gwtmstmp --postpath post office directory [--set] [--get] [--clear]
[--backup] [--restore] [--retention]
[--date mm/dd/yyyy]l [--time hh:mm[am|pm]] [--gmttime seconds]
[--userid GroupWise userID] [--userdb user databasel
Description

The GroupWise Time Stamp utility (GWTMSTMP) places date and time information on user
databases (userxxx.db) in order to support message backup, restore, and retention. The time stamp
indicates the last time the database was backed up.

If a user deletes an item from his or her mailbox and purges it from the Trash, the item is removed
from the user’s database only if the time stamp shows that the item has already been backed up.
Otherwise, the item remains in the user’s database until the database is backed up, at which time it is
purged from the database.

You can run the GroupWise Time Stamp utility on all user databases in a post office or on a single
user database. No other databases are affected.

Backup

To ensure thorough user database backups, you can make sure that deleted items are not purged
from users’ databases until they have been backed up. Two conditions must be met in order to
provide this level of protection against loss of deleted items:

¢ The Do Not Purge Items Until They Are Backed Up option must be selected for the post office in
ConsoleOne (Tools > GroupWise Utilities > Client Options > Environment > Cleanup).

¢ User databases (userxxx.db) must be time-stamped every time a backup is performed so that
items can be purged only after they are backed up.

Restore

You can use the GroupWise Time Stamp utility to manually add the restore time stamp to the
database. The restore time stamp is not required for any GroupWise feature to work properly. Its
primary purpose is informational.

Retention

If you use a message retention application, the application should automatically add the retention
time stamp after retaining the database’s messages. Any messages with dates that are newer than the
retention time stamp cannot be purged from the database. You can use the GroupWise Time Stamp
utility to manually add a retention time stamp.
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Options

Usage Options:

--postpath /post office directory, -p /post office directory

(Required) Specifies the full path to the post office directory where the user databases to time-
stamp are located.

--set, -s

Sets the current date and time (of backup, restore, or retention) on user databases.

--get, -g

Lists existing backup, restore, and retention time stamp information for user databases. If no
time stamps are set, “unknown” is displayed. If no other operational switch is used, --get is
assumed.

--clear, -c

Removes time stamps (of backup, restore, or retention) from user databases.

--backup, --restore, --retention, --modifiedretention, -b, -r, -n,-mn

Specifies the type of time stamp (backup, restore, retention, or modified retention) on which to
perform the get or set operation. If no time stamp type is specified, the operation is performed
on the backup time stamp. Multiple time stamp types can be specified.

--date mm/dd/yyyy, -4 mm/dd/yyyy

Specifies the date that you want placed on user databases. Use the format mm/dd/yyyy; for
example, 05/18/2012 for May 18, 2012. If no date is specified, the current date is used. If your
locale does not use the mm/dd/yyyy format, use gwtmstmp --help to determine the format for
your locale.

--time hh:mm[am|pm], -t hh:mm[am|pm]

Specifies the time that you want placed on user databases. Use the format hh:mm, expressed in a
24-hour format (for example, 20:45) or expressed with the am or pm option (for example,
8:45pm). If no time is specified, 00:00 is used.

--gnttime seconds, -m seconds

Specifies the number of seconds since midnight on January 1, 1970 GMT that you want placed
on the user databases.

--userid user name, -u user name

Provides a specific GroupWise user ID so that an individual user database can be time-stamped.

--userdb user database, -e user_database
Provides a specific database name so that an individual user database can be time-stamped.
Help Options:

--help, -?

Displays the help information and exits.
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Examples

This program normally runs as root.

/opt/novell/groupwise/agents/bin/gwtmstmp -p /gwsystem/acct

Checks the existing time stamp on all GroupWise user databases in a post office.

/opt/novell/groupwise/agents/bin/gwtmstmp -p /gwsystem/acct --set

Sets a current time stamp on all user databases in a post office.

Diagnostics

For information about GroupWise Time Stamp utility error messages, see Troubleshooting 1: Error
Messages (http://www.novell.com/documentation/groupwise2012).

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also

dbcopy(1).

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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gwcesrgen(1)

Name

gwesrgen - GroupWise Generate CSR utility

Syntax

gwcsrgen

Description
The GroupWise Generate CSR utility (GWCSRGEN) generates a certificate signing request (CSR) file

and a private key file. These files are needed to provide secure communication through SSL (Secure
Socket Layer) connections between GroupWise agents and clients.

When you run the Generate CSR utility, you must fill in the following fields in the interface provided:

Key Filename

The name for the private key file (for example, serverl.key). If you don’t want the file stored in the
same directory as the gwcsrgen executable, specify a full path with the file name (for example, /
certs/serverl.key).

Key Password

The password for the private key. The password can be up to 256 characters (single-byte
environments).

CSR Filename

The name for the certificate signing request file (for example, serverl.csr). If you don’t want the file
stored in the same directory as the gwcsrgen executable, specify a full path with the file name (for
example, /certs/serverl.csr).

Country

The two-letter abbreviation for your country (for example, US).

State/Province

The name of your state or province (for example, Utah). Use the full name. Do not abbreviate it.
City

The name of your city (for example, Provo).

Organization

The name of your organization (for example, Novell, Inc.).
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Division

The division of your organization that this certificate is being issued to (for example, Product
Development).

Hostname of Server

Specify the DNS hostname of the server where the server certificate will be used (for example,
dev.provo.novell.com).

Configuration File

For convenience, you can record the information for the above fields in a configuration file so that it is
automatically provided whenever you run the Generate CSR utility. The configuration file must have
the following format:

[Private Key]
Location =
Extension = key

[CSR]
Location =
Extension = csr

[Required Information]

Country =

State =

City =

Organization =

Division =

Hostname =

If you do not want to provide a default for a certain field, insert a comment character (#) in front of
that line. Name the file gwcsrgen. cnf. You can save the file in your current directory (for example, /
opt/novell/groupwise/agents/bin if you run the gwecsrgen executable from that default location)
orin /etc/opt/novell/groupwise/agents

What’'s Next

After the CSR and private key files are created, you need to submit the CSR to a Certificate Authority
in order to receive a server certificate. If you haven't previously used a Certificate Authority, you can
use the keywords “Certificate Authority” to search the Web for Certificate Authority companies. The
process of submitting the CSR varies from company to company. Most provide online submission of
the request. Follow their instructions for submitting the request.

When you receive the server certificate, you can store it, along with the private key file, anywhere on
the server where they will be used. Any GroupWise agent (MTA, POA, DVA, or GWIA) that is
running on the server can use the certificate and private key when using SSL for secure connections.

Files

/etc/opt/novell/groupwise/agents/bin/gwecsrgen.cnf

Configuration file. By providing a configuration file, you do not need to fill in the fields
manually every time you run the Generate CSR utility.

GroupWise Linux Executables 327



Examples

This program normally runs as root.

/opt/novell/groupwise/agents/bin/gwcsrgen

Starts the Generate CSR utility. If you have supplied a configuration file, the fields are filled in
based on the data in the configuration file.

Authors

Copyright 2004-2012, Novell, Inc. (http://www.novell.com). All rights reserved.

See Also

To report problems with this software or its documentation, visit Novell Bugzilla. (http://
bugzilla.novell.com).
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C Third-Party Materials

Cl

The following third-party software is included in Novell GroupWise 2012:

*

*

*

Section C.1, “Apache,” on page 329

Section C.2, “BLT,” on page 330

Section C.3, “GD Graphics Library,” on page 330

Section C.4, “getopt.h,” on page 331

Section C.5, “ICU License - ICU 1.8.1 and Later,” on page 332
Section C.6, “JRE,” on page 332

Section C.7, “NET-SNMP Open Source Package,” on page 332
Section C.8, “"ODMA 2.0,” on page 335

Section C.9, “OpenLDAP,” on page 336

Section C.10, “OpenSSL,” on page 336

Section C.11, “Python 2.2,” on page 338

Section C.12, “Yahoo! UI Library,” on page 338

Apache

The Apache Software License, Version 1.1
Copyright (c) 2000 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted

provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and

the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions

and the following disclaimer in the documentation and/or other materials provided with the

distribution.

The end-user documentation included with the redistribution, if any, must include the following

acknowledgment:

“This product includes software developed by the Apache Software Foundation (http://

www.apache.org/).”

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-

party acknowledgments normally appear.
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C.2

C.3

4. The names “Apache” and “Apache Software Foundation” must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact apache@apache.org.

5. Products derived from this software may not be called “Apache”, nor may “Apache” appear in
their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED "AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache
Software Foundation. For more information on the Apache Software Foundation, please see <http://
www.apache.org/>.

Portions of this software are based upon public domain software originally written at the National
Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

BLT

Copyright 1993-1998 Lucent Technologies, Inc.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that the copyright notice and warranty disclaimer appear in supporting documentation,
and that the names of Lucent Technologies any of their entities not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

Lucent Technologies disclaims all warranties with regard to this software, including all implied
warranties of merchantability and fitness. In no event shall Lucent Technologies be liable for any
special, indirect or consequential damages or any damages whatsoever resulting from loss of use,
data or profits, whether in an action of contract, negligence or other tortuous action, arising out of or
in connection with the use or performance of this software.

GD Graphics Library

Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Cold Spring
Harbor Laboratory. Funded under Grant P41-RR02188 by the National Institutes of Health.

Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by Boutell.Com, Inc.
Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip Warner.
Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg Roelofs.

Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John Ellson
(ellson@graphviz.org).

Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson (ellson@graphviz.org).
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Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 2003, 2004, Doug
Becker and copyright (C) 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 Thomas G.
Lane. This software is based in part on the work of the Independent JPEG Group. See the file
README-JPEG.TXT for more information.

Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David Rowley, with
modifications for thread safety by Thomas Boutell.

Portions relating to GIF decompression copyright 1990, 1991, 1993 by David Koblas, with
modifications for thread safety by Thomas Boutell.

Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo and Johan Van
den Brande.

Permission has been granted to copy, distribute and modify gd in any context without fee, including
a commercial application, provided that this notice is present in user-accessible supporting
documentation.

This does not affect your ownership of the derived work itself, and the intent is to assure proper
credit for the authors of gd, not to interfere with your productive use of gd. If you have questions,
ask. “Derived works” includes all programs that utilize the library. Credit must be given in user-
accessible documentation.

This software is provided “AS IS.” The copyright holders disclaim all warranties, either express or
implied, including but not limited to implied warranties of merchantability and fitness for a
particular purpose, with respect to this code and accompanying documentation.

Although their code does not appear in the current release, the authors also wish to thank Hutchison
Avenue Software Corporation for their prior contributions.

getopt.h

Copyright (c) 2000 The NetBSD Foundation, Inc.
All rights reserved.

This code is derived from software contributed to The NetBSD Foundation by Dieter Baron and
Thomas Klausner.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement:

This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

4. Neither the name of The NetBSD Foundation nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBUTORS
“ASIS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
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PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ICU License - ICU 1.8.1 and Later

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2006 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above
copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS
NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JRE

JRE Note

This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are
available at http://oss.software.ibm.com/icu4j/.

NET-SNMP Open Source Package

¢ Section C.7.1, “---- Part 1: CMU/UCD copyright notice: (BSD like) ----- ,” on page 333

¢ Section C.7.2, “---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----,” on
page 333

¢ Section C.7.3, “---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- ,” on page 334

¢ Section C.7.4, “---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- ,” on page 334
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---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose

and without fee is hereby granted, provided that the above copyright notice appears in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and
that the name of CMU and The Regents of the University of California not be used in advertising or

publicity pertaining to distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice
(BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the Networks Associates Technology, Inc nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS 1S”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ The name of Cambridge Broadband Ltd. may not be used to endorse or promote products
derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER “AS IS” AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright © 2003 Sun Microsystems, Inc.,
4150 Network Circle, Santa Clara, California 95054, U.S.A.
All rights reserved.

Use is subject to license terms below.
This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE
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LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ODMA 2.0

OPEN DOCUMENT MANAGEMENT API LICENSE 1.0
ODMA 2.0 SPECIFICATIONS AND SOFTWARE
Copyright © 1994-1998 AIIM International

LICENSE:

Redistribution and use in source and binary forms, with or without modifications, are permitted
provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

¢ Neither the name of AIIM International nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

DISCLAIMER:

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS”
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

ADDITIONAL INFORMATION:
+ ODMA reference materials, software, and status:
<http://ODMA.info>

¢ Information about this ODMA License and its application:
<http://DMare.info/license/>

¢ Open Source Definition 1.9 and the BSD License
(the model for this ODMA license):
<http://opensource.org>

¢+ HTML (ISO 8859-1) version of this license:
<http://Dmware.info/license/P040801F.htm>
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OpenLDAP

The OpenLDAP Public License
Version 2.8, 17 August 2003

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1 Redistributions in source form must retain copyright statements and notices,

2 Redistributions in binary form must reproduce applicable copyright statements and notices, this
list of conditions, and the following disclaimer in the documentation and/or other materials
provided with the distribution, and

3 Redistributions must contain a verbatim copy of this document.

The OpenLDAP Foundation may revise this license from time to time. Each revision is distinguished
by a version number. You may use this Software under terms of this license revision or under the
terms of any subsequent revision of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS CONTRIBUTORS
“ASIS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The names of the authors and copyright holders must not be used in advertising or otherwise to
promote the sale, use or other dealing in this Software without specific, written prior permission.
Title to copyright in this Software shall at all times remain with copyright holders.

OpenLDAP is a registered trademark of the OpenLDAP Foundation.

Copyright 1999-2003 The OpenLDAP Foundation, Redwood City, California, USA. All Rights
Reserved. Permission to copy and distribute verbatim copies of this document is granted.

OpenSSL

OpenSSL License
Copyright (c) 1998-2002 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgment:

336  GroupWise 2012 Installation Guide



“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit. (http://www.openssl.org/)”

4 The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5 Products derived from this software may not be called “OpenSSL” nor may “OpenSSL” appear
in their names without prior written permission of the OpenSSL Project.

6 Redistributions of any form whatsoever must retain the following acknowledgment:

“This product includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/)”

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS” AND ANY EXPRESSED OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscape's SSL.

This library is free for commercial and non-commercial use as long as the following conditions are
adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is
covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young’s, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author of
the parts of the library used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1 Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3 All advertising materials mentioning features or use of this software must display the following
acknowledgement:

“This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)”
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The word “cryptographic” can be left out if the routines from the library being used are not
cryptographic related :-).

4 If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement:

“This product includes software written by Tim Hudson (tjh@cryptsoft.com)”

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "ASIS” AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

The licence and distribution terms for any publicly available version or derivative of this code cannot
be changed; i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

Python 2.2

Copyright (c) 1991 - 1995, Stichting Mathematisch Centrum Amsterdam, The Netherlands. All rights
reserved.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose
and without fee is hereby granted, provided that the above copyright notice appear in all copies and
that both that copyright notice and this permission notice appear in supporting documentation, and
that the name of Stichting Mathematisch Centrum or CWI not be used in advertising or publicity
pertaining to distribution of the software without specific, written prior permission.

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO
THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS, IN NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE FOR ANY
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Yahoo! Ul Library

Yahoo! Ul Library uses the BSD License which states:
Software License Agreement (BSD License)
Copyright (c) 2006, Yahoo! Inc.

All rights reserved.
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Redistribution and use of this software in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

¢ Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

¢ Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

¢ Neither the name of Yahoo! Inc. nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission of
Yahoo! Inc.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Documentation Updates

This section lists updates to the GroupWise 2012 Installation Guide that have been made since the initial
release of Novell GroupWise 2012. The information helps you to keep current on documentation
updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Installation Guide was republished. Within
each dated section, the updates are listed by the section title.

The GroupWise 2012 Installation Guide has been updated on the following dates:

¢ Section D.1, “May 30, 2014 (GroupWise 2012 SP3),” on page 341
¢ Section D.2, “April 16, 2013 (GroupWise 2012 SP2),” on page 342
¢ Section D.3, “September 20, 2012 (GroupWise 2012 SP1),” on page 343

May 30, 2014 (GroupWise 2012 SP3)

Location Change

Product Overview

Section 2.1.1, “Hardware and Added support for Windows Server 2012 R2.
Operating System
Requirements,” on page 19

Section 2.1.4, “Web Server Specified the IBM JRE, because that is what GroupWise
Requirements,” on page 21 is tested with.

Section 2.2.3, “GroupWise Added WebAccess Mobile support for Android 4.1 using
WebAccess Mobile the Chrome browser.
Requirements,” on page 23

Section 2.2.1, “GroupWise Added support for Windows 8.1.
Client Requirements,” on
page 22

Installation

Section 4.2.2, “Software Added support for Windows Server 2012 R2.
Requirements,” on page 80

and subsequent parallel

sections

Section 9.3.1, “GroupWise Added Support for Windows 8.1.
Windows Client Workstation
Requirements,” on page 214

Update
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Location

Change

Section 14.7, “Understanding
WebAccess Updates,” on
page 242

Chapter 22, “Updating
GroupWise WebAccess,” on
page 267

Appendixes

Section A.1.2, “Compatibility
with GroupWise 7 on Linux,”
on page 291

Section A.2.2, “Compatibility
with GroupWise 7 on
Windows,” on page 293

gwcheck(1) (page 313)
dbcopy(1) (page 319)

Called out the need to implement a different form of
access control because the WebAccess Agent is no
longer present.

Indicated that extended support for GroupWise 7 has
ended.

Corrected the syntax of the GWCheck options.

Improved the description of the -m switch; emphasized
not using other switches with the -l switch.

D.2 April 16, 2013 (GroupWise 2012 SP2)

Location

Change

Product Overview

Section 2.1.1, “Hardware and
Operating System
Requirements,” on page 19

Section 2.1.2, “Software
Requirements,” on page 20

Section 2.1.4, “Web Server
Requirements,” on page 21

Section 2.2.1, “GroupWise
Client Requirements,” on
page 22

Installation

Section 4.2.2, “Software
Requirements,” on page 80
and subsequent parallel
sections

Section 9.3.1, “GroupWise
Windows Client Workstation
Requirements,” on page 214

Update

Added support for Windows Server 2012; improved the
accessibility of agent memory requirements.

Removed non-server Windows versions as appropriate
locations for running the GroupWise Installation
program.

Specified the IBM JRE, because that is what GroupWise
is tested with.

Added support for Windows 8.

Added support for Windows Server 2012; removed non-
server Windows versions as appropriate locations for
running the GroupWise Installation program.

Added Support for Windows 8.
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Location Change

Section 14.7, “Understanding Called out the need to implement a different form of
WebAccess Updates,” on access control because the WebAccess Agent is no
page 242 longer present.

Chapter 22, “Updating
GroupWise WebAccess,” on
page 267

Appendixes

Section A.1.2, “Compatibility  Indicated that extended support for GroupWise 7 has
with GroupWise 7 on Linux,” ended.
on page 291

Section A.2.2, “Compatibility
with GroupWise 7 on
Windows,” on page 293

gwcheck(1) (page 313) Corrected the syntax of the GWCheck options.

dbcopy(1) (page 319) Improved the description of the -m switch; emphasized
not using other switches with the -l switch.

D.3 September 20, 2012 (GroupWise 2012 SP1)

Location Change

Product Overview

Section 1.1.5, “Competitive Added a competitive review for Google Gmail.
Performance,” on page 17

Section 2.2.3, “GroupWise Added support for Android tablets.
WebAccess Mobile
Requirements,” on page 23

Installation

“WebAccess Mobile User Added support for Android tablets.
Requirements” on page 108
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